## Contents

**Preface**

- About This Book ................................................. 18
- Adobe Portable Document Format ............................. 21
- Documentation Conventions .................................... 22

**What’s New**

- New Features and Enhancements ............................ 26

**Chapter 1. Introduction to OMEGAMON II**

- About OMEGAMON II ........................................... 31
- CUA Interface for Ease of Use ............................... 31
- Logical Tuning Approach ....................................... 32
- Features of the OMEGAMON II for CICS CUA Interface .. 33
- Batch Reporting Methods ..................................... 35
- CUA Interface Characteristics ............................... 36

**Chapter 2. Logging Onto OMEGAMON II**

- Logging On Directly ........................................... 50
- Logging on through OMEGAVIEW .............................. 55
- Begin Your OMEGAMON II Session ........................... 56

**Chapter 3. Understanding the Region Status Panel**

- Overview ....................................................... 59
- Status Bar Indicators .......................................... 61
- Switching to Another CICS Region .......................... 64
- Date/Time Stamp ................................................ 65
- Auto Refresh Interval ......................................... 66
- Function Keys .................................................. 67
- Actions Pull-Down Menu ...................................... 68
- GoTo Pull-Down Menu ......................................... 69
- Index Pull-Down Menu ........................................ 74
- Options Pull-Down Menu ...................................... 79
- Help Pull-Down Menu ......................................... 111

**Chapter 4. CICS Tables**

- Overview ....................................................... 115
- AID (Automatic Initiators) .................................... 116
- CSA (CICS Common System Area) ............................ 117
- DCT (Destinations) ............................................ 118
- DDIR (DL/I Database Directory) ............................. 123
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>DL/I (DL/I Control Blocks)</td>
<td>124</td>
</tr>
<tr>
<td>DUMP (Dumps)</td>
<td>125</td>
</tr>
<tr>
<td>ENQ (Enqueues)</td>
<td>126</td>
</tr>
<tr>
<td>EXITS (Exit Points and Programs)</td>
<td>127</td>
</tr>
<tr>
<td>FCT (Files)</td>
<td>129</td>
</tr>
<tr>
<td>ICE (Interval Control Elements)</td>
<td>133</td>
</tr>
<tr>
<td>JOUR (Journals)</td>
<td>134</td>
</tr>
<tr>
<td>LSR (Local Shared Resources)</td>
<td>137</td>
</tr>
<tr>
<td>PDIR (DL/I PSB Directory)</td>
<td>138</td>
</tr>
<tr>
<td>PROG (Programs)</td>
<td>140</td>
</tr>
<tr>
<td>SIT (Initialization Table)</td>
<td>143</td>
</tr>
<tr>
<td>TCB (CICS TCBs)</td>
<td>144</td>
</tr>
<tr>
<td>TCT (Terminals)</td>
<td>145</td>
</tr>
<tr>
<td>TCTFX (Terminal Control Table Prefix)</td>
<td>151</td>
</tr>
<tr>
<td>TCTSE (TCT System Entries)</td>
<td>152</td>
</tr>
<tr>
<td>TD (Transient Data)</td>
<td>154</td>
</tr>
<tr>
<td>TRACE (Trace) for CICS/ESA</td>
<td>155</td>
</tr>
<tr>
<td>TRACE (Trace) for CICS/MVS</td>
<td>156</td>
</tr>
<tr>
<td>TRAN (Transactions)</td>
<td>158</td>
</tr>
<tr>
<td>TS (Temporary Storage)</td>
<td>161</td>
</tr>
<tr>
<td>TSQ (Temporary Storage Queues)</td>
<td>162</td>
</tr>
<tr>
<td>XRF (Extended Recovery Facility)</td>
<td>163</td>
</tr>
<tr>
<td>Chapter 5. Task History</td>
<td>165</td>
</tr>
<tr>
<td>Task History Panel</td>
<td>166</td>
</tr>
<tr>
<td>Task History Details Panel</td>
<td>168</td>
</tr>
<tr>
<td>Chapter 6. Application Trace</td>
<td>191</td>
</tr>
<tr>
<td>Displaying Application Trace Summary Data</td>
<td>192</td>
</tr>
<tr>
<td>Application Trace Panel Description</td>
<td>195</td>
</tr>
<tr>
<td>Displaying Detailed Trace Data</td>
<td>198</td>
</tr>
<tr>
<td>Chapter 7. CICS Memory</td>
<td>207</td>
</tr>
<tr>
<td>CICS Memory Panel Overview</td>
<td>208</td>
</tr>
<tr>
<td>Using the CICS Memory Action Codes</td>
<td>211</td>
</tr>
<tr>
<td>Using the Tools Pull-down</td>
<td>218</td>
</tr>
<tr>
<td>Using CICS Memory Pushbuttons</td>
<td>226</td>
</tr>
<tr>
<td>Chapter 8. MVS Resources and the System Console</td>
<td>233</td>
</tr>
<tr>
<td>MVS Resources Panel</td>
<td>234</td>
</tr>
<tr>
<td>MVS Resources Pushbuttons</td>
<td>235</td>
</tr>
<tr>
<td>System Console Panel</td>
<td>237</td>
</tr>
<tr>
<td>Chapter 9. Workloads</td>
<td>243</td>
</tr>
<tr>
<td>Automatic Initiate Descriptors</td>
<td>244</td>
</tr>
<tr>
<td>Interval Control Elements (ICEs)</td>
<td>249</td>
</tr>
</tbody>
</table>
Appendix C.  Simplified Signon .................................................. 465
  Using Simplified Signon .................................................. 466
  Implementing Simplified Signon for an Existing User .......... 467
  Using Simplified Signon .................................................. 468
Appendix D.  CUA Actions .................................................... 471
  Using CUA Actions ....................................................... 472
  Procedures for Modifying Resource Attributes ............... 473
  Summary of Panel Changes ............................................. 476
Appendix E.  Guide to Candle Customer Support ..................... 489
  Base Maintenance Plan ................................................. 490
  Enhanced Support Services .......................................... 494
  Customer Support Contact Information .......................... 495
Index ................................................................. 497
List of Figures

FIGURE 1. Typical CUA Interface Panel ................................................................. 36
FIGURE 2. Action Bar ......................................................................................... 39
FIGURE 3. Region Status Panel showing Options pulldown ................................. 40
FIGURE 4. Date Format Selection Pop-Up .............................................................. 41
FIGURE 5. Fast Pathing Entry ............................................................................. 43
FIGURE 6. Pushbutton Mnemonics on the Response Times Panel ....................... 43
FIGURE 7. Help Pull-down Menu ........................................................................ 44
FIGURE 8. Sign On Panel .................................................................................... 50
FIGURE 9. Sign On Panel Showing Logon Options ................................................ 52
FIGURE 10. Region Status Panel (CICS/ESA Version 4 and Earlier) ..................... 59
FIGURE 11. Region Status Panel (CICS/ESA Version 5.1.0) ................................. 60
FIGURE 12. Analyze DASD Problems ................................................................. 62
FIGURE 13. AIDs Summary with Actions Pull-down ............................................. 68
FIGURE 14. GoTo Pull-down Menu ................................................................. 69
FIGURE 15. CICS Tables Panel .......................................................................... 70
FIGURE 16. Task History Panel .......................................................................... 71
FIGURE 17. CICS Memory Panel ....................................................................... 72
FIGURE 18. Index Pull-down Menu .................................................................... 74
FIGURE 19. Search Index Pop-up Window ........................................................... 75
FIGURE 20. Typical View Pull-down Menu .......................................................... 76
FIGURE 21. View Some Pop-up Showing Filter Criteria ..................................... 77
FIGURE 22. Options Pull-down Menu ................................................................. 79
FIGURE 23. Preferences Pop-up Window .............................................................. 80
FIGURE 24. Controls Pop-up Window ................................................................. 83
FIGURE 25. Session Defaults Pop-up Window ..................................................... 84
FIGURE 26. Screen Print Output Routing Options Pop-up Window ....................... 86
FIGURE 27. Enable Authorized Commands Pop-up Window ............................... 87
FIGURE 28. Collection Controls Pop-up Window ............................................... 88
FIGURE 29. Internal Bottleneck Collection Pop-up Window ................................ 89
FIGURE 30. Internal Bottleneck Display Controls Window ................................. 91
FIGURE 31. Response Time Collection Pop-up Window ....................................... 92
FIGURE 32. Interval Recording Pop-up Window ................................................. 93
FIGURE 33. Task History Collection Pop-up Window ........................................ 94
FIGURE 34. CICS File/Database Collection Pop-up ............................................. 95
FIGURE 35. Resource Limiting Pop-up ............................................................... 98
FIGURE 36. Monitoring Control Pop-up for CICS/MVS ...................................... 99
FIGURE 37. Monitoring Control Pop-up for CICS/ESA ....................................... 102
FIGURE 38. CICS Shutdown Option Pop-up ...................................................... 106
FIGURE 39. Tasks Thresholds Pop-up Window ................................................... 107
FIGURE 40. Userid Profiles Panel ..................................................................... 108
<table>
<thead>
<tr>
<th>FIGURE</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>41</td>
<td>Region Profiles Panel</td>
<td>109</td>
</tr>
<tr>
<td>42</td>
<td>Help Pull-down Window</td>
<td>111</td>
</tr>
<tr>
<td>43</td>
<td>CICS Tables Panel</td>
<td>115</td>
</tr>
<tr>
<td>44</td>
<td>Destination Control Table Panel</td>
<td>118</td>
</tr>
<tr>
<td>45</td>
<td>DCT Indirect Information Panel</td>
<td>120</td>
</tr>
<tr>
<td>46</td>
<td>DCT Extrapartition Information Panel</td>
<td>120</td>
</tr>
<tr>
<td>47</td>
<td>DCT Remote Information Panel</td>
<td>121</td>
</tr>
<tr>
<td>48</td>
<td>DCT Intrapartition Information Panel</td>
<td>122</td>
</tr>
<tr>
<td>49</td>
<td>DL/I Intrapartition Information Panel</td>
<td>123</td>
</tr>
<tr>
<td>50</td>
<td>Global User Exits (GLUEs) Panel</td>
<td>127</td>
</tr>
<tr>
<td>51</td>
<td>Exit Program Blocks (EPBs) Panel</td>
<td>128</td>
</tr>
<tr>
<td>52</td>
<td>File Control Table (FCT) Panel</td>
<td>129</td>
</tr>
<tr>
<td>53</td>
<td>File Control Table Entry (FCTE) Panel</td>
<td>130</td>
</tr>
<tr>
<td>54</td>
<td>File Control Table Entry – Statistics Panel</td>
<td>131</td>
</tr>
<tr>
<td>55</td>
<td>File Control Table Entry – Logging Panel</td>
<td>131</td>
</tr>
<tr>
<td>56</td>
<td>File Control Table Entry – Data Table Panel</td>
<td>132</td>
</tr>
<tr>
<td>57</td>
<td>Journal Models Panel (CICS/ESA 5.1)</td>
<td>134</td>
</tr>
<tr>
<td>58</td>
<td>Journal Control Table Panel</td>
<td>135</td>
</tr>
<tr>
<td>59</td>
<td>Journal Control Table Entry Panel</td>
<td>136</td>
</tr>
<tr>
<td>60</td>
<td>DL/I PSB Directory (PDIR) Panel</td>
<td>138</td>
</tr>
<tr>
<td>61</td>
<td>DL/I PSB Directory Entry (PDIR Entry) Panel</td>
<td>139</td>
</tr>
<tr>
<td>62</td>
<td>Programs Panel</td>
<td>140</td>
</tr>
<tr>
<td>63</td>
<td>Program Entry Panel (CICS/MVS)</td>
<td>141</td>
</tr>
<tr>
<td>64</td>
<td>Program Entry Panel (CICS/ESA)</td>
<td>142</td>
</tr>
<tr>
<td>65</td>
<td>Remote Program Entry Panel (CICS/ESA 3.3 and above)</td>
<td>142</td>
</tr>
<tr>
<td>66</td>
<td>System Initialization Table (SIT) Panel</td>
<td>143</td>
</tr>
<tr>
<td>67</td>
<td>Terminal Control Table (TCT) Panel</td>
<td>145</td>
</tr>
<tr>
<td>68</td>
<td>Terminal Control Table Terminal Entry (TCTTE) Panel</td>
<td>146</td>
</tr>
<tr>
<td>69</td>
<td>TCT System Entry Panel</td>
<td>147</td>
</tr>
<tr>
<td>70</td>
<td>TCTSE Statistics Panel</td>
<td>148</td>
</tr>
<tr>
<td>71</td>
<td>Sequential TCTTE Panel</td>
<td>149</td>
</tr>
<tr>
<td>72</td>
<td>TCTTE Statistics Panel</td>
<td>150</td>
</tr>
<tr>
<td>73</td>
<td>Terminal Control Table Prefix (TCTFX) Panel</td>
<td>151</td>
</tr>
<tr>
<td>74</td>
<td>Terminal Control Table System Entries Panel</td>
<td>152</td>
</tr>
<tr>
<td>75</td>
<td>Trace Panel (CICS/ESA)</td>
<td>155</td>
</tr>
<tr>
<td>76</td>
<td>Trace Panel (CICS/MVS)</td>
<td>156</td>
</tr>
<tr>
<td>77</td>
<td>Program Check/Abend Trace Table (PC/ATT)</td>
<td>157</td>
</tr>
<tr>
<td>78</td>
<td>Transactions Panel</td>
<td>158</td>
</tr>
<tr>
<td>79</td>
<td>Transaction Entry Panel (CICS/MVS)</td>
<td>159</td>
</tr>
<tr>
<td>80</td>
<td>Transaction Entry Panel (CICS/ESA)</td>
<td>160</td>
</tr>
<tr>
<td>81</td>
<td>Task History Panel</td>
<td>166</td>
</tr>
<tr>
<td>82</td>
<td>Task History Details Panel</td>
<td>168</td>
</tr>
<tr>
<td>83</td>
<td>Task History Storage Panel (CICS/ESA Version 3)</td>
<td>170</td>
</tr>
<tr>
<td>84</td>
<td>Task History Storage Panel (CICS/ESA Version 4)</td>
<td>171</td>
</tr>
<tr>
<td>85</td>
<td>Task History Program Storage Panel</td>
<td>172</td>
</tr>
<tr>
<td>Figure Number</td>
<td>Description</td>
<td>Page</td>
</tr>
<tr>
<td>---------------</td>
<td>------------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>FIGURE 100.</td>
<td>Task History ADABAS Panel</td>
<td>185</td>
</tr>
<tr>
<td>FIGURE 101.</td>
<td>Task History IDMS Panel</td>
<td>186</td>
</tr>
<tr>
<td>FIGURE 102.</td>
<td>Task History DATACOM Panel</td>
<td>187</td>
</tr>
<tr>
<td>FIGURE 103.</td>
<td>Task History SUPRA Panel</td>
<td>188</td>
</tr>
<tr>
<td>FIGURE 104.</td>
<td>Task History USREVNT1 Panel</td>
<td>189</td>
</tr>
<tr>
<td>FIGURE 105.</td>
<td>CICS Memory Panel</td>
<td>209</td>
</tr>
<tr>
<td>FIGURE 106.</td>
<td>Indirect Addressing Pop-up Window</td>
<td>211</td>
</tr>
<tr>
<td>FIGURE 107.</td>
<td>Scan Memory Pop-up Window</td>
<td>213</td>
</tr>
<tr>
<td>FIGURE 108.</td>
<td>Chase Chain Pop-up Window</td>
<td>214</td>
</tr>
<tr>
<td>FIGURE 109.</td>
<td>Zap Memory Pop-up Window</td>
<td>216</td>
</tr>
<tr>
<td>FIGURE 110.</td>
<td>Address Symbol Definition Pop-up Window</td>
<td>217</td>
</tr>
<tr>
<td>FIGURE 111.</td>
<td>CICS Memory Displaying the Tools Pull-down</td>
<td>218</td>
</tr>
<tr>
<td>FIGURE 112.</td>
<td>Number Conversion Pop-up Window</td>
<td>219</td>
</tr>
<tr>
<td>FIGURE 113.</td>
<td>Character Conversion Pop-up Window</td>
<td>220</td>
</tr>
<tr>
<td>FIGURE 114.</td>
<td>Hexadecimal Calculation Pop-up Window</td>
<td>221</td>
</tr>
<tr>
<td>FIGURE 115.</td>
<td>Machine Instructions Pop-up Window</td>
<td>222</td>
</tr>
<tr>
<td>FIGURE 116.</td>
<td>Branch After Compare Pop-up Window</td>
<td>223</td>
</tr>
<tr>
<td>FIGURE 117.</td>
<td>Branch After Arithmetic Pop-up Window</td>
<td>224</td>
</tr>
<tr>
<td>FIGURE 118.</td>
<td>Branch After Test Under Mask Pop-up Window</td>
<td>225</td>
</tr>
<tr>
<td>FIGURE 119.</td>
<td>OMEGAMON II for CICS Memory Panel</td>
<td>226</td>
</tr>
<tr>
<td>FIGURE 120.</td>
<td>CICS Master Terminal Panel (CICS/ESA Version 3)</td>
<td>227</td>
</tr>
<tr>
<td>FIGURE 121.</td>
<td>CICS Master Terminal Panel (CICS/ESA Version 4)</td>
<td>228</td>
</tr>
<tr>
<td>FIGURE 122.</td>
<td>CICS Dataspaces Panel</td>
<td>229</td>
</tr>
<tr>
<td>FIGURE 123.</td>
<td>Dataspaces Memory Panel</td>
<td>230</td>
</tr>
<tr>
<td>FIGURE 124.</td>
<td>OMEGAMON II for CICS Dataspaces Panel</td>
<td>231</td>
</tr>
<tr>
<td>FIGURE 125.</td>
<td>MVS Resources Panel</td>
<td>234</td>
</tr>
<tr>
<td>FIGURE 126.</td>
<td>System Console Panel</td>
<td>238</td>
</tr>
<tr>
<td>FIGURE 127.</td>
<td>VTAM Commands Panel</td>
<td>240</td>
</tr>
<tr>
<td>FIGURE 128.</td>
<td>Command Modification Pop-up Window</td>
<td>241</td>
</tr>
<tr>
<td>FIGURE 129.</td>
<td>AIDs Summary Panel</td>
<td>244</td>
</tr>
<tr>
<td>FIGURE 130.</td>
<td>AID Details Panel</td>
<td>245</td>
</tr>
</tbody>
</table>
FIGURE 131. BMS Details Pop-up ......................................................... 246
FIGURE 132. ICP-PUT Data Details Pop-up ........................................ 246
FIGURE 133. Transaction Routing Details Pop-up. .......................... 247
FIGURE 134. LU6.2 Details Pop-up ................................................... 247
FIGURE 135. Transient Data Details Pop-up ................................. 248
FIGURE 136. ICEs Summary Panel .................................................. 249
FIGURE 137. ICE Details Panel ....................................................... 250
FIGURE 138. Response Times Summary Panel .............................. 252
FIGURE 139. Response Time History Panel ................................. 253
FIGURE 140. Response Time History Details Panel ...................... 254
FIGURE 141. Response Time Details Panel ................................... 255
FIGURE 142. Tasks Summary Panel (CICS/ESA Version 3) ............ 257
FIGURE 143. Task Details Panel (CICS/ESA) ................................ 258
FIGURE 144. Task Addresses Panel (CICS/ESA Version 3) ............ 260
FIGURE 145. Task File Statistics Panel .......................................... 261
FIGURE 146. VSAM File Statistics Panel ...................................... 262
FIGURE 147. DB2 Statistics Panel .................................................. 263
FIGURE 148. DL/I Statistics Panel ............................................... 264
FIGURE 149. USREVNT1 Statistics Panel ..................................... 265
FIGURE 150. Task Remote Information Panel ............................... 266
FIGURE 151. GoTo Remote CICS Pop-up ...................................... 268
FIGURE 152. Task Statistics Panel (CICS Version 3) ...................... 268
FIGURE 153. Task Statistics Panel (CICS Version 4) ...................... 269
FIGURE 154. Task Statistics Panel (CICS Version 5.1.0) ............... 269
FIGURE 155. Task Statistics Panel (CICS TS Version 1.3) ............. 270
FIGURE 156. Task Non-3270 Statistics Panel (CICS TS Version 1.3) .. 271
FIGURE 157. Task Storage Panel .................................................. 272
FIGURE 158. Task Program Storage HWM Panel ........................... 273
FIGURE 159. Task Time Analysis Panel (CICS Version 4) ............... 274
FIGURE 160. Task Time Analysis Panel (CICS/ESA Version 5.1.0) .... 274
FIGURE 161. Task Time Analysis Panel (CICS TS Version 1.3) ......... 275
FIGURE 162. Task Time Detail Analysis Panel (CICS TS Version 1.3) .. 276
FIGURE 163. Task Umbrella Data Panel .................................... 277
FIGURE 164. Task FEPI Statistics ............................................... 278
FIGURE 165. Task Terminal Statistics Panel ............................... 279
FIGURE 166. Task Bridge Details ................................................. 280
FIGURE 167. Transaction Rates Panel ......................................... 281
FIGURE 168. CPU Rates Panel ................................................... 293
FIGURE 169. CICS Address Space Information Panel .................... 295
FIGURE 170. CICS Job Information Panel ................................... 296
FIGURE 171. CICS Address Space TCBs Panel ............................. 297
FIGURE 172. TCB Details Panel .................................................. 298
FIGURE 173. MVS Loaded Modules Panel ................................... 299
FIGURE 174. CICS DASD Performance Panel ............................... 301
FIGURE 175. CICS DASD Status Panel ....................................... 304
<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>176</td>
<td>DASD Statistics Panel</td>
<td>306</td>
</tr>
<tr>
<td>177</td>
<td>DB2 Activity Panel</td>
<td>308</td>
</tr>
<tr>
<td>178</td>
<td>DB2 Transaction Details Panel</td>
<td>309</td>
</tr>
<tr>
<td>179</td>
<td>DBCTL Activity Panel</td>
<td>310</td>
</tr>
<tr>
<td>180</td>
<td>DBCTL Tasks Panel</td>
<td>311</td>
</tr>
<tr>
<td>181</td>
<td>DL/I Activity Panel</td>
<td>312</td>
</tr>
<tr>
<td>182</td>
<td>CICS Tasks Using DL/I Panel</td>
<td>313</td>
</tr>
<tr>
<td>183</td>
<td>DL/I Configuration Panel</td>
<td>314</td>
</tr>
<tr>
<td>184</td>
<td>DL/I ISAM/OSAM Buffers Panel</td>
<td>315</td>
</tr>
<tr>
<td>185</td>
<td>DL/I Interface Addresses Panel</td>
<td>316</td>
</tr>
<tr>
<td>186</td>
<td>DL/I Interface ECBs Panel</td>
<td>317</td>
</tr>
<tr>
<td>187</td>
<td>DL/I Databases Panel</td>
<td>318</td>
</tr>
<tr>
<td>188</td>
<td>DL/I Database Details Panel</td>
<td>319</td>
</tr>
<tr>
<td>189</td>
<td>Open VSAM Files Panel (CICS/ESA Version 4)</td>
<td>320</td>
</tr>
<tr>
<td>190</td>
<td>Open VSAM Files Panel (CICS/ESA Version 5.1.0)</td>
<td>321</td>
</tr>
<tr>
<td>191</td>
<td>VSAM String Waits Panel</td>
<td>322</td>
</tr>
<tr>
<td>192</td>
<td>LSR Buffer Waits Panel</td>
<td>323</td>
</tr>
<tr>
<td>193</td>
<td>VSAM Details Panel</td>
<td>324</td>
</tr>
<tr>
<td>194</td>
<td>VSAM Data Component Statistics Panel</td>
<td>325</td>
</tr>
<tr>
<td>195</td>
<td>VSAM Data Component Allocation Panel</td>
<td>326</td>
</tr>
<tr>
<td>196</td>
<td>VSAM Index Component Statistics Panel</td>
<td>327</td>
</tr>
<tr>
<td>197</td>
<td>VSAM Index Component Allocation Panel</td>
<td>328</td>
</tr>
<tr>
<td>198</td>
<td>Journals Panel (CICS/ESA 5.1.0)</td>
<td>330</td>
</tr>
<tr>
<td>199</td>
<td>Log Streams Panel</td>
<td>332</td>
</tr>
<tr>
<td>200</td>
<td>Journal Models Panel</td>
<td>333</td>
</tr>
<tr>
<td>201</td>
<td>Journal Details Panel</td>
<td>333</td>
</tr>
<tr>
<td>202</td>
<td>Datasets Allocated to CICS Panel</td>
<td>335</td>
</tr>
<tr>
<td>203</td>
<td>File Details Panel</td>
<td>337</td>
</tr>
<tr>
<td>204</td>
<td>LSR Pools Panel</td>
<td>338</td>
</tr>
<tr>
<td>205</td>
<td>LSR Buffer Pool Details Panel</td>
<td>340</td>
</tr>
<tr>
<td>206</td>
<td>LSR Data Buffers Panel</td>
<td>341</td>
</tr>
<tr>
<td>207</td>
<td>LSR Index Buffers Panel</td>
<td>342</td>
</tr>
<tr>
<td>208</td>
<td>LSR Compound Buffers Panel</td>
<td>343</td>
</tr>
<tr>
<td>209</td>
<td>LSR Hiperspace Data Buffers Panel</td>
<td>344</td>
</tr>
<tr>
<td>210</td>
<td>LSR Hiperspace Index Buffers Panel</td>
<td>345</td>
</tr>
<tr>
<td>211</td>
<td>LSR Hiperspace Compound Buffers Panel</td>
<td>346</td>
</tr>
<tr>
<td>212</td>
<td>Terminal Control Table System Entries Panel</td>
<td>347</td>
</tr>
<tr>
<td>213</td>
<td>TCT System Entry Panel</td>
<td>348</td>
</tr>
<tr>
<td>214</td>
<td>TCTSE Statistics Panel</td>
<td>350</td>
</tr>
<tr>
<td>215</td>
<td>Working Set Size and Paging Rates Panel</td>
<td>351</td>
</tr>
<tr>
<td>216</td>
<td>CICS Storage Panel (CICS Version 4)</td>
<td>354</td>
</tr>
<tr>
<td>217</td>
<td>CICS Storage Panel (CICS Version 3)</td>
<td>355</td>
</tr>
<tr>
<td>218</td>
<td>CICS Storage Panel (CICS/MVS)</td>
<td>356</td>
</tr>
<tr>
<td>219</td>
<td>Storage Violations Panel</td>
<td>357</td>
</tr>
<tr>
<td>220</td>
<td>DSA Storage Panel</td>
<td>358</td>
</tr>
<tr>
<td>FIGURE</td>
<td>Description</td>
<td>Page</td>
</tr>
<tr>
<td>----------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>221.</td>
<td>Program Compressions Panel</td>
<td>359</td>
</tr>
<tr>
<td>222.</td>
<td>Address Space Storage Panel (CICS Version 3)</td>
<td>360</td>
</tr>
<tr>
<td>223.</td>
<td>Address Space Storage Panel (CICS Version 4)</td>
<td>361</td>
</tr>
<tr>
<td>224.</td>
<td>Storage Allocation by Components Panel</td>
<td>364</td>
</tr>
<tr>
<td>225.</td>
<td>Storage Subpools Panel</td>
<td>365</td>
</tr>
<tr>
<td>226.</td>
<td>Storage Allocation by Tasks Panel</td>
<td>366</td>
</tr>
<tr>
<td>227.</td>
<td>Page Allocation Map Panel (CICS Version 3)</td>
<td>367</td>
</tr>
<tr>
<td>228.</td>
<td>Page Allocation Map Panel (CICS Version 4)</td>
<td>368</td>
</tr>
<tr>
<td>229.</td>
<td>Storage Details Panel (CICS Version 3)</td>
<td>369</td>
</tr>
<tr>
<td>230.</td>
<td>Storage Details Panel (CICS Version 4)</td>
<td>370</td>
</tr>
<tr>
<td>231.</td>
<td>Allocations Panel (CICS Version 4)</td>
<td>371</td>
</tr>
<tr>
<td>232.</td>
<td>Tape Drives Panel</td>
<td>372</td>
</tr>
<tr>
<td>233.</td>
<td>Tape Drive Details Panel</td>
<td>373</td>
</tr>
<tr>
<td>234.</td>
<td>Temporary Storage Panel</td>
<td>374</td>
</tr>
<tr>
<td>235.</td>
<td>Temporary Storage Queues Panel</td>
<td>375</td>
</tr>
<tr>
<td>236.</td>
<td>Auxiliary Temporary Storage Panel</td>
<td>376</td>
</tr>
<tr>
<td>237.</td>
<td>Temporary Storage Statistics Panel</td>
<td>377</td>
</tr>
<tr>
<td>238.</td>
<td>Temporary Storage Statistics Panel (CICS/ESA Version 5.1.0)</td>
<td>378</td>
</tr>
<tr>
<td>239.</td>
<td>Temporary Storage Table (TST) Panel (CICS/ESA Version 5.1.0)</td>
<td>379</td>
</tr>
<tr>
<td>240.</td>
<td>Transient Data Panel</td>
<td>380</td>
</tr>
<tr>
<td>241.</td>
<td>Intrapartition Transient Data Statistics Panel</td>
<td>382</td>
</tr>
<tr>
<td>242.</td>
<td>Destination Queues Over Limits Panel</td>
<td>384</td>
</tr>
<tr>
<td>243.</td>
<td>TCP/IP Thresholds</td>
<td>385</td>
</tr>
<tr>
<td>244.</td>
<td>TCP/IP Socket Activity</td>
<td>385</td>
</tr>
<tr>
<td>245.</td>
<td>Web Interface panel</td>
<td>386</td>
</tr>
<tr>
<td>246.</td>
<td>Internal Bottlenecks Panel</td>
<td>388</td>
</tr>
<tr>
<td>247.</td>
<td>External Contention Panel</td>
<td>390</td>
</tr>
<tr>
<td>248.</td>
<td>External Contention Details Panel</td>
<td>391</td>
</tr>
<tr>
<td>249.</td>
<td>Internal Bottleneck Details Panel</td>
<td>393</td>
</tr>
<tr>
<td>250.</td>
<td>Common System Area (CSA)</td>
<td>394</td>
</tr>
<tr>
<td>251.</td>
<td>Transaction Statistics Panel (CICS Version 4)</td>
<td>395</td>
</tr>
<tr>
<td>252.</td>
<td>Dumps Panel</td>
<td>396</td>
</tr>
<tr>
<td>253.</td>
<td>Enqueues Panel</td>
<td>397</td>
</tr>
<tr>
<td>254.</td>
<td>Enqueue Conflicts Panel</td>
<td>398</td>
</tr>
<tr>
<td>255.</td>
<td>Enqueue Details Panel</td>
<td>400</td>
</tr>
<tr>
<td>256.</td>
<td>DASD I/O Rate Panel</td>
<td>401</td>
</tr>
<tr>
<td>257.</td>
<td>DASD Details for a Device Panel</td>
<td>403</td>
</tr>
<tr>
<td>258.</td>
<td>CICS Datasets on a DASD Volume Panel</td>
<td>404</td>
</tr>
<tr>
<td>259.</td>
<td>Terminal Control Table Prefix Panel</td>
<td>405</td>
</tr>
<tr>
<td>260.</td>
<td>XRF Information Panel</td>
<td>406</td>
</tr>
<tr>
<td>261.</td>
<td>TSF Entries Panel (PE)</td>
<td>411</td>
</tr>
<tr>
<td>262.</td>
<td>One-line Command Help</td>
<td>424</td>
</tr>
<tr>
<td>263.</td>
<td>Extended Command Help</td>
<td>425</td>
</tr>
<tr>
<td>264.</td>
<td>CICS Regions Panel</td>
<td>468</td>
</tr>
<tr>
<td>265.</td>
<td>View Pulldown Menu</td>
<td>469</td>
</tr>
</tbody>
</table>
FIGURE 266. View Some Panel ......................................................... 470
FIGURE 267. Action Codes on the Programs Panel .................................. 473
FIGURE 268. Actions Pull-down Menu for the Program Entry Panel ......... 474
FIGURE 269. Entry Fields on the Transaction Statistics Panel .................. 475
List of Tables

Table 1. OMEGAMON II for CICS Documentation .................................................. 18
Table 2. Symbols in Command Syntax ................................................................. 22
Table 3. Task Resources and Limit Testing ......................................................... 97
Table 4. CEMT Value Limits ............................................................................. 228
Table 5. CUA Panel Enhancements (CICS Release 2.1.2) ................................ 476
Table 6. CUA Panel Enhancements (CICS Release 3.1.1 or 3.2.1) ..................... 478
Table 7. CUA Panel Enhancements (CICS Release 3.3.0) .................................. 481
Table 8. CUA Panel Enhancements (CICS Release 4.1.0) ................................. 483
Table 9. CUA Panel Enhancements (CICS Release 5.1.0) ................................. 485
OMEGAMON II is a comprehensive software performance monitor that assists in troubleshooting problems and tuning your IBM Customer Information Control System (CICS). Providing a real-time window into CICS activity, OMEGAMON II automatically detects and warns of problems that affect CICS availability and performance, identifying any degradation associated with resources internal to CICS or external to CICS in the MVS environment.

Although OMEGAMON II runs in a separate address space from CICS, it has some facilities that run within the CICS address space.

OMEGAMON II can monitor multiple CICS systems running at different release levels. Refer to the OMEGAMON II for CICS Configuration and Customization Guide for all releases of IBM software that OMEGAMON II currently supports.

This document refers to version 2 of CICS as CICS/MVS, and Versions 3 and greater as CICS/ESA.
About This Book

Who should read this book

This document provides comprehensive information on the features of OMEGAMON II for CICS Version 520 (hereafter referred to as OMEGAMON II). The manual should be read by those who need to understand how or use OMEGAMON II’s CUA interface and menu system interface to access the data you need to analyze CICS performance problems, create profiles, define groups for monitoring purposes, and use all of OMEGAMON II’s features.

- Volume 1 provides the information about the CUA interface.
- Volume 2 provides the information about the menu system interface.

Documentation set information

The documentation listed below is available for OMEGAMON II for CICS.

Table 1. OMEGAMON II for CICS Documentation

<table>
<thead>
<tr>
<th>Document Number</th>
<th>Document Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>C251-6363</td>
<td>OMEGAMON II for CICS Configuration and Customization Guide</td>
<td>Explains how to configure and customize OMEGAMON II after it is installed.</td>
</tr>
<tr>
<td>C254-6312</td>
<td>OMEGAMON II for CICS User’s Guide</td>
<td>Provides a task-oriented guide to using OMEGAMON II. Explains basic features and navigation methods.</td>
</tr>
<tr>
<td>C253-6313</td>
<td>OMEGAMON II for CICS Reference Manual - Volume 1</td>
<td>Provides comprehensive reference information about the features of OMEGAMON II and explains how to access OMEGAMON II data in the CUA interface.</td>
</tr>
<tr>
<td>C253-6314</td>
<td>OMEGAMON II for CICS Reference Manual - Volume 2</td>
<td>Provides comprehensive reference information about the features of OMEGAMON II and explains how to access OMEGAMON II data in the menu system interface.</td>
</tr>
<tr>
<td>C299-6316</td>
<td>OMEGAMON II for CICS Historical Reporting Manual</td>
<td>Describes how to use the SMF records created by OMEGAMON II to produce historical reports.</td>
</tr>
<tr>
<td>WO52-6238</td>
<td>Messages Manual - Volume 1 OMEGAMON II/OMEGAVIEW</td>
<td>Provides reference summary of all OMEGAMON II and OMEGAVIEW messages.</td>
</tr>
<tr>
<td>WO52-6239</td>
<td>Messages Manual - Volume 2 OMEGAMON II/OMEGAVIEW</td>
<td></td>
</tr>
<tr>
<td>WO52-6240</td>
<td>Messages Manual - Volume 3 OMEGAMON II/OMEGAVIEW</td>
<td></td>
</tr>
<tr>
<td>C257-6315</td>
<td>OMEGAMON II for CICS Problem Determination Manual</td>
<td>Describes how to diagnose and solve problems that you may encounter with OMEGAMON II, get the best possible problem-solving help from Candle Customer Support, and prevent or reduce the recurrence of problems.</td>
</tr>
<tr>
<td>Document Number</td>
<td>Document Name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>---------------</td>
<td>-------------</td>
</tr>
<tr>
<td>C299-6370</td>
<td>OMEGAMON II for CICS Quick Reference Card</td>
<td>Pocket-sized document that explains how to use the CUA interface and lists all of the fast paths.</td>
</tr>
<tr>
<td>ET53-5586</td>
<td>End-to-End Response Time (ETE) Feature Reference Manual</td>
<td>Describes ETE and its commands, and lists its error messages, return codes, and sense codes.</td>
</tr>
</tbody>
</table>
Where to look for more information

For more information related to this product and other related products, please see the
- technical documentation CD-ROM that came with your product
- technical documentation information available on the Candle Web site at www.candle.com
- online help provided with this and the other related products.

Ordering additional documentation

To order additional product manuals, contact your Candle Customer Support representative.

We would like to hear from you

Candle welcomes your comments and suggestions for changes or additions to the documentation set. A user comment form, located at the back of each manual, provides simple instructions for communicating with the Candle Information Development department.

You can also send email to UserDoc@candle.com. Please include “OMEGAMON II for CICS Reference Manual, Volume 1, Version 520” in the subject line.
Printing this book

Candle supplies documentation in the Adobe Portable Document Format (PDF). The Adobe Acrobat Reader will print PDF documents with the fonts, formatting, and graphics in the original document. To print a Candle document, do the following:

1. Specify the print options for your system. From the Acrobat Reader Menu bar, select **File > Page Setup…** and make your selections. A setting of 300 dpi is highly recommended as is duplex printing if your printer supports this option.

2. To start printing, select **File > Print…** on the Acrobat Reader Menu bar.

3. On the Print pop-up, select one of the **Print Range** options for
   - All
   - Current page
   - Pages from: [ ] to: [ ]

4. (Optional). Select the Shrink to Fit option if you need to fit oversize pages to the paper size currently loaded on your printer.

Printing problems?

The print quality of your output is ultimately determined by your printer. Sometimes printing problems can occur. If you experience printing problems, potential areas to check are:

- settings for your printer and printer driver. (The dpi settings for both your driver and printer should be the same. A setting of 300 dpi is recommended.)
- the printer driver you are using. (You may need a different printer driver or the Universal Printer driver from Adobe. This free printer driver is available at www.adobe.com.)
- the halftone/graphics color adjustment for printing color on black and white printers (check the printer properties under **Start > Settings > Printer**). For more information, see the online help for the Acrobat Reader.
- the amount of available memory in your printer. (Insufficient memory can cause a document or graphics to fail to print.)

For additional information on printing problems, refer to the documentation for your printer or contact your printer manufacturer.

Contacting Adobe

If additional information is needed about Adobe Acrobat Reader or printing problems, see the Readme.pdf file that ships with Adobe Acrobat Reader or contact Adobe at www.adobe.com.
Documentation Conventions

Introduction
Candle documentation adheres to accepted typographical conventions for command syntax. Conventions specific to Candle documentation are discussed in the following sections.

Panels and figures
The panels and figures in this document are representations. Actual product panels may differ.

Revision bars
Revision bars (|) may appear in the left margin to identify new or updated material.

Variables and literals
In examples of command syntax, uppercase letters are actual values (literals) that the user should type; lowercase letters are used for variables that represent data supplied by the user. Default values are underscored.

LOGON APPLID (cccccccc)
In the above example, you type LOGON APPLID followed by an application identifier (represented by cccccccc) within parentheses.

Note: In ordinary text, variable names appear in italics.

Symbols
The following symbols may appear in command syntax:

<table>
<thead>
<tr>
<th>Table 2. Symbols in Command Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Symbol</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>
Documentation Conventions

Table 2. Symbols in Command Syntax

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Usage</th>
</tr>
</thead>
</table>
| {}     | Some documents use braces to denote required arguments, or to group arguments for clarity. Example:  

    COMPARE {workload} -  
    REPORT={SUMMARY | HISTOGRAM}  

The workload variable is required. The REPORT keyword must be specified with a value of SUMMARY or HISTOGRAM. |
| _     | Default values are underscored. Example:  

    COPY infile outfile - [COMPRESS={YES | NO}]  

In this example, the COMPRESS keyword is optional. If specified, the only valid values are YES or NO. If omitted, the default is YES. |
What’s New

Introduction

This section details the new features and enhancements incorporated into OMEGAMON II for CICS Version 520.

Highlights

OMEGAMON II for CICS Version 520 includes the following new features and enhancements:

- Allows printing a SNAPSHOT of a CICS region.
- Added the Exchange Logname Status exception.
- Added Transaction Server 1.3 Task Monitoring Data and Statistics
- Enhanced RLIM Interval Settings
- Added User Defined Event Monitoring
- Enhanced ADABAS statistics reporting
- Added support for ADABAS 7.1

The following features are no longer supported by OMEGAMON II for CICS Version 520:

- Support for CICS/ESA Version 3.x.x
- Documentation for BookManager no longer supported
New Features and Enhancements

Print SNAPSHOT of CICS Region
The SNAP facility is composed of a sequence of pre-defined OMEGAMON II screens which contain every OMEGAMON Classic command you can use to report on the state and content of your CICS region.

This facility is now accessible in the C2/CUA interface to OMEGAMON II for CICS product. A new item was added to the Options/Controls pulldown which upon selection will route the output to the JES print queue under the common interface (Menu System) Job JCL.

Exchange Logname Status Exception
Exchange Logname status is a new OMEGAMON II for CICS exception added to the list of existing ones under the MRO/ISC. Once enabled the MRO/ISC light will alert users when the Exchange Log Name or XLN is 'Notdone' between two, APPC type connected, CICS systems.

Online Global Facility
The Online Global Facility is introduced to eliminate the requirement for re-assembly and linking of the product global data area module(s). Using the C2/CUA interface, this facility will enable users to SAVE the currently running global module to the library defined by the RKC2GLBL DD statement.

Using the Candle Installation/Configuration Assistance Tool (CICAT), users can edit and verify any of the existing global data area modules. Note that utilities are provided to migrate the previous versions of the global data area to the new format in V520. Refer to the OMEGAMON II for CICS Configuration and Customization Guide for more information.
New Features and Enhancements

Transaction Server 1.3 Task Monitoring Data and Statistics
The OMEGAMON II for CICS product has been enhanced to support the new performance monitoring data and statistics introduced in Transaction Server release 1.3. Non-3270 statistics such as WEB Send and Receive request counts are now displayable in active transactions as well as the Online History (ONDV) component.

The Task Time Analysis screens have been enhanced to include the newly introduced performance monitoring data such as JVM elapsed and suspend times, IMS(DBCTL) wait time, DB2 wait times, Socket I/O wait time, Global ENQ delay, among others. In addition, the Task Timings panels have been redesigned to display a categorical view of Timings attributed to a transaction or task.

Resource Limiting (RLIM) Interval Settings
The Resource Limiting feature of OMEGAMON II for CICS product has been enhanced to introduce a set of user defined intervals. This enhancement will allow users to activate the previously defined rules based on a user modifiable interval. The new RLIM interval may be set in three different ways:

- By TIME.
- By the number of EXEC CICS calls made by a task.
- By the number of Database calls made by a task.

User Defined Event Monitoring
The User Defined Event Monitoring (USREVNT1) describes a way for application programmers to clock and count the number of requests being made to an in-house database, program or procedure. Similar to other Third Party Products such as ADABAS, DATACOM, IDMS and SUPRA, this facility may be enabled from the Options pulldown in the C2/CUA interface under the CICS File/Database collection option.
New Features and Enhancements

ADABAS Statistics Reporting
ADABAS statistics in the OMEGAMON II for CICS product have been traditionally based on DB ID and File number. With the specification of a new operand in the product’s global data area module, users may request OMEGAMON to collect statistics based on DB ID, File number, and Command Code.

Support for ADABAS V7.1
The new release of ADABAS V7.1 supports DB IDs greater than 255. The relevant OMEGAMON II for CICS product panels were enhanced to display a 5-digit database ID.

Online Documentation
With version 520, Candle Corporation has moved OMEGAMON II for CICS manuals from IBM BookMaster to Adobe FrameMaker. This move was made to better enable us to address our customers’ needs by providing tools that enhance productivity.

One of the results of the move is that it is no longer possible to create BookManager versions of the OMEGAMON II for CICS manuals. However, the manuals remain available online in the Adobe PDF version on CD-ROM and are also available on the Candle Corporation website at www.Candle.com.

The documentation CD being provided with this release has robust and easy-to-use search capabilities. You can search for information in multiple volumes, multiple versions, and across products. The CD also provides easy setup of search indexes with a single click of the mouse.

If you want to order printed copies of the documentation, please contact your Candle Support Services representative.
Chapter Overview

This chapter introduces you to the CUA interface of OMEGAMON II and includes the following topics:

- the “logical tuning approach”, which you can use to set performance standards
- monitor, identify, and solve performance problems
- features of OMEGAMON II
- batch reporting
- CUA interface characteristics
- CUA interface help facility
- CUA interface function keys

Chapter Contents

About OMEGAMON II ................................................................. 31
CUA Interface for Ease of Use .................................................. 31
Logical Tuning Approach ......................................................... 32
  Setting performance standards ............................................. 32
  Monitoring performance .................................................... 32
  Identifying and solving performance problems ...................... 32
Features of the OMEGAMON II for CICS CUA Interface .......... 33
  Internal bottleneck collection ............................................. 33
  CICS system analysis ....................................................... 33
  External contention analysis .............................................. 33
  Response time collection .................................................. 34
Batch Reporting Methods ...................................................... 35
  SAS .............................................................................. 35
  OMEGAMON II Historical Reporter ................................... 35
  User-written programs ..................................................... 35
CUA Interface Characteristics ............................................... 36
  Panel contents .................................................................. 36
  Navigation Techniques ..................................................... 42
About OMEGAMON II

The OMEGAMON II realtime monitor alerts you to CICS response time degradation and overall system problems through color-coded status bars or through user-defined status words. Through online help, OMEGAMON II recommends corrective actions.

The OMEGAMON II historical facility collects transaction and resource-related information to enable you to meet service-level objectives and plan for system upgrades.

CUA Interface for Ease of Use

The OMEGAMON II realtime monitor includes two user interfaces: the Common User Access (CUA) interface and the Menu system. This part of the reference manual focuses only on the CUA interface. For information on the menu system, see Part 2 of this manual.

The CUA interface of OMEGAMON II complies with the IBM SAA/CUA Systems Application Architecture/Common User Access guidelines, which promote ease of use in software interfaces. For more information about CUA, see the IBM Common User Access: Basic Interface Design Guide.

Accessed either directly or through OMEGAVIEW®, the OMEGAMON II CUA interface provides a high-level overview of and detailed information on the performance of CICS regions.

With its CUA-compliant panels, color-coded status bars, and point-and-shoot navigation facility, the CUA interface is ideally suited for monitoring CICS regions and responding to a problem as soon as it occurs.
Logical Tuning Approach

All of OMEGAMON II’s features and facilities are designed around the concept of a logical tuning approach. The logical tuning approach consists of the following activities:

- setting standards for CICS performance at your installation
- monitoring your CICS to measure actual performance against these standards
- identifying the cause of performance problems and taking action to correct them

Setting performance standards
You set standards for CICS performance in such areas as

- transaction response time
- transaction throughput
- CPU utilization
- DASD response time
- paging rate
- storage utilization

Monitoring performance
Monitoring CICS performance consists of asking two basic questions:

- Are your performance measurements within an acceptable range?
- What are the problems in the system?

Identifying and solving performance problems
When you select a status bar next to a component on the Region Status panel, you can follow the status condition for the component that was indicated by a light of a particular color (for example, red). You follow the status condition by navigating through panels with the same color light until you reach a panel that has the information you need to determine the nature of the problem and its appropriate solutions.
Features of the OMEGAMON II for CICS CUA Interface

The following features are available to help you manage the operation and performance of CICS:

- internal bottleneck collection
- CICS system analysis
- external contention analysis
- response time collection

The following sections provide brief descriptions of these features.

Internal bottleneck collection

A CICS task waits many times during normal processing. OMEGAMON II’s internal bottleneck collection feature monitors and categorizes the resources for which CICS tasks are waiting. Typical waits can be I/O events, VSAM buffer and string waits, enqueue waits, and short-on-storage conditions.

As the applications grow and change, so does the use of resources in CICS. By highlighting resources for which contention is greatest, OMEGAMON II enables you to focus your tuning efforts where they will do the most good.

CICS system analysis

A CICS system at a typical installation is constantly undergoing change. OMEGAMON II displays control blocks, parameter settings, and current performance on such items as:

- AID/ICE activity
- transient data usage
- temporary storage usage
- CICS table entries
- CICS control blocks
- CICS storage usage
- VSAM files
- DB2 connection
- DL/I activity and status
- DASD usage
- CPU usage and paging
- CICS workload and task history

External contention analysis

OMEGAMON II’s external contention analysis feature identifies other workloads running on MVS that are impacting CICS by competing with it for MVS resources. These workloads can be batch jobs, started tasks, TSO users or even other CICS regions. The displays not only identify the main sources of impact, but also show how CICS is being affected so you can take immediate action to address those areas that will result in the most significant improvement.
Response time collection

OMEGAMON II's response time collection feature provides displays of CICS internal response time for transactions, terminals, and programs, as well as end-to-end response time for VTAM logical units (LUs). OMEGAMON II compares response time against user-specified performance standards for any of these resources or groups of resources.
Batch Reporting Methods

You can select from the following software to produce batch reports from System Management Facilities (SMF) records generated by OMEGAMON II:

- Statistical Analysis System (SAS)
- OMEGAMON II Historical Reporter (formerly called EPILOG™ 1000)
- User-written programs

SAS

SAS reporting allows you to use the OMEGAMON II historical component to generate historical reports based on your CICS performance data. Daily, weekly, and monthly reports display your data at varying levels of detail. As an alternative to the Historical Reporter for reporting SMF data, the SAS support package can help you identify potential performance problems and test the effects of your changes to CICS performance parameters. This facility is especially useful for reporting CICS performance to upper management and for making long-range CICS tuning decisions.

OMEGAMON II Historical Reporter

The OMEGAMON II Historical Reporter generates reports based on data that was collected from CICS regions, written to an SMF dataset, and converted to reporter format.

You can request reports that analyze such areas of performance and capacity as

- response time
- transaction volume and resource use
- program usage
- usage by terminal

See the OMEGAMON II for CICS Historical Reporting Guide for more information.

User-written programs

You can use the interval, system-related, and task-related records that OMEGAMON II writes to SMF in programs that you write to produce historical reports of your system's performance.

See the OMEGAMON II for CICS Configuration and Customization Guide and OMEGAMON II for CICS Historical Reporting Guide for information on how to start, stop, and limit the logging of these records to SMF.
CUA Interface Characteristics

This section describes the layout and features of panels you will see in the CUA interface, navigation techniques, function keys, and the CUA interface help facility.

Panel contents

Panels within the CUA interface are composed of the elements described below. The following figure shows a typical panel.

FIGURE 1. Typical CUA Interface Panel
In the list below, the numbers in parentheses refer to the numbered items in the figure above.

**Action bar**
An action bar (1) appears as the top line on each panel. The items on the action bar represent choices that, when selected, display pulldown menus. See “Action bar” on page 39 for more information.

**Panel body**
Data is displayed in the body of the panel (2). The format of the data varies depending on its type. The panel body can contain status bars, tables, or graphs.
Some fields in the panel body are preceded by an underscore (_) to indicate that you can enter an action code for this field. See “Navigation Techniques” on page 42 for information about entering action codes on panels.

**Pushbuttons**
These are words that appear in angled brackets or parentheses, located near the bottom of the panel (3). You can use pushbuttons to more directly to the panel named within the brackets. Words within parentheses indicate the panel that you are currently viewing. (Pushbuttons do not appear on all panels.)

**Function keys**
Function keys that are active for the current panel are displayed at the bottom of the panel (4). See “Function keys” on page 46 for more information.

**Status bars**
The panel body uses status bars to represent a set of thresholds applied against a CICS component. The color of the status bar indicates whether or not a problem exists and its severity:

- **Red** Critical problem that requires immediate attention
- **Yellow** Warning of a potential problem
- **Green** Satisfactory performance
- **Turquoise** No data is being collected

On a monochrome terminal, words indicate the status of the component. You can specify the words you want to display in the status bars through the Session Defaults pop-up window of the Options pull-down. See “Controls” on page 83.

The default status words that display are as follows:

- Crit (critical status)
- Warn (warning status)
- OK (okay status)
- Idle (component not being monitored)
Text and field colors and highlighting
Attributes such as color, highlighting, and underlining, as well as certain characters, are used in these panels to identify types of text and fields. On a color terminal, colors are used as follows:

White                      Items that are available for selection. On a monochrome terminal, the field appears in the display color for that terminal.

Green with underscore or highlighted  Fields that accept input. On a monochrome terminal, the field is underscored. Entry fields followed by a plus sign (+) are used with the F4 function key to see selection lists or to toggle between settings.

Blue                       Items that are unavailable for selection, either temporarily or permanently. On a monochrome terminal, an asterisk (*) appears as the first character of the selection.

Turquoise                  Items in nonselectable fields; the default value.

Note: If you are using 3270 emulation hardware and software on a personal computer, various panel attributes (such as color, highlight, underline and reverse video) may appear significantly different from the way they appear on an actual 3270 device. You may have to change definitions in your 3270 emulator to achieve desired color mapping. Refer to the appropriate 3270 emulator manuals or consult your system administrator.

Ellipses
An ellipsis (...) following a selection indicates that further selection is required after you make the initial selection. You make selections from another menu or add data to complete the task.

Scrolling
On many panels, when more information is available than can be displayed on one panel, a scroll indicator is available as one of the following:

Lines n to nn of nn         You can overtype this line to specify the line you want to view (see Figure 1 on page 36). Just type the number of the line of information you want to see and press Enter.

Note: This line does not display on panels that have only one screen of data; such panels are not scrollable.

More                      Displayed on some panels in the upper right corner, this indicator is followed by a plus (+) sign, a minus (-) sign, or both. The plus (+) sign means that pressing F8 scrolls forward to display more data.

A minus (-) sign means that pressing F7 scrolls backward to display more data. When both plus and minus display next to More, you can scroll forward or backward.
**Action bar**

The action bar is the first line at the top of a panel. See the figure that follows.

**FIGURE 2. Action Bar**

<table>
<thead>
<tr>
<th>Actions</th>
<th>GoTo</th>
<th>View</th>
<th>Index</th>
<th>Options</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The first position of the action bar is the home position and is used for selecting action bar choices. The action bar choices are as follows:

- **Actions**: Act upon selected objects in the panel body; exit the panel to the previous panel.
  
  For more information on Actions, see “Actions Pull-Down Menu” on page 68.

- **GoTo**: From the current panel, transfer to another related panel of CICS monitoring.
  
  For more information on GoTo, see “GoTo Pull-Down Menu” on page 69.

- **View**: Filter or sort the data displayed on applicable panels.
  
  For more information on View, see “View pull-down” on page 76.

- **Index**: Access panels by selecting either a subcategory or a panel title, or search the panel title index when you do not know a particular panel title.
  
  For more information on Index, see “Index Pull-Down Menu” on page 74.

- **Options**: Customize the CUA interface.
  
  For more information on Options, see “Options Pull-Down Menu” on page 79.

- **Help**: Access the various types of help available in the CUA interface.
  
  For more information about Help, see “Help Pull-Down Menu” on page 111.
Pull-down menu

When you make a selection from the action bar, a pull-down menu is displayed. A pull-down menu provides a list of further selections that you can make. For example, the Options pull-down menu is displayed when you select Options from the action bar, as shown below.

FIGURE 3. Region Status Panel showing Options pulldown

Although part of the underlying panel is visible, it is not usable while the pull-down menu is displayed. If you move the cursor outside the pull-down menu and press a key, the cursor returns to the pull-down menu.
Pop-up window

A pop-up window is displayed when you make a selection from a pull-down menu or press a function key. (See the following figure for an example.) Pop-up windows prompt you for further selections, display help, or explain errors and how to correct them. Even though more than one pop-up window may appear at one time (overlapping each other), only the last pop-up window displayed accepts data.

**FIGURE 4. Date Format Selection Pop-Up**

Although pop-up windows and pull-down menus share several features, you can distinguish them as follows:

- A pull-down menu appears when you make a selection from the action bar.
- A pop-up window appears when additional information is required to complete a function or when an error occurs.
Navigation Techniques

The CUA interface gives you several ways to use OMEGAMON II’s features and functions.

Ways of selecting items

Use one of the following methods to select an item from a panel, a pull-down menu, or a pop-up window:

- Move the cursor to the entry field of your selection and press Enter (provided Implicit Action is on in the Preferences option).
- Type the action code in the entry field and press Enter.
- Type the number of the selection in the entry field of the first selection, and press Enter.
- If you are using a monochrome terminal, type the character in parentheses (also called a mnemonic) in the entry field and press Enter (Mnemonics is on in the Preferences option.)
- Tab to a pushbutton and press Enter or type a mnemonic in the home position to move directly to the panel named in the pushbutton.

For example, to select and display the pull-down menu for Options, enter O in the home position. The Options pull-down menu, shown in Figure 3 on page 40 is displayed. You can then select a menu choice by typing its number in the entry field and pressing Enter.

Fast pathing

Fast pathing in the CUA interface allows you to quickly access pull-down menus, items on pull-down menus, and panels. You do this by entering a mnemonic in the action bar entry field (home position). The mnemonic can be a single character or a string. You can use fast paths to access all panels or, if the panel contains pushbuttons, only panels related to the one you are viewing.

All-panel fast pathing

When you enter the fast path character, the equals sign (=), followed by a mnemonic, OMEGAMON II takes you directly to the panel represented by that mnemonic.

For example, to access the Tasks panel, follow these steps:

1. Type =WT in the action bar entry field. (The = stands for fast path, the W for Workloads, and the T for Tasks.)
2. Press Enter.

The Tasks panel displays.

Note: In some cases an intermediate pop-up may appear so you can select from it before accessing the panel. The pop-up contains items related to the panel, such as transaction IDs, file IDs, task numbers, devices, and program IDs. After you select the item you want from the pop-up and press Enter, the panel appears.

The following figure shows how a fast path entry would appear on the action bar.
FIGURE 5. Fast Pathing Entry

<table>
<thead>
<tr>
<th>=WT</th>
<th>Actions</th>
<th>GoTo</th>
<th>View</th>
<th>Index</th>
<th>Options</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>--------</td>
<td>------</td>
<td>------</td>
<td>-------</td>
<td>---------</td>
<td>------</td>
</tr>
<tr>
<td>KC2F01D</td>
<td>Response Times</td>
<td>Region: CICSPROD</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note: You type the fast path character (=) as part of the entry only when navigating between panels, not pull-down menus.

The appendix titled “Fast Pathing in the CUA Interface” in the OMEGAMON II for CICS User’s Guide lists the fast path mnemonics you can use to access panels in the OMEGAMON II CUA interface.

Pushbutton fast pathing

You can also fast path to the destinations specified in the pushbuttons. This type of fast pathing uses the left angle bracket (<) as the fast path character.

Each pushbutton has a highlighted character. To fast path to a particular pushbutton destination, type the fast path character followed by the highlighted character of the desired pushbutton. Then press Enter.

For example, in the panel that follows, you would enter <H to go to the Response Time History panel.

FIGURE 6. Pushbutton Mnemonics on the Response Times Panel

| _ ADABAPGM | Prog | .3 | 1.2 | 1.3 | .8 | .3 | .5 | .9 | 1.0 | 2.5 |
| _ PRODTRAN | Tran | .1 | .0 | .0 | .1 | .0 | .0 | .0 | .0 | .0 |
| _ PRODTERM | Term | .1 | .0 | .0 | .0 | .0 | .0 | .0 | 1.1 | 1.2 |
| _ TESTTERM | Term | .1 | .0 | .0 | .0 | .0 | .0 | .0 | 1.1 | 1.3 |

Transplex navigation

Through transplex navigation, you can follow a specific transaction from a panel in one OMEGAMON to a panel in another OMEGAMON that contains information corresponding to that transaction. You invoke this feature with a context-sensitive pushbutton that provides the mechanism to navigate between OMEGAMON panels.

Help facility

Help can be accessed from the Help pull-down, from a panel, and from fields on a panel.

The OMEGAMON II help system is comprehensive and contains everything from a glossary of terms and tuning considerations to guides for immediate action. Use the system as a detailed reference and for help in solving problems.

Action bar help

On-line help is available from the action bar by selecting the Help pull-down menu. The Help pull-down menu is displayed, as shown in the following figure.

FIGURE 7. Help Pull-down Menu
The following selections are available from the Help pull-down menu:

**Help for Help**  Explains how to navigate through the OMEGAMON II help panels.

**Extended help**  Panel level help for the current panel. This can also be accessed using F1 on any panel.

**Keys help**  Describes the function keys used in the CUA interface.

**Help index**  Provides an alphabetic index of help panels. Press F6 in the Help Index pop-up to see the Search Index pop-up, which you can use to search for specific help topics.

**Tutorial**  Gives instruction on navigating around OMEGAMON II, tells how to use the parts of the screen, and tells how to get help from fields, the glossary and the help index. This selection also lists tips on using OMEGAMON II. These tips introduce you to new product features and advanced navigation techniques that will help you use the product more efficiently.

**Glossary**  Defines words and phrases for components, functions, and features of CICS and OMEGAMON II. Press F6 to see the Search Glossary pop-up, that you can use to search for specific glossary terms.

**About**  Shows logo, copyright, and product version information.

**User Information**  Shows information about your current session, such as user ID, terminal ID, system ID, VTAM logmode name, and current ACB name.

**New Features**  Describes the new features of the release.

**Panel help**
Help is available for the panel you are currently using by pressing F1 at the home position. A topic describing the panel is then displayed in a pop-up window.

**Field help**
Help is available for an input field on a panel by pressing F1 on the underscore of the field. A topic defining the field is then displayed in a pop-up window.

**Enter key**
Pressing Enter tells the application to do one of the following:
- display the choice selected from a pull-down menu
- save changes or additions to entries made on a pop-up window; then exit
- save changes made to data on panels
- refresh data displayed on panels
Function keys

Function keys are used to perform many tasks in OMEGAMON II. The keys and their uses are displayed at the bottom of each panel.

Only the function keys that are available for the current panel are displayed. For example, panels with data that may continue over several screens display the backward and forward function keys, F7 and F8, respectively, while single-screen panels do not display them.

To display descriptions of the function keys, select **Keys help** from the Help pull-down menu.

The following descriptions of the function keys are generally active throughout the CUA interface:

- **F1=Help**
  Displays a help window for the current panel or window.

- **F2=Keys**
  Toggles (turns on or off) the function key display at the bottom of the panel. (This notation does not appear on the Region Status panel, but the key may still be used there.)

- **F3=Exit**
  Returns to a higher level panel. From a help panel, returns to the panel from which the help was requested. Cancels changes to a panel. From the Region Status panel, exits the CUA interface.

- **F4=Prompt**
  Displays a list of valid selections for an input field. Promptable fields are indicated by the presence of a plus sign (+). Where there are only two valid selections for an input field, such as yes/no or on/off, F4 acts as a toggle, switching between the two selections.

- **F5=Refresh**
  Clears and updates the display panel data. From a data entry panel, restores the last saved value. If the cursor is on a field, the last saved value is restored for that field. If the cursor is not on a field, the last saved values for all fields are restored. From a help panel, displays the Glossary.

- **F6=Console**
  Presents the System Console panel from which you can issue CICS, MVS, JES, and VTAM commands.

- **F7=Bkwd**
  Scrolls backward if more lines exist than can be displayed on the current panel. If you are on the first panel, two asterisks (**) are displayed instead of the function key name.

- **F8=Fwd**
  Scrolls forward if more lines exist than can be displayed on the current panel. If no additional information exists, two asterisks (**) are displayed instead of the function key name.

- **F9=Retrieve**
  On the System Console panel, retrieves the previous command issued from the Command line.

- **F10=Action Bar**
  Moves the cursor to the action bar at the top of the panel or back to where it was in the panel body the last time you pressed F10.

- **F11=Print**
  Prints the screen. To route the screen to the printer, select the Options pull-down, then select Close print log. From a help panel, displays the Help index.

- **F12=Cancel**
  Exits the current pull-down menu or pop-up window without saving entered data.

- **F15=Region Status**
  Returns directly to the Region Status panel.
<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>F18=Defaults</td>
<td>Displays default settings. If the cursor is on a field, the default is restored for that field. If the cursor is not on a field, the defaults for all fields are restored (Available in some pop-up windows.)</td>
</tr>
<tr>
<td>PA2=Default trigger key</td>
<td>Use to return from the OMEGAMON menu system. To change the key, select the Options pull-down menu, then Controls, then Session Defaults.</td>
</tr>
</tbody>
</table>
CUA Interface Characteristics
Chapter Overview

You can log onto OMEGAMON II either directly through VTAM or through OMEGAVIEW. This chapter describes logging on directly through VTAM and tells where to get information for logging on through OMEGAVIEW.

Chapter Contents

Logging On Directly .................................................................................................................. 50
  Entering your VTAM applid ................................................................................................... 50
  Finishing the logon ............................................................................................................. 50
  Optional step: specifying logon options ............................................................................. 52
Logging on through OMEGAVIEW ......................................................................................... 55
Begin Your OMEGAMON II Session ..................................................................................... 56
Logging On Directly

You can log onto OMEGAMON II directly by entering your VTAM application ID (applid).

Before logging on, be sure that the OMEGAMON II address space has been initialized. See the OMEGAMON II for CICS Configuration and Customization Guide for details on initializing the OMEGAMON II address space.

Entering your VTAM applid

To log on, issue the following command at a VTAM terminal (the OMEGAMON II address space must be initialized):

```
LOGON APPLID(aaaaaaaa)
```

where aaaaaaaa is the VTAM applid specified to the CT/Engine™ address space when it was started.

Finishing the logon

After you’ve initiated the logon to OMEGAMON II, the Sign On panel displays to let you finish logging on. This panel validates you to your installation’s Logon Security system. The following figure shows the Sign On panel.

FIGURE 8. Sign On Panel

To sign on, enter your user ID, which is described below:

**User ID**

Enter your 1- to 8-character user ID. The user ID is mandatory even if your installation has no security system.

By default, you will use a userid profile with the same name as your user ID. See “Defining A Different User ID Profile” on page 108 for more information.
You also may need to enter the following:

**Password**

Enter your 1- to 8-character password. The password is not visible as you type it. If you make a mistake, be sure to completely clear the field before retyping the password. The password is mandatory if a security system is in place.

**Change Password**

To change the current password, type Yes. The system prompts you for the new password information.

**Group**

Used only if your system security administrator has implemented group level security. Enter a 1- to 8-character group ID.

**Account**

Used only if your system security administrator has implemented account level security. Enter your installation security account number.

After you enter the signon information described above, you can begin your OMEGAMON II session unless you decide to specify logon options. See “Optional step: specifying logon options” on page 52 for that information, or see “Begin Your OMEGAMON II Session” on page 56.
Optional step: specifying logon options

Usually you can begin your OMEGAMON II session immediately after you’ve logged on through the Sign On panel and the system has initialized.

If, however, you want to verify defaults set up during customization before you begin your session, access the Logon Options pop-up window (press F11 at the Sign On panel). Use this pop-up to specify startup information for the OMEGAMON II session you are starting. Figure 9 on page 52 shows the Sign On panel overlaid with the Logon Options pop-up.

FIGURE 9. Sign On Panel Showing Logon Options

The default values for logon options are obtained from rhivel.RKANPAR(KC2IPA\nn). These values were set up for your site during customization and display in this pop-up when you access it. (The user who installed and configured OMEGAMON II can tell you the high-level prefix for the dataset.)
Through the Logon Options pop-up, you can specify the following values:

<table>
<thead>
<tr>
<th><strong>OMEGAMON II userid profile</strong></th>
<th>Enter the name of the OMEGAMON II userid profile you want to use for the current session.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>If you have already supplied your user ID on the OMEGAMON II Sign On panel, your default userid profile is displayed in this field. The default value is used as your OMEGAMON II userid profile.</td>
</tr>
<tr>
<td></td>
<td>To specify an alternate OMEGAMON II userid profile for this session, enter its name in this field. Press F4 to see a list of currently defined session profiles.</td>
</tr>
<tr>
<td></td>
<td>See “Defining A Different User ID Profile” on page 108 for more information.</td>
</tr>
<tr>
<td><strong>OMEGAMON common interface applid</strong></td>
<td>Enter the 1- to 8-character VTAM application identifier for the OMEGAMON II for CICS common interface session you will use to monitor the CICS region.</td>
</tr>
<tr>
<td><strong>OMEGAMON common interface password</strong></td>
<td>If desired, enter the 1- to 8-character password for the OMEGAMON II common interface (KOCCI) session you are trying to logon to.</td>
</tr>
<tr>
<td></td>
<td>This parameter is required only if security has been implemented for the OBVTAM subtask.</td>
</tr>
<tr>
<td><strong>CICS job name</strong></td>
<td>Enter the 1- to 8-character MVS job (or started task) name of the CICS region you are monitoring. Or, if the started task has a stepname, then use the stepname.</td>
</tr>
<tr>
<td><strong>CICS region profile</strong></td>
<td>Enter the 1- to 8-character CICS region profile name to be used by the session you are defining.</td>
</tr>
<tr>
<td></td>
<td>The CICS region profile contains the OMEGAMON II thresholds settings for all performance measures.</td>
</tr>
<tr>
<td></td>
<td>If you specify a profile name in this field, it must have been previously defined in the OMEGAMON II CUA interface. Press F4 to see a list of currently defined CICS region profiles.</td>
</tr>
<tr>
<td></td>
<td>See “Defining a Different CICS Region Profile” on page 110 for more information.</td>
</tr>
<tr>
<td><strong>Migrate profile from OMEGAMON</strong></td>
<td>This option is a customization feature. See the OMEGAMON II for CICS Configuration and Customization Guide for information.</td>
</tr>
<tr>
<td><strong>OMEGAMON profile to migrate from</strong></td>
<td>This option is a customization feature. See the OMEGAMON II for CICS Configuration and Customization Guide for information.</td>
</tr>
</tbody>
</table>
Logging On Directly

**Password for authorized commands**
If you know that you will be using authorized commands, enter Yes and you will be prompted to set the password for the authorized commands used in OMEGAMON II displays.

Most OMEGAMON II displays use commands from the OMEGAMON menu system. These commands can be protected by either a password or an external security exit which uses RACF or other security programs. Typically, commands are protected to prevent you from modifying the system or affecting other users (listing or changing memory, or killing a task, for example).

Once you enter a password, it is in effect until the end of your session or you reset it. To reset password authorization, use the Enable or Disable authorized commands option in the Options pull-down.

**Logical rows for menu system**
Enter the number of logical rows for the virtual terminal that the OMEGAMON II CUA interface uses to obtain data from the menu system. This number can be from 150–9999.

If the number of logical rows specified is insufficient to hold the output for a command, the command output is truncated. If the CUA interface detects that command output has been truncated, it issues a warning message that the CUA display may contain incomplete data.

Increasing the logical rows size increases the amount of virtual storage used by the virtual session in the OMEGAMON II common interface (KOCCI) address space.

**Display Tip of the Day**
Each time you start a direct logon session, you can select one of the following for the Tips option:

- **Yes** Displays the Tip of the Day when you log on.
- **No** Does not display the Tip of the Day at logon.
- **Wait** Displays the Tip of the Day when you log on until you press Enter to cancel it. This selection gives you a longer time to read the tip.

A different tip appears on each day of the month.

If you leave this field blank, the default value you specified in KC2IPAnn of ddname RKANPAR is used for the Tips option.

**Note:** To change the default tip of the day option for all sessions, specify the new default (Yes, No, or Wait) in rhilev.RKANPAR(KC2IPAnn). For example, after the statement:

```
LROWS=256
```

Enter the following statement:

```
TIPS=YES
```

"Yes" will appear as the default in the Display Tip of the Day field on the Logon Options pop-up.
Logging on through OMEGAVIEW

An alternative method of logging onto OMEGAMON II is through OMEGAVIEW. See “OMEGAVIEW Enhanced Zoom” in the OMEGAMON II for CICS User’s Guide, for information.
Begin Your OMEGAMON II Session

After you’ve entered the required values on the Sign On panel and pressed Enter, the session initializes and you can begin your OMEGAMON II session. See “Understanding the Region Status Panel” on page 57 for information you will need to know for a successful session.

For an overview of what you might do during a typical session, see “CICS Problem-Solving Approaches” in the OMEGAMON II for CICS User’s Guide. This chapter contains scenarios that demonstrate typical situations you may encounter when using OMEGAMON II.
Chapter Overview

The Region Status panel is the first panel you see after you finish logging on. It provides a high-level overview of a particular CICS region, displaying status bars for workloads, resources, and alerts. This chapter covers the following topics:

- the layout of the Region Status panel and ways of investigating status conditions
- action bar selections from the Region Status panel

Chapter Contents

Overview ................................................................. 59
Status Bar Indicators ................................................. 61
  Status Bars and Status Words ............................ 61
  Investigating status conditions .......................... 62
Switching to Another CICS Region ........................ 64
Date/Time Stamp ................................................. 65
Auto Refresh Interval ............................................. 66
Function Keys ....................................................... 67
Actions Pull-Down Menu ........................................ 68
GoTo Pull-Down Menu ............................................ 69
  Access CICS tables ............................................. 70
  Access Task History ............................................ 71
  Access CICS Memory ........................................... 72
  Zoom to the Menu System ................................. 73
Index Pull-Down Menu .......................................... 74
  View pull-down .................................................. 76
Options Pull-Down Menu ...................................... 79
  Preferences ....................................................... 80
  Controls .......................................................... 83
  Collection Controls .......................................... 88
  CICS Shutdown Option ....................................... 106
  Thresholds ....................................................... 106
  Response Time Groups ................................. 107
  Userid Profiles ............................................... 108
  Region Profiles ................................................. 109
Help Pull-Down Menu
Overview

The following figures show the Region Status panel for CICS/ESA Version 4 and earlier and CICS/ESA Version 5.1.0. The name of the CICS region being monitored is in the upper right corner of the panel.

FIGURE 10. Region Status Panel (CICS/ESA Version 4 and Earlier)

<table>
<thead>
<tr>
<th>Workloads</th>
<th>Resources</th>
<th>Alerts</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>AIDs OK</em></td>
<td><em>CPU Crit</em> <em>LSR OK</em> <em>Bottlnck Crit</em></td>
<td></td>
</tr>
<tr>
<td><em>ICEs OK</em></td>
<td><em>DASD Crit</em> <em>MRO/ISC OK</em> <em>CICSloop OK</em></td>
<td></td>
</tr>
<tr>
<td><em>Response Crit</em></td>
<td><em>DB2 OK</em> <em>Paging OK</em> <em>Dumps OK</em></td>
<td></td>
</tr>
<tr>
<td><em>Tasks OK</em></td>
<td><em>DBCTL Warn</em> <em>Storage Crit</em> <em>Enqueues OK</em></td>
<td></td>
</tr>
<tr>
<td><em>TranRate OK</em></td>
<td><em>DL/I OK</em> <em>Tapes OK</em> <em>I/O Rate OK</em></td>
<td></td>
</tr>
<tr>
<td></td>
<td><em>Files OK</em> <em>TempStor OK</em> <em>VTAM ACB OK</em></td>
<td></td>
</tr>
<tr>
<td></td>
<td><em>Journals OK</em> <em>TranData Crit</em> <em>XRF Idle</em></td>
<td></td>
</tr>
</tbody>
</table>

F1=Help  F3=Exit  F4=Prompt  F5=Refresh  F6=Console  F10=Action Bar  F11=Print
FIGURE 11. Region Status Panel (CICS/ESA Version 5.1.0)

On the panel, the status bars are grouped into the following areas:

**Workloads**
Indicates the status of the useful work CICS is currently performing.
See Chapter 9, “Workloads” on page 243, for information on each component in the Workloads section of the Region Status panel.

**Resources**
Indicates the status of resource usage.
See Chapter 10, “Resources” on page 291, for information on each component in the Resources section of the Region Status panel.

**Alerts**
Indicates the status of exceptional conditions that can degrade response time and that may require immediate action.
See Chapter 11, “Alerts” on page 387, for information on each component in the Alerts section of the Region Status panel.
Status Bar Indicators

The next two sections explain the meaning of the status bar indicators and ways of investigating status conditions.

Status Bars and Status Words

Status bars indicate the current status of each CICS component on the Region Status panel, based upon thresholds set to measure performance.

On Color Terminals

On color terminals, the status bars contain lights that represent a component’s status, as follows:

- Red for critical
- Yellow for warning
- Green for normal
- Turquoise for not monitoring or data unavailable

Status words also display on a color terminal. The default status words are:

- Crit (for critical status)
- Warn (for warning status)
- OK (for normal status)
- Idle (for not monitoring)

You can change the status words on a color terminal by using the Session Defaults pop-up window of the Controls option on the Options pull-down menu. Enter up to five alphabetic or numeric characters. (Enter fast path OCS.)

On Monochrome Terminals

On monochrome terminals, words display in place of colors. The default words that display are as follows:

- Crit (for critical status)
- Warn (for warning status)
- OK (for normal status)
- Idle (for not monitoring)

You can change the default words that display on a monochrome terminal by using the Session Defaults pop-up window of the Controls option on the Options pull-down menu. Enter up to five alphabetic or numeric characters. (Enter fast path OCS.)
Investigating status conditions

You can investigate the status conditions indicated by a status bar or status word by navigating from the Region Status panel or entering action code L next to a status bar on the panel. Navigating allows you to show details or to analyze problems for a component. Entering the L action code allows you to view performance measures, thresholds, and the frequency of data collection for a particular component.

Enter S to Show Details

If a status bar for a component indicates that it is performing well (it is either green or characters indicate an OK condition), or indicates a warning or a critical condition, you can enter action code S (Show details) to get more information about the component being monitored. In most instances, a panel showing summary information for the component displays.

Enter A to Analyze Problems

If a status bar for a component indicates that it is performing poorly (it is yellow or red, or characters indicate a warning or critical condition), you can enter action code A to analyze the problem by displaying the performance measures and thresholds values that have been exceeded. A panel then displays listing one or more problems for the component. The following figure shows a problem analysis panel.

FIGURE 12. Analyze DASD Problems

<table>
<thead>
<tr>
<th>Problem Description</th>
<th>Value</th>
<th>Warning</th>
<th>Critical</th>
</tr>
</thead>
<tbody>
<tr>
<td>Response time for 0328 (OMON24)</td>
<td>34ms</td>
<td>30ms</td>
<td>40ms</td>
</tr>
<tr>
<td>Response time for 031C (OMON23)</td>
<td>33ms</td>
<td>30ms</td>
<td>40ms</td>
</tr>
<tr>
<td>Response time for 0319 (OMON30)</td>
<td>31ms</td>
<td>30ms</td>
<td>40ms</td>
</tr>
</tbody>
</table>

Note: You should enter A next to a status bar only if its color or characters indicate the component is having problems. If you enter A next to a healthy status bar, you will get the message shown below.

DASD is not currently experiencing any problems
Enter L to View Frequency of Data Collection

Enter action code L (control data collection) next to a component to display a Thresholds pop-up window that shows the performance measures and thresholds for the component and the frequency of data collection. This field indicates how often OMEGAMON II collects data for the Region Status panel. Setting the frequency of data collection gives you control over resource usage.
Switching to Another CICS Region

The name of the CICS region currently being monitored displays in the Region field of the Region Status panel (see Figure 10 on page 59). If you want to monitor another CICS region, you can switch to it by overtyping the name displayed in the field. A different region will then be monitored.

Note: If you are running OMEGAMON II under OMEGAVIEW, you cannot switch to another CICS region by changing the name in the Region field on the Region Status panel. You can change regions by using the OMEGAVIEW Switch Session key. For information on using this key, see “Transplex™ Navigation and Session Switching” in the OMEGAMON II for CICS User’s Guide.

When you switch regions, OMEGAMON II searches for the region profile in the following order:

1. It looks for a profile with the same name as the region name.
2. If it does not find a profile with the same name as the region, and there is a region profile specified in member KC2IPA<nn>, it uses that name.
3. If it does not find a region profile specified in member KC2IPA<nn> (from dataset rhilev.RKANPAR), it uses $DEFAULT.

If you need to see the list of CICS regions that you can monitor, press F4. The CICS Region pop-up window displays. Tab to the desired region and press Enter.
Date/Time Stamp

The Region Status panel displays the current date and current time. You can specify the format of the date and time that display through the Preferences pop-up of the Options pull-down. See “Options Pull-Down Menu” on page 79 for details. (Enter fast path OP)
Auto Refresh Interval

The auto refresh interval, which indicates the elapsed time, in seconds, before the screen automatically refreshes, is displayed on the Region Status panel. To change the length of the interval, use the Session Defaults pop-up on the Options pull-down.
Function Keys

The following function keys display on the Region Status panel:

<table>
<thead>
<tr>
<th>Function Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1=Help</td>
<td>Displays help for the Region Status panel or fields on the panel.</td>
</tr>
<tr>
<td>F2=Keys</td>
<td>Toggles (turns on or off) the function key display at the bottom of the panel. (This notation does not display on the Region Status panel, but the key may still be used there.)</td>
</tr>
<tr>
<td>F3=Exit</td>
<td>From the Region Status panel, exits the CUA interface.</td>
</tr>
<tr>
<td>F4=Prompt</td>
<td>Displays the list of CICS regions that you can monitor, when the cursor is on the Region input field.</td>
</tr>
<tr>
<td>F5=Refresh</td>
<td>Clears and updates the data on the panel.</td>
</tr>
<tr>
<td>F6=Console</td>
<td>Presents the System Console panel from which you can issue CICS, MVS, JES, and VTAM commands.</td>
</tr>
<tr>
<td>F10=Action Bar</td>
<td>Moves the cursor to the action bar at the top of the panel or back to where it was in the panel body the last time you pressed F10.</td>
</tr>
<tr>
<td>F11=Print</td>
<td>Prints the screen. To route the screen to the printer, select the Options pull-down, then select :xph.Close print:exph. (Enter fast path OL.)</td>
</tr>
</tbody>
</table>
Actions Pull-Down Menu

The Actions pull-down menu enables you to choose an action for an item selected on a data panel or for the object described on a detail panel. Use the Actions pull-down menu when you need to see which action codes are available for the item you have selected. If you do not need to see the available action codes, enter the desired action code directly in a selectable field.

On a color terminal, actions colored blue are currently unavailable for selected items. On a monochrome terminal, unavailable items contain an asterisk (*) as the first character of the selection.

Figure 13 on page 68 shows an example of the Actions pull-down menu.

FIGURE 13. AIDs Summary with Actions Pull-down

See “Using the Actions Pull-down” in the OMEGAMON II for CICS User’s Guide for a procedure on using this menu.
On the Region Status panel, the GoTo pull-down menu allows you to navigate to panels that cannot be reached through status bars.

On other panels, the GoTo pull-down menu lets you navigate to an area of CICS monitoring related to the current panel. The choices on this pull-down vary for each panel. You can access this menu by entering G in the action bar entry field.

Figure 14 on page 69 shows the GoTo pull-down you can access from the Region Status panel.

FIGURE 14. GoTo Pull-down Menu
Access CICS tables

Through this pull-down you can access CICS Tables, which represents a selection of CICS control blocks that are not directly associated with other specific monitoring functions. Selecting CICS Tables from the GoTo pull-down causes the Figure 15 on page 70 to display.

FIGURE 15. CICS Tables Panel

For details on the panels accessible through the CICS Tables panel, see “CICS Tables” on page 113.
Access Task History

You can access Task History information through the GoTo pull-down on the Region Status panel. Task History is the presentation of the historical data collected for all completed transactions in a CICS region. Further details for each completed transaction are available by selecting a row of the Task History panel.

Figure 16 on page 71 shows the Task History panel.

FIGURE 16. Task History Panel

For details on the Task History panels, see “Task History” on page 165.
Access CICS Memory

You can access the CICS Memory panel through the GoTo pull-down menu. The CICS Memory panel displays storage in the CICS address space and is useful for looking at the unformatted contents of virtual storage in the address space.

Areas not formatted by other panels can be examined here. You can also scan virtual storage or chase control block chains to look for specific strings.

Enter action codes in the fields of the Contents section of the panel to select the processing you want. The available action codes are displayed above the table on the panel, and are also listed on the Actions pull-down menu. You can also press Enter in the input field next to any address to display memory at that address.

Figure 17 on page 72 shows the CICS Memory panel.

FIGURE 17. CICS Memory Panel

For details on the panels accessible through CICS Memory, see “CICS Memory” on page 207.
Zoom to the Menu System

Select this choice on the GoTo pull-down to access the facilities provided by the OMEGAMON II menu system. A pop-up window prompts you to specify an OMEGAMON II screen space to which to zoom. Enter the fast path for the topic to which to zoom. To see a list of fast paths for the menu system, press F1 on the Zoom to OMEGAMON Menu System pop-up, or see “Menu System Fastpath Index” in Volume II of the OMEGAMON II for CICS Reference Manual.

To return to the CUA interface from the OMEGAMON menu system, you use the trigger key that you specify through the Session Defaults selection on the Controls pop-up window. See “Zooming to the Menu System” in OMEGAMON II for CICS User’s Guide for the procedure to follow to set the trigger key.
Index Pull-Down Menu

The Index pull-down menu allows you to access panels within OMEGAMON II without going through normal navigation paths. Using this pull-down menu, you can access a panel by selecting a subcategory to which the panel belongs or a panel name. You can also use this pull-down to search the panel title index.

In addition, the fast path mnemonics you use to navigate directly to all panels are based on the choices available through this menu. For example, the fast path for the Response Times panel, \( \text{=WR} \), stands for the navigation path that starts at the Workloads selection on the Index pull-down, then goes to the Response selection on the Workloads menu, then to the Response Time selection on the Response menu, then to the Response Times panel.


The following figure shows the Index pull-down menu.

**FIGURE 18. Index Pull-down Menu**

The Search for selection on the Index pull-down allows you to display the Search Index pop-up window. Figure 19 on page 75 shows the pop-up.
This pop-up window lets you perform a search of the panel title index for all panels containing the specified text in their titles. This selection helps you find information about a particular feature of CICS when you do not know the relevant panel title.

You can enter more than one word in the input field; the entire string will be used as the search criterion. For example, if you enter **Address Space**, a list of the names of all panels that contain the phrase Address Space in their titles will appear.

See “Using the Index Pull-down” in the *OMEGAMON II for CICS User’s Guide* for a procedure on using the Search Index.
View pull-down

The View pull-down menu allows you to filter and sort items displayed on the panel you are viewing. You can filter the contents of a panel to see All, Some, and, in some cases, Problem items. You can also sort by specific columns on the panel, and sort the items in the columns in ascending or descending order.

The View pull-down menu is not available on all panels of OMEGAMON II.

Figure 20 on page 76 shows a typical View pull-down menu.

FIGURE 20. Typical View Pull-down Menu

Select All

Select All from the View pull-down to display all currently available data on the panel. If you set the default view in Session Defaults to show only problems, selecting All will cause all available data for the panel to display instead. See “Controls” on page 83 for information on setting session defaults.

Select the View Some pop-up

Select Some from the View pull-down to display the View Some pop-up window. Use the pop-up to enter filtering criteria so only specific information displays on the panel. For example, you could exclude specific Tran IDs from displaying on the Tasks panel. For more information, see “Using the View Some Pop-up” in the OMEGAMON II for CICS User’s Guide.

Figure 21 on page 77 shows the View Some pop-up.
Promptable Fields and Columns

Some values on the View Some pop-up may have a plus sign (+) at the end of the field. This means you can display a list of choices by tabbing the cursor to the field and pressing F4. Similarly, to see a list of valid comparative operators, move the cursor to the Operator column and press F4. Valid comparative operators are as follows:

- **EQ** (equal)
- **NE** (not equal)
- **LE** (less than or equal)
- **LT** (less than)
- **GE** (greater than or equal)
- **GT** (greater than)

Asterisks in the Value Column

An asterisk in the Value column of View Some means all values will display. You can also type the asterisk as the last character of a character string, for example, JOB*, and only the data that starts with JOB will be displayed.

Two or More Search Criteria

When you specify two or more search criteria, all specified search criteria must match for the data to be displayed.
Saving Filter Criteria and Restoring Values
Filter criteria are saved when you press Enter. You can press F5 on any input field to restore the last saved value. If you press F5 on any non-input field, all values are restored.

Select Problems
Select Problems from the View pull-down to display only those items that have exceeded their thresholds. If you set the default view in Session Defaults to show all data available, selecting Problems will cause only problems to display instead. See “Controls” on page 83 for information on setting session defaults.
Options Pull-Down Menu

When you log onto OMEGAMON II for the first time, it loads a copy of the default set of options.

The Options pull-down menu contains choices to help you customize the CUA interface options. The following figure shows the menu.

**FIGURE 22. Options Pull-down Menu**

Using this menu you can

- change controls for your OMEGAMON II session, for example, the status of collection subtasks, and display and print options
- set thresholds for all panels
- set preferences such as date and time formats, mnemonics, and function key displays

After changing various values in the Options pull-down, OMEGAMON II prompts you to save them for the duration of the current CUA interface session or to save them in either the region profile or the userid profile. The values you saved for the current session will be discarded when you log off.

The Options menu choices are described below.
Preferences

Select this option to set standard defaults for your displays. The following figure shows the selections available.

FIGURE 23. Preferences Pop-up Window

Mnemonics
When Mnemonics is on, an input field displays to allow the entry of fast path mnemonics for quick access to the various pull-down menus. When Mnemonics is off, the input field no longer displays and you must tab to your selection and then press Enter. The default setting is On.

Beep
When Beep is on, the terminal alarm sounds for input errors that are detected by OMEGAMON II. A beep also sounds whenever you press a function key that is not currently available. When Beep is off, the terminal alarm does not sound. The default setting is On.

Panel ID
Displaying the panel ID may be useful if you have to report any problems with the current panel. The default setting is Off.

Time/Date Display
When Time/Date Display is on, the current time and date display on the right side of the action bar separator line. When off, the current time and date do not display. The default setting is On. Press F4 to toggle between On and Off.
Function Key Area
When Function Key Area is on, the currently available function keys display on the bottom one or two lines of the panel. When off, the function key area does not display. In some cases, this allows you to see more information on the panel. The default setting is On. Press F4 to toggle between On and Off.

Implicit Action
When Implicit Action is on, you can simply position the cursor in the entry field of a panel selection and press Enter for an implicit action to occur. The implicit action is panel dependent. When Implicit Action is off, you must type an explicit action code in the entry field. The default setting is On.

National Language
Displays the current choice for national language. Press F1 to view a list of available choices.

Exit Confirmation
When Exit Confirmation is on, a prompt displays to confirm an exit from the current application.
The default setting is On. Press F4 to toggle between On and Off.

Delete Confirmation
When Delete Confirmation is on, a prompt displays to confirm a delete action that you requested.
The default setting is On. Press F4 to toggle between On and Off.

Date Format
Select the date format you want to use for the current date at the top of each panel. The default format is mm/dd/yy. Press F4 to see a list of available formats. The only valid date formats used within panels are mm/dd/yy and dd.mm.yy.
Time

Select the time format you want to use for the current time at the top of each panel. You can select the following:

**Format**

Select either the 12 or 24 to specify the 12- or 24-hour time format. The default format is 24.

**Separator character**

The character that displays between the hours, minutes, and seconds portion of the time stamp. The default character is a colon. Any character is valid.

**Morning indicator**

The two-character code that indicates morning hours when the 12-hour time format is selected. The default value is AM. Any two characters are valid.

**Afternoon indicator**

The two-character code that indicates hours after 11:59:59 in the morning, when the 12-hour time format is selected. The default value is PM. Any two characters are valid.

The only valid time format used within panels is 24-hour format, hh:mm:ss.
Controls

Select this option to specify such administrative details as settings for session defaults, the routing of screen print output, and the enabling or disabling of your Authorized Command Facility password. Figure 24 on page 83 shows the pop-up window that displays.

FIGURE 24. Controls Pop-up Window

A pop-up window displays for each selection on the Controls pop-up. The following pop-up windows display:

- Sessions Defaults
- Screen Print Output Routing Options
- Enable Authorized Commands
Session Defaults

Figure 25 on page 84 shows the Session Defaults pop-up:

**FIGURE 25. Session Defaults Pop-up Window**

This pop-up allows you to specify the session controls described below.

**Auto Refresh Interval**
This field indicates the elapsed time, in seconds, before the screen is automatically refreshed.

The default for this option is no auto refresh (Off).

**Trigger to Return from Zoom**
This field indicates which key will act as a trigger to return from the OMEGAMON II menu system to the CUA interface of OMEGAMON II.

Valid options are the function keys 1–24 and the PA keys 1–3. For the procedure to follow to set the trigger key, see “Zooming to the Menu System” in the OMEGAMON II for CICS User’s Guide.

**Default View**
This field indicates the default view of data panels.

- **All**
  Displays all of the available data.

- **Problems**
  Displays only those items that have exceeded their thresholds.

To toggle between All and Problems, press F4.

The default view is in effect until you select a view different from the default on the View pull-down menu.
Options Pull-Down Menu

Fold Terminal ID Input Fields
Indicates if any terminal ID that you type will be folded to upper case or not. You select either of the following to determine the case:

- **Yes**: Terminal IDs that you type in will be folded to upper case.
- **No**: Terminal IDs that you type in will not be folded to upper case, but will be used as entered.

When you select a terminal with a mixed case ID from a list of terminals, the terminal ID will not be folded to upper case even if this option is set to Yes. Only terminal IDs that you type on the screen will be folded to upper case.

This option is not saved in your user profile, but it defaults to Yes each time you log on to OMEGAMON II.

Use Status Words
This field indicates whether status words are displayed on the Region Status panel.

Status characters reflect the threshold status.

Enter Yes in this field if you are using a monochrome terminal, or if you want to display characters as well as color on a color terminal.

To toggle between Yes and No, press F4.

Critical Status Word
The alphanumeric critical status word used on the Region Status panel when the critical threshold has been exceeded.

Warning Status Word
The alphanumeric warning status word used on the Region Status panel when the warning threshold has been exceeded.

OK Status Word
The alphanumeric OK status word used on the Region Status panel when no thresholds have been exceeded.

Idle Status Word
The alphanumeric idle status word used on the Region Status panel when no data is being collected for a component.

Saving Your Session Default Settings
After changing settings, OMEGAMON II prompts you to save them for the duration of the current session or to save them in the userid profile.

Screen Print Output Routing Options
This pop-up window lets you set up the destination information for screen prints. Figure 26 on page 86 shows the pop-up.
The following fields display on the pop-up:

**Sysout Class**

The sysout class that you normally use for your print jobs.

**Copies**

Enter the number of copies to be printed. Specify 1–999.

**Destination**

Enter your printer destination.

This field can contain up to 17 characters, and you can choose between two forms to specify the destination. The first form is `node.name`, which is generally used to specify remote printers. The components of this form, node and name, can each be up to 8 characters long. These components are delimited by the period. The second form of the destination lets you specify just the name of the printer. In this case, the destination can be only 8 characters long.

**Form name**

If desired, enter a print form name.

**Hold output**

Indicate whether you want the print output held in the input queue before it is printed. Press F4 to toggle between Yes and No.

**Fold to uppercase**

Indicate whether you want the print output in uppercase. Press F4 to toggle between Yes and No.

**Routing information**

You may enter a description in this field. Your logon ID will be specified automatically.
Enable Authorized Commands

This pop-up window allows you to enter the OMEGAMON II Authorized Command Facility password. The following figure shows the pop-up:

**FIGURE 27. Enable Authorized Commands Pop-up Window**

If you try to navigate and receive a message saying you are not authorized to view the information, then you need to enter the OMEGAMON II password. Once you type the password and press Enter, you will be able to display information and take actions that are password protected. Once you enter a password, it is in effect until the end of your session.

Disable Authorized Commands

To prevent the display of password-protected information, select Disable Authorized Commands from the Controls pop-up. A message displays stating that the command was successfully reset.

Print SNAPSHOT of CICS Region

Selecting Print SNAPSHOT of CICS region from the Controls pop-up will cause a SNAPSHOT to be taken for the current CICS region. The resulting output is written to the OMEGAMON II for CICS log file, then is automatically routed to the JES Print Queue under the OMEGAMON II for CICS address space job JCL. An informational message is displayed upon successful completion of the SNAPSHOT function.
Collection Controls

This option allows you to manage the collection of performance data for CICS regions, set internal bottleneck display controls, and predetermine the amount of CICS resources that a task may use (resource limiting). Data collection can be managed for the following:

- internal bottlenecks
- interval recording
- response time
- task history
- CICS file and database statistics

The following figure shows the Collection Controls pop-up window:

FIGURE 28. Collection Controls Pop-up Window

The following sections describe the collection controls.
**Internal Bottleneck Collection**

The Internal Bottleneck Collection pop-up window enables you to control the collection of internal resource bottleneck information for the current CICS region. Internal bottleneck analysis identifies the various reasons why tasks in your CICS region are waiting.

Bottleneck data is collected in a common area for each CICS region. This information is shared by all OMEGAMON II sessions monitoring that region.

Use this pop-up to see the current status of the bottleneck collector and to change collection options. Figure 29 on page 89 shows the Internal Bottleneck Collection pop-up.

**FIGURE 29. Internal Bottleneck Collection Pop-up Window**

<table>
<thead>
<tr>
<th>Actions</th>
<th>GoTo</th>
<th>Index</th>
<th>Options</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>KC2QDEX</td>
<td>Internal Bottleneck Collection</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Type any changes, then press Enter.

| Collection status . . . : Active |
| Collection start date . : 08/26/93 Collection start time : 2:38:20 |
| Interval elapsed time . : 1:00 MN Number of samples . . : 31 |

| New collection status . . Active__ + (Active/Inactive) |
| Minimum displayed ratio . 10 % (0-99) |
| Clear the accumulators . . No_ + (Yes/No) |

Changing either of the following fields will clear the accumulators.

| Collection interval . . . 10 min (0-999) |
| Sample frequency . . . . . 2.0 sec (0.1-9.9) |

F1=Help  F4=Prompt  F5=Refresh  F12=Cancel  F18=Default|

F1=Help  F3=Exit  F4=Prompt  F5=Refresh  F6=Console  F10=Action Bar  F11=Print
The following fields are defined for this pop-up.

**Interval Elapsed Time**
This field shows the elapsed time since the current collection interval began.

Bottleneck data is collected and averaged for the duration of the interval.

At the end of the interval, the accumulated data will be cleared.

**Number of Samples**
This field shows the number of collected samples since the current collection interval began.

Bottleneck data is collected and averaged for the duration of the interval.

The number of samples per interval is determined by the sample frequency. For example, in a 1-minute collection interval, with a sample frequency of 2 seconds, there will be 30 samples.

**New Collection Status**
Displays the status of the bottleneck collector for the current CICS region. To start or stop the collector, press F4 to toggle between Active and Inactive, then press Enter. Changing the status of the bottleneck collector affects all OMEGAMON II sessions monitoring the current region.

**Minimum Displayed Ratio**
This field can be overtyped with a value between 0–99.

In bottleneck panels, only resources that meet or exceed this bottleneck ratio will display.

**Clear the Accumulators**
This field indicates whether to clear the current bottleneck data.

Press F4 to toggle between Yes and No.

**Collection Interval**
This field can be overtyped with the length of time over which bottleneck data should be accumulated and averaged before being cleared.

**Sample Frequency**
This field can be overtyped with a value indicating how often samples of bottleneck data are taken from the CICS region.

You can display the collected internal bottleneck data by selecting the Bottleneck status bar on the Region Status panel. The status bar indicates when the percentage of wait time for a particular resource exceeds the bottleneck threshold.
Internal Bottleneck Display

Internal bottleneck analysis is a realtime facility that looks over a short-term time interval and identifies the various reasons why CICS tasks in your CICS region are waiting.

The Internal Bottleneck Display Controls panel shows all the possible internal bottlenecks that may exist your CICS region. The following figure shows the panel.

FIGURE 30. Internal Bottleneck Display Controls Window

You can control whether or not waits caused by specific bottleneck reasons are displayed on the Internal Bottlenecks panel: move the cursor to the Display State field next to the resource and press F4 to toggle between On and Off, then press Enter.

The Resource Type and Resource Name columns show the CICS designation for the type of resource being waited on.

There are 10 buckets reserved for Third Party Product Support (TPPS). The first third party product that incurs a wait in a specific region uses TPPS: Bucket 0; the next third party product to incur a wait uses TPPS: Bucket 1, and so on.
Response Time Collection

The Response Time Collection pop-up window enables you to control the collection of response time information. The following figure shows the pop-up.

FIGURE 31. Response Time Collection Pop-up Window

<table>
<thead>
<tr>
<th>Actions</th>
<th>GoTo</th>
<th>Index</th>
<th>Options</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>KC2QRTA</td>
<td>Response Time Collection</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Type any changes, then press Enter.

Current subtask status: Active
Subtask start date: 08/26/93 Subtask start time: 8:13:43
New subtask status: Active__ + (Active/Inactive)

F1=Help  F4=Prompt  F12=Cancel

Response OK  DB2  CRIT  Paging OK  Dumps OK
Tasks OK  DBCTL  WARN  Storage WARN  Enqueues OK
TranRate CRIT  DL/I  OK  Tapes OK  I/O Rate OK
Files OK  TempStor OK  VTAM ACB OK
Journals OK  TranData OK  XRF  CRIT

F1=Help  F3=Exit  F4=Prompt  F5=Refresh  F6=Console  F10=Action Bar  F11=Print

Response time data is collected into a common area for each CICS region. This information is shared by all OMEGAMON II sessions monitoring that region. Changing the status of the response time collector affects all OMEGAMON II sessions monitoring the current region.

The New Subtask Status field displays the status of the response time collector for the current CICS region. Use this pop-up window to activate or deactivate the response time data collector. Press F4 on the New Subtask Status field to toggle between Active and Inactive, then press Enter.

When the collection status is Active, the Response Times panel displays response times for defined groups.

**Note:** OMEGAMON II must be initialized in CICS before the response time collector can be activated. Issue the CICS transaction OMEG INIT, or add program KOCOME00 to the PLTPI before you recycle CICS.
Interval Recording

The Interval Recording pop-up window enables you to control the collection of interval records. Use this pop-up to see the current status of the interval record collector and to change collection options. The following figure shows the pop-up.

FIGURE 32. Interval Recording Pop-up Window

The interval record collector analyzes each CICS region at a specified interval, collecting response time, bottleneck, and resource information. This data is then formatted and written to SMF for later analysis.

There is no online display of interval record information. The records must be processed by a batch job that produces reports from the SMF records. Candle Corporation supplies a batch job that analyzes the response time data in the interval records. When a group exceeds its response time threshold, the job formats response time information for that group.

To activate the interval record collector, press F4 at the New Subtask Status field, then press Enter. The word Active will appear in the field.

Note: OMEGAMON II must be initialized in CICS and the internal bottleneck and response time collectors must also be activated before you can activate interval record collection.

See the OMEGAMON II for CICS Historical Reporting Guide for more information on collecting interval records and producing problem reports.
Task History Collection

The Task History Collection pop-up window enables you to control the collection of task history information. The following figure shows the pop-up.

FIGURE 33. Task History Collection Pop-up Window

```
KCH2HIS               Task History Collection

Type any changes, then press Enter.

  Current subtask status: Active
  Subtask start date . . : 08/26/93    Subtask start time . . : 2:38:22
  Data store type . . . : Dataspace   Data store size . . . : 956K
  Data store size (recs) : 912         Records received . . . : 113
  Data store wraparounds : 0           Cross memory posts . . : 0
  Cycle time . . . . . . : 2           Display requests . . . : 0

  New subtask status . . : Active__ + (Active/Inactive)

  F1=Help  F4=Prompt  F12=Cancel
```

Task history data is collected into a separate dataspace or file for each CICS region. This information is shared by all OMEGAMON II sessions monitoring that region.

Use this pop-up window to activate or deactivate the collection of task history data and to view data collection information.

When the collection status is Active, the Task History panel displays a summary of completed tasks.

The New Subtask Status field displays the status of the task history collector for the current CICS region. To start or stop the collector, press F4 to toggle between Active and Inactive.

Changing the status of the task history collector affects all OMEGAMON II sessions monitoring the current region.

**Note:** OMEGAMON II must be initialized in CICS before the task history collector can be activated. Issue the CICS transaction OMEG INIT, or add program KOCOME00 to the PLTPI before you recycle CICS.
CICS File/Database Information Collection

The CICS File/Database Collection pop-up window enables you to dynamically control the collection of statistics for VSAM, DB2, DL/I, and third-party database products. The following figure shows the pop-up.

FIGURE 34. CICS File/Database Collection Pop-up

For VSAM, task statistics are always collected if CICS Monitoring is active. You also have the option to collect file statistics.

For DB2, only task statistics may be collected.

For the other products, you can decide whether you want to collect only summary statistics at the task level, or if you also want to collect detailed statistics for each file or database.

To change a value, move the cursor to an input field and press F4 to toggle between Yes and No, then press Enter.

You may collect task statistics without collecting file statistics. However, file statistics rely on the collection of task statistics. Therefore, if you want to turn on file statistics, you must also turn on task statistics.

The column Write to Data Store controls the writing of file statistics to the task history data store. To view file statistics for a completed task, select the appropriate product name from the Task History Details panel.

The column Write to SMF controls the writing of file statistics to SMF for batch processing.
Task level statistics are always written while task level monitoring is on. Task statistics for a running task are available from the Task File Statistics panel. They are also displayed by the Task History Details panel for completed tasks.

See “Task History” on page 165 for more information on Task History.

Resource Limiting

Resource limiting allows you to predetermine the amount of CICS resources that a task may use. Any task that reaches a usage threshold will be abended by OMEGAMON II. The CICS resources that OMEGAMON II can monitor, on a task basis are:

- CPU time
- elapsed time
- number of file and database requests
- current amount of CICS task storage in use

For each resource in the global data area, you set a threshold and identify the tasks that must comply with the threshold. You can specify tasks using wildcard characters. All tasks, except those specified in an exclude list, are subject to a resource limit. If a task has more than one limit for a resource, the lowest limit is used.

Once resource limiting has been enabled, OMEGAMON II tests transactions to determine whether the threshold criteria have been met. OMEGAMON II’s testing can either be performed following each CICS EXEC call or database request, or can be set to perform testing after a specified number of calls or period of time.

OMEGAMON II determines whether a threshold has been reached when a CICS transaction issues EXEC level commands. Transactions with EXEC CICS calls are tested based upon the resource usage of all prior CICS requests, while exclusively MACRO level CICS transactions are not tested and are not subject to resource limiting. Database requests are tested at the time any number of them are received.

A separate threshold is available for each type of file and database request. Currently these requests are:

- EXEC level file control
- EXEC and CALL DL/I requests
- DB2 requests
- third-party database (IDMS, ADABAS, DATACOM, USREVNT1, and SUPRA) requests

OMEGAMON II purges any transactions performing function shipping in the CICS application owning region (AOR) that exceed the threshold.

For storage usage, there is one threshold for task storage used in the DSA (<16M) and one threshold for all task storage used in the DSA and EDSA (<16M & >16M), respectively. OMEGAMON II compares the amount of task storage currently in use with the amount requested to determine whether a limit has been reached.
**Activating Resource Limiting**

When OMEGAMON II is initialized in the CICS region, you can automatically enable resource limiting based on parameters you supplied in the global data area module.

To activate Resource Limiting,

1. From the Resource Limiting panel, select the Resource Limiting Status menu item.
2. Within the Resource Limiting Status panel, you can change the status of resource limiting from active to inactive and vice versa in the New Subtask field. Simply position the cursor on the field and press F4, then press Enter.

**Default Resource Limiting Testing Frequency**

The point at which OMEGAMON II performs resource limiting testing depends on both the resource, and whether or not you have specified RLIM interval settings.

The following table displays each resource and the frequency of its limit testing. The subsequent section discusses how to set RLIM testing intervals that can be used in place of these defaults.

<table>
<thead>
<tr>
<th>Resource</th>
<th>Tested . . .</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU time</td>
<td>At every EXEC CICS call.</td>
</tr>
<tr>
<td>Elapsed time</td>
<td>At every EXEC CICS call.</td>
</tr>
<tr>
<td>File Control request</td>
<td>At every EXEC CICS file control request.</td>
</tr>
<tr>
<td>DL/I request</td>
<td>At every EXEC CICS call. It is not tested during EXEC DLI or CALLDLI requests, therefore, OMEGAMON II does not abend a task until the next EXEC CICS request.</td>
</tr>
<tr>
<td>DB2 request</td>
<td>At every EXEC DB2 call.</td>
</tr>
<tr>
<td>Database request</td>
<td>At every database request.</td>
</tr>
<tr>
<td>Storage</td>
<td>At every GETMAIN request. A conditional GETMAIN that causes a task to reach or exceed its limit is abended even if the GETMAIN request fails due to a lack of storage.</td>
</tr>
</tbody>
</table>
**Setting Resource Limiting Testing Intervals**

Resource limiting testing intervals may be set to change the frequency of threshold testing from previously defined resource limits or rules. The benefit of this feature is that, properly set, it can reduce the amount of CPU usage attributed to RLIM processing.

There are two general types of RLIM testing intervals:

- Time-based interval settings allow you to specify the period of time that must pass between threshold tests. This interval is specified in seconds, and may be set for any number up to a period of one week (614800 seconds).

- Command-instance interval settings allow you to specify the number of CICS EXEC or database calls that must be made between threshold tests. Any number of EXEC or database calls may be specified.

Once RLIM has been activated, a non-zero setting for any of the interval types will cause that interval to be applied to all transactions. Also, any previous settings are ignored if a new setting is specified. Setting all interval types to 0 will result in the defaults being used.

To set a resource limiting interval, follow the series of steps below:

1. From the Resource Limiting panel, select the Resource Limiting Interval menu item.
2. Within the Resource Limiting Interval panel, choose a type of interval setting, then input an appropriate magnitude in the corresponding field.

The following figure shows the Resource Limiting pop-up window.

---

**FIGURE 35. Resource Limiting Pop-up**

---
Monitoring Control Facility and CICS/MVS

The monitoring control facility, when running with CICS/MVS™, gives you the capability of viewing the current status of the three monitoring components (CICS monitoring, OMEGAMON II monitoring, and SMF data collection). You can also change the status of OMEGAMON II monitoring and SMF data collection by OMEGAMON II.

To access the monitoring control facility in the CUA interface, perform either of the following:

- Enter **OOM** as a fastpath command on any OMEGAMON II panel. The Monitoring Control pop-up displays.

  Or

- Perform the following procedure:
  
  1. Tab to the Options selection of the action bar and press Enter. The Options pull-down appears.
  2. Type **O** (Collection controls) and press Enter. The Collection Controls pop-up displays.
  3. Type **M** (Monitoring Control) and press Enter. The Monitoring Control pop-up displays.

When you access monitoring control in the CUA interface and are running with CICS/MVS, the following new Monitoring Control pop-up (Figure 36 on page 99) displays.

**FIGURE 36. Monitoring Control Pop-up for CICS/MVS**

![Monitoring Control Pop-up for CICS/MVS](image-url)
The status of the three monitoring components (CICS monitoring, OMEGAMON II monitoring, and SMF data collection) displays for all versions of CICS.

For CICS/MVS, the status of CICS monitoring cannot be changed. The components that can be changed are:

- **OMEGAMON II monitoring status**

  Controls the status of OMEGAMON II global user exits within the current CICS region. If you set the OMEGAMON II monitoring status to inactive, the following features of OMEGAMON II are not available (because they require that the global user exits be active):

  - Task history
  - Interval record collector
  - Response time analysis
  - SMF data suppression
  - File statistics
  - Storage statistics
  - Program compressions
  - Task CPU utilization
  - TP I/O data
  - Resource limiting for the following resources:
    - CPU
    - DLI
    - DSA
    - EDSA
    - VSAM

**Notes:**

1. If OMEGAMON II monitoring is inactive, only the global user exits are turned off. You still retain other OMEGAMON II functionality, such as bottleneck analysis and the ability to kill tasks.

2. Global user exits are not required for resource limiting of the following resources:
   - ADABAS
   - DATACOM
   - DB2
   - ELAPSED
   - IDMS
   - SUPRA

3. **OMEGAMON II monitoring status is independent of the CICS monitoring status.**
SMF data collection status

Controls whether SMF data is written by OMEGAMON II. (This component does not affect the monitoring records written by CICS.)

**Note:** To set SMF data collection to active, you must also set OMEGAMON II monitoring status to active.

The following table shows the valid combinations of monitoring states for CICS/MVS:

<table>
<thead>
<tr>
<th>CICS Monitoring Status</th>
<th>OMEGAMON II Monitoring Status</th>
<th>SMF Data Collection Status</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Active</td>
<td>Active</td>
<td>OMEGAMON II global user exits active</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CICS writes monitoring records</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>OMEGAMON II writes SMF records</td>
</tr>
<tr>
<td>Active</td>
<td>Active</td>
<td>Inactive</td>
<td>OMEGAMON II global user exits active</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CICS writes monitoring records</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>OMEGAMON II SMF records are suppressed</td>
</tr>
<tr>
<td>Active</td>
<td>Inactive</td>
<td>Active</td>
<td>Error: SMF data collection status of active requires OMEGAMON II monitoring status of active.</td>
</tr>
<tr>
<td>Active</td>
<td>Inactive</td>
<td>Inactive</td>
<td>OMEGAMON II global user exits inactive</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CICS writes monitoring records</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>OMEGAMON II SMF records are suppressed</td>
</tr>
<tr>
<td>Inactive</td>
<td>Active</td>
<td>Active</td>
<td>OMEGAMON II global user exits active</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CICS does not write monitoring records</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>OMEGAMON II writes SMF records</td>
</tr>
<tr>
<td>Inactive</td>
<td>Active</td>
<td>Inactive</td>
<td>OMEGAMON II global user exits active</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CICS does not write monitoring records</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>OMEGAMON II SMF records are suppressed</td>
</tr>
<tr>
<td>Inactive</td>
<td>Inactive</td>
<td>Active</td>
<td>Error: SMF data collection status of active requires OMEGAMON II monitoring status of active.</td>
</tr>
<tr>
<td>Inactive</td>
<td>Inactive</td>
<td>Inactive</td>
<td>OMEGAMON II global user exits inactive</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CICS does not write monitoring records</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>OMEGAMON II SMF records are suppressed</td>
</tr>
</tbody>
</table>

1 CICS writes monitoring records irrespective of the status of SMF data collection.
Monitoring Control Facility and CICS/ESA

The monitoring control facility, when running with CICS/ESA, gives you the capability of viewing the current status of the three monitoring components (CICS monitoring, OMEGAMON II monitoring, and SMF data collection). You can also change the status of any of these components.

To access the monitoring control facility in the CUA interface, perform either of the following:

- Enter OOM as a fastpath command on any OMEGAMON II panel. The Monitoring Control pop-up displays.

Or

- Perform the following procedure:
  1. Tab to the Options selection of the action bar and press Enter. The Options pull-down appears.
  2. Type O (Collection controls) and press Enter. The Collection Controls pop-up displays.
  3. Type M (Monitoring Control) and press Enter. The Monitoring Control pop-up displays.

See Figure 37 on page 102 for the Monitoring Control pop-up for CICS/ESA.

When you access monitoring control in the CUA interface and are running with CICS/ESA, the following new Monitoring Control pop-up displays.

FIGURE 37. Monitoring Control Pop-up for CICS/ESA
The status of the three monitoring components (CICS monitoring, OMEGAMON II monitoring, and SMF data collection) displays for all versions of CICS.

For CICS/ESA the status of all components can be changed:

- **CICS monitoring status**
  Controls the status of both CICS global and performance monitoring. Global monitoring corresponds to SIT parameter MN, and performance monitoring corresponds to SIT parameter MNPER.

- **OMEGAMON II monitoring status**
  Controls the status of OMEGAMON II global user exits within the current CICS region. The following features of OMEGAMON II require that the global user exits be active:
  - Task history
  - Interval record collector
  - Response time analysis
  - SMF data suppression

  **Note:** If OMEGAMON II monitoring is inactive, only the global user exits are turned off. You still retain other OMEGAMON II functionality, such as resource limiting and the ability to kill tasks.

- **SMF data collection status**
  Controls the status of SMF data collection within the currently monitored CICS region.

  **Note:** In CICS/ESA all SMF records are written by CICS. Therefore, the collection of SMF data requires that CICS monitoring be active.

See the following table, which lists the valid combinations of monitoring states for CICS/ESA.
Valid combinations of monitoring states with CICS/ESA

The following table shows the valid combinations of monitoring states for CICS/ESA:

<table>
<thead>
<tr>
<th>CICS Monitoring Status</th>
<th>OMEGAMON II Monitoring Status</th>
<th>SMF Data Collection Status</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Active</td>
<td>Active</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Active</td>
<td>Active</td>
<td>Inactive</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Active</td>
<td>Inactive</td>
<td>Active</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Active</td>
<td>Inactive</td>
<td>Inactive</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Inactive</td>
<td>Active</td>
<td>Active</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Inactive</td>
<td>Active</td>
<td>Inactive</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Inactive</td>
<td>Inactive</td>
<td>Active</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Inactive</td>
<td>Inactive</td>
<td>Inactive</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** The above information replaces the information contained in section CMF Monitoring Possibilities (CICS/ESA) of Appendix C of the OMEGAMON II for CICS Configuration and Customization Guide.
Activating Application Trace (CICS Version 3 and Above)

Authorized users can perform the following application trace functions:

- Start and stop the application trace facility.
- Start and stop writing trace data to the OMEGAMON™ task history collector.
- Start and stop writing trace data to the System Management Facilities (SMF). (If you use SMF, application trace data is written to SMF type 255 records.)

Use the following procedure to start and stop application trace functions.

1. From the Options pulldown on any OMEGAMON II for CICS panel, select **Collection Controls**... and press Enter.
   **Result:** The Collection Controls pop-up displays.

   [Collection Controls]
   Select one of the following, then press Enter.
   
   1. Internal Bottleneck Collection
   2. Internal Bottleneck Display
   3. Response Time Collection
   4. Interval Recording
   5. Task History Collection
   6. CICS File/Database Collection
   7. Resource Limiting...
   8. Monitoring Control
   9. VSAM Analysis
   10. Storage Violation Analysis
   11. Dump Analysis
   12. Application Trace Facility

   F1=Help  F12=Cancel

2. From the Collection Controls pop-up, select **Application Trace Facility** and press Enter.
   **Result:** The Application Trace Facility pop-up displays.

   [Application Trace Facility]
   Type any changes, then press Enter.

   Application  Write to  Write to
              Tracing      Data Store   SMF
              ---------    ---------    ---------
             Off +      Off +      Off +

   F1=Help  F4=Prompt  F5=Refresh  F12=Cancel
   F18=Default

3. On the Application Trace Facility popup, tab to the desired collection option (Application Tracing, Write to Data Store, or Write to SMF) and press F4 to toggle the option On or Off.

   **Note:** Any user can view the Application Trace Facility popup panel, but only authorized users can change the collection options.
If the **Write to Data Store** option is On, trace data is written to the historical datastore. You can activate application tracing without writing trace data to either the datastore or to SMF. If you do, the trace data that is collected is simply discarded once the task completes.

### CICS Shutdown Option

This option allows you to specify whether or not to purge waiting conversational tasks in CICS at CICS shutdown, or to prompt the MVS console operator so they can determine whether to terminate waiting conversational tasks. Figure 38 on page 106 shows the pop-up.

**FIGURE 38. CICS Shutdown Option Pop-up**

![CICS Shutdown Option Pop-up](image)

### Thresholds

Use this option to set performance measures (service level indicators such as CPU rate or response time) and the frequency of data collection for workloads, resources, and alerts. Each CICS component on the Region Status panel has one or more performance measures with warning and critical thresholds. When one of the thresholds has been reached, the status bar on the Region Status panel changes color. Moreover, on panels, many fields show highlighting depending on the status of thresholds set for the component.

This option also allows you to indicate how often OMEGAMON II collects data for the Region Status panel. Setting the frequency of data collection gives you control over resource usage. See “Thresholds” in the *OMEGAMON II for CICS User’s Guide* for procedures on setting thresholds.

Figure 39 on page 107 shows the thresholds pop-up for Tasks.
After changing any threshold values, you are prompted to save them for the duration of the current CUA interface session or to save them in the region profile.

**Response Time Groups**

This option allows you to access the Response Time Groups panel, which shows you all the groups currently defined. You can use the panel to change the attributes of existing groups or to create new groups.

Response time thresholds may be set for transaction, program, terminal, or LU elements belonging to one or more groups.

Response time and bottleneck data collection and interval recording collect data by groups. If the response time collection subtask has been activated, the groups you’ve defined or changed will display in the Response Times panel (only if there has been activity).

For more information, see “Defining Response Time Groups for Monitoring” in the *OMEGAMON II for CICS User’s Guide*.
Userid Profiles

This option shows you all the userid profiles currently defined. It allows you to manage your userid profiles by copying, printing, or deleting them, or by switching to another profile from the current profile. You can create new userid profiles, and delete all the profiles listed except the default profile. Figure 40 on page 108 shows the panel that displays through this option.

FIGURE 40. Userid Profiles Panel

Dynamic Profile Facility

The Dynamic Profile Update Facility provides a way for users to dynamically import and export individual Omegamon II for CICS profiles to and from a partitioned dataset by creating import and export dialogs that may be invoked externally through MVS.

Defining A Different User ID Profile

OMEGAMON II allows you to enter a userid profile when you log on. The userid profile contains the settings from the Preferences selection on the Options pull-down menu, and from two subcategories of the Controls selection on the Options pull-down, Screen Output Routing Options and Session Defaults.

If the default userid profile does not suit your needs, you can define a different userid profile. You can enter the profile in the OMEGAMON II Userid Profile field of the Logon Options pop-up when you log onto OMEGAMON II. You specify a name for the new userid profile in the Userid Profiles panel.

See “Userid Profiles” in the OMEGAMON II for CICS User’s Guide for a procedure on defining a different userid profile.
Region Profiles

This option displays all currently defined region profiles and enables you to switch to another profile from the current profile. You can also use this option to perform the following actions:

- **Copy**: Copies the attributes of the selected region profile to a new profile and allows you to rename it.
- **Delete**: Deletes the selected region profile.
- **Print**: Prints the selected region profile to the destination you specify in the Screen Print Output Routing Options panel.
- **Export**: Exports the selected region profile to the dataset you specify in the Export Region Profile pop-up.

The following options are available from the Actions pull-down menu:

- **Import a profile**: Imports an exported region profile from another OMEGAMON II region.
- **Migrate profiles**: Migrates all region profiles from another release of OMEGAMON II.

*Note: Before you migrate your profiles, the Table Database (TDB) must contain the region profiles of the previous release of OMEGAMON II. After you migrate your profiles, the TDB contains the region profiles converted to the required format of the current OMEGAMON II release.*

- **Close Print Log**: Closes the screen print dataset containing screens you have selected for printing using the F11 key. It also routes the screens to be printed.

Figure 41 on page 109 shows the Region Profiles panel.

**FIGURE 41. Region Profiles Panel**

![Region Profiles Panel](image-url)
Defining a Different CICS Region Profile

The region profile contains the threshold settings for all performance measures for a given CICS region. This profile is used by all userids that monitor a specific region.

If the default region profile does not suit your needs, you can define different region profile to enter in the CICS Region Profile field of the Logon Options pop-up when you log onto OMEGAMON II. You specify a name for the new region profile in the Region Profiles panel.

See “Region Profiles” in the OMEGAMON II for CICS User’s Guide for a procedure on defining another CICS region profile.
Help Pull-Down Menu

The OMEGAMON II help system is comprehensive and contains everything from a glossary of terms and tuning considerations to guides for immediate action. Use the system as a detailed reference and for help in solving problems.

One way to access the help system is through the Help pull-down menu. Simply move the cursor to the Help choice on the action bar or type H in the home position. Then press Enter. The Help pull-down menu displays, as shown in Figure 42 on page 111.

FIGURE 42. Help Pull-down Window

To display a help topic, move the cursor to the entry field of your selection, or type its number or mnemonic in the entry field. Then press Enter.

For an explanation of each selection on the Help pull-down, see “Action bar help” on page 44. Online help can also be accessed through panels and panel fields with the F1 key. See “Panel help” on page 45 and “Field help” on page 45 for details.
Help Pull-Down Menu
# Chapter Overview

This chapter describes the panels you can access through the CICS Tables selection on the GoTo pull-down menu of the Region Status panel.

## Chapter Contents

<table>
<thead>
<tr>
<th>Panel Name</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>115</td>
</tr>
<tr>
<td>AID (Automatic Initiators)</td>
<td>116</td>
</tr>
<tr>
<td>CSA (CICS Common System Area)</td>
<td>117</td>
</tr>
<tr>
<td>DCT (Destinations)</td>
<td>118</td>
</tr>
<tr>
<td>DCT Indirect Information panel</td>
<td>119</td>
</tr>
<tr>
<td>DCT Extrapartition Information panel</td>
<td>120</td>
</tr>
<tr>
<td>DCT Remote Information panel</td>
<td>121</td>
</tr>
<tr>
<td>DCT Intrapartition Information panel</td>
<td>122</td>
</tr>
<tr>
<td>DDIR (DL/I Database Directory)</td>
<td>123</td>
</tr>
<tr>
<td>DL/I (DL/I Control Blocks)</td>
<td>124</td>
</tr>
<tr>
<td>DUMP (Dumps)</td>
<td>125</td>
</tr>
<tr>
<td>ENQ (Enqueues)</td>
<td>126</td>
</tr>
<tr>
<td>EXITS (Exit Points and Programs)</td>
<td>127</td>
</tr>
<tr>
<td>Exit Program Blocks (EPBs) panel</td>
<td>127</td>
</tr>
<tr>
<td>FCT (Files)</td>
<td>129</td>
</tr>
<tr>
<td>File Control Table panel</td>
<td>129</td>
</tr>
<tr>
<td>File Control Table Entry (FCTE) panel</td>
<td>129</td>
</tr>
<tr>
<td>FCCTE pushbuttons</td>
<td>130</td>
</tr>
<tr>
<td>ICE (Interval Control Elements)</td>
<td>133</td>
</tr>
<tr>
<td>JOUR (Journals)</td>
<td>134</td>
</tr>
<tr>
<td>Journal Models panel (CICS/ESA 5.1)</td>
<td>134</td>
</tr>
<tr>
<td>Journal Control Table panel (Prior to CICS/ESA 5.1)</td>
<td>135</td>
</tr>
<tr>
<td>Journal Control Table Entry (Prior to CICS/ESA 5.1)</td>
<td>135</td>
</tr>
<tr>
<td>LSR (Local Shared Resources)</td>
<td>137</td>
</tr>
<tr>
<td>PDIR (DL/I PSB Directory)</td>
<td>138</td>
</tr>
<tr>
<td>PDIR panel</td>
<td>138</td>
</tr>
<tr>
<td>DL/I PSB Directory Entry (PDIR Entry) panel</td>
<td>139</td>
</tr>
<tr>
<td>PROG (Programs)</td>
<td>140</td>
</tr>
</tbody>
</table>
Programs panel ................................................. 140
Program Entry panel ........................................ 141
SIT (Initialization Table) .................................... 143
TCB (CICS TCBs) .............................................. 144
TCT (Terminals) ................................................. 145
  Terminal Control Table (TCT) panel ..................... 145
  TCTTE (TCT Terminal Entry) panel ....................... 146
  TCT System Entry panel .................................. 147
  Sequential TCTTE panel .................................. 149
TCTFX (Terminal Control Table Prefix) .................... 151
TCTSE (TCT System Entries) ................................ 152
TD (Transient Data) .......................................... 154
TRACE (Trace) for CICS/ESA ............................... 155
TRACE (Trace) for CICS/MVS ............................... 156
  Program Check/Abend Trace Table panel ............... 157
TRAN (Transactions) ......................................... 158
  Transactions panel ....................................... 158
  Transaction Entry panel ................................ 159
TS (Temporary Storage) ...................................... 161
TSQ (Temporary Storage Queues) ......................... 162
XRF (Extended Recovery Facility) ....................... 163
Overview

The tables listed on the panel below allow you to:

- confirm that CICS resources have been defined correctly
- display resource activity.

To select a table for viewing, enter S next to the table name.

The following figure shows the CICS Tables panel.

**FIGURE 43. CICS Tables Panel**

<table>
<thead>
<tr>
<th>AID</th>
<th>Automatic initiators</th>
<th>PDIR</th>
<th>DL/I PSB directory</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSA</td>
<td>CICS common system area</td>
<td>PROG</td>
<td>Programs</td>
</tr>
<tr>
<td>DCT</td>
<td>Destinations</td>
<td>SIT</td>
<td>System initialization table</td>
</tr>
<tr>
<td>DDIR</td>
<td>DL/I database directory</td>
<td>TCB</td>
<td>CICS TCBs</td>
</tr>
<tr>
<td>DL/I</td>
<td>DL/I control blocks</td>
<td>TCT</td>
<td>Terminals</td>
</tr>
<tr>
<td>DUMP</td>
<td>Dumps</td>
<td>TCTX</td>
<td>TCT prefix</td>
</tr>
<tr>
<td>ENQ</td>
<td>Enqueues</td>
<td>TCTX</td>
<td>TCT system entries</td>
</tr>
<tr>
<td>EXITS</td>
<td>Exit points and programs</td>
<td>TD</td>
<td>Transient data</td>
</tr>
<tr>
<td>FCT</td>
<td>Files</td>
<td>TRACE</td>
<td>Trace</td>
</tr>
<tr>
<td>ICE</td>
<td>Interval control elements</td>
<td>TRAN</td>
<td>Transactions</td>
</tr>
<tr>
<td>JOUR</td>
<td>Journal control table</td>
<td>TS</td>
<td>Temporary storage</td>
</tr>
<tr>
<td>LSR</td>
<td>Local shared resources</td>
<td>TSQ</td>
<td>Temporary storage queues</td>
</tr>
<tr>
<td>MCT</td>
<td>Monitor control table</td>
<td>XRF</td>
<td>Extended recovery facility</td>
</tr>
</tbody>
</table>

F1=Help  F2=Keys  F3=Exit  F5=Refresh  F6=Console  F10=Action Bar  F11=Print  F15=Region Status
AID (Automatic Initiators)

Select this field on CICS Tables to display the automatic initiate descriptors (AIDs) panel. AIDs are control blocks used by CICS to queue task initiation requests for tasks associated with unavailable terminals.

Enter S in the entry field to display a summary panel showing AIDs.

For more information on AIDs, see “Automatic Initiate Descriptors” on page 244.
CSA (CICS Common System Area)

Select this field on CICS Tables to see the CICS common system area (CSA). CSA is a control block that CICS uses to store values that pertain to the entire CICS region.

Enter S in the entry field to display the current contents of the CSA.

For more information on the CSA panel, see “CICS Loop (CICS Time-of-Day Clock)” on page 394.
DCT (Destinations)

Select this field on CICS Tables to see the Destination Control Table (DCT). DCT is a control block CICS uses to track transient data destinations.

Transient data provides a queuing facility enabling data to be stored for subsequent internal or offline processing. Queues are defined by the user in the DCT and can be intrapartition, extrapartition, indirect or remote.

Enter S in the entry field to display the current entries in the DCT.

The following figure shows the Destination Control Table panel.

FIGURE 44. Destination Control Table Panel

This panel displays summary information and statistics on all transient data destinations defined in your system.
To obtain detailed information on a specific entry, enter S next to an item in the Queue ID column and press Enter. Depending on the type of queue selected, one of the following four panels will display.

If this Queue Type Displayed  This Panel Appears
Indirect  DCT Indirect Information (see Figure 45 on page 120)
Extra  DCT Extrapartition Information (see Figure 46 on page 120)
Remote  DCT Remote Information (see Figure 47 on page 121)
Intra  DCT Intrapartition Information (see Figure 48 on page 122)

To free up space in the intrapartition dataset, authorized users can enter D next to an ID of an intrapartition queue and delete intrapartition transient data queues. Deleting unneeded queues from the intrapartition dataset makes space available in the dataset for other queues.

Authorized users can also delete remote and indirect queues if the physical queue that they are associated with are intrapartition queues.

A queue should be deleted when
- it is associated with an out-of-service device
- it was created in error
- the records in the queue contain an error as a result of a bug in the application that wrote the records

DCT Indirect Information panel

This panel provides information about an indirect transient data queue. An indirect destination provides a way of combining requests directed to multiple queues into a single real destination.

Use this panel to obtain additional information on the indirect queue.

If authorized, you can also use this panel to delete this queue if the base queue is of type intrapartition. If the base queue is not of type intrapartition, an error message will be returned. To delete this queue, select Delete Queue from the Actions pull-down menu. A confirmation pop-up displays after you press Enter so you can confirm the deletion.

Figure 45 on page 120 shows the DCT Indirect Information panel.
DCT (Destinations)

**FIGURE 45. DCT Indirect Information Panel**

This panel displays information about an extrapartition transient data queue and the associated dataset, as defined in the Destination Control Table (DCT).

Use this panel to see the name of the dataset used for this transient data queue and to see whether there have been any input/output errors with the dataset.

The following figure shows the Extrapartition Information panel.

**FIGURE 46. DCT Extrapartition Information Panel**
**DCT Remote Information panel**

This panel displays information about a remote transient data queue as defined in the Destination Control Table (DCT).

Use this panel to see where this remote destination is being routed, as shown in the Remote System Name and Remote Queue Name fields.

If authorized, you can also delete the queue displayed on this panel if the base queue is of type intrapartition. If the base queue is not of type intrapartition, an error message will be returned. To delete the queue, select Delete Queue from the Actions pull-down menu. A confirmation pop-up displays after you press Enter, so you can confirm the deletion.

The following figure shows the Remote Information panel.

**FIGURE 47. DCT Remote Information Panel**
DCT Intrapartition Information panel

This panel displays detailed information and statistics on a specific intrapartition destination. If the queue length exceeds the trigger level for a queue associated with a terminal, but ATI transactions are not being initiated at the specified facility, make sure that the terminal is defined as ATI capable. It must also be in service and, unless defined with CREATESESS, the terminal must already be in session with CICS.

Authorized users can delete the intrapartition transient data queue displayed on this panel by selecting Delete Queue from the Actions pull-down menu. After the user presses Enter, a confirmation pop-up displays, and the user can then confirm the deletion.

Figure 48 on page 122 shows the DCT Intrapartition Information panel.

FIGURE 48. DCT Intrapartition Information Panel
DDIR (DL/I Database Directory)

Select this field on CICS Tables to see the DL/I Database Directory panel, which lists the entries in the DL/I Database Directory (DDIR). Each entry in the DDIR is a DL/I data management block (DMB).

View this panel to see which DL/I databases have been defined for access from this system. Figure 49 on page 123 shows the DL/I Database Directory panel.

FIGURE 49. DL/I Database Directory Panel

---

<table>
<thead>
<tr>
<th>Database</th>
<th>Access</th>
<th>DMB</th>
<th>DMB</th>
<th>DMB</th>
<th>Active</th>
</tr>
</thead>
<tbody>
<tr>
<td>BE1CHKPT</td>
<td>Started</td>
<td>Exclusive</td>
<td>00000000</td>
<td>1</td>
<td>59</td>
</tr>
<tr>
<td>BE2LORDR</td>
<td>Stopped</td>
<td>Exclusive</td>
<td>00000000</td>
<td>2</td>
<td>0</td>
</tr>
<tr>
<td>BE2LPART</td>
<td>Stopped</td>
<td>Exclusive</td>
<td>00000000</td>
<td>3</td>
<td>0</td>
</tr>
<tr>
<td>BE2ORDER</td>
<td>Started</td>
<td>Exclusive</td>
<td>00000000</td>
<td>4</td>
<td>85</td>
</tr>
<tr>
<td>BE2ORDRX</td>
<td>Started</td>
<td>Exclusive</td>
<td>00000000</td>
<td>5</td>
<td>45</td>
</tr>
<tr>
<td>BE2PARTS</td>
<td>Started</td>
<td>Exclusive</td>
<td>00000000</td>
<td>6</td>
<td>101</td>
</tr>
<tr>
<td>BE2PCUST</td>
<td>Started</td>
<td>Exclusive</td>
<td>00000000</td>
<td>7</td>
<td>47</td>
</tr>
<tr>
<td>DI21PART</td>
<td>Started</td>
<td>Exclusive</td>
<td>00000000</td>
<td>8</td>
<td>112</td>
</tr>
</tbody>
</table>

---

F1=Help  F2=Keys  F3=Exit  F5=Refresh  F6=Console  F10=Action Bar  F11=Print  F15=Region Status
DL/I (DL/I Control Blocks)

Select this field on CICS Tables to see the DL/I control blocks, a collection of addresses of internal DL/I control blocks and routines.

Items covered include the addresses of the DL/I interface routines and the addresses of the following:

- DDIR (DL/I Database directory)
- PDIR (DL/I Program Specification Block directory)
- ISB (DL/I Interface Scheduling Block)

For more information on the DL/I control block panels, see “DL/I Interface Addresses panel” on page 316.
DUMP (Dumps)

Select this field on CICS Tables to see CICS dump activity statistics.

Items covered include the number of dumps taken, the status of dump suppression, and the name of the current dump data set.

See “Dumps” on page 396 for details on the DUMP tables.
ENQ (Enqueues)

Select this field on CICS Tables to see the current CICS enqueues and to examine enqueue bottlenecks in the CICS region.

Information is provided indicating the resources in use, the current owner of each resource, and the tasks waiting on each resource.

See “Enqueues” on page 397 for details on enqueues.
EXITS (Exit Points and Programs)

Select this field on CICS Tables to see a panel that lists all the global user exits (GLUEs) that are currently installed and that shows the name of the program associated with each exit.

The following figure shows the Global User Exits panel.

FIGURE 50. Global User Exits (GLUEs) Panel

Use this panel to determine the status of each exit.

Exit Program Blocks (EPBs) panel

Select the EPBs pushbutton on the Global User Exits panel to see the Exit Program Blocks (EPBs) panel, which lists all the exit program blocks in the CICS system.

You can use this panel to find out what exit programs are installed in CICS and the characteristics of each program.

Figure 51 on page 128 shows the Exit Program Blocks panel.
FIGURE 51. Exit Program Blocks (EPBs) Panel
**FCT (Files)**

Select this field on CICS Tables to see summary information for the entries in the File Control Table (FCT). The FCT panel displays.

**File Control Table panel**

The FCT panel lists all FCT entries defined in the system and gives an overview of the characteristics and use of each file.

Figure 52 on page 129 shows the File Control Table panel.

**FIGURE 52. File Control Table (FCT) Panel**

![File Control Table (FCT) Panel](image)

**File Control Table Entry (FCTE) panel**

This panel displays when you enter S in the File ID field on the File Control Table panel. The panel shows details about one file in the CICS system by displaying the contents of a File Control Table entry (FCTE).

The File Control Table Entry panel contains the general information coded in your FCT.

Use this panel to see if the file is correctly defined and see its current status.

Figure 53 on page 130 shows the File Control Table Entry panel.
FIGURE 53. File Control Table Entry (FCTE) Panel

The FCTE panel contains pushbuttons that navigate to other panels, as follows:

- File Details or VSAM Details
- File Control Table Entry – Statistics
- File Control Table Entry – Logging
- File Control Table Entry – Data Table

See the following sections for information on these panels.

File Details or VSAM Details
Select the Details pushbutton on the File Control Table Entry panel to see the File Details or VSAM Details panel. If the file is non-VSAM or is VSAM and not open, the File Details panels displays. If the file is an open VSAM file, the VSAM Details panel displays. For more information on the File Details and VSAM Details panels, see “File Details panel (prior to CICS/ESA 5.1.0)” on page 336 and “VSAM Details panel” on page 324.

File Control Table Entry – Statistics
Select the FCTE Statistics pushbutton on the File Control Table Entry panel to see a panel that shows usage statistics for a file in the CICS system.

This panel gives details about the activity for a file and can be useful in determining whether a file is waiting for buffers or for strings.

Figure 54 on page 131 shows the File Control Table Entry – Statistics panel.
FIGURE 54. File Control Table Entry – Statistics Panel

File Control Table Entry – Logging

Select the FCTE Logging pushbutton on the File Control Table Entry panel to see the File Control Table Entry – Logging panel. This panel shows whether the logging is being done for the specified file in the CICS system and, if so, what journal is being used for the log.

The following figure shows the File Control Table Entry – Logging panel.

FIGURE 55. File Control Table Entry – Logging Panel
**File Control Table Entry – Data Table**

Select the FCTE Data Table pushbutton on the File Control Table Entry panel to see the File Control Table Entry – Data Table panel. This panel shows details about the data table used for this file.

Use this panel to view the usage statistics for the data table.

The following figure shows the File Control Table Entry – Data Table panel.

---

**FIGURE 56. File Control Table Entry – Data Table Panel**

---

**File ID** . . . . . . . ABCD001_ + | **Access method** . . . . : VSAM  
---

**Data table status** . . . : Open | **Data table loaded** . . . : Yes  
**Data table recoverable**: No | **Entries (current)** . . : 126  
**Records have been lost**: No | **Entries in use (curr.)**: 1  
**Allowed in use (max)** : 1 | **Entries (maximum)** . . : 1024  
**Data table size** . . . : 10969 | **Entries (HWM)** . . . : 126  
**Successful reads** . . . : 200 | **Records loaded** . . . : 40  
**Failing reads** . . . . : 2 | **Records added** . . . . : 87  
**Successful deletes** . . : 1 | **Adds failed for full** . . : 0  
**Successful updates** . : 3 | **Adds/loads rejected** . : 0  
---

<Details> <FCTE> <FCTE Statistics> <FCTE Logging> (FCTE Data Table)

F1=Help  F2=Keys  F3=Exit  F4=Prompt  F5=Refresh  F6=Console  F10=Action Bar

F11=Print  F15=Region Status
ICE (Interval Control Elements)

Select this field on CICS Tables to see the interval control elements (ICEs), which control time-related processing requests in CICS.

Enter S next to this field to examine the ICEs in the CICS region. The Interval Control Elements panel displays. See “Interval Control Elements (ICEs)” on page 249 for more information on ICEs.
This section describes the JOUR selection on the CICS Tables panel for CICS/ESA 5.1 and earlier supported versions of CICS.

CICS/ESA 5.1 uses the MVS system logger, thereby making journal datasets (including DFHJ01x) of earlier CICS versions redundant. Instead, journal datasets are replaced by MVS system logger log streams. In CICS/ESA 5.1, the journal control table (JCT) is also redundant, and the journal entries in the JCT are replaced by journal model resource definitions in the CICS system definition (CSD) file.

### Journal Models panel (CICS/ESA 5.1)

To see the journal models defined in the CSD, select the JOUR field on the CICS Tables panel. The Journal Models panel then appears with information about installed journal models, as shown in the following figure.

![Journal Models Panel (CICS/ESA 5.1)](image)

A journal model resource definition provides the association between a CICS journal name and the associated physical log streams managed by the MVS system logger, or between the journal name and the SMF log. See the IBM CICS for MVS/ESA Resource Definition Guide for more information on defining journal models.

The Journal Models panel includes the journal model name, template name, journal type, and prototype log stream name. The panel has no selectable fields.

To sort the panel by journal model, journal name, journal type, and log stream name, select the View pull-down from the action bar and enter the action code for the items you want to sort.

For information on all the Journals panels for CICS/ESA 5.1, see “Journals” on page 330.
Journal Control Table panel (Prior to CICS/ESA 5.1)

If you are using a CICS version prior to 5.1, select the JOUR field on CICS Tables to see the JCT entries, which define journal processing in CICS. The Journal Control Table (JCT) panel appears.

Each entry in the JCT represents one journal used by CICS or by an application. View the Journal Control Table (JCT) panel to see which journals and their attributes are being used by the system. The following figure shows the Journal Control Table panel.

FIGURE 58. Journal Control Table Panel

<table>
<thead>
<tr>
<th>Action</th>
<th>GoTo</th>
<th>View</th>
<th>Index</th>
<th>Options</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Journal Control Table Entry (Prior to CICS/ESA 5.1)**

This panel displays when you select an item in the Journal ID column on the Journal Control Table panel. It displays the attributes of a single journal.

Each journal control table (JCT) entry represents one journal used by CICS or by an application.

This panel is useful in determining whether a journal is in use.

Figure 59 on page 136 shows the Journal Control Table Entry panel.
### FIGURE 59. Journal Control Table Entry Panel

<table>
<thead>
<tr>
<th>Actions</th>
<th>GoTo</th>
<th>Index</th>
<th>Options</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>_______</td>
<td>_____</td>
<td>_____</td>
<td>_______</td>
<td>_____</td>
</tr>
</tbody>
</table>

**KC2P32D**

**Journal Control Table Entry**

**Region: CICSPROD**

**Fastpath:** =CJE

**Auto(60)**

---

<table>
<thead>
<tr>
<th>Journal ID ......: 03 +</th>
<th>Journal status ......: Open</th>
<th>Journal type ......: Disk/2</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Data format ......: SMF</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Resource security level: n/a</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Crucial ......: Yes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Retry ......: Yes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Pause ......: No</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Logical record count ......: 0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Physical record count ......: 0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Average block size ......: 0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Buffer full count ......: 0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Buffer shift-up count ......: n/a</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Buffer shift-up count ......: n/a</td>
</tr>
</tbody>
</table>

---

<table>
<thead>
<tr>
<th>JCTE address ......: 00047940</th>
<th>Open option ......: Initial</th>
<th>Syswait option ......: As is</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owning CSSY TCA address: 00077EC0</td>
<td>Open option ......: Initial</td>
<td>Syswait option ......: As is</td>
</tr>
<tr>
<td>Owning CSSY task number: 24</td>
<td>Owning CSSY task number: 24</td>
<td></td>
</tr>
</tbody>
</table>

---

<table>
<thead>
<tr>
<th>Current extent DFHJ03A : TDCICS1.TOC.TDOCS22.DFHJ03A</th>
</tr>
</thead>
</table>

F1=Help  F2=Keys  F3=Exit  F4=Prompt  F5=Refresh  F6=Console  F10=Action Bar
F11=Print  F15=Region Status
LSR (Local Shared Resources)

Select this field on CICS Tables to see the local shared resources (LSR) pools, which VSAM uses to enhance the processing of data.

Enter S next to this field to examine statistics describing the current use of each LSR pool. The Local Shared Resources Pools panel displays. See “Local Shared Resources (LSR)” on page 338 for details on the panel.
**PDIR (DL/I PSB Directory)**

Select this field on CICS Tables to see the DL/I program specification block (PSB) directory (PDIR). The PDIR is a control block CICS uses internally to keep track of DL/I PSBs.

**PDIR panel**

The DL/I PSB Directory (PDIR) panel contains an entry for each PSB associated with the CICS region. PSBs define the use of DL/I databases by applications in the CICS region.

View this panel to see PSBs defined for access from this system.

Figure 60 on page 138 shows the DL/I PSB Directory panel.

---

**FIGURE 60. DL/I PSB Directory (PDIR) Panel**

<table>
<thead>
<tr>
<th>PSB</th>
<th>Schedule</th>
<th>Readonly</th>
<th>Schedule</th>
<th>PSB</th>
<th>PSB</th>
<th>Intent</th>
</tr>
</thead>
<tbody>
<tr>
<td>DFHSAM05</td>
<td>No</td>
<td>No</td>
<td>Batch T3</td>
<td>1328</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DFHSAM14</td>
<td>No</td>
<td>No</td>
<td>Batch T3</td>
<td>1472</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DFHSAM15</td>
<td>No</td>
<td>No</td>
<td>Batch T3</td>
<td>1472</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DFHSAM24</td>
<td>No</td>
<td>No</td>
<td>Batch T3</td>
<td>1408</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DFHSAM25</td>
<td>No</td>
<td>No</td>
<td>Batch T3</td>
<td>1408</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DFHSAM05</td>
<td>No</td>
<td>No</td>
<td>Batch T3</td>
<td>1648</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PC2CCNAM</td>
<td>No</td>
<td>No</td>
<td>Batch T3</td>
<td>2960</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PC2CPINV</td>
<td>No</td>
<td>No</td>
<td>Batch T3</td>
<td>1856</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PC2CPPUR</td>
<td>No</td>
<td>No</td>
<td>Batch T3</td>
<td>2672</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PE2CORDR</td>
<td>No</td>
<td>No</td>
<td>Batch T3</td>
<td>3968</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

F1=Help  F2=Keys  F3=Exit  F5=Refresh  F6=Console  F10=Action Bar  F11=Print  F15=Region Status
DL/I PSB Directory Entry (PDIR Entry) panel

This panel displays when you select an item in the PSB Name column of the DL/I PSB Directory panel. It shows the contents of a single DL/I program specification block (PSB).

You may overtype the name of the PSB displayed or press F4 for a list of PSBs in the system.

The following figure shows the DL/I PSB Directory Entry panel.

**FIGURE 61. DL/I PSB Directory Entry (PDIR Entry) Panel**

![DL/I PSB Directory Entry (PDIR Entry) Panel](image-url)
Select this field on CICS Tables to see the programs defined to CICS.

**Programs panel**

The Programs panel contains an entry for each program defined to CICS and information such as the program name, the program location, and the current use count of the program.

Enter **S** next to a field to display a specific entry. The following figure shows the Programs panel.

**FIGURE 62. Programs Panel**

This panel displays a summary of all programs that are defined to and managed by CICS program management.

Since the list displayed is generally extensive, you may find it helpful to use the filter and sort options available from the View pull-down menu to see exactly what you want.

Use this panel to tune your system to make optimum use of virtual storage. If the panel indicates that large programs are currently loaded but their Current Usage is zero and their Total Usage is low, determine if they have been unnecessarily defined as resident. If so,
change their definitions to be nonresident for more efficient use of the DSA or EDSA. Conversely, if the panel indicates that programs used frequently are being repeatedly loaded and deleted, as indicated by the Program Location column changing from a DSA to blank and vice versa, consider making these programs resident to reduce overhead and to use virtual storage more efficiently.

**Program Entry panel**

This panel displays when you select an item in the Program ID column of the Programs panel. In the panel, you can see detailed information obtained by describing a program managed by CICS program management. For programs that have been used, additional statistics and fields will be displayed.

Use this panel to review the definition of a program that is causing tasks to terminate abnormally. Make sure that the program has been loaded from the correct load library.

The following three figures show the Program Entry panels for CICS/MVS and CICS/ESA.

**FIGURE 63. Program Entry Panel (CICS/MVS)**
### FIGURE 64. Program Entry Panel (CICS/ESA)

<table>
<thead>
<tr>
<th>Program ID</th>
<th>DFHAKP</th>
<th>Entry address</th>
<th>08688AB0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Enabled</td>
<td>Definition type</td>
<td>Catalog</td>
</tr>
<tr>
<td>Defined language</td>
<td>Assembler</td>
<td>Program attribute</td>
<td>Reusable</td>
</tr>
<tr>
<td>Deduced language</td>
<td>Assembler</td>
<td>Current use count</td>
<td>0</td>
</tr>
<tr>
<td>Length</td>
<td>5928</td>
<td>Total use count</td>
<td>1</td>
</tr>
<tr>
<td>AMODE</td>
<td>31</td>
<td>Total load count</td>
<td>1</td>
</tr>
<tr>
<td>RMODE</td>
<td>24</td>
<td>Current copies</td>
<td>1</td>
</tr>
<tr>
<td>CEDF allowed</td>
<td>No</td>
<td>Load status</td>
<td>Loaded</td>
</tr>
<tr>
<td>Load point</td>
<td>0007C000</td>
<td>Entry point</td>
<td>8007C060</td>
</tr>
<tr>
<td>Loaded from</td>
<td>RPL</td>
<td>Program location</td>
<td>CDSA</td>
</tr>
<tr>
<td>Data location</td>
<td>Below</td>
<td>Exec key</td>
<td>CICS</td>
</tr>
<tr>
<td>Use count</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fetch count</td>
<td>0</td>
<td>Deletes by compression</td>
<td>0</td>
</tr>
<tr>
<td>Statistics last reset</td>
<td>23:59:59</td>
<td>Refreshes</td>
<td>0</td>
</tr>
<tr>
<td>RPL dataset</td>
<td>CICS.V410.SDFHLOAD</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### FIGURE 65. Remote Program Entry Panel (CICS/ESA 3.3 and above)

<table>
<thead>
<tr>
<th>Program ID</th>
<th>AREMOTE</th>
<th>Entry address</th>
<th>0867C3A8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Enabled</td>
<td>Definition type</td>
<td>Catalog</td>
</tr>
<tr>
<td>Defined language</td>
<td>NotDefin</td>
<td>Program attribute</td>
<td>Reusable</td>
</tr>
<tr>
<td>Deduced language</td>
<td>NotDeduc</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote system ID</td>
<td>RSYS</td>
<td>CEDF allowed</td>
<td>Yes</td>
</tr>
<tr>
<td>Remote program ID</td>
<td>BREMOTE</td>
<td>Data location</td>
<td>Below</td>
</tr>
<tr>
<td>Remote transaction ID</td>
<td>RENT</td>
<td>Exec key</td>
<td>USER</td>
</tr>
</tbody>
</table>

F1=Help F2=Keys F3=Exit F4=Prompt F5=Refresh F6=Console F10=Action Bar
F11=Print F15=Region Status
SIT (Initialization Table)

Select this field on CICS Tables to see the system initialization table (SIT). The SIT is a control block CICS uses to keep track of the options supplied to the CICS region at startup time.

Enter S next to this field to display the values contained in the SIT.

The following figure shows the System Initialization Table panel.

FIGURE 66. System Initialization Table (SIT) Panel

This panel displays the address and suffix of the SIT used by CICS at initialization time. An alphabetical list of most parameters is displayed showing keyword, description and value.

Use this panel as a convenient means of confirming your initialization parameters while you are diagnosing problems or performing tuning.

The information contained in the SIT can be grouped into three categories:

- information used to control the initialization process
- suffixes to load specific versions of CICS modules and tables
- information used to control CICS system functions

Most of the parameters in the SIT can be overridden in any of the following ways:

- in the PARM parameter of the EXEC PGM=DFHSIP statement
- in the SYSIN dataset defined in the startup job stream
- through the system operator’s console
TCB (CICS TCBs)

Select this field on CICS Tables to see the MVS task control blocks (TCBs) present in the CICS region.

Enter S next to this field to display the TCBs in the CICS region and the relationships among them. The CICS Address Space TCBs panel displays. See “CICS Address Space TCBs panel” on page 297 for information on this panel.
TCT (Terminals)

Select this field on CICS Tables to see the Terminal Control Table (TCT), which contains the attributes of terminals defined to the CICS region.

Terminal Control Table (TCT) panel

Each entry in the TCT represents one terminal connected with the CICS region.

The following figure shows the Terminal Control Table panel.

FIGURE 67. Terminal Control Table (TCT) Panel

This panel shows you what terminals are defined to CICS and several attributes of each terminal. You can use this panel to see whether terminals are correctly defined and to see the transactions that are associated with the terminals (in the Active Tran ID column).
TCT (Terminals)

TCTTE (TCT Terminal Entry) panel

This panel displays when the appropriate terminal type is displaying in the Terminal Type column next to the item you select in the Terminal ID column of the TCT panel.

The panel shows details about one TCT terminal entry. A terminal entry describes all the characteristics of one terminal defined to CICS.

You can use this panel to see if this terminal is defined correctly to CICS and to see if a transaction is associated with the terminal.

The following figure shows the Terminal Control Table Terminal Entry panel.

FIGURE 68. Terminal Control Table Terminal Entry (TCTTE) Panel
TCT System Entry panel

This panel displays when the appropriate terminal type is showing in the Terminal Type column next to the item you select on the TCT panel.

Figure 69 on page 147 shows the TCT System Entry panel.

FIGURE 69. TCT System Entry Panel

This panel displays summary information contained within a TCTSE describing a remote system with which the system being monitored can communicate.

If the % links in use remains at 100% for prolonged periods, while the waits for links are increasing, it is possible that the bottleneck is being caused by slow response from the remote system. This may be caused by isolated or system-wide problems in the remote region, such as bottlenecks for specific resources or an SOS condition. Use the Task summary panel to determine which tasks are monopolizing the links. Return to the Region Status panel and change the region name to that of the remote system to determine why tasks there are being suspended. See “Tasks Summary panel” on page 257 for information on Tasks.

If the Task summary shows that the links are servicing tasks as expected but you are still experiencing response time problems due to waits for links, try increasing the number of sessions between this and the remote region.

Select the TCTSE Statistics pushbutton for an analysis of the different requests made to the remote region. The TCTSE Statistics panel displays. See “TCT System Entry Statistics panel” on page 148 for information on this panel.
**TCT System Entry Statistics panel**

The TCT System Entry panel contains a pushbutton, TCTSE Statistics, which navigates to the TCT System Entry (TCTSE) Statistics panel. This panel shows the activity statistics for one TCT system entry.

A system entry describes all the characteristics of one communications connection defined to CICS.

Figure 70 on page 148 shows the TCTSE Statistics panel.

---

**FIGURE 70. TCTSE Statistics Panel**

---

```
____  Actions  GoTo  Index  Options  Help
------------------------------------------------------------ 06/16/93 16:51:03
KC2P47D                  TCT System Entry Statistics          Region: CICSPROD
Fastpath: =RMS                                                        Auto(60)
@-------------------------------------^--------------------------------------
|   System ID . . . . . . : CS40 + | _ TCTSE address . . . . : 0606E288 |
|   Terminal type . . . . : System |   Terminal model  . . . . : None     |
#-------------------------------------~--------------------------------------

System Statistics

<-------------------------------------^-------------------------------------->
|   Primary links . . . . : 10       | Secondary links . . . . : 10       |
|   Primary links in use  : 1         | Secondary links in use  : 0        |
| _ Number of AIDs queued : 0         |   DL/I request  . . . . : 0        |
|   Max allocs outstanding: 0         |   FC request  . . . . . : 0        |
|   Failed link allocates : 0         |   IC request  . . . . . : 0        |
|   Queued link allocates : 0         |   TD request  . . . . . : 0        |
|   Total link allocates  : 0         |   TS request  . . . . . : 0        |
#-------------------------------------~--------------------------------------

<TCTSE>  (TCTSE Statistics)
F1=Help  F2=Keys  F3=Exit  F4=Prompt  F5=Refresh  F6=Console  F10=Action Bar
F11=Print  F15=Region Status
```
Sequential TCTTE panel

This panel displays when the appropriate terminal type is displaying in the Terminal Type column next to the terminal ID you select on the TCT panel. It shows details about one TCT terminal entry for a sequential device.

A sequential terminal entry is used by CICS to simulate a terminal on a sequential device, such as a magnetic tape, DASD, card reader, or printer.

Figure 71 on page 149 shows the Sequential TCTTE panel.

FIGURE 71. Sequential TCTTE Panel

You can use this panel to see if this terminal is defined correctly to CICS and to see if a transaction is associated with the terminal.

TCTTE Statistics panel

The Sequential TCTTE and TCTTE panels both have a pushbutton for TCTTE Statistics. When you select the pushbutton, the TCTTE Statistics panel displays.

This panel shows the activity statistics for one TCT terminal entry. A terminal entry describes all the characteristics of one terminal defined to CICS.

You can use this panel to see the amount of activity for this terminal and whether the terminal is experiencing any errors.

Figure 72 on page 150 shows the TCTTE Statistics panel.
FIGURE 72. TCTTE Statistics Panel

```
___ Actions GoTo Index Options Help
------------------------------------------------------------ 06/16/93 16:54:44
KC2P42D  TCTTE Statistics  Region: CICSPROD
Fastpath: =CTS  Auto(60)
@-------------------------------------^--------------------------------------
| Terminal ID . . . . . M488 + | _ TCTTE address . . . : 087B1228 |
| Terminal type . . . : LU2 | Terminal model . . . : 2 |
#-------------------------------------~-------------------------------------

@-------------------------------------^-------------------------------------
| Number of inputs  . : 16 | Transmission errors  . : 0 |
| Number of outputs . : 25 | Transaction errors  . : 0 |
| Number of transactions: 13 | Storage violations  . : 0 |
#-------------------------------------~-------------------------------------

<TCTTE>  (TCTTE Statistics)
F1=Help  F2=Keys  F3=Exit  F4=Prompt  F5=Refresh  F6=Console  F10=Action Bar
F11=Print  F15=Region Status
```
TCTFX (Terminal Control Table Prefix)

Select this field on CICS Tables to see the Terminal Control Table Prefix (TCTFX), which contains general information about CICS terminal control and VTAM.

Enter S next to this field to see the panel.

Figure 73 on page 151 shows the Terminal Control Table Prefix panel.

FIGURE 73. Terminal Control Table Prefix (TCTFX) Panel

This panel shows information on the VTAM attributes of CICS terminal control, such as VTAM applid in use and VTAM ACB state, and information on the autoinstall of terminals.
TCTSE (TCT System Entries)

Select this field on CICS Tables to see the TCT entries that pertain to communication between systems. Information is included for interregion, intersystem, and LU6.x communications.

Enter S next to this field to see a panel displaying the attributes of the TCT system entries.

Figure 74 on page 152 shows the Terminal Control Table System Entries panel.

FIGURE 74. Terminal Control Table System Entries Panel

This panel displays a list of all remote systems to which this system has access. The status and type of each connection is displayed with statistics showing current and past availability.

The XLN Status column indicates whether an Exchange Logname Status exception has occurred or not. This exception is enabled or disabled by entering L before MRO/ISC on the Region Status panel, and indicates that an LU 6.2 connection between two CICS regions has failed.

If tasks are abended or otherwise unable to access the resources owned by a remote system, ensure that the system status is in service and, if ISC, acquired.

Poor response time will occur if tasks need to wait for a link to the remote system. If waits occur frequently or the number of links in use is 100%, this may be due to performance problems in the remote system leading to increased task lifetimes.
It may be that, for those systems to which 100% of links are in use, the remedy is to simply define additional links to increase the number of sessions between this and the remote system. However, before doing so, display the Task summary and look for tasks that are waiting on a resource type of IRLINK with a resource name of SYSIDNT. If these tasks remain suspended, it is possible that an associated task in the other region is not responding because the task there has been suspended. Identify the task in the remote region and determine the resource on which it is waiting. See “Tasks” on page 257 for information on Tasks.

In the case of distributed transaction processing (DTP) applications, poor program design may also lead to waits for links because links are not being freed when no longer required.
TD (Transient Data)

Select this field on CICS Tables to see transient data (TD) statistics, which include information such as TD VSAM control interval usage, buffer and string usage, and input/output counts.

Enter S next to this field to see the current values for transient data statistics. The Intrapartition Transient Data Statistics panel displays. See “Intrapartition Transient Data Statistics panel” on page 382 for information on this panel.
TRACE (Trace) for CICS/ESA

Select this field on CICS Tables to see trace definitions and statistics.

Enter S next to this field to see a panel displaying the current status of tracing in CICS and the levels of tracing for each CICS component.

The following figure shows the Trace Panel for CICS/ESA.

FIGURE 75. Trace Panel (CICS/ESA)

This panel gives you an overview of the current tracing options in effect. Of particular interest is whether auxiliary tracing is active since that can have an adverse impact on the performance of the CICS region.
**TRACE (Trace) for CICS/MVS**

If you are using CICS/MVS, the Trace panel gives you an overview of the current tracing and CICS Monitoring Facility (CMF) options in effect. Of particular interest is whether auxiliary tracing is active since that can have an adverse impact on the performance of the CICS region.

Figure 76 on page 156 shows the Trace Panel for CICS/MVS.

**FIGURE 76. Trace Panel (CICS/MVS)**

<table>
<thead>
<tr>
<th>Code</th>
<th>Component Name</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>KC</td>
<td>Task control</td>
<td>Yes</td>
</tr>
<tr>
<td>SC</td>
<td>Storage control</td>
<td>Yes</td>
</tr>
<tr>
<td>PC</td>
<td>Program control</td>
<td>Yes</td>
</tr>
<tr>
<td>IC</td>
<td>Interval control</td>
<td>Yes</td>
</tr>
</tbody>
</table>

---

**Trace Level Indicators**

<table>
<thead>
<tr>
<th>Code</th>
<th>Component Name</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>KC</td>
<td>Task control</td>
<td>Yes</td>
</tr>
<tr>
<td>SC</td>
<td>Storage control</td>
<td>Yes</td>
</tr>
<tr>
<td>PC</td>
<td>Program control</td>
<td>Yes</td>
</tr>
<tr>
<td>IC</td>
<td>Interval control</td>
<td>Yes</td>
</tr>
</tbody>
</table>

---

F1=Help  F2=Keys  F3=Exit  F5=Refresh  F6=Console  **=Bkwd  F8=Fwd
F10=Action Bar  F11=Print  F15=Region Status
Program Check/Abend Trace Table panel

The Program Check/Abend Trace Table displays when you select the PC/Abend Trace Address field on the Trace panel for CICS/MVS.

Figure 77 on page 157 shows the Program Check/Abend Trace Table panel.

FIGURE 77. Program Check/Abend Trace Table (PC/ATT)

The top portion of the panel shows the total number of program checks and abends that have occurred in the region since it last started. In the lower portion, up to six entries from the table are displayed, showing the most recent program checks and abends.

When multiple transactions abend within a short period of time, the PC/ATT is often useful in determining which program check or abend was the initial cause of a problem and which further abends or program checks were simply consequences of that initial problem.

You should note that the storage addressed by the register values shown in the PC/ATT may no longer apply to the transaction that abended. However, registers pointing to CICS management modules or resident application programs will still be valid and may assist in online diagnosis.
TRAN (Transactions)

Select this field on CICS Tables to see the definitions of transactions in the CICS region.

Transactions panel

The Transactions panel displays summary information and statistics on all transactions that have been defined in your system.

The list displayed is generally extensive, and you may find it helpful to use the filter and sort options available from the View pull-down menu to see exactly what you want. To obtain detailed information on a specific entry, position the cursor next to a Tran ID and press Enter.

Figure 78 on page 158 shows the Transactions panel.

FIGURE 78. Transactions Panel
Transaction Entry panel

This panel displays when you enter S next to an entry in the Tran ID column of the Transactions panel. Current statistics for the entry are displayed. The following figures show the panel for CICS/MVS and for CICS/ESA Versions 3 and 4.

FIGURE 79. Transaction Entry Panel (CICS/MVS)
Use this panel to confirm the definition of a transaction if you are experiencing incorrect output or abnormal task termination. Select the Program ID field to confirm that the correct program from the correct library is being executed. The Program Entry panel displays. See “Program Entry panel” on page 141 for information on this panel.

If the Storage Violations field is not zero, you may want to disable this transaction through CEMT until the cause can be determined.

If the Restart count is high, investigate the cause of the abnormal terminations by analyzing the transaction dumps.

When appropriate for the type of transaction, the Program ID field is replaced by the _Bridge Exit field.

### Transaction Entry for CICS/MVS

For CICS/MVS, a transaction can be defined with a stall purge indicator, SPURGE(YES), which permits CICS to terminate the transaction in the event the system stalls. A setting of SPURGE(NO) will be overridden by any DTIMOUT value and a transaction suspended due to an unavailable resource will be terminated with an AKCS abend.

### Transaction Entry for CICS/ESA

For CICS/ESA, the meaning of SPURGE has been changed to indicate whether or not the transaction is initially system purgeable. A setting of NO prevents the transaction from being purged by DTIMOUT, CEMT or via an EXEC CICS SET TASK PURGE command. For DTIMOUT to be effective, SPURGE must be set to YES. If the purge leads to an abend, the abend code will depend on which component of CICS suspended the task.
TS (Temporary Storage)

Select this field on CICS Tables to see the Temporary Storage Statistics panel, which displays general information about the current state of temporary storage.

See “Temporary Storage Statistics panel” on page 377 for more information on this panel.
Select this field on CICS Tables to see the Temporary Storage Queues panel, which lists all of the temporary storage queues that exist in this CICS system. For each queue, information such as the name of the queue, the location of the queue, and the number of items in the queue is shown.

Use this panel to see the queues that are in use and their size.

See “Temporary Storage Queues panel” on page 375 for more information on this panel.
XRF (Extended Recovery Facility)

Select this field on CICS Tables to see the extended recovery facility (XRF), which is a feature of CICS used to enhance CICS availability.

Enter S next to this field to see a panel that displays summary information related to XRF, which covers both the primary and alternate CICS regions. The XRF Information panel displays. See “XRF (Extended Recovery Facility)” on page 406 for information on this panel.
XRF (Extended Recovery Facility)
Chapter Overview

This chapter contains information on the Task History selection that appears on the GoTo pull-down menu of the Region Status panel.

OMEGAMON II collects performance and resource related statistics as each task completes. It uses either the CICS global user exit (GLUE) facility to collect these statistics for CICS/MVS or the CICS monitoring facility (CMF) to collect these statistics for CICS/ESA.

In order to minimize overhead for CICS/MVS, OMEGAMON II collects a subset of the data that would otherwise be collected by the CMF.

Chapter Contents

Task History Panel ................................................................. 166
Task History Details Panel .................................................... 168
   Task History Details pushbuttons ....................................... 169
   Task History Details selections ........................................... 181
Task History Panel

The following panel displays when you select Task History from the GoTo pull-down menu.

### FIGURE 81. Task History Panel

<table>
<thead>
<tr>
<th>Actions</th>
<th>GoTo</th>
<th>View</th>
<th>Index</th>
<th>Options</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>--------</td>
<td>------</td>
<td>------</td>
<td>-------</td>
<td>---------</td>
<td>------</td>
</tr>
</tbody>
</table>

KC2T01D Task History
Fastpath: =H
Auto(Off)

Search range . . 00/00/00 00:00:00 to 00/00/00 00:00:00
Display range . . 07/17/95 11:39:16 to 07/17/95 12:02:29

- -------------^------^--------^------^------^-------^---------^-------^-------
<table>
<thead>
<tr>
<th>Task End Time</th>
<th>Tran</th>
<th>Task Number</th>
<th>Term</th>
<th>CPU Time</th>
<th>Resp Time</th>
<th>Storage HWM</th>
<th>File I/O</th>
<th>Abend Code</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>11:39:16</td>
<td>OMEG</td>
<td>34</td>
<td>.3</td>
<td>2.6</td>
<td>0</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>11:59:17</td>
<td>CRSR</td>
<td>37</td>
<td>.0</td>
<td>1.0</td>
<td>0</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>12:02:26</td>
<td>CLS2</td>
<td>38</td>
<td>.0</td>
<td>0.4</td>
<td>0</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>12:02:26</td>
<td>CLS1</td>
<td>39</td>
<td>-ABP</td>
<td>0.1</td>
<td>0</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>12:02:26</td>
<td>CLS2</td>
<td>40</td>
<td>-ABO</td>
<td>0.1</td>
<td>0</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>12:02:29</td>
<td>CATA</td>
<td>41</td>
<td>n/a</td>
<td>0.0</td>
<td>0</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>12:02:29</td>
<td>CQRY</td>
<td>42</td>
<td>3831</td>
<td>0.0</td>
<td>0</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>
- -------------~------~--------~------~------~-------~---------~-------~-------

Notes:

1. The CPU Time field is not highlighted for excluded tasks. See the CPU_EXTENDED_TRANS parameter section in the OMEGAMON II for CICS Configuration and Customization Guide for information on excluding tasks.

2. If you navigate to this panel directly using GoTo, Index, or the fast path (=H), the Response Time column cannot be thresholded (no highlight will appear). If you navigate to the panel from the Response Time Details or the Response Time History Details panel, the Response Time column can be highlighted, because you have already selected a transaction ID or a terminal ID.

The Task History panel displays a task summary of task performance and resource utilization. Viewing the history of tasks is useful to detect those tasks that did not meet the service level objectives at your installation.

For example, if your service level objective is a response time of 3 seconds, you can select the list of tasks whose response time has exceeded 3 seconds. You do this by selecting the View pull-down from the action bar and specifying the selection criteria you want. If no tasks meet the selection criteria, the Task History panel will display showing no information.

Users of file-based data stores can sort the Task History panel with the most recent records displayed first (that is, in descending order of task start time). For more information on using...
the View pull-down with Task History, see the section on using the View pull-down menu in the OMEGAMON II for CICS User’s Guide.

You can also limit the selection to a specific date and time range by overtyping the search range fields at the top of the panel. To search the entire data store for eligible tasks, specify the following in the search range:

00/00/00 00:00:00 to 00/00/00 00:00:00

Enter the date as MM/DD/YY unless you specified a European date format in your profile. In that case enter the date as DD/MM/YY.

Enter the time as HH:MM:SS.

Enter 00/00/00 00:00:00 in the start date and time fields to search from the start of the data store.

Enter 00/00/00 00:00:00 in the end date and time fields to search to the end of the data store.

The year values 81 through 99 correspond to the 20th century; values 00 through 40 correspond to the 21st century.

To determine why a particular task has an unusually large response time, enter S next to the task and view detailed statistics for that task. The Task History Details panel then displays. See “Task History Details Panel” on page 168 for information on this panel.
Task History Details Panel

The Task History Details panel displays when you select a task in the Task End Time column of the Task History panel.

Figure 82 on page 168 shows the Task History Details panel.

**FIGURE 82. Task History Details Panel**

---

**Note:** The CPU Time field is not highlighted for excluded tasks. See the section on GLOBAL_OPTIONS parameters in the OMEGAMON II for CICS Configuration and Customization Guide for information on excluding tasks.

If the high-water mark (HWM) storage used is excessive, select the Storage pushbutton to see detailed usage of storage by this task. The Task History Storage panel displays. See “Task History Storage panel” on page 170 for information on this panel.

If the task has made file or database calls and task-level monitoring is enabled for that file or database, the number of requests and elapsed time will be shown. If the number of requests or elapsed time seems excessive, enter S next to the file type to display database statistics for that task.

If application trace records are available for this task, the Trace pushbutton is displayed. Select this pushbutton to get a summary of trace records.

To display other detailed statistics for this task, select the appropriate pushbutton. See “Task History Details pushbuttons” on page 169 for information on the panels accessible through the pushbuttons contained on this panel.
Task History Details pushbuttons

The Task History Details panel contains pushbuttons that navigate to the following panels:

- Task History Storage
- Task History Timings
- Task History Statistics
- Task History Umbrella Data
- Task History Terminal Statistics
- Task History FEPI

Notes:

1. The Timings and Statistics pushbuttons do not appear on the Task History Details panel for CICS/MVS.
3. The FEPI pushbutton appears on Task History Details only if you use the FEPI feature with CICS.

The following sections describe each panel.
Task History Storage panel

This panel displays when you select the Storage pushbutton on the Task History Details panel. It shows specific storage activity for a particular task. It includes storage explicitly requested by the task and implicitly requested by CICS service processing on behalf of the task.

Figure 83 on page 170 and Figure 84 on page 171 show the panels for CICS/ESA Versions 3 and 4.

FIGURE 83. Task History Storage Panel (CICS/ESA Version 3)
If the number of GETMAIN requests or the amount of HWM storage appears high, examine your application to determine any unnecessary use of storage. You can step through your application with CEDF to determine the amount of storage and the location in the application for each storage request.

On the panel, the HWM Total Program Storage field represents the total amount of storage allocated during the lifetime of the task. If you are using CICS Version 4, you can select this field to navigate to the Program Storage HWM History panel. See “Task History Program Storage panel” on page 172 for details on this panel.

To display other detailed statistics for this task, select the Details, Timings, Statistics, Umbrella, FEPI or Task Terminal pushbuttons.
This panel displays when you select the Program Storage HWM field on the Task History Storage panel for CICS Version 4 and above. The following figure shows the panel.

FIGURE 85. Task History Program Storage Panel

This panel displays the maximum amount of program storage used by the selected task in each of the DSAs, both above and below the 16 megabyte line.

Task History Timings panel

This panel displays when you select the Timings pushbutton on the Task History Details panel. The Task History Timings panel displays a cumulative breakdown of where the selected task spent time during its execution cycle. These timings are collected by the CICS Monitoring Facility and are described in either the IBM CICS/ESA Customization Guide or the CICS/ESA V5.3 Performance Guide.

The following figures show the panel for CICS/ESA Version 4 and above, as well as for CICS TS Version 1.3.
FIGURE 86. Task History Timings Panel (CICS Version 4 and above)

<table>
<thead>
<tr>
<th>Task number : 3</th>
<th>Transaction ID : CSSY</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU time : 0.411s</td>
<td>Total wait time : 17.052s (76%)</td>
</tr>
<tr>
<td>Task elapsed time : 22.400s</td>
<td>Dispatch time : 5.347s (23%)</td>
</tr>
<tr>
<td>Overall elapsed time : 0.000s</td>
<td>1st dispatch delay : 0.000s (23%)</td>
</tr>
</tbody>
</table>

Note: The CPU Time field is not highlighted for excluded tasks. Refer to the OMEGAMON II for CICS Configuration and Customization Guide for information on excluding tasks.

FIGURE 87. Task History Timings Panel (CICS TS Version 1.3)

<table>
<thead>
<tr>
<th>Task number : 62</th>
<th>Transaction ID : DB2T</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dispatch time : 0.321s</td>
<td>Suspend time : 7.418s</td>
</tr>
<tr>
<td>QR TCB elapsed time : 0.321s</td>
<td>1st dispatch delay : 0.000s</td>
</tr>
<tr>
<td>Other TCBs elapsed : 0.000s</td>
<td>Re-dispatch wait : 0.002s</td>
</tr>
<tr>
<td>CPU time : 0.002s</td>
<td>Total I/O : 0.000s</td>
</tr>
<tr>
<td>RLS CPU time : 0.000s</td>
<td>Total other wait times : 2.311s</td>
</tr>
<tr>
<td>RMI elapsed time : 2.312s</td>
<td>Uncaptured wait times : 5.102s</td>
</tr>
<tr>
<td>JVM elapsed time : 0.000s</td>
<td>Syncpoint elapsed time : 0.289s</td>
</tr>
<tr>
<td>JVM elapsed time : 0.000s</td>
<td>Exception wait time : 0.000s</td>
</tr>
</tbody>
</table>

Note: The CPU Time field is not highlighted for excluded tasks. Refer to the OMEGAMON II for CICS Configuration and Customization Guide for information on excluding tasks.
For the Task History Timings panel, the total amount of time a task is considered to be active is displayed as Dispatch time, while the total amount of waiting time for the task is displayed as Suspend time. The subsets that comprise either Dispatch time or Suspend time are displayed below each total.

For CICS TS Version 1.3, other timing fields such as RMI elapsed time, JVM elapsed time, Syncpoint elapsed time, and Exception wait time display the total time spent by CICS performing these specific types of processing on behalf of the task. Imbeded within each of these fields is a portion of the Dispatch and Suspend times as reported by the CICS Monitoring Facility.

To display other detailed statistics for this task, select the Details, Storage, Statistics, Umbrella, Task Terminal, or, if available, FEPI pushbuttons.

**Task History Detail Timings panel (CICS TS Version 1.3)**

The Task History Details panel displays when you choose a selectable field such as CPU Time or RMI elapsed time from the Task History Timings panel. The panel displays a cumulative breakdown of the amount of time spent by the task in the area you selected. For example, if CPU Time was selected, the panel displays the amount of CPU time spent during the task’s execution cycle. These timings are collected by the CICS Monitoring Facility and are described in the IBM CICS/ESA V5.3 Performance Guide.

The following figure shows the panel for CICS TS Version 1.3.

**FIGURE 88. Task History Detail Timings Panel (CICS TS Version 1.3)**

The first row of information in the lower box represents the total amount of time spent by the task in the area you selected from the Task History Timings panel. The subsequent rows are a subset of this total.
Task History Statistics panel

This panel displays when you select the Statistics pushbutton on the Task History Details panel. The Task History Statistics panel displays, showing the number of requests issued for CICS services such as program control, journal control, terminal control, BMS, temporary storage, and transient data. The following figures show the panel for CICS/ESA Version 3, Version 4, Version 5.1.0, and CICS TS version 1.3.

FIGURE 89. Task History Statistics Panel (CICS Version 3)
FIGURE 90. Task History Statistics Panel (CICS Version 4)

FIGURE 91. Task History Statistics Panel (CICS Version 5.1.0)
For CICS/MVS (CICS Version 3 above), this panel displays the number of requests issued for terminal control.

For CICS/ESA (CICS Version 4 and 5.1.0 above), this panel displays the number of requests issued for CICS services, such as program control, journal control, temporary storage, and transient data.

For CICS/ESA (CICS TS Version 1.3), this panel additionally displays the number of IMS/DBCTL requests, DB2 requests, distributed program link (DPL) requests, program link user replaceable modules (URMs) requests, and indicates whether non-3270 related statistics are available for the selected task.

Tasks that perform many temporary storage or transient data requests can incur long response times due to the potential for I/O activity.

To examine the temporary storage and transient data statistics, select the corresponding resource from the Region Status panel and view.

To display other detailed statistics for this task, select the Details, Timings, Storage, Umbrella, FEPI, or Task Terminal pushbuttons.
**Task History Umbrella Data panel**

This panel displays when you select the Umbrella pushbutton on the Task History Details panel. Figure 93 on page 178 shows the panel.

*Note:* The Umbrella pushbutton will be available and this panel accessible only if at least one of the three OMEGAMON II Umbrella fields contains data; that is, not low-values.

**FIGURE 93. Task History Umbrella Data Panel**

This panel contains three Umbrella fields that can be updated from within an application program.

Specifying an umbrella transaction or program ID can be useful in tracking the progress of long-running tasks that perform multiple functions or of tasks where many programs may be invoked through a single transaction ID, a situation found in many fourth-generation language packages.

The umbrella user data is a work area available for use by an application for reading and storing information. It is displayed in this panel in character and hexadecimal formats. For more information on using umbrella services, see the *OMEGAMON II for CICS Configuration and Customization Guide*.
Task History Terminal Statistics panel

The Task History Terminal Statistics panel displays when you select the Task Terminal pushbutton on the Task History Details panel. Figure 94 on page 179 shows the panel.

This panel applies to CICS Version 4 and above. In prior releases, terminal statistics are displayed on the Task History Statistics panel.

FIGURE 94. Task History Terminal Statistics Panel
Task History Details Panel

Task History FEPI panel
The Task History FEPI (Front End Programming Interface) panel displays when you select the FEPI pushbutton on the Task History Details panel. The FEPI pushbutton appears on Task History Details only if you use the FEPI feature with CICS. The following figure shows the panel.

FIGURE 95. Task History FEPI Panel

This panel displays the FEPI-related statistics collected for this task.
Task History Details selections

The panels described in the following sections display when you select the “requests” fields on the Task History Details panel.

Task History FCT panel

This panel displays when you select the FCT requests field on the Task History Details panel. The following figure shows the panel.

**FIGURE 96. Task History FCT Panel**

This panel displays the number of requests to CICS file control made by the displayed task. These numbers are collected by the CICS Monitoring Facility (CMF) in CICS/ESA.

These figures do not include any remote file requests issued by the task.

If this task has also accessed another type of database for which file statistics have been collected, a pushbutton for the database will be displayed.

You can select from the following pushbuttons on the Task History FCT panel:

- EXEC FILE
- DL/I
- DB2
- ADABAS
- IDMS
- DATACOM
- SUPRA
- USREVNT1

**Note:** These pushbuttons appear only when the corresponding data exists for the task being viewed.

The following sections describe each of the panels that display when you select these pushbuttons. The pushbuttons listed above appear on every panel to which you navigate using the pushbuttons.
**Task History EXEC FILE panel**

This panel displays when you select the EXEC FILE requests field on the Task History Details panel. The following figure shows the panel.

**FIGURE 97. Task History EXEC FILE Panel**

This panel displays the file activity carried out by the particular task. The upper portion of the panel shows counts and total elapsed times categorized by EXEC CICS FILE request. These counts include requests to VSAM datasets, data tables, and remote files. For example, EXEC CICS FILE requests are reported on an AOR for requests that are function shipped to another CICS region.

The bottom half of the panel contains a scrollable list of counts and elapsed times for each file. The maximum number of files that OMEGAMON II displays is controlled by parameters you specify in the global data area. For more information, refer to the *OMEGAMON II for CICS Configuration and Customization Guide*.

If the number of files used by this task exceeds the amount specified in the global data area, only the defined number of files appear. The total statistics on the top half of the panel reflects the total file usage, however. If this occurs, adjust the number of files you specify using the DATABASE_COLLECTION parameter in the global data area.

To display detailed file statistics for a particular file ID, enter **S** next to the File ID entry. The Task History FCT Details panel displays.

You can dynamically control the collection of EXEC CICS FILE statistics from the CICS File/Database Collection pop-up (fastpath OOF). To permanently change the collection options, use the DATABASE_COLLECTION parameter in the global data area module.
Note: VSAM file-level statistics are collected by OMEGAMON only when a file request invokes the EXEC interface program, DFHEIP. Detailed statistics will not be collected for a file, therefore, for any transaction that does not access the file through an EXEC CICS call. For example, detailed statistics for file DFHCSD are not available for transaction CEDA. EXEC CICS FILE requests are also not reported for mirror tasks or macro-level applications.

To display file statistics for another type of database, select the appropriate pushbutton to navigate to another panel.

Task History DL/I panel

This panel displays when you select the DL/I requests field on the Task History Details panel. The following figure shows the panel.

FIGURE 98. Task History DL/I Panel

The panel shows the DL/I activity carried out by the particular task. The top half of the panel contains counts and total elapsed times by DL/I command.

The bottom half of the panel contains a scrollable list of counts and elapsed times for each DBD and PSB. Usage by PSB name includes schedule and terminate requests as well as all requests serviced by DBCTL. Usage by DBD name includes all other local and remote DL/I requests.
The maximum number of DBD/PSB IDs that OMEGAMON II displays is controlled by parameters you specify in the global data area. For more information, refer to the OMEGAMON II for CICS Configuration and Customization Guide.

If the number of IDs used by this task exceeds the amount specified in the global data area, only the defined number of IDs appears. The total statistics on the top half of the panel reflects the total DL/I usage, however. If this occurs, adjust the number of files you specify using the DATABASE_COLLECTION parameter in the global data area.

To display detailed file statistics for a particular database, enter $S$ next to the DBD/PSB ID entry. The DL/I Task History PSB/DB Details panel then displays.

To display file statistics for another type of database, select the appropriate pushbutton.

**Task History DB2 panel**

This panel displays when you select the DB2 requests field on the Task History Details panel. The following figure shows the panel.

**FIGURE 99. Task History DB2 Panel**

The panel shows the DB2 activity carried out by the particular task, and it contains counts and total elapsed times by SQL command.

To display file statistics for another type of database, select the appropriate pushbutton.

This panel does not contain any selectable fields.
Task History ADABAS panel

This panel displays when you select the ADABAS requests field on the Task History Details panel. It shows the ADABAS activity carried out by the particular task.

The following figure shows the panel.

**FIGURE 100. Task History ADABAS Panel**

<table>
<thead>
<tr>
<th>File Number</th>
<th>Requests</th>
<th>Average</th>
<th>Total</th>
<th>%Response</th>
<th>0..........100</th>
</tr>
</thead>
<tbody>
<tr>
<td>_ 00009-077-OP</td>
<td>1</td>
<td>0.000s</td>
<td>0.000s</td>
<td>0%</td>
<td>&gt;</td>
</tr>
<tr>
<td>_ 00009-077-S8</td>
<td>2</td>
<td>0.000s</td>
<td>0.000s</td>
<td>0%</td>
<td>&gt;</td>
</tr>
<tr>
<td>_ 00009-077-S1</td>
<td>3</td>
<td>0.000s</td>
<td>0.000s</td>
<td>0%</td>
<td>&gt;</td>
</tr>
<tr>
<td>_ 00009-077-A1</td>
<td>4</td>
<td>0.000s</td>
<td>0.000s</td>
<td>0%</td>
<td>&gt;</td>
</tr>
<tr>
<td>_ 00009-077-C1</td>
<td>5</td>
<td>0.000s</td>
<td>0.000s</td>
<td>0%</td>
<td>&gt;</td>
</tr>
<tr>
<td>_ 00009-077-BT</td>
<td>6</td>
<td>0.000s</td>
<td>0.000s</td>
<td>0%</td>
<td>&gt;</td>
</tr>
<tr>
<td>_ 00090-009-ET</td>
<td>7</td>
<td>0.000s</td>
<td>0.000s</td>
<td>0%</td>
<td>&gt;</td>
</tr>
</tbody>
</table>

The top half of the panel contains counts and total elapsed times by ADABAS command.

The bottom half of the panel contains a scrollable list of counts and elapsed times for each ADABAS file. The filename consists of the Database ID and the 3-digit file number.

The maximum number of files that OMEGAMON II displays is controlled by parameters you specify in the global data area. For more information, refer to the OMEGAMON II for CICS Configuration and Customization Guide.

If the number of files used by this task exceeds the amount specified in the global data area, only the defined number of files appear. The total statistics on the top half of the panel reflects the total file usage, however. If this occurs, adjust the number of files you specify using the DATABASE_COLLECTION parameter in the global data area.

To display detailed file statistics for a particular file, enter **S** next to the File Number entry. The Task History ADABAS Details panel then displays.

To display ADABAS summary information, select the ADABAS Summary pushbutton.
Task History Details Panel

Task History IDMS panel

This panel displays when you select the IDMS requests field on the Task History Details panel. The panel shows the IDMS activity carried out by the particular task.

The following figure shows the panel.

FIGURE 101. Task History IDMS Panel

The top half of the panel contains counts and total elapsed times by IDMS command.

The bottom half of the panel contains a scrollable list of counts and elapsed times for each IDMS file. The filename can be the record, area, or set name.

The maximum number of files that OMEGAMON II displays is controlled by parameters you specify in the global data area. For more information, refer to the OMEGAMON II for CICS Configuration and Customization Guide.

If the number of files used by this task exceeds the amount specified in the global data area, only the defined number of files appear. The total statistics on the top half of the panel reflects the total file usage, however. If this occurs, adjust the number of files you specify using the DATABASE_COLLECTION parameter in the global data area.

To display detailed file statistics for a particular file, enter S next to the Dataname entry. The Task History IDMS Details panel then displays.

To display file statistics for another type of database, select the appropriate pushbutton.
Task History DATACOM panel

This panel displays when you select the DATACOM requests field on the Task History Details panel. The Task History DATACOM panel displays, showing the DATACOM activity carried out by the particular task.

The following figure shows the panel.

FIGURE 102. Task History DATACOM Panel

The top half of the panel contains counts and total elapsed times by DATACOM command.

The bottom half of the panel contains a scrollable list of counts and elapsed times for each DATACOM file. The filename consists of the Database ID and the table ID. The Database ID is determined by searching the URT for an entry containing the table ID. If no entry is found, the Database ID contains blanks.

The maximum number of files that OMEGAMON II displays is controlled by parameters you specify in the global data area. For more information, refer to the OMEGAMON II for CICS Configuration and Customization Guide.

If the number of files used by this task exceeds the amount specified in the global data area, only the defined number of files appear. The total statistics on the top half of the panel reflects the total file usage, however. If this occurs, adjust the number of files you specify using the DATABASE_COLLECTION parameter in the global data area.

To display detailed file statistics for a particular file, enter S next to the URT/Table ID entry. The Task History DATACOM Details panel then displays.

To display file statistics for another type of database, select the appropriate pushbutton.
Task History Details Panel

Task History SUPRA panel

This panel displays when you select the SUPRA requests field on the Task History Details panel. The Task History SUPRA panel displays, showing the SUPRA activity carried out by the particular task.

The following figure shows the panel.

FIGURE 103. Task History SUPRA Panel

The top half of the panel contains counts and total elapsed times by SUPRA command.

The bottom half of the panel contains a scrollable list of counts and elapsed times for each SUPRA file.

The maximum number of files that OMEGAMON II displays is controlled by parameters you specify in the global data area. For more information, refer to the OMEGAMON II for CICS Configuration and Customization Guide.

If the number of files used by this task exceeds the amount specified in the global data area, only the defined number of files appear. The total statistics on the top half of the panel reflect the total file usage, however. If this occurs, adjust the number of files you specify using the DATABASE_COLLECTION parameter in the global data area.

To display detailed file statistics for a particular file, enter S next to the File ID. The Task History SUPRA Details panel displays.

To display file statistics for another type of database, select the appropriate pushbutton.
Task History USREVNT1 panel

This panel displays when you select the USREVNT1 requests field on the Task History Details panel. The following figure shows the panel.

**FIGURE 104. Task History USREVNT1 Panel**

The panel shows the User Event activity carried out by the particular task. The actual user event name displayed on this panel is defined via the USREVNT1 parameter within the global data area. For more information, refer to the *OMEGAMON II for CICS Configuration and Customization Guide*.

The top half of the panel contains counts and total elapsed times by user event requests. The bottom half of the panel contains a scrollable list of counts and elapsed times for each resource.

To display a summary of counts and elapsed times per function type for this task, press the USREVNT1 pushbutton at the bottom of the screen.

To display detailed file statistics for a particular resource that was accessed during user event processing, enter S next to the appropriate Resource entry. The Task History USREVNT1 Details panel then displays.
Chapter Overview

This chapter contains information on the application trace facility.

Chapter Contents

Displaying Application Trace Summary Data ........................................... 192
  Introduction ......................................................................................... 192
  Requirements ..................................................................................... 192
  Displaying the Application Trace panel ................................................. 193

Application Trace Panel Description ......................................................... 195
  Introduction ......................................................................................... 195
  Tailoring the sequence of trace entries ................................................. 195
  View Some panel description ............................................................... 196
  Locating a specific trace entry ............................................................... 197

Displaying Detailed Trace Data ................................................................. 198
  Introduction ......................................................................................... 198
  Application Trace Entry panel for TSKSTRT ........................................ 198
  Application Trace Entry panel for EXECIN .......................................... 199
  Application Trace Entry panel for EXECOUT ........................................ 200
  Application Trace Entry panel for RMIIN ............................................ 201
  Application Trace Entry panel for UMBSERV ...................................... 202
  Application Trace Entry panel for RMIOUT .......................................... 203
  Application Trace Entry panel for PCABEND ....................................... 204
  Application Trace Entry panel for TPPSIN .......................................... 205
  Application Trace Entry panel for TPPSOUT ....................................... 205
Displaying Application Trace Summary Data

Introduction
When the application trace facility is active, a trace record is produced at each of the following points for each program that executes in the region:

- Task start.
- Entry to an EXEC CICS command.
- Completion of an EXEC CICS command.
- Entry to an RMI call.
- Completion of an RMI call.
- Completion of an OMEGAMON umbrella service request.
- Transaction abend.
- Entry to third party product support.
- Exit from third party product support.

These trace entries are displayed on the Application Trace panel.

Requirements
To use the application trace facility, you must perform the customization for the OMEGBSC section as follows:

- Customize your MCT for the OMEGBSC entry
- Customize your GLOBAL_OPTIONSnn parameter USER_EVENT_MONITORING by specifying basic=cccccccc where cccccccc is the OMEGBSC entry name.
- Define a User-Event Monitoring Point for the basic section.

Refer to the Configuration and Customization Guide for more information.
Displaying the Application Trace panel

Perform the steps on the following page to display the Application Trace panel:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 1    | From the Region Status panel, select **Task History** from the GoTo pulldown, or enter the `=H` fastpath from any panel.  
**Result:** The Task History panel displays: |
|      | ![Task History Panel](image) |
| 2    | On the Task History panel, you can enter the search range for the time period you want to search. You can also use the View pulldown to tailor the display. Once you have done this, proceed to step 3. |
| 3    | From the Task History panel, you can display the Task History Details panel for a selected transaction or bypass the Task History Details panel and go directly to the Application Trace panel. Go to step 5 if you want to bypass the Task History Details panel.  
From the Task History panel, you can display the Task History Details panel by placing the cursor in the action entry field preceding the Task End Time for a transaction and pressing Enter.  
**Result:** The Task History Details panel is displayed: |
|      | ![Task History Details Panel](image) |
4 On the Task History Details panel, select the Trace pushbutton to display the Application Trace panel.

**Result:** The Application Trace panel appears:

<table>
<thead>
<tr>
<th>Trace</th>
<th>Program</th>
<th>Offset</th>
<th>Function</th>
<th>Resource</th>
<th>Response</th>
<th>Elapsed Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>TSTSTR</td>
<td>TSTTEST2</td>
<td>78</td>
<td>ADDRESS</td>
<td>F0000000</td>
<td>NORMAL</td>
<td>0.000063</td>
</tr>
<tr>
<td>EXECUT</td>
<td>TSTTEST2</td>
<td>78</td>
<td>ADDRESS</td>
<td>24000</td>
<td>NORMAL</td>
<td>0.000037</td>
</tr>
<tr>
<td>EXECIN</td>
<td>TSTTEST2</td>
<td>60</td>
<td>GETMAIN</td>
<td>143008</td>
<td>NORMAL</td>
<td>0.045881</td>
</tr>
<tr>
<td>RM1IN</td>
<td>TSTTEST2</td>
<td>60</td>
<td>GETMAIN</td>
<td>KOCOME00</td>
<td>0.000034</td>
<td></td>
</tr>
<tr>
<td>RM1OUT</td>
<td>TSTTEST2</td>
<td>60</td>
<td>RESOURCE MANAGER</td>
<td>KOCOME00</td>
<td>0.000062</td>
<td></td>
</tr>
<tr>
<td>PCABEND</td>
<td>TSTTEST2</td>
<td>60</td>
<td>RESOURCE MANAGER</td>
<td>KOCOME00</td>
<td>0.000034</td>
<td></td>
</tr>
<tr>
<td>EXECIN</td>
<td>DFHPEP</td>
<td>7A</td>
<td>ADDRESS</td>
<td>0BA89C8</td>
<td>NORMAL</td>
<td>0.000057</td>
</tr>
<tr>
<td>EXECUT</td>
<td>DFHPEP</td>
<td>7A</td>
<td>ADDRESS</td>
<td>0BA89C8</td>
<td>NORMAL</td>
<td>0.000057</td>
</tr>
<tr>
<td>EXECIN</td>
<td>DFHPEP</td>
<td>64</td>
<td>RETURN</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

5 From the Task History panel, you can go directly to the Application Trace panel by typing action code T (for Trace) in the action entry field preceding the Task End Time for the transaction and pressing Enter.

The Application Trace panel is described in “Application Trace Panel Description” on page 195.
Application Trace Panel Description

Introduction

You can perform the following actions on the Application Trace panel:

- Specify a string to locate a specific trace record.
- Locate the trace record with the longest elapsed time.
- Access a detailed Application Trace Entry panel for a selected trace record.
- Sort the display in ascending or descending chronological order.

Tailoring the sequence of trace entries

Use the following procedure to specify how the trace entries are displayed on the Application Trace panel:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 1    | Select the View pulldown on the Application Trace panel.  
  **Result:** The View pulldown is displayed.  
  1. All   
  2. Some...  
  1. Sort by trace time  
  Sort order  
  1. Ascending  
  2. Descending  
  F1=Help  F12=Cancel |
| 2    | Select from the following display options:  
  **All** View all the trace entries collected (the default).  
  **Some...** Display the View Some panel, on which you can specify filtering criteria. The View Some panel is described in “View Some panel description” on page 196.  
  **Sort Order** Specify 1 to display trace entries in ascending (earliest-to-latest) sequence (the default). Specify 2 to display trace entries in descending (latest-to-earliest) sequence. |
# View Some panel description

Use the following procedure to access the View Some panel to specify filtering criteria for the trace events displayed on the Application Trace panel:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 1    | From the View pulldown, select **View Some** and press Enter.  
*Result:* The View Some panel displays. |

![View Some panel](image)

<table>
<thead>
<tr>
<th>Field</th>
<th>Operator</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trace type</td>
<td>EQ</td>
<td>*_______+</td>
</tr>
<tr>
<td>Program ID</td>
<td>EQ</td>
<td>*_______</td>
</tr>
<tr>
<td>Function</td>
<td>EQ</td>
<td>*___</td>
</tr>
<tr>
<td>Resource</td>
<td>EQ</td>
<td>*_______</td>
</tr>
<tr>
<td>Response</td>
<td>EQ</td>
<td>*_______</td>
</tr>
<tr>
<td>Elapsed time</td>
<td>EQ</td>
<td>*<em>:</em>:_.             ______</td>
</tr>
<tr>
<td></td>
<td></td>
<td>_ : _ : _ . ______</td>
</tr>
<tr>
<td></td>
<td></td>
<td>hh : mm : ss . tttttt</td>
</tr>
</tbody>
</table>

F1=Help  F4=Prompt  F5=Refresh  F12=Cancel

| 2    | On the View Some panel, type your changes and press Enter. You can perform the following actions to specify your changes:  
- Type the appropriate operator and value for one or more fields to complete a filtering selection expression.  
- Place the cursor on an operator in the Operator column and press F4 to select among a list of valid operators. You can select EQ (the default), NE, GT, LT, GE, or LE.  
- Specify the appropriate value for the selected field. You can place the cursor in the Value field for Trace type and press F4 to select among a list of valid trace type values. |
**Locating a specific trace entry**

You can use the Locate pulldown on the Application Trace panel to:

- Locate the first occurrence of a specific string value in the collected records.
- Display the trace record with the next occurrence of the specified string.
- Locate the trace record showing the longest elapsed time.

Use the following procedure to locate a specific trace entry:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 1    | Select the Locate pulldown from the action bar.  
**Result:** The Locate pulldown menu is displayed:  
  - 1. Locate first...  
  - 2. Locate next  
  - 3. Locate highest elapsed time  
  F1=Help  F12=Cancel |
| 2    | Select one of the following options:  
- Locate first...  
  **Result:** The Locate String popup panel is displayed. Type in the string value and press Enter: |
Displaying Detailed Trace Data

Introduction

You can display a detailed data panel for any trace record listed on the Application Trace panel. To do so, place the cursor in the action entry field preceding the Trace Type and press Enter. In response, an Application Trace Entry panel is displayed. The data on the Application Trace Entry panel differs for each trace type as follows:

<table>
<thead>
<tr>
<th>If the Trace Type is...</th>
<th>See the following section for a sample Application Trace Entry panel...</th>
</tr>
</thead>
<tbody>
<tr>
<td>TSKSTRT</td>
<td>“Application Trace Entry panel for TSKSTRT”</td>
</tr>
<tr>
<td>EXECIN</td>
<td>“Application Trace Entry panel for EXECIN” on page 199</td>
</tr>
<tr>
<td>EXECOUT</td>
<td>“Application Trace Entry panel for EXECOUT” on page 200</td>
</tr>
<tr>
<td>RMIIN</td>
<td>“Application Trace Entry panel for TSKSTRT” on page 198</td>
</tr>
<tr>
<td>RMIOUT</td>
<td>“Application Trace Entry panel for RMIOUT” on page 203</td>
</tr>
<tr>
<td>UMBSERV</td>
<td>“Application Trace Entry panel for UMBSERV” on page 202</td>
</tr>
<tr>
<td>PCABEND</td>
<td>“Application Trace Entry panel for PCABEND” on page 204</td>
</tr>
<tr>
<td>TPSIN</td>
<td>“Application Trace Entry panel for TPSIN” on page 205</td>
</tr>
<tr>
<td>TPSOUT</td>
<td>“Application Trace Entry panel for TPSOUT” on page 205</td>
</tr>
</tbody>
</table>

Application Trace Entry panel for TSKSTRT

The data on this panel is collected at task start.

Note: To display the Program Entry panel for the program identified in the Program field, place the cursor in the action entry field preceding the field and press Enter. The Program Entry panel contains information taken from the Processing Program Table (PPT).
Displaying Detailed Trace Data

Application Trace Entry panel for EXECIN

The data on this panel is collected on entry to an EXEC CICS command.

---

<table>
<thead>
<tr>
<th>Task number . . : nnnn</th>
<th>Transaction ID : ABCD</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time . . . . : 09:38:43.332820</td>
<td>Function code : 0202</td>
</tr>
<tr>
<td>Trace type . . : EXECIN</td>
<td>Command . . . : ADDRESS</td>
</tr>
<tr>
<td>Program . . . : TSTTEST2</td>
<td>Resource . . : COMMAREA</td>
</tr>
<tr>
<td>Offset . . . : 78</td>
<td>Elapsed time . : 00:00:00.09136</td>
</tr>
</tbody>
</table>

Notes:

1. To display the Program Entry panel for the program identified in the **Program** field, place the cursor in the action entry field preceding the field and press Enter. The Program Entry panel contains information taken from the Processing Program Table (PPT).

2. To display the contents of CICS memory beginning with the address shown in the **Offset** field, place the cursor in the action entry field preceding the field and press Enter.

3. To display the contents of the EXEC Interface Block (EIB), select the EIB pushbutton and press Enter.
Displaying Detailed Trace Data

Application Trace Entry panel for EXECOUT

The data on this panel is collected on completion of an EXEC CICS command.

Notes:

1. To display the Program Entry panel for the program identified in the Program field, place the cursor in the action entry field preceding the field and press Enter. The Program Entry panel contains information taken from the Processing Program Table (PPT).

2. To display the contents of memory beginning with the displayed offset, place the cursor in the action entry field preceding the Offset field and press Enter.

3. To display the contents of CICS memory at the address shown in the Address field, place the cursor in the action entry field preceding the field and press Enter.

4. To display the contents of the EXEC Interface Block (EIB), select the EIB pushbutton.
Application Trace Entry panel for RMIIN

The data on this panel is collected at the point of entry to a call to RMI services.

**Notes:**

1. To display the Program Entry panel for the program identified in the **Program** field, place the cursor in the action entry field preceding the field and press Enter. The Program Entry panel contains information taken from the Processing Program Table (PPT).

2. To display the contents of CICS memory beginning with the address shown in the **Offset** field, place the cursor in the action entry field preceding the field and press Enter.
Displaying Detailed Trace Data

**Application Trace Entry panel for UMBSERV**

The data on this panel is collected at the completion of a call to OMEGAMON umbrella transaction services.

<table>
<thead>
<tr>
<th>Task number . . : nnnn</th>
<th>Transaction ID : ABCD</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time . . . . : 09:38:43.378913</td>
<td>Request type . : 5</td>
</tr>
<tr>
<td>Trace type . . : UMBSERV</td>
<td>Command . . . : PUT UMBRELLA TRN</td>
</tr>
<tr>
<td>Program . . . . : TSTTEST2</td>
<td>Resource . . . : 0 (NORMAL)</td>
</tr>
<tr>
<td>Offset . . . . : EA</td>
<td></td>
</tr>
<tr>
<td>Elapsed time . : 00:00:00.000062</td>
<td></td>
</tr>
<tr>
<td>Umbrella data . : ABCD</td>
<td></td>
</tr>
</tbody>
</table>

**Notes:**

1. To display the Program Entry panel for the program identified in the **Program** field, place the cursor in the action entry field preceding the field and press Enter. The Program Entry panel contains information taken from the Processing Program Table (PPT).

2. To display the contents of CICS memory beginning with the address shown in the **Offset** field, place the cursor in the action entry field preceding the field and press Enter.
Application Trace Entry panel for RMIOUT

The data on this panel is collected on return from a call to RMI services.

```
<table>
<thead>
<tr>
<th>Task number . . : nnnn</th>
<th>Transaction ID : ABCD</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time . . . . : 09:38:43.378947</td>
<td>Function code : 0082</td>
</tr>
<tr>
<td>Trace type . . : RMIOUT</td>
<td>Command . . . : RESOURCE MANAGER</td>
</tr>
<tr>
<td>Program . . . : TSTTEST2</td>
<td>Resource . . . : KOCOME00</td>
</tr>
<tr>
<td>Offset . . . . : EA</td>
<td>Response . . . : 00000000</td>
</tr>
<tr>
<td>Elapsed time . : 00:00:00.000034</td>
<td></td>
</tr>
</tbody>
</table>
```

**Notes:**

1. To display the Program Entry panel for the program identified in the **Program** field, place the cursor in the action entry field preceding the field and press Enter. The Program Entry panel contains information taken from the Processing Program Table (PPT).

2. To display the contents of CICS memory beginning with the address shown in the **Offset** field, place the cursor in the action entry field preceding the field and press Enter.
Displaying Detailed Trace Data

Application Trace Entry panel for PCABEND

The data for this panel is collected at the point of task abend.

<table>
<thead>
<tr>
<th>Task number . . : nnnn</th>
<th>Transaction ID : ABCD</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time . . . . : 09:38:44.502986</td>
<td>Abend code . . : ASRA</td>
</tr>
<tr>
<td>Trace type . . : PCABEND</td>
<td>PSW . . . . : 078D0000 001410F2</td>
</tr>
<tr>
<td>Program . . . . : TSTTEST2</td>
<td>Interrupt . . : 00020001</td>
</tr>
<tr>
<td>Elapsed time . : 00:00:01.124039</td>
<td></td>
</tr>
</tbody>
</table>

Registers on Entry to Abend

| R0  : 00000000 | R1  : 0013B68C | R2  : 89BE524C | R3  : 00141028 |
| R4  : 0005E360 | R5  : 00000005 | R6  : 0008D100 | R7  : 000086D0 |
| R8  : 08C0A850 | R9  : 00143008 | R10 : 08C0A850 | R11 : 0013B0C4 |

Notes:

1. To display the Program Entry panel for the program identified in the Program field, place the cursor in the action entry field preceding the field and press Enter. The Program Entry panel contains information taken from the Processing Program Table (PPT).

2. To display the contents of memory beginning with the displayed Program Status Word (PSW), place the cursor in the action entry field preceding the PSW field and press Enter.

3. To display the contents of a register, place the cursor in the action entry field preceding the register and press Enter.

4. To display the contents of the Execute Interface Block (EIB), select the EIB pushbutton.
### Application Trace Entry panel for TPPSIN

The data for this panel is collected at the point of entry to third party support.

<table>
<thead>
<tr>
<th>Task number</th>
<th>Transaction ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>56</td>
<td>HST1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Time</th>
<th>Product</th>
</tr>
</thead>
<tbody>
<tr>
<td>09:44:39.475195</td>
<td>ADABAS</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Trace type</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>TPPSIN</td>
<td>SEARCH</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Elapsed time</th>
<th>Database</th>
</tr>
</thead>
<tbody>
<tr>
<td>00:00:00.015764</td>
<td>050-100</td>
</tr>
</tbody>
</table>

### Application Trace Entry panel for TPPSOUT

The data for this panel is collected at the point of exit from third party support.

<table>
<thead>
<tr>
<th>Task number</th>
<th>Transaction ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>56</td>
<td>HST1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Time</th>
<th>Product</th>
</tr>
</thead>
<tbody>
<tr>
<td>09:44:42.145176</td>
<td>ADABAS</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Trace type</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>TPPSOUT</td>
<td>SEARCH</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Elapsed time</th>
<th>Database</th>
</tr>
</thead>
<tbody>
<tr>
<td>00:00:00.018157</td>
<td>050-100</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Return code</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>X'00000000'</td>
<td></td>
</tr>
</tbody>
</table>

F1=Help  F2=Keys  F3=Exit  F5=Refresh  F6=Console  F7=Bkwd  F8=Fwd  F10=Action  Bar  F11=Print  F15=Region Status  PA1=Switch
Displaying Detailed Trace Data
Chapter Overview

CICS Memory displays storage in the CICS address space. It is useful for looking at the unformatted contents of virtual storage in the address space. Areas not formatted by other panels can be examined here. You can also scan virtual storage or chase control block chains looking for specific strings.

This chapter contains information on the CICS Memory selection that appears on the GoTo pull-down menu of the Region Status panel.

Chapter Contents

CICS Memory Panel Overview ................................................................. 208
Available action codes ................................................................. 210
List memory outside of pointers ....................................................... 210
Change the offset value ................................................................. 210
Using the CICS Memory Action Codes ............................................. 211
   Indirect addressing ................................................................. 211
   Scan Memory pop-up ............................................................... 213
   Chase Chain pop-up ............................................................... 214
   Zap Memory pop-up ............................................................... 216
   Address Symbol Definition pop-up ............................................ 217
Using the Tools Pull-down ............................................................... 218
   Number Conversion pop-up ....................................................... 219
   Character Conversion pop-up ..................................................... 220
   Hexadecimal Calculation pop-up ............................................... 221
   Machine Instructions pop-up ..................................................... 222
   Branch After Compare pop-up .................................................... 223
   Branch After Arithmetic pop-up ............................................... 224
   Branch After Test Under Mask pop-up ....................................... 225
Using CICS Memory Pushbuttons .................................................. 226
   OMEGAMON II for CICS Memory panel .................................... 226
   CICS Master Terminal panel ..................................................... 227
   CICS Dataspaces panel ............................................................. 229
   OMEGAMON II for CICS Dataspaces panel ................................. 231
CICS Memory Panel Overview

Virtual storage is usually arranged logically with control blocks, data areas, and tables. Much of what you may want to view can be obtained from pointers contained within other control blocks.

The CICS Memory panels were constructed to assist you in traversing from one area to another. Several methods are available for your use, as follows:

**Address manipulation**
You can specify the storage to be displayed by navigating from a known location using displacements, indirections, or a combination of these. Each address that you specify will be made of an anchor value (a symbol or address) and a series of manipulations performed from that anchor. The final result of all of this manipulation is the generation of a target address.

**Target address**
The target address is the virtual storage location at which processing is to begin.

**Available processes**
Once you have generated a target address, you will determine what process is to be performed. You can display contiguous storage at the target address (default display), scan for a string match beginning at the target address, or search a control block chain starting at the target address.

All the virtual storage displays, scans, or chain searches in CICS memory begin at a specific starting point. This starting point is specified by selecting an anchor address or symbol and directing a series of manipulations that will develop the required starting point. OMEGAMON II generates the starting point by using the anchor, indirection codes, and displacements.

Figure 105 on page 209 shows the CICS Memory panel.
If you specify an offset not ending in X'0', the display will scroll to the closest lower offset ending in X'0'.

Available action codes

For each field in the Contents section of the panel, you can enter action codes to select the desired processing. Each code will cause the appropriate pop-up window to display when additional data is required.

<table>
<thead>
<tr>
<th>To Perform the Following:</th>
<th>Use this Action Code:</th>
</tr>
</thead>
<tbody>
<tr>
<td>List Memory Using Pointers</td>
<td>Indirection (I or ? or %)</td>
</tr>
<tr>
<td></td>
<td>The Indirect Addressing pop-up window displays if I is specified. If ? or % are specified, you display to the specified address. See “Indirect addressing” on page 211 for information on this pop-up.</td>
</tr>
<tr>
<td>Scan Memory for a String</td>
<td>Scan (N)</td>
</tr>
<tr>
<td></td>
<td>The Scan Memory pop-up window displays. See “Scan Memory pop-up” on page 213 for information on this pop-up.</td>
</tr>
<tr>
<td>Chase a Control Block Chain</td>
<td>Chain (C)</td>
</tr>
<tr>
<td></td>
<td>The Chase Chain pop-up window displays. See “Chase Chain pop-up” on page 214 for information on this pop-up.</td>
</tr>
<tr>
<td>Change Memory</td>
<td>ZAP (Z)</td>
</tr>
<tr>
<td></td>
<td>The Zap Memory pop-up window displays. See “Zap Memory pop-up” on page 216 for information on this pop-up.</td>
</tr>
<tr>
<td>Assign a Symbolic Name</td>
<td>Address Symbol (Y)</td>
</tr>
<tr>
<td></td>
<td>The Address Symbol Definition pop-up window displays. See “Address Symbol Definition pop-up” on page 217 for information about this pop-up.</td>
</tr>
</tbody>
</table>

List memory outside of pointers

In addition to entering action codes in the Contents section, you can also list memory outside of the pointers listed in the CICS Memory panel by typing a new address or symbol next to the field “Type address (or symbol) to display”. The new address may be a combination of address, displacement, and indirection symbols.

Change the offset value

An additional method of changing the display is to change the offset value to bring a particular offset to the top of the scroll area. To do this, enter the desired offset in the entry field next to the word “Offset” in the “Offset xxxx to yyyy of 800” line on the CICS Memory panel. This field displays the range of offsets from the target address currently displayed in the scroll area and the total number of bytes that can be viewed.

If you specify an offset not ending in X’0’, the display will scroll to the closest lower offset ending in X’0’.
Using the CICS Memory Action Codes

This section describes the processing you can perform by selecting from the seven action codes that appear across the top (and on the Actions pull-down menu) of the CICS Memory panel.

Indirect addressing

The term indirect addressing refers to using the contents of the currently addressed fullword of storage as a pointer.

When you enter I next to a field in the Contents section of the CICS Memory panel, OMEGAMON II displays a pop-up that allows you to add additional parameters to generate an address. This pop-up initially assumes 31-bit addressing.

Figure 106 on page 211 shows the pop-up (to fast path here, type =MI).

FIGURE 106. Indirect Addressing Pop-up Window

This pop-up allows you to extend an address selection in order to calculate a new target address.

On the Indirect Addressing pop-up, the I you entered next to a field in the Contents section of the CICS Memory panel will be replaced with a question mark.

You can type additional information in the Address field, which contains the target address specification. You may modify the address by adding additional indirection codes and offsets as required to generate a virtual address.

Indirection codes you may use are as follows:
- “?” is used as an action code and as a modifier on the Address line to indicate 31-bit indirection.
- “%” is used as an action code and as a modifier on the Address line to indicate 24-bit indirection.

You need to use the “%” sign instead of the “?” mark when the pointers are 24-bit addresses rather than 31-bit addresses.

The indirections are placed behind the address of the pointer.

You may use as many levels of indirection as you can fit in the input field.

An indirect address has the form aaaaaaaa?, where aaaaaaaa is the storage address of the pointer (indicated by the question mark) to the place in memory you want to have displayed. For example, to display the memory pointed to by the pointer in 00110168, type 110168?.

You can specify displacements from an address. For example, instead of finding the pointer at X’110168’ and displaying that area, you can indicate the pointer X’40’ bytes from X’110168’ by typing 110168+40?.

An anchor address may be either a hexadecimal address (110168) or a symbol (CSA). When a symbol is used, it must be followed by an offset, even if that offset is zero.
Scan Memory pop-up

The Scan Memory pop-up window displays when you enter **N** next to a field in the Contents section of CICS Memory. The pop-up requests additional information required to complete a scan operation.

The storage scan code performs a string search within a block of storage beginning at the target address.

The system performs a case-sensitive storage compare from the target address for the number of bytes requested. When a complete match is found and the compare string is completely within the bounds of the requested number of bytes, the scan stops with a storage display. The display begins at the point of string match and is not word aligned.

The following figure shows the pop-up (to fast path here, type **=MN**).

**FIGURE 107. Scan Memory Pop-up Window**
To scan memory, starting at the target address, you must:

1. Type the string in hexadecimal or character format.
2. Indicate, in hexadecimal, the number of bytes of memory to be scanned. The default, if you do not enter a value, is X'800' (2048) bytes of storage.

**Note:** Character string comparisons are case sensitive.

The following fields are defined for this pop-up.

- **Character String**: This field is for entering the search string in character format. You may enter a character string containing up to 16 characters of upper and lowercase information.
- **Hexadecimal String**: This field is for entering the search string in hexadecimal format. You may enter up to 32 digits of information.
- **Hexadecimal Length to Scan**: The amount of storage, starting at the Address field, to scan for the Hexadecimal string.
- **Address**: The target address specification. String scanning will begin here.

**Chase Chain pop-up**

When you enter C next to a field in the Contents section of CICS Memory, the Chase Chain pop-up window displays. You can use this action code when you want to search for a specific value within a control block that is a member of similarly chained blocks.

The following figure shows the pop-up (to fast path here, type =MC).

**FIGURE 108. Chase Chain Pop-up Window**

---

To scan memory, starting at the target address, you must:

1. Type the string in hexadecimal or character format.
2. Indicate, in hexadecimal, the number of bytes of memory to be scanned. The default, if you do not enter a value, is X'800' (2048) bytes of storage.

**Note:** Character string comparisons are case sensitive.
Use this pop-up to supply required information for chasing control block chains. You must provide the following three missing elements to complete the scan:

- Either a character or hexadecimal string that will be matched to a value in the control block. The character string is case sensitive.
- The displacement from the start of the control block to the string (positive or negative).
- The displacement to the chain pointer.

The following fields are defined for this pop-up.

- **Character String**: This field is for entering the search string in character format. You may enter a character string containing up to 16 characters of upper and lowercase information.
- **Hexadecimal String**: This field is for entering the search string in hexadecimal format. You may enter up to 32 digits of information.
- **Hexadecimal Offset to String**: You must provide the displacement (positive or negative) from the beginning of the control block to the location of the string.
- **Hexadecimal Offset to Chain Pointer**: You must provide the displacement (positive or negative) from the beginning of the control block to the pointer to the next element on the chain.
- **Address**: The address of the starting control block. The scan starts here and continues until either a match or a zero chain pointer is found.
Zap Memory pop-up

You can change the contents of virtual storage in the CICS or OMEGAMON II for CICS address space by entering the Z action code next to a field in the Contents section of CICS Memory. The Zap Memory pop-up window displays. In the pop-up, the Address field shows the location of the storage to be modified by this command.

Caution:
Modifying virtual storage may violate the integrity of CICS or of OMEGAMON II.

Figure 109 on page 216 shows the pop-up window that displays (to fast path here, type =MZ).

FIGURE 109. Zap Memory Pop-up Window

To change the contents of storage, replace the information next to the New String field with new values, then press Enter. Use either hexadecimal or character format for the new string you enter.
Address Symbol Definition pop-up

When you enter Y next to a field in the Contents section of CICS Memory, the Address Symbol Definition pop-up window displays. This pop-up allows you to assign a name or symbol to an address. The value of the symbolic address is the target address after all manipulations are performed on the anchor value.

Symbolic address assignments are useful when you are searching storage and need to reference specific addresses repeatedly. They allow you to develop quick access to storage that you want to display.

Figure 110 on page 217 shows the pop-up (to fast path here, type =MY).

FIGURE 110. Address Symbol Definition Pop-up Window

To define the symbol:

1. Type a 1–8 character name next to the address displayed in the first line (the address of the field you selected in the CICS Memory panel).

2. In the rest of the address input field, you can specify indirection and displacements.
   Indirection and displacements are used to arrive at the resulting address every time the symbol is used.

Once you have redefined the symbols, you can use them in the CICS Memory or the OMEGAMON II for CICS Memory panels.

Note: A set of predefined symbols is provided by OMEGAMON II. They are displayed in the pop-up along with any symbols you have defined. You cannot delete the predefined symbols generated by OMEGAMON II. You can, however, delete user-defined symbols from the internal tables by entering D next to the ones you want to delete.
Using the Tools Pull-down

The tools can help you when you are looking at memory lists, converting values from decimal to hexadecimal and vice versa, or decoding machine instructions.

The following figure shows the Tools pull-down menu, which is available only on the memory-related panels of OMEGAMON II.

**FIGURE 111. CICS Memory Displaying the Tools Pull-down**

On the Tools pull-down, type the number or character of the function you want and then press Enter. A pop-up screen is displayed, where applicable, for you to type in additional data.

The tools available on the pull-down are as follows:

- **Number Conversion**
  - Converts hexadecimal numbers to decimal and vice versa.

- **Character Conversion**
  - Converts characters to their hex equivalents.

- **Hexadecimal Calculator**
  - Lets you apply basic arithmetic to two hexadecimal integers.

- **Machine Instructions**
  - Converts hex pockets to mnemonics and vice versa.

- **Branch after Compare**
  - Shows extended mnemonics for branch instructions.

- **Branch after Arithmetic**
  - Shows extended mnemonics for branch instructions.

- **Branch after Test Under Mask**
  - Shows extended mnemonics for branch instructions.

The following sections describe each tool in detail.
Number Conversion pop-up

When you select Number Conversions from the Tools pull-down, the Number Conversions pop-up window displays.

The following figure shows the pop-up.

**FIGURE 112. Number Conversion Pop-up Window**

This pop-up performs number conversion from decimal to hexadecimal or vice versa.

Enter either a decimal or a hexadecimal number and the equivalent representation is displayed after you press Enter.

A maximum of 8 hexadecimal digits are allowed. The value is a signed number, right aligned, and padded with zeros.

The Number Conversion pop-up contains the following fields.

**Decimal Number**

The decimal number you want to convert or the result of converting the hexadecimal number.

**Hexadecimal Number**

The hexadecimal number you want to convert or the result of converting the decimal number. The field is a signed number, right aligned to 8 digits, and padded with zeros.
Character Conversion pop-up

When you select Character Conversion from the Tools pull-down the Character Conversion pop-up window displays.

The following figure shows the pop-up.

FIGURE 113. Character Conversion Pop-up Window

```
This pop-up allows you to convert a character string to its hexadecimal equivalent or vice versa.

Type a character string and press Enter. The string will be displayed in its hexadecimal representation.

If you type a hexadecimal string, it is displayed in its character representation.

The following fields are defined for this pop-up.

Character String
The character string to be converted or the results of hexadecimal string conversion.

The maximum number of characters is 8.

Hexadecimal String
The hexadecimal string to be converted or the results of character string conversion.

The maximum number of hexadecimal digits is 16.
```
Hexadecimal Calculation pop-up

When you select Hexadecimal Calculation from the Tools pull-down the Hexadecimal Calculation pop-up window displays.

The following figure shows the pop-up.

FIGURE 114. Hexadecimal Calculation Pop-up Window

This pop-up provides a two-number hexadecimal calculator. The numbers are assumed to be signed.

You may type two hexadecimal numbers and the operation to be performed on them. Use the symbols described below for each operation.

<table>
<thead>
<tr>
<th>IF you want to . . .</th>
<th>THEN use . . .</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add operand 1 to operand 2</td>
<td>+</td>
</tr>
<tr>
<td>Subtract operand 2 from operand 1</td>
<td>-</td>
</tr>
<tr>
<td>Multiply operand 1 and operand 2</td>
<td>*</td>
</tr>
<tr>
<td>Divide operand 1 by operand 2</td>
<td>/</td>
</tr>
</tbody>
</table>
The following fields are defined for this pop-up.

**Operand 1**
The first parameter of the hexadecimal arithmetic. The maximum number of hexadecimal digits is 8.

**Operator**
The arithmetic operator.

**Operand 2**
The second parameter of the hexadecimal arithmetic. The maximum number of hexadecimal digits is 8.

### Machine Instructions pop-up

When you select Machine Instructions from the Tools pull-down, the Machine Instructions pop-up window displays.

The following figure shows the pop-up.

**FIGURE 115. Machine Instructions Pop-up Window**

This pop-up decodes a hexadecimal number into the mnemonic for the machine instruction or vice versa.

Type either a two-character hexadecimal number or a mnemonic for a machine instruction and press Enter. The converted value will be displayed.

The following fields are defined for this pop-up.

**Operation code**
The two-digit hexadecimal operation code.

**Mnemonic**
The mnemonic operation code.
Using the Tools Pull-down

Branch After Compare pop-up

When you select Branch After Compare from the Tools pull-down, the Branch After Compare pop-up window displays.

The following figure shows the pop-up.

FIGURE 116. Branch After Compare Pop-up Window

This pop-up contains a list of the extended branch mnemonics for use after a compare instruction.

The extended mnemonics for the RX and RR format branch instructions are displayed first, followed by their name, and next by their mnemonic representation, including the mask. The hexadecimal equivalents are shown in parentheses.

This pop-up is for viewing only.
Branch After Arithmetic pop-up

When you select Branch After Arithmetic from the Tools pull-down, the Branch After Arithmetic pop-up window displays.

The following figure shows the pop-up.

FIGURE 117. Branch After Arithmetic Pop-up Window

This pop-up contains a list of the extended branch mnemonics for use after an arithmetic instruction.

The extended mnemonics for the RX and RR format branch instructions are displayed first, followed by their name, and next by their mnemonic representation, including the mask. The hexadecimal equivalents are shown in parentheses.

This pop-up is for viewing only.
Branch After Test Under Mask pop-up

When you select Branch After Test Under Mask from the Tools pull-down, the Branch After Test Under Mask pop-up window displays.

The following figure shows the pop-up.

**FIGURE 118. Branch After Test Under Mask Pop-up Window**

This pop-up contains a list of the extended branch mnemonics for use after a test under mask (TM) instruction.

The extended mnemonics for the RX and RR format branch instructions are displayed first, followed by their name, and next by their mnemonic representation, including the mask. The hexadecimal equivalents are shown in parentheses.

This pop-up is for viewing only.
Using CICS Memory Pushbuttons

The CICS Memory panel contains pushbuttons that you can select to navigate to the following panels:

- OMEGAMON II for CICS Memory
- CICS Master Terminal
- CICS Dataspace
- OMEGAMON II for CICS Dataspaces

All the pushbuttons that appear on CICS Memory also appear on all the panels to which you navigate using the pushbuttons.

The following sections describe the panels.

OMEGAMON II for CICS Memory panel

The OMEGAMON II for CICS Memory panel displays when you select the OCII Memory pushbutton on CICS Memory or on any other panel where the pushbutton appears. It displays storage in the OMEGAMON II for CICS address space.

The following figure shows the panel.

FIGURE 119. OMEGAMON II for CICS Memory Panel

You can use this panel in exactly the same way you would use the CICS Memory panel. Its action codes and fields are the same as those contained on that panel. See “CICS Memory Panel Overview” on page 208 for details on using this panel.
### CICS Master Terminal panel

The CICS Master Terminal panel displays when you select the CEMT pushbutton on CICS Memory or on any other panel where the pushbutton appears.

The CICS Master Terminal panel shows selected values that can be changed using the CEMT command provided with CICS. These are global dispatcher values affecting all CICS operations.

The interval values determine how quickly CICS responds to processing situations. The maximum task values are used to limit the concurrent activity of applications (for CICS Version 3 only). All of these displayed values are used to help resolve CICS stalls.

The following figures show the panel for CICS/ESA Version 3 and CICS/ESA Version 4.

**FIGURE 120. CICS Master Terminal Panel (CICS/ESA Version 3)**

![CICS Master Terminal Panel (CICS/ESA Version 3)](image)
The panel displays a subset of the CEMT values. These CEMT values control how tasks are handled within the CICS dispatching mechanism. Changing the values will affect the entire operation of CICS.

You can overtype the value displayed and press Enter to make the change.

The limits for each of the values in this panel appear in the following table.

### Table 4. CEMT Value Limits

<table>
<thead>
<tr>
<th>Field Name</th>
<th>CICS/MVS 2.1.2</th>
<th>CICS/ESA 3.2.1 and 3.3</th>
<th>CICS/ESA 4.1</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum active tasks</td>
<td>1–999</td>
<td>2–999</td>
<td>n/a</td>
<td>tasks</td>
</tr>
<tr>
<td>Maximum tasks</td>
<td>2–999</td>
<td>n/a</td>
<td>n/a</td>
<td>tasks</td>
</tr>
<tr>
<td>Stall time interval</td>
<td>100–327670</td>
<td>n/a</td>
<td>n/a</td>
<td>msec</td>
</tr>
<tr>
<td>Runaway task interval</td>
<td>0–2700000</td>
<td>0,500–2700000</td>
<td>0,500–2700000</td>
<td>msec</td>
</tr>
<tr>
<td>Scan delay interval</td>
<td>n/a</td>
<td>0–5000</td>
<td>0–5000</td>
<td>msec</td>
</tr>
<tr>
<td>Region exit interval</td>
<td>100–327670</td>
<td>100–3600000</td>
<td>100–3600000</td>
<td>msec</td>
</tr>
<tr>
<td>Class n maximum tasks</td>
<td>1–999</td>
<td>1–999</td>
<td>n/a</td>
<td>tasks</td>
</tr>
</tbody>
</table>
Notes:
1. Maximum active tasks ≤ Maximum tasks
2. Scan delay interval ≤ Region exit interval
3. Region exit interval ≤ Stall time interval
4. Class n maximum tasks < Maximum tasks

CICS Dataspaces panel

The CICS Dataspaces panel displays when you select the CICS Dataspaces pushbutton on CICS Memory or on any other panel where the pushbutton appears.

Dataspaces memory is allocated to an owning address space and resembles other MVS address spaces. In this respect, it is manipulated like any other virtual storage array.

Hiperspace is allocated from expanded memory.

The following figure shows the panel.

FIGURE 122. CICS Dataspaces Panel

This panel displays a list of the dataspaces allocated to the currently selected CICS region.

For each dataspace, the panel displays the dataspace name, type, owning task name and TCB, and size information.

You can investigate the contents of any of the displayed dataspaces by entering S next to the name field.
Dataspace Memory panel

The Dataspace Memory panel displays when you select a dataspace name on the CICS Dataspaces panel. This panel displays storage in the CICS-owned dataspace.

Dataspace memory is allocated to an owning address space and resembles other MVS address spaces. In this respect, the panels for dataspace memory look and act like those of the CICS or OMEGAMON II for CICS address spaces. Hiperspace is allocated from expanded memory.

The following figure shows the panel.

**FIGURE 123. Dataspace Memory Panel**

The panel shows additional information about the dataspace, including the dataspace name, assigned storage key, and castout and fetch protect status.

Use this panel to view the unformatted contents of the CICS-owned dataspace memory.

You can also scan dataspace storage or chase control block chains looking for specific strings.

Use the action codes displayed on the panel to select the desired processing. Each code will cause an appropriate pop-up window to appear when additional data is required. These codes operate exactly like the I (indirect addressing), N (scan memory), and Z (change memory) codes used in the CICS Memory panel, except that the pop-ups that appear when you select them are titled as follows:
- Dataspace Indirect Addressing
- Scan Dataspace Memory
- Zap Dataspace Memory

See “Using the CICS Memory Action Codes” on page 211 for details on using these action codes.

**OMEGAMON II for CICS Dataspaces panel**

This panel displays when you select the OCII Dataspaces pushbutton on the CICS Memory panel or on any panel where the pushbutton appears.

Dataspace memory is allocated to an owning address space and resembles other MVS address spaces. OMEGAMON II for CICS uses a dataspace as an extension of its own address space for its various tables, pointers, and processing data.

The following figure shows the panel.

**FIGURE 124. OMEGAMON II for CICS Dataspaces Panel**

The panel displays a list of the dataspaces allocated to the OMEGAMON II for CICS common interface started task (KOCCI).

For each dataspace, the panel displays the dataspace name, type, owning task name and TCB, and size information.

This display is informational only, and there is no further display or navigation provided.
Chapter Overview

This chapter describes the MVS Resources selection that appears on the GoTo pull-down menu in many panels of OMEGAMON II (or enter fast path =RCR). This chapter also describes the System Console panel, which you can access by pressing F6 on any panel of OMEGAMON II.

Chapter Contents

MVS Resources Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .234
MVS Resources Pushbuttons. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .235
  CPU rates . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .235
  Working set size and paging rates . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .235
  CICS address space information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .235
  CICS job information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .236
  CICS address space TCBs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .236
  MVS loaded modules . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .236
  XRF information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .236
System Console Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .237
  Selecting commands . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .239
MVS Resources Panel

When you select MVS Resources from the GoTo pull-down the MVS Resources panel displays. The following figure shows the panel.

FIGURE 125. MVS Resources Panel

This panel displays information about MVS resource consumption within the CICS address space. This information is for the last OMEGAMON II cycle.

Use this panel to see the system resources that your CICS address space used for the last OMEGAMON II cycle.
MVS Resources Pushbuttons

The MVS Resources panel contains these push-buttons that navigate to the following panels:

- CPU Rates
- Working Set Size and Paging Rates
- CICS Address Space Information
- CICS Job Information
- CICS Address Space TCBs
- MVS Loaded Modules
- XRF Information

All the push-buttons that appear on MVS Resources also appear on each panel you navigate to using the push-buttons. Each panel is described below.

CPU rates
When you select the CPU push-button on MVS Resources, the CPU Rates panel displays. This panel displays information about CICS CPU usage.

The first section of the panel presents a breakdown of the CICS CPU rate into TCB (task control block) and SRB (service request block) times for the last OMEGAMON II cycle. The second section displays a table of CPU usage by CICS tasks.

See “CPU” on page 293 for more information on this panel.

Working set size and paging rates
When you select the Paging push-button on MVS Resources, the Working Set Size and Paging Rates panel displays. This panel displays statistics about the private and common areas of the CICS address space.

Use this panel to see the paging rate and storage usage and to determine if the working set size and/or paging rate need adjustment.

See “Paging” on page 351 for more information about this panel.

CICS address space information
When you select the ASID push-button on MVS Resources, the CICS Address Space Information panel displays. This panel displays general information about the CICS address space.

See “CICS Address Space Information panel” on page 295 for more information about this panel.
CICS job information
When you select the Job push-button on MVS Resources, the CICS Job Information panel displays. This panel displays information about CICS as an active MVS job. It contains information relative to MVS, JES, and VTAM.

Use this panel to see statistics about the general operation of the CICS job.

See “CICS Job Information panel” on page 296 for more information about this panel.

CICS address space TCBs
When you select the TCBs push-button on MVS Resources, the CICS Address Space TCBs panel displays. This panel displays information about the TCB structure within the CICS address space.

A task control block (TCB) is a dispatchable unit of work and is created by an MVS ATTACH macro.

Use this panel to analyze the structure of CICS TCBs and to assess how program is performing. Since many third-party products attach multiple TCBs, you can use this panel to locate where they are attached.

See “CICS Address Space TCBs panel” on page 297 for more information on this panel.

MVS loaded modules
When you select the Modules push-button on MVS Resources, the MVS Loaded Modules panel displays. This panel displays information about the modules that have been loaded by MVS into the CICS address space.

The list does not include modules from the DFHRPL concatenation which are loaded by CICS’s own loader and are placed into DSA storage.

Modules loaded after CICS initialization can cause the region to abend if there is not enough free virtual storage left. Some of these modules include monitors, security package routines, and programming language service modules.

You can inspect the modules by placing the Show Details (S) action code next to the entry address of the load module you want to examine.

See “MVS Loaded Modules panel” on page 299 for more information on this panel.

XRF information
When you select the XRF push-button on MVS Resources, the XRF Information panel displays. This panel displays summary information on the active (primary) and alternate CICS systems.

See “XRF (Extended Recovery Facility)” on page 406 for more information on this panel.
System Console Panel

The MVS operating system allows control to be spread among multiple physical locations. This is done by creating a network of operators’ consoles and assigning various tasks to each of them.

The following mechanisms control this separation of tasks:

**Operator authority**
Each operator’s console is assigned an authority. The master operator’s console can issue all commands and the secondary consoles can issue commands belonging only to their assigned console type.

**Routing codes and descriptors**
Each operator message sent from MVS, JES, or a program or task contains routing and descriptor codes. If none is provided by the sender, a default set of codes is provided. In any case, no message is sent without these codes.

Each operator’s console is assigned a set of routing codes which it is to display and handle. Using this method, each console can be assigned a unique function (for example, tape, printer, security, telecommunications, and so on).

The descriptor code describes an operator message’s function and determines how the message will be displayed on the terminal.

**Hardcopy log**
One of the consoles is described as the hardcopy log. This special console may be a printer or a dataset. In either case, it is used to maintain a continuous record of all console traffic.

When problems have occurred, the hardcopy log allows you to examine the state of the system. Error messages or outstanding replies can often point to the sources of the problem.

In OMEGAMON II the network of operators’ consoles is accessible through the System Console panel, which you display by pressing F6 on any panel.

Figure 126 on page 238 shows the System Console panel.
This panel displays the contents of an MVS operator’s console. You can enter MVS or JES commands.

The console ID is displayed with its assigned console type followed by the contents of the screen.

Your command authority is that of the console being viewed.

The operator’s console contains messages from all MVS tasks in the system. You may find indications of problems that may not be evident using other means of analysis.

In addition, you may be able to perform operator actions that will relieve problems. The ability to watch system performance from the operator’s perspective often allows you to recognize opportunities to adjust system and CICS parameters.

To switch operator consoles, type a new console ID.
The following fields are defined for the panel.

**Console ID**
This field contains the two-digit MVS operator console ID (use a number from 01 through 99). If you do not provide a value, the master console ID will be used.

Enter a console ID number to view and act as if you were the operator at that terminal. The displayed MVS/JES command output comes from the assigned console.

**Command**
This field is used to input MVS or JES commands on behalf of the operator.

Your command authority is that of the displayed console.

**Selecting commands**
You can select command groups from the Commands pull-down menu on the System Console panel and choose a command to send to the operator’s terminal.

The following command groups are available:

- CICS
- System
- VTAM
- JES2
- JES3

After you select a particular command group, a panel displays that contains a list of the commands in the group. Figure 127 on page 240 shows an example of a command list for VTAM commands.
This panel allows you to manipulate the contents of the command list. Use it to add, modify, delete, or issue commands.

You can assign a two-character mnemonic to commonly used commands. Add the mnemonic to the fast path for the appropriate command list in the home position of the System Console panel, then press Enter. Doing this allows you to bypass the commands list panel and send the command directly to the command line of the System Console panel. For example, enter **CCQQ**. The first C stands for Commands, the second C stands for the CICS Master Terminal Commands panel, and the QQ is the mnemonic for the CEMT | AUTOINSTALL command. The complete version of the command appears on the command line of the System Console panel.

To add a new command, type the mnemonic, command, and description contents on the first line of the display and press Enter. The command is added to the command list.

To use an existing command, place the appropriate action code next to the desired command to modify, delete, or issue the command to the operator’s console. Enter S to select a command, M to modify it, and D to delete a command.

If you use the Select action code, you are returned to the System Console panel with the command ready to be modified and sent to the operator’s terminal.
Modifying a command

To modify a command on the command list panel, follow these steps:

1. Enter M next to the desired command. Press Enter.

   The Command Modification pop-up window displays. The following figure shows the pop-up.

   **FIGURE 128. Command Modification Pop-up Window**

   ![Command Modification Pop-up Window](image)

2. Type the mnemonic, command, and description information contents on the line of the pop-up and press Enter.

   The modified command is added to the command list.
**Deleting a command**

To delete a command from the command list panel, follow these steps:

1. Enter **D** next to the desired command. Press Enter.
   
   A confirmation pop-up window displays.

2. Enter **1** or **P** to confirm the deletion.
Chapter Overview

This chapter describes the components that appear in the Workloads portion of the Region Status panel of OMEGAMON II. The Workloads components indicate the status of the amount of useful work that CICS is currently performing.

Chapter Contents

Automatic Initiate Descriptors .................................................. 244
  AIDs Summary panel ............................................................... 244
  AID Details panel ................................................................. 245
Interval Control Elements (ICEs) ................................................ 249
  ICEs Summary panel .............................................................. 249
  ICE Details panel ................................................................. 250
Response .............................................................................. 251
  Response Times Summary panel ................................................ 251
  Response Time Details panel .................................................... 255
Tasks ................................................................................. 257
  Tasks Summary panel .............................................................. 257
  Task Details panel ................................................................. 258
  Task Details pushbuttons ......................................................... 259
TranRate (Transaction Rate) ....................................................... 281
Units of Work (CICS/ESA Version 5.1.0) ...................................... 283
  User authority required .......................................................... 283
  Setting thresholds ................................................................. 283
  Fastpaths for UOW panels ...................................................... 284
  Identifying shunted UOW problems ......................................... 284
  Identifying UOW enqueue failures .......................................... 287
  Identifying forced heuristic decisions .................................... 289
Automatic Initiate Descriptors

Automatic initiate descriptors (AIDs) are created when CICS is unable to start a task because a resource is not available. An accumulation of AIDs can have an adverse impact on CICS storage and CPU availability. An AID remains in CICS until the resources are available, CICS is shutdown, or the AID is killed.

OMEGAMON II allows you to remove (kill) waiting AIDs to avoid system degradation. See the OMEGAMON II for CICS User’s Guide for procedure on killing AIDs.

AIDs Summary panel

To see the status of AIDs in the CICS region, select the AID status bar on the Region Status panel. The AIDs summary panel displays.

The following figure shows the AIDs summary panel.

FIGURE 129. AIDs Summary Panel

This panel displays summary information on all AIDs in the CICS region. It shows you the work waiting on terminals and remote systems.

This panel allows bottlenecks involving terminals or printers to be identified. For example, a request to start a task connected to a printer appears as an AID when the target printer is not available. If many AIDs have accumulated, response time may be adversely affected because CICS attempts to start each AID on every dispatch of the terminal control program.
You can enter one of the following action codes in the entry field preceding the Request ID (the action codes are not case sensitive):

**S (Show details)**  
Navigates to the AID Details panel (see Figure 130 on page 245), which shows information for the selected AID, including the reason why the AID is waiting.

**K (Kill the AID selected)**  
Removes the selected AID from CICS.

**M (Kill all AIDs for the terminal)**  
Removes all AIDs from CICS that have the same terminal ID value as the selected AID.

**N (Kill all AIDs for the transaction)**  
Removes all AIDs from CICS that have the same transaction ID value as the selected AID.

### AID Details panel

When you select a specific AID on the AID summary panel to gain further information on it, the AID Details panel displays.

The following figure shows the panel.

**FIGURE 130. AID Details Panel**

The AID Details panel displays detailed information for the selected AID and the status of the target terminal on which the task is run.

When this AID is scheduled for a terminal or printer that may be unavailable for a prolonged period (for instance, because of a hardware failure), OMEGAMON II allows you to “kill” this AID. See the *OMEGAMON II for CICS User’s Guide* for procedure on killing AIDs.
Supplementary data fields
The following sections describe the pop-up windows that may appear when you select the Supplementary Data field of the AID Details panel.

**BMS Details pop-up**

The BMS Details pop-up displays if you select the Supplementary Data field of the AID Details panel when BMS is displayed. The following figure shows the pop-up:

**FIGURE 131. BMS Details Pop-up**

This pop-up shows BMS details for the current AID. The Operator Check Type field identifies the routing list for the selected BMS maps. It specifies the map destination as terminals and/or operators.

The Operator ID field identifies the class of operators who are to receive the map. If no routing list is specified and the OPCLASS information is omitted, the map is routed to all remotely defined terminals in the connected terminal-owning region (TOR). If no routing list is specified and the OPCLASS is specified, the message is not sent to any remote operator at all.

Operator-qualifying information cannot be used across systems unless specific terminals are named in a routing list.

**ICP-PUT Data Details pop-up**

The ICP-PUT Data Details pop-up displays if you select the Supplementary Data field of the AID Details panel when ICP-PUT is displayed in it. The following figure shows the pop-up:

**FIGURE 132. ICP-PUT Data Details Pop-up**
This pop-up displays ICP-PUT data details for the current AID. It identifies the suspended transaction, the system that initiated the transaction, and the current rescheduling count.

**Transaction Routing Details pop-up**

The Transaction Routing Details pop-up displays if you select the Supplementary Data field of the AID Details panel when TranRout is displayed in it. The following figure shows the pop-up:

![FIGURE 133. Transaction Routing Details Pop-up](image)

This pop-up displays transaction routing details for the current AID. It provides the application-owning (AOR) and terminal-owning region (TOR) system IDs in addition to the time the AID was created.

**LU6.2 Details pop-up**

The LU6.2 Details pop-up displays if you select the Supplementary Data field of the AID Details panel when LU6.2 is displayed in it. The following figure shows the pop-up:

![FIGURE 134. LU6.2 Details Pop-up](image)

This pop-up shows the modename for the LU6.2 protocol involved in ISC. The modename specifies a collection of sessions with the remote system.

The modename defines a 1- to 8-character VTAM LOGMODE name. The VTAM LOGMODE name designates the set of characteristics desired for a session.
**Transient Data Details pop-up**

The Transient Data Details pop-up displays if you select the Supplementary Data field on the AID Details panel when TranData is displayed in it. The following figure shows the pop-up:

![Transient Data Details Pop-up](image)

This pop-up displays the transient data queue against which input/output operations are performed.
Interval Control Elements (ICEs)

Interval control elements (ICEs) are created when an interval control request is received. The request may be to start a transaction now, or at some time in the future. The request may also be to wait for a specified time period, or notify a task that a specific time has been reached.

At expiry time the ICE may remain on the ICE chain if the system is short on storage (SOS) or at MXT.

When the interval expires, CICS either attaches a transaction or an AID is created for the task.

OMEGAMON II allows you to kill ICEs to prevent unwanted tasks from being attached. See the OMEGAMON II for CICS User’s Guide for procedure on killing ICEs.

ICEs Summary panel

Select ICE from the Region Status panel to see the status of all the ICEs in the CICS region. The Interval Control Elements (ICEs) summary panel displays.

Figure 136 on page 249 shows the ICEs summary panel.

FIGURE 136. ICEs Summary Panel

This panel displays summary information on all ICEs in the CICS region. It shows the work queued for the system and when that work is scheduled to occur.
You can enter one of the following action codes in the entry field preceding the Request ID (the action codes are not case sensitive):

**S (Show details)**

Enter next to an ICE to see detailed information about the ICE. The panel navigates to the ICE Details panel (see Figure 137 on page 250) so you can validate the ICE and the resources it will require at task create time.

**K (Kill a single ICE)**

Removes an ICE from the CICS system.

**m (Kill all ICEs for a terminal)**

Removes all ICEs with the same terminal ID as the selected ICE from CICS.

**n (Kill all ICEs for a transaction)**

Removes all ICEs with the same transaction ID as the selected ICE.

See the *OMEGAMON II for CICS User’s Guide* for procedure on killing ICEs.

**ICE Details panel**

After viewing the ICEs in the summary panel, you can select a specific ICE and gain further information for problem analysis. To do this, on the summary panel enter **S** in the entry field next to the ICE in question. The ICE Details panel displays.

Figure 137 on page 250 shows the ICE Details panel.

### FIGURE 137. ICE Details Panel

This panel displays detailed information for the selected ICE. For Wait and Post type ICEs, information on the waiting tasks is also displayed.
**Response**

OMEGAMON II collects, analyzes, and displays CICS response time for predefined groups of transactions, terminals, and programs. It also collects end-to-end response time data for logical unit (LU) groups, when the End-to-End™ (ETE) feature is active.

The Response Time component of OMEGAMON II collects response times at the element level for the previous 9 minutes of activity, and also for every time slot defined to OMEGAMON II. This provides the Response Time panels with response time details at the element level and group level for the current minute and last 8 minutes, and for the previous 24-hour period.

Response time is the elapsed time difference calculated by subtracting the start time from the end time of a CICS logical unit of work. End-to-end response time is the elapsed time between the user sending a request to CICS and receiving a response at the terminal.

All response times (conversational and nonconversational) are recorded at task termination and maintained in realtime so the product can report the overall performance of transaction throughput in CICS.

OMEGAMON II allows you to monitor response time based on data generated by groups of like elements. VTAM logical units (LUs) groups are used for monitoring end-to-end response time. Transaction, program, and terminal groups can be used to monitor internal CICS response time or bottleneck analysis.

This grouping of information is key to response time analysis.

To collect and analyze response time data, you may define one or more response time groups and their thresholds, or you can use the predefined groups shipped with OMEGAMON II. You have the option of changing one or more groups and their thresholds permanently or only for the duration of an OMEGAMON II session. See “Defining Response Time Groups for Monitoring” in the OMEGAMON II for CICS User’s Guide for information on changing response time groups for the duration of a session, and see the OMEGAMON II for CICS Configuration and Customization Guide for information on changing them permanently.

**Response Times Summary panel**

Select Response from the Region Status panel to see recent response times in the CICS region. The Response Times summary panel displays.

The following figure shows the panel.
This panel displays response times for active groups within OMEGAMON II. Only those groups that have registered activity within the last 9 minutes are displayed.

The panel is sorted in descending order based on the largest value in the Current Minute column. The worst response time appears at the top of the display, followed by the remaining groups (up to a maximum of 30).

Lack of resources may cause poor response time. By identifying the resources in short supply, you can resolve the problem and restore acceptable response times.

You can make the selections described below to get further information:

- Enter the Show Details (S) action code next to a particular group to see response time details for that group. The Response Time Details panel displays. This panel provides a list of the element IDs defined to the group. Response times are provided for each active element in the group.

  See “Response Time Details panel” on page 255 for information on this panel.

- Enter the Bottlenecks (B) action code next to a group name to see the internal bottlenecks affecting the selected group. The Internal Bottlenecks panel displays.

  See “Bottlenecks” on page 388 for information on this panel.

- Select MVS Resources from the GoTo pull-down menu to examine environmental factors. These external factors may have a significant impact on CICS response time. See “MVS Resources and the System Console” on page 233 for more information.
Select the Response Time History pushbutton on the Response Times panel to view response times over the previous 24-hour period for the current region. The Response Time History panel displays. Information on this panel can be limited to a specific group name or can be based on a group type.

See “Response Time History panel” on page 253 for information on this panel.

Response Time History panel

The Response Time History panel displays when you select the Response Time History pushbutton at the bottom of the Response Times panel. This panel shows response time history for one group or all groups of a given element type.

Figure 139 on page 253 shows the panel.

FIGURE 139. Response Time History Panel

For each predefined time slot, as specified in the global data area module, the total number of transactions belonging to the selected group (or groups) is displayed. The group name defaults to an asterisk (*), while the default group type is TRAN.
Enter S next to a time slot to view details about the elements that were active during a specified interval. The Response Time History Details panel displays. See “Response Time History Details panel” on page 254 for information on this panel.

**Response Time History Details panel**

The Response Time History Details panel displays when you select a time slot on the Response Time History panel. Figure 140 on page 254 shows the panel.

**FIGURE 140. Response Time History Details Panel**

This panel shows average response times during a selected time slot.

Enter S to select an element and view the history of any task(s) associated with the element. Viewing an element’s history may allow you to isolate long running tasks. This information is also useful when setting CMXT limits, since long running tasks affect the performance of other transactions.
Response Time Details panel

After viewing the response times for the current minute through the previous 8 minutes in the Response Times summary panel, you can select a specific group name and further analyze response time status. The Response Time Details panel displays, as shown in Figure 141 on page 255.

FIGURE 141. Response Time Details Panel

This panel displays response time in seconds for all elements within the specified group that have recorded activity within the last 9 minutes.

The response times are displayed in 1-minute intervals, starting with the current minute.

The elements are sorted in descending response time order for the Current Minute column.

For transactions, programs, and terminals, OMEGAMON II displays the internal CICS response time. For logical units, OMEGAMON II displays the end-to-end (ETE) response time. This time is additionally broken down into the host and network response times.

If you are displaying the details of transaction or terminal groups, you can select individual elements for further detail display. You cannot select programs and logical units.

Select the Internal Bottlenecks pushbutton, to view the internal resources affecting the current group.

Use the GoTo pull-down menu item MVS Resources to examine environmental factors. You can also use the External Contention panel (select the External Contention pushbutton) to identify other address spaces which may be having a significant impact on CICS response time.
You can overtype the value shown in the **Group name** field with any other specific group name. Press F4 to see a list of all group names defined to the CICS region.

To display activity for all elements, enter an asterisk (*) for the group name.

**Note:** *Current response time values for this panel follow the same format as the Response Times panel (see Figure 138 on page 252).*

**Response Time Details pushbuttons**

Pushbuttons at the bottom of the Response Time Details panel navigate to the following panels:

- Internal Bottlenecks
- External Contention

The following sections describe each panel.

**Internal Bottlenecks panel**

The Internal Bottlenecks panel allows you to view the bottlenecks affecting a specific group. The panel shows detected bottlenecks in the target CICS region, displayed in descending bottleneck ratio order. Most resource types have an equivalent resource name, which is the name of the resource causing the bottleneck.

See “**Bottlenecks**” on page 388 for more information on the Internal Bottlenecks panel.

**External Contention panel**

The External Contention panel allows you to identify other address spaces that are impacting the current CICS region. Examples of these factors are paging, swapping, and the execution of other address spaces.

See “**External Contention panel**” on page 389 for more information on the External Contention panel.
### Tasks

The Tasks component of OMEGAMON II allows you to monitor currently running CICS tasks and see an instantaneous display of system activity. As tasks complete, OMEGAMON II saves pertinent resource usage data for online viewing and batch reporting. CICS task analysis includes statistical information from the OMEGAMON II task area and the CICS monitoring area.

### Tasks Summary panel

Select Tasks from the Region Status panel to see the status of all the tasks in the CICS region. The Tasks summary panel displays.

Figure 142 on page 257 shows the panel for CICS/ESA Version 3.

**FIGURE 142. Tasks Summary Panel (CICS/ESA Version 3)**

1. The % of AMXT field does not display for CICS/ESA Version 4 and above.
2. The CPU Time field is not highlighted for excluded tasks. See the GLOBAL_OPTIONS parameter section in the OMEGAMON II for CICS Configuration and Customization Guide for information on excluding tasks.

This panel displays the current workload of the CICS address space and how close it is running to the task limits, as well as a summary of all tasks in the system.

If CICS is stalled or the entire system is experiencing slow response time, determine if the MXT or AMXT values have been exceeded. If not, determine whether CICS is SOS (short-on-storage). This condition can be caused by MXT or AMXT values that are too high.
If CMXT, MXT, or AMXT values have been reached, this may be because these values have been set too low or that tasks are not terminating. Use the task summary to determine if tasks are completing and new tasks are being attached. If not, examine the resource type and resource name for which each task is waiting.

Use the action codes K (kill) or F (force kill) to terminate looping or deadlocked tasks. See the OMEGAMON II for CICS User’s Guide for procedure on terminating tasks.

To display the statistics for each of the transaction classes, select the Highest % of CMXT field.

By analyzing the wait resource type and name you may be able to determine the existence and cause of bottlenecks that are degrading performance. For CICS/ESA wait reasons, see the IBM CICS Problem Determination Guide; for additional CICS/ESA wait reasons provided by OMEGAMON II, press F1 to see online help for the Tasks summary panel. Select the highlighted term **Resource Type**.

### Task Details panel

OMEGAMON II collects detailed task statistics using exit facilities in CICS/MVS. For CICS/ESA, OMEGAMON II uses exit facilities and the CICS Monitoring Facility. From the Tasks summary panel, you can select a specific task for further analysis. The Task Details panel then displays. The following figure shows the panel for CICS/ESA.

**FIGURE 143. Task Details Panel (CICS/ESA)**

Note: The CPU Time field is not highlighted for excluded tasks. See the GLOBAL_OPTIONS parameters section in the OMEGAMON II for CICS Configuration and Customization Guide for information on excluding tasks.
This panel displays detailed information about a CICS task for both CICS/ESA and CICS/MVS. To view additional information about the task, select one of the pushbuttons at the bottom of the screen (see “Task Details pushbuttons” on page 259 for information on the panels that display).

High CPU and storage consumption are indicators of a looping task that can seriously degrade performance. A tight looping task can lock up the entire CICS region or exhaust available CICS storage, putting CICS under stress because of a short-on-storage situation.

If you want to see how the task has spent its time so far, select the Timings pushbutton. The Task Time Analysis panel displays. See “Task Time Analysis panel” on page 273 for information on this panel.

If you want to see details about the amount of storage a task is currently using or statistics about the storage it has used throughout its life, select the Storage pushbutton. The Task Storage panel displays. See “Task Storage panel” on page 272 for information on this panel.

If you have determined that a task needs to be removed from the system, use the kill or force kill functions. See the OMEGAMON II for CICS User’s Guide for procedure on terminating tasks.

Task Details pushbuttons

The Task Details panel contains pushbuttons that navigate to the following panels:

- Task Addresses
- Task File Statistics
- Task Remote Information
- Task Statistics
- Task Storage
- Task Time Analysis
- Task Umbrella Data
- Task FEPI Statistics
- Task Terminal Statistics
- Bridge

Notes:


2. Pushbuttons that allow transplex navigation (for example, GoTo DB2, GoTo DBCTL, and GoTo Remote CICS) appear on the panels listed above only under the following conditions:
   - You must be running OMEGAMON II under OMEGAVIEW with the appropriate level of maintenance.
   - For the GoTo DB2 and GoTo DBCTL pushbuttons, the task must be currently processing a request in DB2 and DBCTL.
   - For a GoTo Remote CICS pushbutton, OMEGAVIEW must be monitoring the region being examined, and the task must be processing a request in a remote region.
These pushbuttons let you navigate to corresponding panels in OMEGAMON II for DB2, OMEGAMON II for DBCTL, or to corresponding remote task information panels. See “GoTo Remote Pushbutton” on page 267 for more information on the GoTo Remote CICS pushbutton.

For more information on transplex navigation, see the appendix “Transplex Navigation and Session Switching” in the OMEGAMON II for CICS User’s Guide.

All the pushbuttons that appear on Task Details also appear on each panel you navigate to using the pushbuttons.

The following sections describe each panel.

**Task Addresses panel**

The Task Addresses panel displays when you select the Addresses pushbutton on the Task Details panel. The following figure shows the panel for CICS/ESA Version 3.

**FIGURE 144. Task Addresses Panel (CICS/ESA Version 3)**

---

**Note:** For CICS Version 4 and above, the TQE field shows TXN (Transaction Manager Transaction) instead.

For CICS/ESA, this panel displays the addresses of control blocks used by the dispatcher and application domains to control the execution of the task. For CICS/MVS, this panel displays the addresses of control blocks used by CICS task control to control the execution of the task.

If you suspect a storage violation has corrupted one of the control blocks, select the control block to view it in an unformatted storage display.
**Task File Statistics panel**

The Task File Statistics panel displays when you select the Files pushbutton on the Task Details panel. The following figure shows the panel.

**FIGURE 145. Task File Statistics Panel**

```
<table>
<thead>
<tr>
<th>File Type</th>
<th>Total Requests</th>
<th>Total Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>VSAM</td>
<td>15</td>
<td>n/a</td>
</tr>
<tr>
<td>DB2</td>
<td>2</td>
<td>0.236</td>
</tr>
<tr>
<td>DL/I</td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td>MQ</td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td>ADABAS</td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td>DATACOM</td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td>IDMS</td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td>SUPRA</td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td>USREVNT1</td>
<td>10</td>
<td>41.034</td>
</tr>
</tbody>
</table>
```

This panel displays the number of requests issued by the task for VSAM, DL/1, DB2, MQ, ADABAS, DATACOM, IDMS, USREVNT1, or SUPRA files and the time spent while issuing the requests.

You can select the VSAM, DL/1, DB2, MQ, and USREVNT1 fields for further information, but not the ADABAS, DATACOM, IDMS, or SUPRA fields.

Excessive file requests might indicate an application error.

The time used to issue and wait for the completion of file requests is one of the response time components for the task.

DASD hardware problems or poor file placement result in long I/O response times that can significantly deteriorate CICS transactions response times.
The VSAM File Statistics panel displays when you select the VSAM field on the Task File Statistics panel. The following figure shows the panel.

**FIGURE 146. VSAM File Statistics Panel**

<table>
<thead>
<tr>
<th>s V</th>
<th>Call Type</th>
<th>Count</th>
<th>n/a</th>
</tr>
</thead>
<tbody>
<tr>
<td>s V</td>
<td>Adds</td>
<td>1</td>
<td>n/a</td>
</tr>
<tr>
<td>D</td>
<td>Browses</td>
<td>12</td>
<td>n/a</td>
</tr>
<tr>
<td>I</td>
<td>Deletes</td>
<td>0</td>
<td>n/a</td>
</tr>
<tr>
<td>S</td>
<td>Gets</td>
<td>1</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td>Puts</td>
<td>1</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td>Total requests</td>
<td>15</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Total VSAM calls</td>
<td>15</td>
<td></td>
</tr>
</tbody>
</table>

This panel displays counts for file access commands issued by this task up to now.

Excessive time spent accessing files may be a symptom of problems in the way the files are placed or of a hardware malfunction. Excessive file accesses might indicate an application problem.

To view response time for DASD, return to the Region Status panel and select the DASD status bar.

To view this transaction’s performance history, select the GoTo pull-down, then select Task History. On the Task History panel, you can then specify selection of only this transaction ID to view and compare the transaction’s history with the current task’s behavior.

See “Task History” on page 165 for information on Task History.
The DB2 Statistics panel displays when you select the DB2 field on the Task File Statistics panel. The following figure shows the panel.

**FIGURE 147. DB2 Statistics Panel**

This panel displays counts and total elapsed times for DB2 commands issued by this task up to now.

Excessive time spent accessing database records may be a symptom of problems in the way the files are placed or of a hardware malfunction.

Excessive database calls might indicate an application problem.

To view response time for DASD, return to the Region Status panel and select the DASD status bar.

To view this transaction’s performance history, select the GoTo pull-down menu. Then select Task History. On the Task History panel, you can then specify selection of only this transaction ID to view and compare the transaction’s history with the current task’s behavior.

See “Task History” on page 165 for information on Task History.
**DL/I Statistics**

The DL/I Statistics panel displays when you select the DL/I field on the Task File Statistics panel. The following figure shows the panel.

**FIGURE 148. DL/I Statistics Panel**

This panel displays counts and total elapsed times for DL/I commands issued by this task up to now.

Excessive time spent accessing database records may be a symptom of problems in the way the files are placed or of a hardware malfunction.

Excessive database calls might indicate an application problem.

To view response time for DASD, return to the Region Status panel and select the DASD status bar.

To view this transaction’s performance history, select the GoTo pull-down menu. Then select Task History. On the Task History panel, you can then specify selection of only this transaction ID to view and compare the transaction’s history with the current task’s behavior.

See “Task History” on page 165 for information on Task History.
**USREVNT1 Statistics panel**

The USREVNT1 Statistics panel displays when you select the USREVNT1 field on the Task File Statistics panel. The following figure shows the panel.

**FIGURE 149. USREVNT1 Statistics Panel**

This panel displays counts and total elapsed times for USREVNT1 requests issued by this task up to now. The actual user event name displayed on this panel is defined via the USREVNT1 parameter within the global data area.

The elapsed time is an interval between the time when an application program invokes a defined user event or a defined process, and the time control is returned back to the application. The defined user event or process may be of any kind, such as a database call, call to another program, or execution of a subroutine within a program. As such, the time interval does not represent CPU time, but rather the overall wall clock time of the entire event.

User Event monitoring is defined and controlled within the global data area. For further information, refer to the *OMEGAMON II for CICS Configuration and Customization Guide*.

To view this transaction’s performance history, select the GoTo pull-down menu. Then select Task History. On the Task History panel, you can then specify selection of only this transaction ID to view and compare the transaction’s history with the current task’s behavior.

See “Task History” on page 165 for information on Task History.
**Task Remote Information panel**

The Task Remote Information panel displays when you select the Remote pushbutton on the Task Details panel. The following figure shows the panel.

**FIGURE 150. Task Remote Information Panel**

This panel displays the information relevant to the task’s interaction with other CICS systems.

The unit-of-work ID (UOW ID) is a unique identifier for the task. It is made up of a store clock portion and a sequence number, plus the netname.

The netname is the fully qualified name by which the originating system is known to the VTAM network. The following list tells how the netname is determined.

- If the task is locally attached or part of an ISC or IRC attach header, the netname is derived from the TCT (terminal control table).
- If the task’s facility is an LUTYPE6.2 or IRC link, the netname is the networkid.LUname.
- If the task’s facility is non-VTAM, the netname is made up of the networkid.generic_applid.
- If the task is originated by a DL/I batch session, the netname is made up of the jobname.stepname.procname of the originator.

In an ISC or MRO environment, the UOW ID combined with netname uniquely identifies a task in the network.

CICS provides the intercommunication facilities needed to communicate with other CICS and non-CICS systems in the same or in different hosts.
Multiregion operations (MRO) uses the interregion communication (IRC) facility to enable communications between CICS systems in the same host, independent of the SNA access method. To implement MRO, CICS uses type 3 SVC or MVS cross memory services, depending on the parameters you specify in the Terminal Control Table (TCT) or the CEDA transaction.

Intersystem communications (ISC) is the facility that uses the SNA access method provided by ACF/VTAM to enable communications between CICS and non-CICS systems residing in the same or in different hosts. Again, parameters in the TCT or CEDA define the connection and access method.

To implement ISC or MRO you must do the following:

- Specify required SIT parameters.
- Have the necessary VTAM definitions for ISC.
- Implement some CICS modules as LPA resident.
- Define resources with the CEDA transaction or in the TCT.

The information needed to implement ISC or MRO is in the *CICS/MVS Intercommunication Guide* and the *CICS/ESA Intercommunication Guide*.

Performance problems in the remote CICS region, such as SOS, slow down tasks attempting transaction routing or function shipping. If the other CICS is running on the same host, return to the Region Status panel and overtype the CICS region name to analyze it (or use the session switching feature if you are running under OMEGAVIEW).

**GoTo Remote Pushbutton**

The GoTo Remote CICS pushbutton appears on the Task Remote Information panel only if

- you are running OMEGAMON II under OMEGAVIEW with the appropriate level of maintenance
- you have logged onto OMEGAMON II via OMEGAVIEW
- the task is currently processing a request in a remote region

Use this pushbutton to navigate to the GoTo Remote CICS pop-up, where you can select a CICS system ID and zoom to a panel displaying corresponding remote task information. An example of this pop-up appears below.
FIGURE 151. GoTo Remote CICS Pop-up

```
+------------------------------------------
| GoTo Remote CICS                          |
| Lines 1 to 3 of 99                        |
| Move cursor to selection, then press Enter.|
+------------------------------------------

System | Appl | Facility | Facility | Session | Session |
------- |------ |---------- |---------- |--------- |--------- |
| ID     | ID    | Type      | ID        | I/O      | Side     |
------- |------ |---------- |---------- |--------- |--------- |
| CIC6   | CICSA  | FC       | PAYMSTR   | SEND     | Frontend |
| CIC7   | CICSA  | FC       | RATES     | RECEIVE  | Frontend |
| CIC8   | CICSA  | TrnRout   |           | SEND     | Backend  |

F1=Help  **=Bkwd  F8=Fwd  F12=Cancel
```

Task Statistics panel

The Task Statistics panel displays when you select the Statistics pushbutton on the Task Details panel. The following figures show the panel for CICS/ESA Version 3, Version 4, Version 5.1.0, and CICS TS version 1.3.

FIGURE 152. Task Statistics Panel (CICS Version 3)

```
+-------------------------------+-------------------------------------------------------------------+
| Actions | GoTo | Index | Options | Help |-------------------------------------------------------------------|
+-------------------------------+-------------------------------------------------------------------|
| KC2C06D                         | Task Statistics                                                   |
| Fastpath: =WTS                 | Region: CICSPROD                                                   |
| 06/30/94 12:30:36              | Auto(60)                                                          |
| Task number . . . . . . 22 +   | Transaction ID . . . . : CSNC                                     |
| Primary trm input msgs : 0     | Secndry trm input msgs : 0                                        |
| Primary trm input chrs : 0     | Secndry trm input chrs : 0                                        |
| Primary trm output msgs: 0     | Secndry trm output msgs : 0                                       |
| Primary trm output chrs: 0     | Secndry trm output chrs: 0                                        |
| BMS requests . . . . : 0       | Program links . . . . : 18                                        |
| BMS map requests . . . : 0     | Program XCTLs . . . . : 1                                          |
| BMS map in requests . . : 0    | Program loads . . . . : 0                                         |
| BMS map out requests : 0       | Journal writes . . . . : 36                                       |
| IC starts . . . . . : 0        | Syncpoints. . . . . : 12                                          |
| TS gets . . . . . . : 0        | TD gets . . . . . . : 0                                           |
| TS puts to main . . . : 0      | TD puts . . . . . . : 0                                           |
| TS puts to auxiliary : 0       | TD purges . . . . . : 0                                           |
+-------------------------------+-------------------------------------------------------------------+
<Details> <Addresses> <Files> <Remote> <Statistics> <Storage> <Timings>
F1=Help F2=Keys F3=Exit F4=Prompt F5=Refresh F6=Console F10=Action Bar
F11=Print F15=Region Status
```
**FIGURE 153. Task Statistics Panel (CICS Version 4)**

<table>
<thead>
<tr>
<th>Task number</th>
<th>Transaction ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>27</td>
<td>TES2</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>2</td>
<td>4</td>
</tr>
<tr>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

**FIGURE 154. Task Statistics Panel (CICS Version 5.1.0)**

<table>
<thead>
<tr>
<th>Task number</th>
<th>Transaction ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>19</td>
<td>CFQR</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Program links</th>
<th>TS gets</th>
<th>Program XCTLs</th>
<th>TS puts to main</th>
<th>Program loads</th>
<th>TS puts to auxiliary</th>
<th>Syncpoints</th>
<th>TD gets</th>
<th>Journal writes</th>
<th>TD puts</th>
<th>CICS logger writes</th>
<th>TD puts</th>
<th>IC starts</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>
FIGURE 155. Task Statistics Panel (CICS TS Version 1.3)

For CICS/MVS (CICS Version 3 above), this panel displays the number of requests issued for terminal control.

For CICS/ESA (CICS Version 4 and 5.1.0 above), this panel displays the number of requests issued for CICS services, such as program control, journal control, temporary storage, and transient data.

For CICS/ESA (CICS TS Version 1.3), this panel additionally displays the number of IMS/DBCTL requests, DB2 requests, distributed program link (DPL) requests, program link user replaceable modules (URMs) requests, and indicates whether non-3270 related statistics are available for the selected task.

Tasks that perform many temporary storage or transient data requests might incur large response times due to the potential for I/O activity.

If you want to examine temporary storage and transient data statistics, select the corresponding status bar from the Region Status panel to see any conditions that might degrade response time.
Task Non-3270 Statistics Panel

The Task Non-3270 Statistics panel displays when you select the Non-3270 Statistics display field from the Task Statistics panel. The following figure shows the panel for CICS TS 1.3.

FIGURE 156. Task Non-3270 Statistics Panel (CICS TS Version 1.3)

This panel displays statistics for a particular task that are not related to the 3270 interface. For example, the panel displays the number of requests for CICS services such as WEB send and receive requests, object-oriented foundation class requests, and identifies the WEB client IP address that corresponds with the selected task.

The Transaction Group ID fields can be used to correlate transactions that were executed for the same incoming work request and originated over the CICS WEB, IIOP, or a 3270 Bridge interface. To perform a correlation operation, copy the values from the Transaction Group ID fields and return to the Tasks Summary panel. From there, select the View > View Some menu items and input the copied values into the TRGID. EQ. Inclusion Criteria field.
Task Storage panel

The Task Storage panel displays when you select the Storage pushbutton on the Task Details panel. The following figure shows the panel for CICS/ESA.

FIGURE 157. Task Storage Panel

This panel displays the storage activity for a particular task.

For CICS/ESA, the Current section displays statistics collected by the Storage Manager. The Statistics section shows CICS monitoring statistics.

For CICS/MVS, the Current section displays statistics based on an examination of all storage chained to the task’s TCA. The Statistics section shows statistics collected by OMEGAMON II.

If the number of GETMAIN requests or a storage HWM appears high, examine your application to determine any unnecessary use of storage.

If you want to determine the amount of storage and the location in the application for each storage request, you can step through your application with CEDF.
The Task Program Storage HWM panel displays when you select the Program Storage HWM field on the Task Storage panel. The following figure shows the panel.

**FIGURE 158. Task Program Storage HWM Panel**

This panel displays the maximum amount of program storage used by the selected task in each of the DSAs, both above and below the 16 megabyte line.

**Task Time Analysis panel**

This panel displays when you select the Timings pushbutton on the Task Details panel. The Task Time Analysis panel displays a cumulative breakdown of where the selected task spent time during its execution cycle. These timings are collected by the CICS Monitoring Facility and are described in either the IBM CICS/ESA Customization Guide or the CICS/ESA V5.3 Performance Guide.

The following figures show the panel for CICS/ESA Version 4, CICS/ESA Version 5.1.0, as well as for CICS TS Version 1.3.
**FIGURE 159. Task Time Analysis Panel (CICS Version 4)**

```plaintext
____ Actions GoTo Index Options Help
------------------------------------------- 06/30/94 9:34:04
KC2C08D Task Time Analysis Region: CICSPROD
Fastpath: =WTI Auto(60)
| Task number. . . . . . 27 | Transaction ID . . TES2 |
| CPU time . . . . . . . 0.252s | Total wait time . . 5.322s |
| Task elapsed time . . 8.468s | Dispatch time . . 3.146s |
| Overall elapsed time : 0.000s | 1st dispatch delay . 0.000s |

Lines 1 to 5 of 17
```

**FIGURE 160. Task Time Analysis Panel (CICS/ESA Version 5.1.0)**

```plaintext
____ Actions GoTo Index Options Help
------------------------------------------- 03/07/97 17:11:39
KC2C08D Task Time Analysis Region: TDOCS27
Fastpath: =WTI Auto(Off)
| Task number. . . . . . 19 | Transaction ID . : CFQR |
| CPU time . . . . . . . 0.000s | Total wait time . : n/a |
| Elapsed time . . . . 05:23.78 | Dispatch time . . 0.000s |
| Overall elapsed time : 5:23.785 | 1st dispatch delay : 0.000 |

Lines 14 to 19 of 19
```

---

274 OMEGAMON II for CICS Reference Manual, Volume 1, Version 520
FIGURE 161. Task Time Analysis Panel (CICS TS Version 1.3)

Note: The CPU Time field is not highlighted for excluded tasks. See the GLOBAL_OPTIONS parameter section in the OMEGAMON II for CICS Configuration and Customization Guide for information on excluding tasks.

For the Task Time Analysis panel, the total amount of time a task is considered to be active is displayed as Dispatch time, while the total amount of waiting time for the task is displayed as Suspend time. The subsets that comprise either Dispatch time or Suspend time are displayed below each total.

For CICS TS Version 1.3, other timing fields such as RMI elapsed time, JVM elapsed time, Syncpoint elapsed time, and Exception wait time display the total time spent by CICS performing these specific types of processing on behalf of the task. Imbedded within each of these fields is a portion of the Dispatch and Suspend times as reported by the CICS Monitoring Facility.

To display other detailed statistics for this task, select the Details, Storage, Statistics, Umbrella, Task Terminal, or, if available, FEPI pushbuttons.

Task Time Detail Analysis panel (CICS TS Version 1.3)

The Task Time Detail Analysis panel displays when you choose a selectable field such as CPU Time or RMI elapsed time from the Task Time Analysis panel. The panel displays a cumulative breakdown of the amount of time spent by the task in the area you selected. For example, if CPU Time was selected, the panel displays the amount of CPU time spent during the task’s execution cycle. These timings are collected by the CICS Monitoring Facility and are described in the IBM CICS/ESA V5.3 Performance Guide.

The following figure shows the panel for CICS TS Version 1.3.
The first row of information in the lower box represents the total amount of time spent by the task in the area you selected from the Task History Timings panel. The subsequent rows are a subset of this total.
Task Umbrella Data panel

The Task Umbrella Data panel displays when you select the Umbrella pushbutton on the Task Details panel. The following figure shows the panel.

**Note:** The Umbrella pushbutton will be available and this panel accessible only if at least one of the three OMEGAMON II Umbrella fields contains data; that is, not low-values.

**FIGURE 163. Task Umbrella Data Panel**

This panel contains three Umbrella fields that can be updated from within an application program.

Specifying an umbrella transaction or program ID can be useful in tracking the progress of long-running tasks that perform multiple functions or of tasks where many programs may be invoked through a single transaction ID, a situation found in many fourth-generation language packages.

The umbrella user data is a work area available for use by an application for reading and storing information. It is displayed in this panel in character and hexadecimal formats. For more information on using umbrella services, see the *OMEGAMON II for CICS Configuration and Customization Guide*.
Task FEPI Statistics panel

The Task FEPI Statistics panel displays when you select the FEPI pushbutton on the Task Details panel. The pushbutton displays only if you use the FEPI feature with CICS. The following figure shows the panel.

FIGURE 164. Task FEPI Statistics

This panel displays the FEPI-related statistics collected for this task.
Task Terminal Statistics panel

The Task Terminal Statistics panel displays when you select the Terminal Stats pushbutton on the Task Details panel. Figure 165 on page 279 shows the panel.

This panel shows the number of requests issued for CICS terminal services.
Task Bridge Details panel

The Task Bridge Details panel displays when you select the Bridge pushbutton on the Task Details panel. The following figure shows the panel:

FIGURE 166. Task Bridge Details

These fields may be used to diagnose where the transaction originated and what function it is performing.
TranRate (Transaction Rate)

The transaction rate is a good indicator of CICS system throughput. OMEGAMON II calculates the number of CICS transactions executed per second or per minute, depending on the transaction rate unit you set previously through the Transaction Rate Thresholds panel.

Select TranRate from the Region Status panel to see the total transaction attach rate and individual transaction dispatch rates for the current 1-minute interval. The Transaction Rates panel displays, as shown in the following figure.

You can use this panel to monitor the activity level in CICS.

FIGURE 167. Transaction Rates Panel

The scale on the graph varies depending on the setting of the critical transaction rate high threshold. When you set this threshold in the Transaction Rates Thresholds pop-up, excessive transaction rates are flagged on the Transaction Rates and Region Status panels, and consequently in OMEGAVIEW.

The Total transaction rate value represents the total number of transactions attached by CICS during the current interval and is not equivalent to the sum of the dispatch rates of the individual transaction IDs listed.

You may see high transaction rates with a low total transaction rate because no new transactions are attached, but those already attached are being dispatched by CICS. A high total transaction rate, however, with a low transaction rate may indicate a problem, in that CICS is attaching new transactions that are not being dispatched.

None of the fields on this panel can be selected to navigate to any other panel.

Note: The transaction rates displayed are not for the minute immediately preceding the last time the panel was updated. Rather, the rates are based on the number of transactions that have been dispatched since the current minute interval began. At the end of the current minute interval, all rate counters are reset to zero and the rates are recalculated.
TranRate (Transaction Rate)

For transactions that average less than 60 per minute, you may want to change the transaction rate unit setting from per second to per minute. To change the unit setting, press F4 on the Transaction Rate Unit field of the Transaction Rates Threshold pop-up to toggle between second and minute, then press Enter.
Units of Work (CICS/ESA Version 5.1.0)

If you are using OMEGAMON II for CICS to manage a CICS/ESA Version 5.1.0 system, you can access CICS recovery manager facilities to make inquiries into Unit of Work (UOW) management in a CICS region. OMEGAMON II for CICS displays a new workload, **UOWs**, on the Region Status Panel, and supplies four new thresholds to track and display information about UOWs:

- Shunted UOWs
- Total time UOWs shunted
- Forced heuristic decisions
- Enqueue failures per UOW

User authority required

For CUA function level security, the resource `cicsname.KC2.MEM.CEMT` controls user authorization for the actions.

For menu system security, user authorization for the actions is controlled by restricting access to the CMT command.

Setting thresholds

You can change the threshold settings for UOWs. To reset your thresholds, complete the following step.

From the Region Status panel, type `L` next to the **UOWs** workload and press Enter.

**Result:** The UOW Thresholds panel displays. Type over the existing settings and press Enter.
Fastpaths for UOW panels

The procedures in the following sections show you how to access a panel by analyzing a UOW problem. Once you are familiar with the panels, you may choose to access them using the fastpaths shown below.

<table>
<thead>
<tr>
<th>Panel Name</th>
<th>Fastpath</th>
</tr>
</thead>
<tbody>
<tr>
<td>UOWs</td>
<td>=WU</td>
</tr>
<tr>
<td>UOW Details</td>
<td>=WUD</td>
</tr>
<tr>
<td>UOW Links</td>
<td>=WUL</td>
</tr>
<tr>
<td>UOW Enqueues</td>
<td>=WUQ</td>
</tr>
<tr>
<td>UOW Statistics</td>
<td>=WUS</td>
</tr>
</tbody>
</table>

Identifying shunted UOW problems

Introduction

You can display an overview of the recovery manager and all the UOWs in the region that is currently being managed.

An authorized user can also perform these actions against shunted UOWs:

- Force commit
- Force backout
- Force defined action

If a shunted UOW causes a problem by, for example, holding a lock resulting in enqueue failures, you can use the COMMIT or BACKOUT action to commit or back out the shunted UOW. To force a backout or commit as specified in the transaction definition for the UOW, use the FORCE action.
Navigating to shunted UOW information - procedure

To access information about shunted UOWs and the total time UOWs shunted, follow these steps:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 1    | From the Region Status panel, type **A** next to **UOW** and press Enter.  
**Result:** The Analyze UOW Problems panel displays. |

<table>
<thead>
<tr>
<th>Problem Description</th>
<th>Value</th>
<th>Warning</th>
<th>Critical</th>
</tr>
</thead>
<tbody>
<tr>
<td>- Enq failures for AD6A74A894C0A001</td>
<td>2</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>- Forced heuristic decisions</td>
<td>2</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>- Shunted UOWs</td>
<td>1</td>
<td>0</td>
<td>1</td>
</tr>
</tbody>
</table>

2    | From the Analyze UOW Problems panel, type **S** next to **Shunted UOWs** or **Total time UOWs shunted** and press Enter.  
**Result:** The UOWs panel displays, which is filtered for shunted UOWs, sorted in descending shunt time. |

<table>
<thead>
<tr>
<th>UOW</th>
<th>UOW</th>
<th>Tran</th>
<th>Wait</th>
<th>Time</th>
<th>Enqueue</th>
<th>ID</th>
<th>State</th>
<th>ID</th>
<th>State</th>
<th>Shunted</th>
<th>Failures</th>
</tr>
</thead>
<tbody>
<tr>
<td>AC8EFD1BDA7DF601</td>
<td>Indoubt</td>
<td>AUPD</td>
<td>Shunted</td>
<td>22m</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

((UOWs) <UOW Statistics>
F1=Help  F2=Keys  F3=Exit  F5=Refresh  F6=Console  F10=Action Bar  F11=Print  F15=Region Status)
The UOWs panel displays an overview of the Recovery Manager domain and all the UOWs in the region. From this panel, you can:

- Type **C**, **B**, or **F** next to the UOW ID for which you want to force an action.
- Type **S** next to the UOW ID for which you want more detail. Go to Step 4.
- Type **S** next to the Highest enqueue failures field to display the UOW enqueues panel. Go to “Identifying UOW enqueue failures” on page 287 for more information.
- Use the UOW Statistics pushbutton to display UOW statistics. Go to “Identifying forced heuristic decisions” on page 289 for more information about this panel.

The UOW Details panel displays. This panel provides detailed information about a particular UOW known to the recovery manager.

- Use the UOW Enqueues pushbutton, if displayed, to view the UOW Enqueues panel. Go to “Identifying UOW enqueue failures” on page 287 for more information.
- Type **S** next to UOW address to display the contents of storage at that address.
- Use the UOW Links pushbutton
- Use the UOW Links pushbutton, if displayed, to display information about links. Go to “Navigating to the UOW Links panel” on page 287 for more information about the UOW Links panel.
- Use the Action bar item to employ the purge task or force-purge task options.
- Type S next to NetUOWid (hex) to display the Task History panel and view other completed pieces of the selected transaction with the same Network UOW ID.

From this panel, you can:

- Use the UOW Enqueues pushbutton, if displayed, to view the UOW Enqueues panel. Go to “Identifying UOW enqueue failures” on page 287 for more information.
- Type **S** next to UOW address to display the contents of storage at that address.
- UOW Links pushbutton
- Use the UOW Links pushbutton, if displayed, to display information about links. Go to “Navigating to the UOW Links panel” on page 287 for more information about the UOW Links panel.
- Use the Action bar item to employ the purge task or force-purge task options.
- Type S next to NetUOWid (hex) to display the Task History panel and view other completed pieces of the selected transaction with the same Network UOW ID.
Navigating to the UOW Links panel

This panel displays a list of other CICS systems or resource managers, when applicable, that are involved in a unit of work. A link is the association between a UOW and a connection to a remote system or resource manager.

You can access this panel using the UOW Links pushbutton from the UOW Details panel. If a connection has been discarded, you may want to delete a link by typing D next to the Link ID and pressing Enter.

Identifying UOW enqueue failures

Introduction

You can display information about locks held by a shunted UOW. If the unit of work is shunted in-doubt, all locks are retained. If it is shunted because of a commit or backout failure, only the locks on the failed resources are retained. Retained locks cause other transactions to receive a condition that usually results in an abend (locked response), while other lock conflicts cause the transaction to suspend.

If a shunted UOW causes a problem by, for example, holding a lock resulting in enqueue failures, you can use the COMMIT or BACKOUT action to commit or back out the shunted UOW. To force a backout or commit as specified in the transaction definition for the UOW, use the FORCE action.
Navigating to enqueue failure information - procedure

To access information about UOW Enqueue failures, follow these steps:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 1    | From the Region Status panel, type A next to **UOW** and press Enter.  
**Result:** OMEGAMON II for CICS displays the Analyze UOW Problems panel. |

<table>
<thead>
<tr>
<th>Problem Description</th>
<th>Value</th>
<th>Warning</th>
<th>Critical</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enq failures for AD6A74A894C0A001</td>
<td>2</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>Total time UOWs shunted (minutes)</td>
<td>21</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>Forced heuristic decisions</td>
<td>2</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>Shunted UOWs</td>
<td>1</td>
<td>0</td>
<td>1</td>
</tr>
</tbody>
</table>

| F1=Help  F2=Keys  F3=Exit  F5=Refresh  F6=Console  F10=Action Bar  F11=Print  F15=Region Status |

| 2    | From the Analyze UOW Problems panel, type S next to **Enq failures for xxxx** and press Enter.  
**Result:** OMEGAMON II for CICS displays the UOW Enqueues panel. |

<table>
<thead>
<tr>
<th>Type</th>
<th>Resource</th>
<th>Qual</th>
<th>Fails</th>
</tr>
</thead>
<tbody>
<tr>
<td>TDQueue</td>
<td>TDQNAME</td>
<td>FROMQ</td>
<td>1</td>
</tr>
<tr>
<td>File</td>
<td>FILENAME</td>
<td>KEYFLD</td>
<td>0</td>
</tr>
</tbody>
</table>

The UOW Enqueues panel displays the locks held by a shunted UOW.
Identifying forced heuristic decisions

Introduction

You can display the UOW statistics panel to view statistics for the Recovery Manager domain. This panel provides a summary of the number of times heuristic decisions have been applied to resolve in-doubt UOWs. It is recommended that you avoid forced heuristic decisions, if possible, to prevent data integrity exposures.

Navigating to forced heuristic decisions - procedure

To access information about forced heuristic decisions, follow these steps:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>From the Region Status panel, type A next to UOW and press Enter.</td>
</tr>
</tbody>
</table>

**Result:** OMEGAMON II for CICS displays the Analyze UOW Problems panel.
2. From the Analyze UOW Problems panel, type **S** next to **Forced heuristic decisions** and press Enter.

**Result:** OMEGAMON II for CICS displays the UOW Statistics panel.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 2    | From the Analyze UOW Problems panel, type **S** next to **Forced heuristic decisions** and press Enter.  
**Result:** OMEGAMON II for CICS displays the UOW Statistics panel. |

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 3    | The UOW Statistics panel displays statistics from the Recovery Manager domain.  
To receive more information about enqueue failures, you can type **S** in the input field to display the UOW Enqueues panel. |
Chapter Overview

This section of the Region Status panel lists names of CICS resources and indicates the status of their usage. You can select these resources for information on system performance. This section gives you information such as

- amount of CPU time each task is using
- storage usage and storage problems for the CICS region
- response times for DASD
- file IDs

The following sections describe each component in the Resources section of the Region Status panel.

Chapter Contents

CPU ................................................................. 293
  CPU Rates pushbuttons .................................. 294
DASD ......................................................... 301
  CICS DASD Performance panel ......................... 301
  Three solutions to DASD problems .................... 302
  Tuning guidelines ........................................ 303
  CICS DASD Status panel ................................. 304
  CICS DASD Performance pushbuttons .................. 305
  DASD Details for a Device panel ....................... 307
  CICS Datasets on a DASD Volume panel ............... 307
DB2 ............................................................. 308
  DB2 Transaction Details panel ......................... 309
DBCTL ....................................................... 310
  DBCTL Tasks panel ....................................... 311
DL/I ............................................................ 312
  DL/I pushbuttons ....................................... 313
  DL/I Database Details panel ......................... 319
Files .......................................................... 320
  Open VSAM Files panel .................................. 320
  Open VSAM Files pushbuttons ......................... 322
VSAM Details panel .......................................................... 324
VSAM Details pushbuttons ............................................. 329
Journals ........................................................................... 330
  Journals panel (CICS/ESA 5.1.0) .................................. 330
  Journal Details panel (CICS/ESA 5.1.0) ......................... 333
  Setting thresholds (CICS/ESA 5.1.0) .............................. 334
  Analyzing journal problems .......................................... 334
  Datasets allocated to CICS panel (prior to CICS/ESA 5.1.0) 335
  File Details panel (prior to CICS/ESA 5.1.0) .................. 336
Local Shared Resources (LSR) .......................................... 338
  LSR Pools pushbuttons ................................................ 339
  LSR Buffer Pool Details panel ....................................... 340
  Buffer counts selections ................................................ 341
MRO/ISC ......................................................................... 347
  TCT System Entry panel ............................................... 348
Paging ............................................................................. 351
  Working Set Size and Paging Rates pushbuttons ............. 352
Storage ........................................................................... 354
  Storage Violations panel .............................................. 357
  DSA Storage panel ....................................................... 358
  Program Compressions panel ...................................... 359
  Address Space Storage panel .......................... ........................ 360
  Storage Allocation by Components panel ...................... 364
Tapes ............................................................................ 372
  Tape Drive Details panel ............................................. 373
TempStor (Temporary Storage) ......................................... 374
  Temporary Storage Pushbuttons .................................. 375
TranData (Transient Data) ................................................. 380
  Benefit of REUSE ..................................................... 381
  Effects of recovery .................................................... 381
  Tuning intrapartition transient data .............................. 381
  Intrapartition Transient Data Statistics panel .................. 382
  Destination Queues Over Limits panel ........................... 384
TCP/IP Socket Activity ...................................................... 385
Web Interface ................................................................... 386
Select CPU from the Region Status panel to see the status of CPU consumption for all tasks. The CPU Rates panel displays. The following figure shows the panel.

**FIGURE 168. CPU Rates Panel**

This panel displays information about CICS CPU usage.

The first section presents a breakdown of the CICS CPU rate into TCB (task control block) and SRB (service request block) times for the last OMEGAMON II cycle. The second section shows a table of CPU usage by CICS tasks.

Current tasks are listed in descending CPU time order. For each task, you can see the task number, transaction ID, and CPU usage, based on the time set in the Task CPU Time threshold window. Since this is current usage, the usage may change every time the panel refreshes. Press Enter or F5 to refresh the data displayed on the panel.

Abnormally high CPU usage by your CICS system as a whole or by any single transaction may indicate errors. You must evaluate CPU usage indicated in the panel based on your own knowledge and prior measurements. When you observe excessive usage, you can select the offending task by placing the Show Details (S) action code next to the task number and pressing Enter. The Task Details panel then displays.

If you suspect that a task is looping, you can kill that task. See the OMEGAMON II for CICS User’s Guide for procedure on killing tasks.

**Note:** The CPU Time field is not highlighted for excluded tasks. See the GLOBAL_OPTIONS macros and parameter section in the OMEGAMON II for CICS Configuration and Customization Guide for information on excluding tasks.
CPU

CPU Rates pushbuttons

The CPU Rates panel contains pushbuttons that navigate to the following panels:

- Working Set Size and Paging Rates
- CICS Address Space Information
- CICS Job Information
- CICS Address Space TCBs
- MVS Loaded Modules
- MVS Resources
- XRF Information

All the pushbuttons that appear on CPU Rates also appear on all the panels to which you navigate using the pushbuttons.

The following sections describe each panel.

Working Set Size and Paging Rates panel

The Working Set Size and Paging Rates panel displays when you select the Paging pushbutton on CPU Rates.

This panel displays statistics about the private and common areas of the CICS address space. Use this panel to see the paging rate and storage usage and to determine if the working set size or paging rate needs adjustment.

See “Paging” on page 351 for more information on this panel.
CICS Address Space Information panel

The CICS Address Space Information panel displays when you select the ASID pushbutton on CPU Rates. The following figure shows the panel.

**FIGURE 169. CICS Address Space Information Panel**

This panel displays general information about the CICS address space.

Use this panel to see the statistics about the CICS address space.
CICS Job Information panel

The CICS Job Information panel displays when you select the Job pushbutton on CPU Rates. The following figure shows the panel.

FIGURE 170. CICS Job Information Panel

This panel displays information about CICS as an active MVS job. It contains information relative to MVS, JES, and VTAM.

Use this panel to see statistics about the general operation of the CICS job.
The CICS Address Space TCBs panel displays when you select the TCBs pushbutton on CPU Rates. The following figure shows the panel.

**FIGURE 171. CICS Address Space TCBs Panel**

This panel displays information about the TCB (task control block) structure within the CICS address space.

A task control block (TCB) is a dispatchable unit of work and is created by an MVS ATTACH macro. If a task attaches another task, the attacher is known as a mother task and the attachee is known as a daughter task. If the mother task attaches a second task, this then becomes the daughter task’s sister task.

Running a program under a separate TCB allows a certain amount of independence from other programs running in the same address space, such as the ability to be dispatched and perform work even though the other tasks are waiting.

Use this panel to analyze the structure of CICS TCBs and to assess how program is performing. Since many third-party products attach multiple TCBs, you can also use this panel to locate where they are attached.

To display PSW (program status word) and general purpose register contents for the selectable TCB entry, enter **S** next to its TCB Description. The TCB Details panel displays.
The following TCBs are selectable for CICS/ESA when they exist as follows:

- Resource-owning. The CICS/ESA TCB that performs all file opens and closes.
- Quasi-reentrant. The CICS/ESA TCB under which all user application code runs.
- Concurrent. The CICS/ESA TCB that services VSAM file requests.

For CICS/MVS, the Jobstep TCB is selectable.

**TCB Details panel**

The TCB Details panel displays when you select a selectable field on the CICS Address Space TCBs panel. The following figure shows the panel.

**FIGURE 172. TCB Details Panel**

This panel displays PSW (program status word) and general purpose register contents for the selected TCB.

This panel can assist you in debugging CICS problems such as loops and unusual waits.

Select the PSW and Registers fields to display storage contents for the associated task. The CICS Memory panel displays.
MVS Loaded Modules panel

The MVS Loaded Modules panel displays when you select the Modules pushbutton on CPU Rates. The following figure shows the panel.

**FIGURE 173. MVS Loaded Modules Panel**

This panel displays information about the modules that have been loaded by MVS into the CICS address space.

The list does not include modules from the DFHRPL concatenation which are loaded by CICS's own loader and are placed into DSA storage.

Modules loaded after CICS initialization can cause the region to abend if not enough free virtual storage is left.

Some of these modules include monitors, security package routines, and programming language service modules.

You can inspect the modules by placing the Show Details (S) action code next to the entry address of the load module you want to examine.
The MVS Resources panel displays when you select the MVS Resources push-button on CPU Rates.

This panel displays information about MVS resource consumption within the CICS address space. This information is for the last OMEGAMON II cycle.

Use this panel to see the system resources that your CICS address space used for the last OMEGAMON II cycle.

See “MVS Resources and the System Console” on page 233 for more information on this panel.

The XRF Information panel displays when you select the XRF pushbutton on CPU Rates.

This panel displays summary information on the active (primary) and alternate CICS systems.

See “XRF (Extended Recovery Facility)” on page 406 for more information on this panel.
DASD

Select DASD from the Region Status panel to see the status of DASD devices allocated to CICS. You can use this information to observe how devices respond to the demands of CICS as it competes with the rest of the jobs in the system.

CICS DASD Performance panel

The CICS DASD Performance panel displays when you select DASD from the Region Status panel. The following figure shows the panel.

FIGURE 174. CICS DASD Performance Panel

The table in the first section of the panel contains two fields used to indicate the number of DASD devices accessed by CICS that are either not ready or not responding.

The table in the second section displays the DASD response time and DASD percent busy for certain volumes. The volumes that appear depend on the options selected from the View pull-down menu and whether “CICS” or “ALL” DASD is specified on the DASD resource threshold panel. The range for the response time graph varies according to the threshold settings.

If the number of devices flagged as “not ready” or “not responding” is not zero, position the cursor at the appropriate field and press Enter to display a list of the failing devices. Problems of this kind usually occur as a result of hardware errors or power failure and should be resolved immediately.
Three solutions to DASD problems

The time taken to perform an I/O request to a DASD device, usually measured in milliseconds, far exceeds that needed to execute a segment of code, usually measured in micro- or nanoseconds.

Since most CICS transactions perform some I/O to application and/or CICS datasets, delays in DASD response time will have a very significant impact on the overall response and throughput of the entire CICS system.

Following are three solutions to DASD problems and suggestions on how each may be implemented:

- Reduce the number of physical and logical I/O operations.
- Tune the dataset definitions and allocations on the volume.
- Balance the I/O operations.

Reduce I/O

To reduce I/O, follow these guidelines:

- use LSR and allocate additional buffers
- use data tables
- use Main temporary storage
- minimize program compressions
- redesign online application programs
- minimize CI/CA splits
- use caching

Tune I/O

To perform tuning of I/O, follow these guidelines:

- Specify correct CI size; this should be large if access is primarily sequential and smaller if random access is more common.
- De-fragment datasets spread over multiple extents of the same volume.
- Specify location of VTOC correctly.

Balance I/O

To balance I/O, follow these guidelines:

- Spread high-use datasets across multiple volumes; for example, temporary storage.
- Minimize use of DASD volumes shared by multiple processors.
- Locate batch and online files on separate volumes.
- Place data and index components of VSAM KSDSs on separate volumes.
- Place concurrently used datasets on separate volumes.
Tuning guidelines

If the number of devices flagged as not ready or not responding is not zero, position the cursor at the appropriate field and press Enter to display a list of the failing devices (the CICS DASD Status panel displays; see “CICS DASD Status Panel” on page 304). Problems of this kind usually occur as a result of hardware errors or power failure and should be resolved immediately.

The following generalized guidelines may be useful for tuning your system:

- Average DASD response time: < 40 ms
- DASD percent busy (random access): < 35 ms

Select the DASD resource threshold panel and specify that only CICS DAS should be displayed. Then sort the list by descending response time. The resulting table will show you which devices have exceeded the thresholds you’ve set, with those having the greatest potential impact on transaction response time listed first.

To obtain details such as the number of CICS datasets that reside on the volume, select each device in the order displayed. Select the CICS Open DCBs field on the DASD Details for a Device panel to determine the names of the datasets and whether any of them are heavily used as indicated by the EXCP count.

To assess whether external contention is a problem, return to the CICS DASD Performance panel and select the I/O Rate pushbutton to obtain a comparison of the total I/O rate to the CICS I/O rate. If the total I/O rate greatly exceeds that of CICS, consider moving heavily used CICS datasets to an alternate volume.

To obtain a breakdown of the four DASD response time components, select the Statistics pushbutton. The DASD Statistics panel displays.

If there are devices that are busy more than 50% of the time, you may want to move heavily used CICS datasets to a less used volume.
CICS DASD Status panel

The CICS DASD Status panel displays when you select either the CICS DASD Not Ready or CICS DASD Not Responding fields on the CICS DASD Performance panel. The following figure shows the panel.

**FIGURE 175. CICS DASD Status Panel**

This panel displays a list of devices that are either not responding to CICS I/O requests, or have entered the dropped ready state.

The performance of a telecommunications system such as CICS is highly dependent on the timely completion of I/O requests. Should an I/O issued to any DASD device allocated to CICS take longer than one OMEGAMON II cycle to complete, a line of status information concerning the device will be presented. Suppose, for example, that CICS issues an I/O against volume CICS02, which is currently RESERVEd by another CPU. If the same I/O is seen waiting for the device over two consecutive OMEGAMON II cycles, it will be reported as not responding.

When a device is not responding to I/O requests, it is likely to be the result of shared DASD contention. Check the RESERVE status of the device to determine whether the device is being held exclusively by another user. If the job issuing the RESERVE does not require a lock on CICS datasets, consider moving the CICS files to some other volume.

If RESERVE is not at issue, the problem may be caused by head-of-string contention. The current allocation and open DCB columns can assist in deciding whether there are too many tasks trying to access data on the device. If a large number of I/O bound jobs are simultaneously attempting to perform reads and writes against a volume containing CICS datasets, the performance of CICS may suffer. In such a case, move some of the CICS datasets to alternate volumes in an effort to balance I/O activity.

Finally, see if the current user column indicates that one or two jobs are monopolizing the device. If most of the I/O activity can be traced back to a couple of I/O intensive users, it might
be a good idea to move the datasets associated with those jobs to some other volume, thus minimizing their impact on CICS.

A device in the dropped ready state may indicate a hardware problem such as a power supply failure. Such a state may also be the result of the switch being turned off at the device. Some standard responses to a dropped ready device are as follows:

- Vary the device online if access to the master console is available.
- On 3350s and 3375s, press the Attention key. No external controls are provided on newer devices.

Select any listed device to obtain details that include the number of CICS datasets residing on the volume. The DASD Details for a Device panel displays (see “DASD Details for a Device panel” on page 307). On that panel, select the CICS Open DCBs field to determine specifically which datasets are being affected. The CICS Datasets on a DASD Volume panel displays (see “CICS Datasets on a DASD Volume panel” on page 307).

**CICS DASD Performance pushbuttons**

The CICS DASD Performance panel contains pushbuttons that navigate to the following panels.

- DASD I/O Rate
- DASD Statistics

All the pushbuttons that appear on CICS DASD Performance also appear on all the panels to which you navigate using the pushbuttons.

The following sections describe these panels.

**DASD I/O Rate panel**

The DASD I/O Rate panel displays when you select the I/O Rate pushbutton on CICS DASD Performance.

This panel presents a comparison of total I/O rates with CICS I/O rates to assess whether or not external contention is a problem. The volumes that appear depend on the options selected from the View pull-down menu and whether “CICS” or “ALL” DASD is specified on the DASD resource threshold panel.

See “I/O Rate” on page 401 for more information on this panel.
DASD Statistics panel

The DASD Statistics panel displays when you select the Statistics pushbutton on CICS DASD Performance. The following figure shows the panel.

FIGURE 176. DASD Statistics Panel

<table>
<thead>
<tr>
<th>Device</th>
<th>Volume</th>
<th>%Busy</th>
<th>Avg Q</th>
<th>Avg I/O</th>
<th>Pending</th>
<th>Connect</th>
<th>Disconn.</th>
<th>Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>14B</td>
<td>OMON27</td>
<td>2%</td>
<td></td>
<td></td>
<td>1ms</td>
<td>5ms</td>
<td>10ms</td>
<td>17ms</td>
</tr>
<tr>
<td>153</td>
<td>OMON29</td>
<td>8%</td>
<td></td>
<td></td>
<td>9ms</td>
<td>1ms</td>
<td>5ms</td>
<td>27ms</td>
</tr>
<tr>
<td>159</td>
<td>OMON30</td>
<td>10%</td>
<td></td>
<td></td>
<td>4ms</td>
<td>7ms</td>
<td>5ms</td>
<td>25ms</td>
</tr>
<tr>
<td>169</td>
<td>TSO002</td>
<td>1%</td>
<td></td>
<td></td>
<td>1ms</td>
<td>6ms</td>
<td>2ms</td>
<td>10ms</td>
</tr>
<tr>
<td>30C</td>
<td>PPSMP3</td>
<td>1%</td>
<td></td>
<td></td>
<td></td>
<td>2ms</td>
<td>2ms</td>
<td>5ms</td>
</tr>
<tr>
<td>31C</td>
<td>OMON23</td>
<td>59%</td>
<td>2</td>
<td>144ms</td>
<td>11ms</td>
<td>5ms</td>
<td>26ms</td>
<td>188ms</td>
</tr>
<tr>
<td>328</td>
<td>OMON24</td>
<td>2%</td>
<td></td>
<td>5ms</td>
<td>7ms</td>
<td>6ms</td>
<td>21ms</td>
<td>41ms</td>
</tr>
<tr>
<td>338</td>
<td>OMON20</td>
<td>8%</td>
<td></td>
<td>5ms</td>
<td>5ms</td>
<td>10ms</td>
<td>25ms</td>
<td>46ms</td>
</tr>
</tbody>
</table>

This panel displays utilization and response time data for either all online DASD or just those devices containing datasets opened by CICS (according to the setting specified on the DASD resource threshold panel). The contents of the panel may be further filtered using the View pull-down menu. The response time is broken down into its four components.

If %Busy frequently exceeds 35% and I/O requests are being delayed, as indicated by the Avg Q Length field, select the device to determine how many CICS datasets reside on the volume and how heavily they are used. Heavily used CICS datasets should be moved to a less busy volume.
The action you should take for DASD devices where the total response time exceeds 40 ms depends on where most of the time is being spent:

<table>
<thead>
<tr>
<th>Column on Panel</th>
<th>Action to Take</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avg I/O Q Time</td>
<td>Indicates a busy device. Consider moving heavily used datasets to a different device.</td>
</tr>
<tr>
<td>Pending Time</td>
<td>Indicates a busy path. Consider moving volumes to balance string use.</td>
</tr>
<tr>
<td>Connect Time</td>
<td>Indicates excessive data transfer time. Check poor dataset blocking and inefficient applications.</td>
</tr>
<tr>
<td>Disconnect Time</td>
<td>Indicates probable excessive seek time or a rotation position sensing (RPS) miss. Check concurrent use dataset conflicts, poor VTOC placement, path contention, fragmented extents, and so forth.</td>
</tr>
</tbody>
</table>

**DASD Details for a Device panel**

The DASD Details for a Device panel displays when you select an item in the Device column of the CICS DASD Performance panel, the DASD I/O Rate panel, or the DASD Statistics panel.

This panel displays device details and a response time graph for a single DASD unit. The response time is broken down into its four components.

Both the device and volume fields allow input. Either can be changed to obtain a detail report for any given device. However, if both device and volume are entered, device will always take precedence.

Entering S in the CICS Open DCBs field on the DASD Details for a Device panel navigates to the CICS Datasets on a DASD Volume panel. See “CICS Datasets on a DASD Volume panel” on page 404 for information on this panel.

See “DASD Details for a Device panel” on page 403 for more information on the DASD Details for a Device panel.

**CICS Datasets on a DASD Volume panel**

The CICS Datasets on DASD Volume panel displays when you select the CICS Open DCBs field on the DASD Details for a Device panel.

This panel displays every dataset allocated by CICS on the specified device. An EXCP count, along with a graphical representation of the same, is presented for each CICS dataset on the volume.

See “CICS Datasets on a DASD Volume panel” on page 404 for more information on this panel.
Select DB2 from the Region Status panel to learn the current status of the DB2 attachment to the CICS region and see statistical information for transactions that are currently accessing DB2 activity. The following figure shows the panel that displays.

FIGURE 177. DB2 Activity Panel

This panel displays the parameters used to define the CICS-DB2 connection and the control characteristics contained in the Resource Control Table (RCT). In addition, a selectable list of CICS transaction IDs that access DB2 is presented, along with information specific to each of those transaction IDs.

You can use the information on this panel to confirm that the CICS-DB2 connection has been defined properly, and that DB2 activity for this CICS is within expected ranges.

Several of the fields on this panel have thresholds that will allow you to highlight activity that is outside acceptable ranges for your environment. You can set critical and warning values for these fields in the DB2 Thresholds pop-up window (see "Thresholds" in the OMEGAMON II for CICS User’s Guide for the procedure on setting thresholds).

The DB2 Attached at Shutdown field will alert you to this condition, which has the potential to halt CICS shutdown processing. Thresholds for each transaction ID can be set for Max Active Threads, % of Aborts, % of Waits, and % Threads in Use.
DB2 Transaction Details panel

Each field in the Tran ID column on the DB2 Activity panel is selectable and navigates to the DB2 Transaction Details panel. The following figure shows the panel.

FIGURE 178. DB2 Transaction Details Panel

This panel displays DB2-related definitions and usage patterns for a specified CICS transaction ID. Note that this information is for a transaction ID, rather than for a CICS task.

You can use the information on this panel to confirm that the CICS-DB2 connection for this transaction ID has been defined properly, and that DB2 activity for this transaction ID is within expected ranges.

Overtypes the displaying transaction ID to view information for a different transaction ID, or press F4 to see a list of transaction IDs for which DB2 information is available.
Select DBCTL on the Region Status panel to see the status of the DBCTL attachment to the CICS region. The panel that displays, DBCTL Activity, also identifies the DBCTL address space. The following figure shows the panel.

**FIGURE 179. DBCTL Activity Panel**

This panel identifies the DBCTL address space and the status of the CICS DBCTL interface. Key information regarding the DBCTL definition is displayed, as well as usage information for the previous DBCTL session.

You can compare the information on this panel to expected or target values to confirm that DBCTL has been properly defined to CICS, and that activity for the DBCTL region is within expected ranges.

Select the DBCTL Tasks pushbutton to view a list of CICS tasks that are interfacing with DBCTL.
The DBCTL Tasks pushbutton at the bottom of the DBCTL Activity panel navigates to the DBCTL Tasks panel. The following figure shows the panel.

FIGURE 180. DBCTL Tasks Panel

This panel displays a scrollable list of all CICS tasks that are using DBCTL. Each task represents a DBCTL thread. The panel shows the DBCTL request type, and tells whether the task is suspended in DBCTL.

If you suspect a problem in DBCTL, you can use the information on this panel to identify tasks that are using DBCTL. Additional information for each task, such as whether the task is suspended in DBCTL, can help you identify a DBCTL problem.
Select DL/I on the Region Status panel to see information about local DL/I activity, including resource use within the three IMS pool types: DMB, PSB, and ENQ. You can also see active DL/I tasks. The following figure shows the panel.

**FIGURE 181. DL/I Activity Panel**

This panel displays information about DL/I activity for local DL/I in the currently-monitored CICS region. It describes resources that are available to DL/I, and shows how DL/I has used those resources DMB Pool information, PSB Pool information, and ENQ Pool information are presented, along with DL/I thread information.

You can use this panel to see how DL/I threads and resource pools are being utilized. High percentages of pool or thread utilization may be an early indication that these resources are underallocated.

This panel also shows active DL/I calls. If either the current value or high-water mark for active DL/I calls is higher than expected, it may mean that DL/I throughput would benefit from additional resources. Other fields on this panel will tell you whether tasks have had to wait for specific resources. You should consider the number of tasks that have had to wait for resources when deciding whether additional resources should be allocated.
**DL/I pushbuttons**

The DL/I Activity panel contains pushbuttons that navigate to the panels listed below.

- CICS Tasks Using DL/I
- DL/I Configuration
- DL/I ISAM/OSAM Buffers
- DL/I Interface Addresses
- DL/I Interface ECBs
- DL/I Databases

All the pushbuttons that appear on DL/I Activity also appear on all the panels to which you navigate using the pushbuttons.

The following sections describe each panel.

**CICS Tasks Using DL/I panel**

The following sections describe each panel. When you select the CICS Tasks pushbutton on DL/I Activity, the CICS Tasks Using DL/I panel displays. The following figure shows the panel.

**FIGURE 182. CICS Tasks Using DL/I Panel**

This panel displays information about CICS tasks that use local DL/I services. Each task is displayed with information on the nature and status of DL/I resources used by the task.

The information on this panel can be used to monitor the progress of tasks using DL/I services. You may be able to identify an application problem by analyzing the ISB Status field for all tasks displayed.

Additional information is available for each task displayed.
DL/I Configuration panel

The DL/I Configuration panel displays when you select the Config pushbutton on DL/I Activity. The following figure shows the panel.

FIGURE 183. DL/I Configuration Panel

This panel displays information describing the way the local DL/I system is configured for the CICS that is being monitored.

The information on this panel can be used to confirm that the configuration parameters for this system have been set properly.
DL/I ISAM/OSAM Buffers panel

The DL/I ISAM/OSAM Buffers panel displays when you select the Buffers pushbutton on DL/I Activity. The following figure shows the panel.

FIGURE 184. DL/I ISAM/OSAM Buffers Panel

This panel displays information about ISAM/OSAM buffers that are used for DL/I I/O operations for this region. The panel displays information describing buffer size and I/O activity for each buffer.

If you are using VSAM buffers for your database I/O, you can find information about VSAM buffers in the LSR Pools panel. Navigate to this panel by selecting LSR from the Region Status panel.

The information on this panel can be used to tune buffer allocations for ISAM/OSAM buffers. If the Lookaside Ratio is too low, it may indicate that throughput could be improved by allocating more buffers of a certain size. If the I/O information shows buffers with no activity, investigation may reveal that buffers of this size are unnecessary.
DL/I Interface Addresses panel

The DL/I Interface Addresses panel displays when you select the Addresses pushbutton on DL/I Activity. The following figure shows the panel.

FIGURE 185. DL/I Interface Addresses Panel

This panel displays selectable addresses for various control blocks, pools, and modules that are used in the DL/I interface.

The panel displays additional control block addresses for the last CICS task that used DL/I.

Each field on this panel is selectable. Selecting an address will take you to a view of that address in storage. Being able to see the values of these structures in memory can aid you in determining the cause of a DL/I problem.
DL/I Interface ECBs panel

The DL/I Interface ECBs panel displays when you select the ECBs pushbutton on DL/I Activity. The following figure shows the panel.

**FIGURE 186. DL/I Interface ECBs Panel**

```
<table>
<thead>
<tr>
<th>ECB Name</th>
<th>Description</th>
<th>POST Status</th>
<th>Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>DLPSTECB</td>
<td>Single thread</td>
<td>Posted</td>
<td>_ 0034A134</td>
</tr>
<tr>
<td>DLPPSECW</td>
<td>PSB pool wait</td>
<td>Not set</td>
<td>_ 0034A26C</td>
</tr>
<tr>
<td>DLPISECB</td>
<td>PSB/DMB pool</td>
<td>Not set</td>
<td>_ 0034A13C</td>
</tr>
<tr>
<td>DLPSBECB</td>
<td>PSB scheduling</td>
<td>Not set</td>
<td>_ 0034A214</td>
</tr>
<tr>
<td>DLISBECD</td>
<td>Free ISB</td>
<td>Not set</td>
<td>_ 0034A215</td>
</tr>
<tr>
<td>DLSCHECB</td>
<td>Scheduling code</td>
<td>Not set</td>
<td>_ 0034A216</td>
</tr>
<tr>
<td>DLDBDECB</td>
<td>DB quiesce</td>
<td>Not set</td>
<td>_ 0034A219</td>
</tr>
<tr>
<td>DLDSTECB</td>
<td>DFSDST hold</td>
<td>Not set</td>
<td>_ 0034A21A</td>
</tr>
<tr>
<td>DLPSOECB</td>
<td>DBRC signon</td>
<td>n/a</td>
<td>_ n/a</td>
</tr>
<tr>
<td>DLPRCECB</td>
<td>DBRC SYNC</td>
<td>Not set</td>
<td>_ 0034A1E8</td>
</tr>
</tbody>
</table>
```

This panel displays information about the most important ECBs that the DL/I interface uses to control its processing. Current POST status and the selectable ECB address is shown for each ECB.

Waiting ECBs can have a significant adverse effect on DL/I task throughput. You can use this panel to identify ECBs that are persistently waiting. This information, along with an understanding of the ECB’s function within the DL/I interface, may enable you to identify the cause of poor throughput.
**DL/I Databases panel**

The DL/I Databases panel displays when you select the DBDs pushbutton on DL/I Activity. The following figure shows the panel.

**FIGURE 187. DL/I Databases Panel**

This panel displays information about local DL/I databases defined to this system. For each database it displays counts of I/O activity.

You may be able to spot a problem on this panel if counts of I/O activity are not in line with your expectations. Use the View pull-down to sort the display by the count you are interested in to get a quick idea of which databases may have unusually high or unusually low I/O counts.

If you require additional information on any database, select the Database ID field (enter S) to see a detail panel for that database. The DL/I Database Details panel displays. See “DL/I Database Details panel” on page 319 for information on this panel.
DL/I Database Details panel

The DL/I Database Details panel displays when you select a database ID in the DL/I Databases panel. The following figure shows the panel.

FIGURE 188. DL/I Database Details Panel

This panel displays detail information about a selected DL/I database. It provides complete counts of I/O activity for this database, as well as additional information on how the database is defined and used.

You can use the information on this panel to confirm that the database has been properly defined to CICS, and that I/O activity for this database is within expected ranges.

The DMB address and In-core address are selectable. Select either of these fields (enter **S**) to display the data at these addresses.
Files

Select Files on the Region Status panel to see the status of files based upon the thresholds of the following performance measures:

- File strings % in use
- File string current waits
- File string % waits vs I/O
- VSAM CA splits/interval (data)
- VSAM CI splits/interval (data)
- VSAM extents/interval (data)
- VSAM CA, CI splits, extents (index)

Enter an S to display information about open VSAM files, including string waits, splits, and extents.

Open VSAM Files panel

When you select Files on the Region Status panel, the Open VSAM Files panel displays, which shows a summary of all open VSAM files for the CICS region. The following figures show the panel for CICS/ESA Versions 4 and 5.1.0.

FIGURE 189. Open VSAM Files Panel (CICS/ESA Version 4)
This panel displays information that would indicate file response time degradation for all opened VSAM files, including files not defined in the FCT (File Control Table).

Except for Current String Waits, String Waits vs. I/O, and Current Strings in Use, the information is based on activity occurring during the last measured interval. The time when statistics for splits and extents were collected and its duration are shown at the top of the panel.

Observe any occurrences of string waits and CI/CA splits, especially on critical files. These events will cause any task accessing these files to wait.

File access is often the slowest part of CICS response time and therefore should be monitored and well tuned. See the chapter called "File Analysis," in Part 2 of the OMEGAMON II for CICS Reference Manual for more information on VSAM files.
Open VSAM Files pushbuttons

The Open VSAM Files panel contains pushbuttons that navigate to the following panels:

- Datasets Allocated to CICS
- VSAM String Waits
- LSR Buffer Waits
- Local Shared Resources Pools

All the pushbuttons that appear on Open VSAM Files also appear on each panel to which you navigate using the pushbuttons.

The following sections describe each panel.

Datasets Allocated to CICS panel

When you select the Datasets pushbutton on Open VSAM Files, the Datasets Allocated to CICS panel displays.

This panel displays a summary of datasets allocated to the CICS region. It includes the ddname, dataset name, volume and attributes.

See “Journals” on page 330 for more information on this panel.

VSAM String Waits panel

When you select the String Waits pushbutton on Open VSAM Files, the VSAM String Waits panel displays. The following figure shows the panel.

![FIGURE 191. VSAM String Waits Panel](image)

This panel displays all tasks currently experiencing string waits, including owners and waiters.
This information can help you determine if too few strings have been defined for the file or if an application program is having a problem while accessing the file.

If a task owns a string, enter S next to the task number for detailed task information. You can then see if the task is in a wait condition and thereby locking out other tasks that are waiting for strings. The Task Details panel displays. See “Task Details panel” on page 258 for information on this panel.

**LSR Buffer Waits panel**

The LSR Buffer Waits panel displays when you select the Buffer Waits pushbutton on Open VSAM Files. The following figure shows the panel.

**FIGURE 192. LSR Buffer Waits Panel**

This panel displays files which are currently experiencing LSR buffer waits. The number of tasks currently waiting for LSR buffers and the highest number of tasks that have been waiting for LSR buffers are displayed for each file.

Information appears only for files that are defined in the FCT.

Type S next to a file to see detailed information. The File Details panel displays. The information on this panel tells you which LSR pool the file is using, and helps you tune the number of LSR buffers. See “File Details panel (prior to CICS/ESA 5.1.0)” on page 336 for information on this panel.

**Local Shared Resources (LSR) Pools panel**

The Local Shared Resources (LSR) Pools panel displays when you select the LSR pushbutton on Open VSAM. This panel displays summary information about the LSR pools that have been built in CICS for both VSAM files and local DL/I databases. It shows both CICS and VSAM information, providing a statistical analysis of your LSR pools.

See “Local Shared Resources (LSR)” on page 338 for more information on this panel.
VSAM Details panel

You can select a file ID on the Open VSAM Files panel to see details for a particular file. The VSAM Details panel then displays.

FIGURE 193. VSAM Details Panel

Note: The fields displayed vary according to whether or not this file uses LSR facilities.

If the file uses LSR facilities, this panel displays information on VSAM KSDS (key sequenced datasets). If not, the panel displays information on non-KSDS VSAM datasets.

If LSR facilities are used, this panel provides a convenient means of verifying the attributes of any KSDS defined to your system. If not, this panel allows you to verify the attributes of any non-KSDS VSAM file defined to your system.

If this is a heavily used file and transactions accessing it are suffering from poor response time, select the Volume Serial field to obtain details for the DASD device. If there is contention indicated by the total number of open DCBs or the device has a high % busy value, consider moving this dataset to an alternate volume, perhaps on a less busy channel.

The DDname and Dataset Name fields may be overtyped to obtain information on different files. If both fields are overtyped, the overtyped DDname will take precedence.

To assist you in identifying potential problems, you may assign thresholds to the fields displaying the number of splits and extents by selecting the Files/VSAM Thresholds pop-up through the Options pull-down, or by entering fast path commands on the command line. If LSR facilities are not used, you may assign thresholds to the field displaying the number of additional extents that were taken in the last interval.

Note: The fields displayed vary according to whether or not this file uses LSR facilities.
VSAM Data Component Statistics panel

When you select the Data Component Name field on VSAM Details, the VSAM Data Component Statistics panel displays. The following figure shows the panel.

**FIGURE 194. VSAM Data Component Statistics Panel**

This panel displays detailed information about one of the following:

- the data component of a VSAM KSDS file (key sequenced dataset) which uses LSR facilities
- the data component of a VSAM KSDS file which does not use LSR facilities
- a VSAM file which is not a KSDS dataset

CI and CA splits can occur for a KSDS dataset. CI splits and, to a greater degree, CA splits can degrade the response time of transactions accessing a file. You should reorganize a file with sufficient freespace in each CI and CA if you notice frequent occurrences of splits.

If the file uses Local Shared Resources (LSR), you can enter **S** next to the Share Control field to obtain information on the LSR pool.

The DDname and Dataset name may be overtyped to obtain information on different files. If both fields are overtyped, the overtyped DDname will take precedence.

Select the Data Allocation pushbutton for detailed information on the allocation for the data component of this VSAM KSDS file. The VSAM Data Component Allocation panel displays. See “VSAM Data Component Allocation panel” on page 326 for information on this panel.
Select the Index Statistics pushbutton for detailed information about the index component of this VSAM KSDS file. The VSAM Index Component Statistics panel displays. See “VSAM Index Component Allocation panel” on page 328 for information on this panel.

Select the Index Allocation pushbutton for detailed information on the allocation for the index component of this VSAM KSDS file. The VSAM Index Component Allocation panel displays. See “VSAM Index Component Allocation panel” on page 328 for information on this panel.

**VSAM Data Component Allocation panel**

Select the Data Allocation pushbutton on the VSAM Data Component Statistics panel to see the VSAM Data Component Allocation panel. The following figure shows the panel.

*FIGURE 195. VSAM Data Component Allocation Panel*

This panel displays detailed allocation information about the data component of a VSAM KSDS (key sequenced dataset) file, or detailed allocation information about a VSAM file which is not a KSDS dataset.
When you select the Index Component Name field on the VSAM Details panel, the VSAM Index Component Statistics panel displays. The following figure shows the panel.

**FIGURE 196. VSAM Index Component Statistics Panel**

This panel displays detailed information about the index component of a VSAM KSDS file (key sequenced dataset) that uses LSR facilities, or it displays information for a VSAM KSDS file that does not use LSR facilities.

CI and CA splits can occur for a KSDS dataset. CI splits and, to a greater degree, CA splits can degrade the response time of transactions accessing a file. You should reorganize a file with sufficient freespace in each CI and CA if you notice frequent occurrences of splits.

If the file uses LSR facilities, you can obtain information on the LSR pool by entering S next to the Share Control field. The LSR Buffer Pool Details panel displays.

The DDname and Dataset Name fields may be overtyped to obtain information on different files. If both fields are overtyped, the overtyped DDname will take precedence.

Select the Data Statistics pushbutton for detailed information about the data component of this VSAM KSDS file. The VSAM Data Component Statistics panel displays. See “VSAM Data Component Statistics panel” on page 325 for information on this panel.

Select the Data Allocation pushbutton for detailed information on the allocation for the data component of this VSAM KSDS file. The VSAM Data Component Allocation panel displays. See “VSAM Data Component Allocation panel” on page 326 for information on this panel.
Select the Index Allocation pushbutton for detailed information on the allocation for the index component of this VSAM KSDS file. The VSAM Index Component Allocation panel displays. See “VSAM Index Component Allocation panel” on page 328 for information on this panel.

**VSAM Index Component Allocation panel**

Select the Index Allocation pushbutton on VSAM Index Component Statistics to see the VSAM Index Component Allocation panel. The following figure shows the panel.

**FIGURE 197. VSAM Index Component Allocation Panel**

This panel displays detailed allocation information about the index component of a VSAM KSDS file (key sequenced dataset).

The DDname and Dataset Name fields may be overtyped to obtain information on different files. If both fields are overtyped, the overtyped ddname will take precedence.

Select the Data Statistics pushbutton for detailed information about the data component of this VSAM KSDS file. The VSAM Data Component Statistics panel displays. See “VSAM Data Component Statistics panel” on page 325 for information on this panel.

Select the Data Allocation pushbutton to see detailed information on the allocation for the data component of this VSAM KSDS file. The VSAM Data Component Allocation panel displays. See “VSAM Data Component Allocation panel” on page 326 for information on this panel.

Select the Index Statistics pushbutton for detailed information about the index component of this VSAM KSDS file. The VSAM Index Component Statistics panel displays. See “VSAM Index Component Allocation panel” on page 328 for information on this panel.
VSAM Details pushbuttons

The VSAM Details panel may contain pushbuttons that navigate to the following panels:

- File Control Table Entry
- File Control Table Entry–Statistics
- File Control Table Entry–Logging
- File Control Table Entry–Data Table

These pushbuttons appear only if the file has a file control table entry (FCTE).

All the pushbuttons that appear on VSAM Details also appear on all the panels to which you navigate using the pushbuttons.

The following sections describe each panel.

File Control Table Entry (FCTE) panel

The FCT Entry panel displays when you select the FCTE pushbutton on VSAM Details. This panel shows details about one file in the CICS system by displaying the contents of a File Control Table (FCT) entry.

The panel gives details about a file so that you can see if the file is correctly defined and its current status.

See “File Control Table Entry (FCTE) panel” on page 129 for more information on this panel.

FCT Entry–Statistics panel

The FCT Entry–Statistics panel displays when you select the FCTE Statistics pushbutton on VSAM Details.

This panel shows usage statistics for a file in the CICS system and gives details about the activity for a file. It can be useful in determining if a file is waiting for buffers or for strings.

See “File Control Table Entry – Statistics” on page 130 for more information on this panel.

FCT Entry–Logging panel

The FCT Entry–Logging panel displays when you select the FCTE Logging pushbutton on VSAM Details.

This panel shows what logging is being done for one file in the CICS system.

The panel indicates if logging is being done for the file and, if so, what journal is being used for the log.

See “File Control Table Entry – Logging” on page 131 for more information on this panel.

FCT Entry–Data Table panel

The FCT Entry–Data Table panel displays when you select the FCTE Data Table pushbutton on VSAM Details.

This panel shows details about the data table used for this file.

Use this panel to view the usage statistics for the data table.

See “File Control Table Entry – Data Table” on page 132 for more information on this panel.
This section describes the Journals selection on the Region Status panel for all supported versions of CICS.

CICS/ESA 5.1.0 uses the MVS system logger, thereby making journal datasets (including DFHJ01x) of earlier CICS versions redundant. Instead, journal datasets are replaced by MVS system logger log streams. The journal control table (JCT) is also redundant, and the journal entries in the JCT are replaced by journal model resource definitions in the CICS system definition (CSD) file.

**Journals panel (CICS/ESA 5.1.0)**

The Journals panel is the initial OMEGAMON II panel that displays data based on the CICS/ESA log manager domain. This domain replaces the journal control management function of prior CICS versions. The log manager works with the MVS system logger, available in MVS/ESA 5.2, to provide a focal point for all system log, forward recovery log, and user journal output within a single MVS sysplex.

With OMEGAMON II for CICS, you can now display information about:

- the system log and general logs
- currently connected MVS log streams
- specific CICS journals for problem analysis

If you are using CICS/ESA 5.1.0, select Journals from the Region Status panel to see a summary of the usage and status of the system log and general logs. The Journals panel is shown in the following figure.

**FIGURE 198. Journals Panel (CICS/ESA 5.1.0)**

![Journals Panel (CICS/ESA 5.1.0)](image-url)
An authorized user can perform the following actions against the journals listed on the panel by typing the appropriate action code (E, I, F, or R) in the entry field preceding each journal name:

- Enable journal
- Disable journal
- Flush journal
- Reset journal

For CUA function level security, resource cicsname.KC2.MEM.CEMT controls user authorization for the actions. For menu system security, you control user authorization for the actions by restricting access to the CMT command.

To see whether a journal has experienced a log stream failure, check the Journal Status column. If log stream failures occur, consult the MVS systems programmer for your site.

To sort the panel by journal name, journal status, system log, journal type, or log stream name, select the View pull-down from the action bar and enter the action code for the items you want to sort.

CICS automatically creates a user journal as a log-of-logs, DFHLGLOG, which contains copies of the file control tie-up records for recoverable files and log stream exception information. This provides data set recovery products such as CICSVR with the information required for recovery control without the need to scan the large amounts of data on the forward recovery logs.

In a sysplex environment, the log-of-logs should be a single log stream shared by all CICS regions that use the same set of recoverable data sets. You can define the log stream to be used by the log-of-logs in a journal model resource definition. Specify the journal name parameter as DFHLGLOG.

If you do not want CICS to write a log-of-logs, specify a journal model resource definition with a journal name of DFHLGLOG and a type of Dummy.

**Journals panel pushbuttons**

The Journals panel contains pushbuttons that navigate to the following panels:

- Log Streams
- Journal Models

All the pushbuttons that appear on the Journals panel also appear on all the panels to which you navigate using the pushbuttons.

Each panel you can navigate to using these pushbuttons is described below.
**Log Streams panel**

The Log Streams panel displays information about currently connected MVS log streams. It displays the log stream name, whether or not a system log is mapped to a displayed MVS log stream name, whether or not a log stream has failed, and the use count. This panel contains no selectable fields and is shown in the following figure.

**FIGURE 199. Log Streams Panel**

To sort the panel by log stream name, system log, stream failed or use count, select the View pull-down from the action bar and enter the action code for the items you want to sort.

**Journal Models panel**

The Journal Models panel displays information on installed journal models, which are defined as resources in the CICS system definition file (CSD). A journal model resource definition provides the association between a CICS journal name and the associated physical log streams managed by the MVS system logger, or between the journal name and the SMF log. See the IBM *CICS for MVS/ESA Resource Definition Guide* for more information on defining journal models.

The Journal Models panel, shown in the following figure, includes the journal model name, template name, journal type, and prototype log stream name. The panel has no selectable fields.
To sort the panel by journal model, journal name, journal type, and log stream name, select the View pull-down from the action bar and enter the action code for the items you want to sort.

**Journal Details panel (CICS/ESA 5.1.0)**

The Journal Details panel shows detailed information on a CICS journal. To display the Journal Details panel, type action code `S` in the entry field preceding the journal name on the Journals panel. The following figure shows the Journal Details panel.

**FIGURE 201. Journal Details Panel**
Setting thresholds (CICS/ESA 5.1.0)

To change the threshold settings for journal descriptions, from the Region Status panel, type L next to the Journals resource and press Enter. The Journals Thresholds panel is displayed. Type over the existing settings and press Enter.

Analyzing journal problems

To display information about journal problems, follow these steps:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>From the Region Status panel, type A next to the Journals resource and press Enter. <strong>Result:</strong> The Analyze Journals Problems panel displays.</td>
</tr>
<tr>
<td>2</td>
<td>From the Analyze Journals Problems panel, type S next to the problem description you want more information about and press Enter. <strong>Result:</strong> The Journals Details panel displays. If the journal status is Failed, the Failure reason field provides information which may help you resolve the problem. Authorized users can also use the actions from the Actions pull-down menu to help resolve problems.</td>
</tr>
</tbody>
</table>
Datasets allocated to CICS panel (prior to CICS/ESA 5.1.0)

If you are using a CICS version prior to CICS/ESA 5.1.0, select Journals from the Region Status panel to see a summary of the datasets allocated to the CICS region. When you navigate to this panel, it is filtered to show only journal datasets, as shown in the following figure.

FIGURE 202. Datasets Allocated to CICS Panel

---

Note: If you are using CICS/ESA 5.1.0, the fast path for this panel is =RFA.

This panel displays the ddname, dataset name, volume and attributes.

For more information on a particular journal dataset, enter S next to the dataset name.

To sort the display or to limit it to a specific or generic ddname, high-level dsname, volume, or disposition, select the View pull-down from the action bar and enter the action code of the items you want to sort.

Datasets Allocated to CICS pushbuttons

The Datasets Allocated to CICS panel contains pushbuttons that navigate to the following panels:

- Open VSAM Files
- VSAM String Waits
- LSR Buffer Waits
- Local Shared Resources (LSR) Pools

The following sections describe each panel.
Open VSAM Files panel

This panel displays information that would indicate file response time degradation for all opened VSAM files, including files not defined in the FCT (File Control Table).

Except for Current String Waits, String Waits vs. I/O, and Current Strings in Use, the information is based on activity occurring during the last measured interval. For more information on this panel, see “Open VSAM Files panel” on page 339.

VSAM String Waits panel

This panel displays all tasks currently experiencing string waits, including owners and waiters.

This information can help you determine if too few strings have been defined for the file or if an application program is having a problem while accessing the file.

For more information on this panel, see “VSAM String Waits panel” on page 339.

LSR Buffer Waits panel

This panel displays files which are currently experiencing LSR buffer waits. The number of tasks currently waiting for LSR buffers and the highest number of tasks that have been waiting for LSR buffers are displayed for each file.

Information appears only for files that are defined in the FCT.

See “LSR Buffer Waits panel” on page 339 for more information on this panel.

Local Shared Resources (LSR) Pools panel

This panel displays summary information about the LSR pools that have been built in CICS for both VSAM files and local DL/I databases. It shows both CICS and VSAM information, providing a statistical analysis of your LSR pools.

See “Local Shared Resources (LSR)” on page 338 for more information on this panel.

File Details panel (prior to CICS/ESA 5.1.0)

You can select a ddname listed on the Datasets Allocated to CICS panel to get further information on a journal dataset. In fact, this panel provides a convenient means of verifying the attributes of any dataset defined to your system.

If the ddname you selected is for a non-VSAM file or is VSAM and not open, the File Details panel displays. If the ddname is an open VSAM file, the VSAM Details panel displays. A figure of the File Details panel appears below; a figure for the VSAM Details panel can be found in “VSAM Details panel” on page 324.
FIGURE 203. File Details Panel

This panel displays information on non-VSAM and closed VSAM datasets obtained from the CICS TIOT and from format-1 DSCBs from the VTOC on the DASD device.

The Related Information box displays information dependent on the dataset type.

If this is a heavily used file and transactions accessing it are suffering from poor response time, select the Volume Serial field to obtain details for the DASD device. If the total number of open DCBs suggests that contention may be a problem, or the device has a high % busy value, consider moving this dataset to an alternate volume, perhaps on a less busy channel.

The DDname, Dataset Name and Concatenation Index fields may be overtyped to obtain information on different files. If both the DDname and Dataset Name fields are overtyped, the overtyped ddname will take precedence.
Local Shared Resources (LSR)

Select LSR from the Region Status panel to display summary information about the local shared resources pools (LSR) that have been built in CICS for both VSAM files and local DL/I databases.

The following figure shows the Local Shared Resources (LSR) Pools panel:

**FIGURE 204. LSR Pools Panel**

<table>
<thead>
<tr>
<th>Pool ID</th>
<th>Pool Status</th>
<th>Open</th>
<th>%Active</th>
<th>Tasks Waiting</th>
<th>Successful Lookasides</th>
<th>Buffer Reads</th>
<th>Lookaside Ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td>01</td>
<td>Created</td>
<td>1</td>
<td>0%</td>
<td>0</td>
<td>1</td>
<td>8</td>
<td>11%</td>
</tr>
<tr>
<td>02</td>
<td>Notbuilt</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>03</td>
<td>Notbuilt</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>04</td>
<td>Created</td>
<td>1</td>
<td>0%</td>
<td>0</td>
<td>63</td>
<td>6</td>
<td>91%</td>
</tr>
<tr>
<td>05</td>
<td>Created</td>
<td>9</td>
<td>55%</td>
<td>0</td>
<td>5176</td>
<td>2713</td>
<td>66%</td>
</tr>
<tr>
<td>06</td>
<td>Notbuilt</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>07</td>
<td>Notbuilt</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>08</td>
<td>Notbuilt</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

This panel shows both CICS and VSAM information, providing a statistical analysis of your LSR pools.

The number of successful lookasides is one of the important statistics for LSR pools. The higher this number, the less I/O is performed. The Lookaside Ratio field will appear red or yellow if it is below its corresponding threshold. One way to improve the lookaside ratio is to increase the number of buffers for those sizes that have a low lookaside ratio.

If you are experiencing response time problems caused by string waits (see the Tasks Waiting column), you should increase the number of strings.

*Note:* Allocating more strings than your application needs will waste virtual storage.
LSR Pools pushbuttons

The LSR Pools panel contains pushbuttons that navigate to the panels listed below.

- Open VSAM Files
- Datasets Allocated to CICS
- VSAM String Waits
- LSR Buffer Waits

The following sections describe each panel.

Open VSAM Files panel

This panel displays information that would indicate file response time degradation for all opened VSAM files, including files not defined in the FCT (File Control Table).

Except for Current String Waits, String Waits vs. I/O, and Current Strings in Use, the information is based on activity occurring during the last measured interval. For more information on this panel, see “Open VSAM Files panel” on page 320.

Datasets Allocated to CICS panel

This panel displays a summary of datasets allocated to the CICS region. It includes DDname, dataset name, volume and attributes.

For more information on a particular dataset, enter S next to the dataset name.

You can sort the display or limit it to a specific or generic DDname, high-level dsname, volume, or disposition. For more information on this panel, see “Journals” on page 330.

VSAM String Waits panel

This panel displays all tasks currently experiencing string waits, including owners and waiters.

This information can help you determine if too few strings have been defined for the file or if an application program is having a problem while accessing the file.

For more information on this panel, see “VSAM String Waits panel” on page 322.

LSR Buffer Waits panel

This panel displays files which are currently experiencing LSR buffer waits. The number of tasks currently waiting for LSR buffers and the highest number of tasks that have been waiting for LSR buffers are displayed for each file.

Information appears only for files that are defined in the FCT.

See “LSR Buffer Waits panel” on page 323 for more information on this panel.
Local Shared Resources (LSR)

**LSR Buffer Pool Details panel**

The LSR Buffer Pool Details panel displays when you select a particular pool ID on the LSR Pools panel. The following figure shows the panel.

**FIGURE 205. LSR Buffer Pool Details Panel**

This panel displays detailed information about the selected LSR pool. To view another pool, enter the pool number in the Pool ID field. Press F4 for a list of currently defined pools.

If you are experiencing response time problems caused by string waits (Tasks Waiting field), you should increase the number of strings.

**Note:** Allocating more strings than your application needs will waste virtual storage.

To view statistics information about VSAM buffers, and hiperspace buffers if defined, select the appropriate field in the section of the panel titled Buffer Counts. See “Buffer counts selections” on page 341 for information on each panel that displays from these fields.
Buffer counts selections

The Buffer Counts section of the LSR Buffer Pool Details panel contains six fields that you can select to view statistics information about VSAM buffers, and hiperspace buffers if defined. The following sections describe the panels that display after you select the fields.

LSR Data Buffers panel

The LSR Data Buffers panel displays when you select the Data Buffers field on LSR Buffer Pool Details. The following figure shows the panel.

This panel displays the data buffer statistics for the selected LSR pool. Data buffers are separate from index buffers when defined by CED in CICS/ESA.

The number of successful lookasides is one of the important statistics for LSR pool. The higher this number, the less I/O is performed. The lookaside ratio field will appear red or yellow if it is below its corresponding threshold. One way to improve the lookaside ratio is to increase the number of buffers for those sizes that have a low lookaside ratio.

If you are experiencing response time problems caused by string waits (Tasks Waiting field), you should increase the number of strings.

Note: Allocating more strings than your application needs will waste virtual storage.
LSR Index Buffers

The LSR Index Buffers panel displays when you select the Index Buffers field on LSR Buffer Pool Details. The following figure shows the panel that displays.

FIGURE 207. LSR Index Buffers Panel

This panel displays the index buffer statistics for the selected LSR pool. Index buffers are separate from data buffers when defined by CEDA in CICS/ESA.

The number of successful lookasides is one of the important statistics for LSR pool. The higher this number, the less I/O is performed. The lookaside ratio field will appear red or yellow if it is below its corresponding threshold. One way to improve the lookaside ratio is to increase the number of buffers for those sizes that have a low lookaside ratio.

If you are experiencing response time problems caused by string waits (Tasks Waiting field), you should increase the number of strings.

Note: Allocating more strings than your application needs will waste virtual storage.
LSR Compound Buffers

The LSR Compound Buffers panel displays when you select the Compound Buffers field on LSR Buffer Pool Details. The following figure shows the panel that displays.

FIGURE 208. LSR Compound Buffers Panel

This panel displays the compound buffer statistics for the selected LSR pool. A compound buffer is shared by the data and index components and is created with the macro resource definition.

The number of successful lookasides is one of the important statistics for LSR pool. The higher this number, the less I/O is performed. The lookaside ratio field will appear red or yellow if it is below its corresponding threshold. One way to improve the lookaside ratio is to increase the number of buffers for those sizes that have a low lookaside ratio.

If you are experiencing response time problems caused by string waits (Tasks Waiting field), you should increase the number of strings.

Note: Allocating more strings than your application needs will waste virtual storage.
LSR Hiperspace Data Buffers

The LSR Hiperspace Data Buffers panel displays when you select the Hiperspace Data Buffers field on LSR Buffer Pool Details. The following figure shows the panel.

![Figure 209. LSR Hiperspace Data Buffers Panel](image)

This panel displays the hiperspace data buffer statistics for the selected LSR pool. Hiperspace data buffers are separate from hiperspace index buffers when defined by CEDA in CICS/ESA.

The number of successful lookasides is one of the important statistics for LSR pool. The higher this number, the less I/O is performed. The lookaside ratio field will appear red or yellow if it is below its corresponding threshold. One way to improve the lookaside ratio is to increase the number of buffers for those sizes that have a low lookaside ratio.

If you are experiencing response time problems caused by string waits (Tasks Waiting field), you should increase the number of strings.

**Note:** Allocating more strings than your application needs will waste virtual storage.
LSR Hiperspace Index Buffers

The LSR Hiperspace Index Buffers panel displays when you select the Hiperspace Index Buffers field on LSR Buffer Pool Details. The following figure shows the panel.

FIGURE 210. LSR Hiperspace Index Buffers Panel

This panel displays the hiperspace index buffer statistics for the selected LSR pool. Hiperspace index buffers are separate from hiperspace data buffers when defined by CEDA in CICS/ESA.

The number of successful lookasides is one of the important statistics for LSR pool. The higher this number, the less I/O is performed. The lookaside ratio field will appear red or yellow if it is below its corresponding threshold. One way to improve the lookaside ratio is to increase the number of buffers for those sizes that have a low lookaside ratio.

If you are experiencing response time problems caused by string waits (Tasks Waiting field), you should increase the number of strings.

Note: Allocating more strings than your application needs will waste virtual storage.
LSR Hiperspace Compound Buffers

The LSR Hiperspace Compound Buffers panel displays when you select the Hiperspace Compound Buffers field on LSR Buffer Pool Details. The following figure shows the panel.

**FIGURE 211. LSR Hiperspace Compound Buffers Panel**

This panel displays the hiperspace compound buffer statistics for the selected LSR pool. A hiperspace compound buffer is shared by the hiperspace data and index components, and is created with the macro resource definition.

The number of successful lookasides is one of the important statistics for LSR pool. The higher this number, the less I/O is performed. The lookaside ratio field will appear red or yellow if it is below its corresponding threshold. One way to improve the lookaside ratio is to increase the number of buffers for those sizes that have a low lookaside ratio.

If you are experiencing response time problems caused by string waits (Tasks Waiting field), you should increase the number of strings.

**Note:** Allocating more strings than your application needs will waste virtual storage.
MRO/ISC

CICS can communicate with other systems in two ways: through intersystem communication (ISC) and multiregion operation (MRO). Whichever method is used, each remote system must be defined by a terminal control table system entry (TCTSE).

A given system may gain access to the resources of a remote system by using one of the following types of facilities:

- Function shipping
- Asynchronous processing
- Transaction routing
- Distributed transaction processing (DTP)
- Distributed program link

Not all facilities are available for all forms of intercommunication, and there are some restrictions for DTP under MRO that do not apply under ISC. For more information, refer to the IBM CICS Intercommunication Guide.

When you select MRO/ISC from the Region Status panel, the Terminal Control Table System Entries panel displays. The following figure shows the panel.

FIGURE 212. Terminal Control Table System Entries Panel

This panel displays a list of all remote systems to which this system has access. The status and type of each connection is displayed with statistics showing current and past availability.

The XLN Status column indicates whether an Exchange Logname Status exception has occurred or not. This exception is enabled or disabled by entering L before MRO/ISC on the...
Region Status panel, and indicates that an LU 6.2 connection between two CICS regions has failed.

If tasks are abended or otherwise unable to access the resources owned by a remote system, ensure that the system status is in service and, if ISC, is acquired.

Poor response time will occur if tasks need to wait for a link to the remote system. If waits occur frequently or the number of links in use is 100%, this may be due to performance problems in the remote system leading to increased task lifetimes.

It may be that, for those systems to which 100% of links are in use, the remedy is to simply define additional links to increase the number of sessions between this and the remote system. However, before doing so, display the Task summary panel and look for tasks that are waiting on a resource type of IRLINK with a resource name of SYSIDNT. If these tasks remain suspended, it is possible that an associated task in the other region is not responding because the task there has been suspended. Identify the task in the remote region and determine the resource on which it is waiting. See “Tasks” on page 257 for information on the Tasks summary panel.

In the case of distributed transaction processing (DTP) applications, poor program design may also lead to waits for links because links are not being freed when no longer required.

**TCT System Entry panel**

This panel displays when you select a system ID in the Terminal Control Table System Entries panel. The following figure shows the panel.

**FIGURE 213. TCT System Entry Panel**

![TCT System Entry Panel](image-url)
This panel displays summary information contained within a TCTSE describing a remote system with which the system being monitored can communicate.

If the % links in use remains at 100% for prolonged periods, while the waits for links are increasing, it is possible that the bottleneck is being caused by slow response from the remote system. This may be caused by isolated or system-wide problems in the remote region, such as bottlenecks for specific resources or an SOS (short-on-storage) condition.

Use the Task summary panel to see which tasks are monopolizing the links. Then return to the Region Status panel to change the region name for the remote system to determine why those tasks are being suspended. See “Tasks” on page 257 for more information.

If the task summary shows that the links are servicing tasks as expected but you are still experiencing response time problems due to waits for links, try increasing the number of sessions between this and the remote region.

Select the TCTSE Statistics pushbutton for an analysis of the different requests made to the remote region. The TCTSE Statistics panel displays. See “TCTSE Statistics panel” on page 350 for information on this panel.
TCTSE Statistics panel

The TCT System Entry panel contains a pushbutton for TCTSE Statistics, which navigates to the TCT System Entry Statistics (TCTSE) panel. This panel shows the activity statistics for one TCT system entry.

A system entry describes all the characteristics of one communications connection defined to CICS. The following figure shows the panel.

FIGURE 214. TCTSE Statistics Panel

```
--- Actions GoTo Index Options Help
------------------------------------- 06/16/93 16:51:03
KC2P47D TCT System Entry Statistics Region: CICSPROD
Fastpath: =RMS Auto(60)

System Statistics
-------------------------------------^--------------------------------------
| System ID . . . . . . CS40 + | TCTSE address . . . . : 0606E288 |
| Terminal type . . . . : System | Terminal model . . . . : None |

-------------------------------------^--------------------------------------
| Primary links . . . . : 10 | Secondary links . . . . : 10 |
| Primary links in use : 1 | Secondary links in use : 0 |
| Number of AIDs queued : 0 | DL/I request . . . . . : 0 |
| Max allocs outstanding: 0 | FC request . . . . . . : 0 |
| Failed link allocates : 0 | IC request . . . . . . : 0 |
| Queued link allocates : 0 | TD request . . . . . . : 0 |
| Total link allocates : 0 | TS request . . . . . . : 0 |

<TCTSE> (TCTSE Statistics)
F1=Help F2=Keys F3=Exit F4=Prompt F5=Refresh F6=Console F10=Action Bar
F11=Print F15=Region Status
```
Paging

Select Paging on the Region Status panel to display the Working Set Size and Paging Rates panel. This panel presents statistics about the private and common areas of the CICS address space. The following figure shows the panel.

FIGURE 215. Working Set Size and Paging Rates Panel

Use this panel to see the paging rate and storage usage and to determine whether the working set size or paging rate needs adjustment.

The paging rate is of primary concern because CICS transactions wait until the page fault is resolved. Some paging is normal, but excessive paging can cause response time degradation. The type of processor you have determines whether the paging rate is excessive.

If your CICS region is defined in a performance group where storage isolation is in effect, you can see its minimum, maximum, and target working set size values. For more information on working set size, see the IBM MVS Initialization and Tuning Guide and the IBM CICS Performance Guide.
Working Set Size and Paging Rates pushbuttons

The Working Set Size and Paging Rates panel contains pushbuttons that navigate to the following panels:

- CPU Rates
- CICS Address Space Information
- CICS Job Information
- CICS Address Space TCBs
- MVS Loaded Modules
- MVS Resources
- XRF Information

All the pushbuttons that appear on the Working Set Size and Paging Rates panel also appear on all the panels to which you navigate using the pushbuttons.

The following sections describe each panel.

CPU Rates panel

The CPU Rates panel displays when you select the CPU pushbutton on Working Set Size and Paging Rates. This panel displays information about CICS CPU usage.

The first section of the panel presents a breakdown of the CICS CPU rate into TCB (task control block) and SRB (service request block) times for the last OMEGAMON II cycle. The second section displays a table of CPU usage by CICS tasks.

See “CPU” on page 293 for more information on this panel.

CICS Address Space Information panel

The CICS Address Space Information panel displays when you select the ASID pushbutton on Working Set Size and Paging Rates. This panel displays general information about the CICS address space.

Use this panel to see the statistics about the CICS address space.

See “CICS Address Space Information panel” on page 295 for more information on this panel.

CICS Job Information panel

The CICS Job Information panel displays when you select the Job pushbutton on Working Set Size and Paging Rates. This panel displays information about CICS as an active MVS job. It contains information relative to MVS, JES, and VTAM.

Use this panel to see statistics about the general operation of the CICS job.

See “CICS Job Information panel” on page 296 for more information on this panel.
CICS Address Space TCBs panel
The CICS Address Space TCBs panel displays when you select the TCBs pushbutton on Working Set Size and Paging Rates. This panel displays information about the TCB (task control block) structure within the CICS address space.

A task control block (TCB) is a dispatchable unit of work and is created by an MVS ATTACH macro.

Use this panel to analyze the structure of CICS TCBs and to assess how program is performing. Since many third-party products attach multiple TCBs, you can also use this panel to locate where they are attached.

See “CICS Address Space TCBs panel” on page 297 for more information on this panel.

MVS Loaded Modules panel
The MVS Loaded Modules panel displays when you select the Modules pushbutton on Working Set Size and Paging Rates. This panel displays information about the modules that have been loaded by MVS into the CIC address space.

The list does not include modules placed into the DSA by CICS’s own loader.

Modules loaded after CICS initialization can cause the region to abend if not enough free virtual storage is left.

Some of these modules include monitors, security package routines, and programming language service modules.

See “MVS Loaded Modules panel” on page 299 for more information on this panel.

MVS Resources panel
The MVS Resources panel displays when you select the MVS Resources pushbutton on Working Set Size and Paging Rates. This panel displays information about MVS resource consumption within the CICS address space. This information is for the last OMEGAMON II cycle.

Use this panel to see the system resources that your CICS address space used for the last OMEGAMON II cycle.

See “MVS Resources and the System Console” on page 233 for more information on this panel.

XRF Information panel
The XRF Information panel displays when you select the XRF pushbutton on Working Set Size and Paging Rates. This panel displays summary information on the active (primary) and alternate CICS systems.

See “XRF (Extended Recovery Facility)” on page 406 for more information on this panel.
Select Storage from the Region Status panel to display the CICS Storage panel. The following figure shows the panel that displays for CICS Version 4.

This figure shows the panel that displays for CICS Version 3.3.
FIGURE 217. CICS Storage Panel (CICS Version 3)

This figure shows the panel that displays for CICS/MVS.
This panel presents an overview of storage usage and storage problems for the CICS region, including the percentage of DSA and EDSA allocated, the availability of MVS address space storage, and some information on storage violations and short-on-storage (SOS) conditions. For CICS/MVS, the panel also contains statistics on storage above and below the 16MB line.

If DSA or EDSA utilization is high, or CICS is running short-on-storage, select whichever DSA is affected (for CICS/MVS, you can select only the DSA field) to display storage allocation by CICS components.

For CICS/MVS, if the program compression rate is high, select the Program Compression field to see compression history for the last 5 minutes.

If Largest Free LSQA or OSCOR is low (if outside their thresholds for CICS/MVS), select the Free OSCOR field to display an overview of address space storage.

Select the Storage Violations field to display transactions and terminals experiencing storage violations.
Storage Violations panel

The Storage Violations panel displays when you select the Storage Violations field on the CICS Storage panel. The following figure shows the panel.

**FIGURE 219. Storage Violations Panel**

<table>
<thead>
<tr>
<th>Resource</th>
<th>Type</th>
<th>Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>_CECI</td>
<td>Transaction</td>
<td>5</td>
</tr>
<tr>
<td>_CEMT</td>
<td>Transaction</td>
<td>21</td>
</tr>
<tr>
<td>_LV21</td>
<td>Terminal</td>
<td>3</td>
</tr>
<tr>
<td>_BUG1</td>
<td>Transaction</td>
<td>1</td>
</tr>
<tr>
<td>_BUG2</td>
<td>Transaction</td>
<td>1</td>
</tr>
<tr>
<td>_LV01</td>
<td>Terminal</td>
<td>15</td>
</tr>
<tr>
<td>_LV03</td>
<td>Terminal</td>
<td>2</td>
</tr>
<tr>
<td>_LV44</td>
<td>Terminal</td>
<td>3</td>
</tr>
</tbody>
</table>

This panel shows an overview of storage violations experienced in this CICS region, including the total number of violations since the last time statistics were reset (when monitoring CICS/ESA) or during the life of the CICS region (when monitoring CICS/MVS), and total numbers of violations for each transaction or terminal that has experienced a storage violation during this period.

Select resources (whether terminals or transactions) that have experienced violations to obtain details about the particular resource. This may help identify the application or program that is causing storage corruption.

If a particular transaction or set of transactions is causing storage violations, you may want to disable the transactions associated with the failing application to protect other applications from storage corruption and the performance impact of storage violation dumps.
**DSA Storage panel**

The DSA Storage panel displays when you select either DSA or EDSA from the Area column of the CICS Storage panel for CICS Version 4 and above. The following figure shows the panel.

**FIGURE 220. DSA Storage Panel**

This panel displays information about the amount and type of storage each DSA is using.

**Recommendation:** If you see an SOS condition, consider increasing the DSALIM or EDSALIM parameters in the SIT.
Program Compressions panel

The Program Compressions panel displays when you select the Program Compressions/min. field on the CICS/MVS version of the CICS Storage panel (see “CICS Storage Panel (CICS/MVS)” on page 356). The following figure shows the panel.

FIGURE 221. Program Compressions Panel

This panel displays details of program compressions over the previous 5 minutes of CICS execution. It shows the number of program compressions in the last 5 minutes, the total number of program compressions for this CICS execution, and gives a numerical and graphical display of the number of compressions in each of the last 5 minutes.

A high number of program compressions is usually an indication of storage constraint in the DSA. This may be simply because of insufficient storage, or may be due to other factors (typically, response time problems causing tasks to hold storage for longer periods than usual).

You should take the following actions to reduce storage constraint:

- increase the size of the DSA
- move CICS workloads into other regions (for example, move applications or implement MRO)
- take steps to improve transaction response time
### Address Space Storage panel

The Address Space Storage panel displays when you select the Free OSCOR field on the CICS Storage panel. The following figures show the panel for CICS Version 3 and CICS Version 4.

**FIGURE 222. Address Space Storage Panel (CICS Version 3)**

<table>
<thead>
<tr>
<th>Area</th>
<th>Address Range</th>
<th>Available</th>
<th>Unalloc.</th>
<th>Frag. Free</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extended private</td>
<td>08300000 - 7FFFFFFF</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ELSQA/SWA</td>
<td>08E2FFFFF - 7FFFFFFF</td>
<td>1811M</td>
<td>4K</td>
<td>60K</td>
</tr>
<tr>
<td>ELSQA/SWA/USER</td>
<td>09D29FFF - 0E2FFFFF</td>
<td>71512K</td>
<td></td>
<td></td>
</tr>
<tr>
<td>User</td>
<td>08300000 - 09D29FFF</td>
<td></td>
<td>0K</td>
<td>54K</td>
</tr>
<tr>
<td>_ ERLDSA</td>
<td>09457000 - 09C56FFF</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>_ EUDSA</td>
<td>08C57000 - 09456FFF</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>_ ECDSA</td>
<td>08457000 - 08C56FFF</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Private</td>
<td>00005000 - 006FFFFF</td>
<td></td>
<td>0K</td>
<td>57K</td>
</tr>
<tr>
<td>LSQA/SWA</td>
<td>005BFF00 - 005FFFFF</td>
<td></td>
<td>0K</td>
<td></td>
</tr>
<tr>
<td>LSQA/SWA/USER</td>
<td>00458FFFF - 005FFFFF</td>
<td>2456K</td>
<td></td>
<td></td>
</tr>
<tr>
<td>User</td>
<td>00005000 - 00458FFF</td>
<td></td>
<td>0K</td>
<td>33K</td>
</tr>
<tr>
<td>_ UDSA</td>
<td>0013A000 - 00139FFF</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>_ CDSA</td>
<td>0003A000 - 00139FFF</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

F1=Help  F2=Keys  F3=Exit  F5=Refresh  F6=Console  F10=Action Bar  F11=Print  F15=Region Status
This panel displays details of the allocation of MVS storage within the CICS address space. Information about various storage areas in the CICS address space is shown, including (for the CICS Version 3 panel only) information on the dynamic storage areas managed by CICS storage management. These storage areas are:

- **DSA**
- **EDSA**
- **CDSA**
- **UDSA**
- **ECDSA**
- **EUDSA**
- **ERDSA**

**Note:** *DSA fields do not appear on the panel for CICS Version 4.*

This information includes the range of addresses available in each area and the available, unallocated, and fragmented free storage associated with each MVS storage area. See “MVS storage area” on page 362 for more information.

Select one of the DSA fields (you can select only DSA for CICS/MVS) to see details of storage allocation within CICS-managed storage.

If the storage available in any area appears to be insufficient for your system’s needs, you may need to reallocate storage within your CICS address space.
MVS storage area

An MVS storage area is a portion of virtual storage that exists within a range of addresses (the upper and lower boundaries of the area). Each MVS storage area is used to manage storage requests for a set of MVS storage subpools.

There are two broad categories of MVS storage areas: Common areas, which occupy the same range of addresses in, and are accessible to, all MVS address spaces, and private storage areas, which are contained within a single MVS address space. Most CICS-related storage is contained in the private areas of CICS address spaces (also known as CICS regions).

The private areas of an address space are divided into extended private (above the 16M line) and private (below the 16M line) areas, each of which is further divided into a system and user area. This results in the following private MVS storage areas existing in each address space:

- Extended private
  - System area (ep)
  - (available storage)
  - User area (ep)
- Private
  - System area (p)
  - (available storage)
  - User area (p)

Each area may contain virtual storage that is allocated (that is, in use), unallocated, or that makes up fragmented free space in the area. Between each user and system area is available virtual storage that has not yet been allocated to any MVS storage area.

User area (extended private)

The extended private user area is an MVS storage area that is allocated from the lowest available address in extended private storage (just above extended common storage) and grows "upwards" towards the top of extended private storage as additional user area storage is requested. Storage in this area is user-requested storage, which in the case of CICS will be CICS control blocks and modules, MVS control blocks and whatever is required to execute CICS, plus the EDSA, ECDSA, EUDSA, and ERDSA, which hold storage obtained from MVS and is then managed by CICS storage management.

As stated, this user area grows "upwards" towards the top of extended private storage, while the system area grows "downwards" towards the bottom of storage. The virtual storage between the two areas is considered to be available storage. However, the user area can only grow to a certain extent as it is limited by a "user area limit" value. This value is set in the installation exit IEFUSI. (The IBM-supplied default exit sets a user area limit of 32MB above the top of common storage.)

The user area can also expand until its upper bound meets the lower bound of the system area. In practice this is unlikely, as the extended private area is so large that the system area is unlikely to expand below the user area limit.
Note that since there is a limit to the expansion of the user area but no limit to expansion of the system area, available storage is divided into two portions: storage into which the system area can expand and storage into which either the system area or user area can expand.

**MVS storage subpool**

MVS storage subpools are used to supply storage with the appropriate characteristics in response to storage allocation requests (for example, MVS GETMAIN requests). Each subpool is assigned a number that is specified during storage requests either explicitly or via default values. Each storage subpool has a set of characteristics associated with it. Examples of such characteristics include:

- MVS storage area (which holds the subpool)
- Pageable or fixed
- Fetch protected (or not)
- Storage protection key to use
- When the storage is freed
- Below or above the 16MB line (or anywhere)

Storage is allocated to a subpool in multiples of 4K-byte pages so all storage areas on a given page must belong to the same subpool.

The *IBM Authorized Assembler Programming Guide* lists MVS storage subpools and their characteristics.
Storage Allocation by Components panel

The Storage Allocation by Components panel displays when you select a storage area from the Area column on the CICS Storage panel. The following figure shows the panel for CICS/ESA.

FIGURE 224. Storage Allocation by Components Panel

For CICS/ESA, this panel shows an overview of the storage used in a DSA broken down by the major CICS components that consume storage. For each component, the total storage allocated for that component and the percentage of the DSA this consumes is displayed. For CICS/MVS, this panel shows an overview of the storage used in the DSA, broken down by storage subpools. For each subpool the total storage allocated for the subpool and the percentage of the DSA this consumes is displayed. This panel also displays the amount of storage allocated for the DSA, the amount of free space remaining, and the largest contiguous piece of free storage.

For CICS/ESA, if the storage consumption of any components are outside their thresholds, select those components to get a breakdown of the components’ storage usage by individual storage subpool.

For CICS/MVS, if the storage consumption of program or task-related storage is outside thresholds, select the components to get a breakdown of the storage usage.
Storage Subpools panel
The Storage Subpools panel displays when you select a CICS component from the Storage Allocation by Components panel. The following figure shows the panel.

This panel shows the breakdown of a particular storage component group in a DSA by individual storage subpool names. For each subpool, the panel displays the total storage allocated for that subpool, the amount of storage used, the number of getmain and freemain requests, and the total number of storage elements that make up the subpool.

If storage usage in the monitored DSA is outside its thresholds, unusually high or low allocations in one or more subpools may help indicate the cause of the problem. The function of individual subpools is described in the IBM Performance Guide for the appropriate CICS release.
**Storage Allocation by Tasks panel**

The Storage Allocation by Tasks panel displays when you select Task from the Component column on the Storage Allocation by Components panel. The following figure shows the panel.

**FIGURE 226. Storage Allocation by Tasks Panel**

Each row in this panel shows information about an individual task, including the task number assigned to the task by CICS, the current number of storage elements allocated to the task, and the amount of storage allocated to the task both above and below the 16MB line.

Select an individual task to display statistics about storage usage by that task.

Use the View pull-down to display a subset of tasks or to change the order in which tasks are displayed.

**Storage Allocation by Components pushbuttons**

The Storage Allocation by Components panel contains pushbuttons that navigate to the following panels:

- Page Allocation Map
- Storage Details
- Allocations

All the pushbuttons that appear on Storage Allocation by Components also appear on all the panels to which you navigate.

The following sections describe each panel.
The Page Allocation Map panel displays when you select the PAM pushbutton on Storage Allocation by Components. The following figures show the panel for CICS Version 3 and CICS Version 4.

**FIGURE 227. Page Allocation Map Panel (CICS Version 3)**
This panel displays the Page Allocation Map (PAM) for a particular DSA. In the panel, each page is represented by a single character position, with the character indicating the storage component group to which the page is allocated. For CICS/MVS, the character indicates the storage subpool to which the page is allocated. This panel also shows the size of the DSA being displayed, the free space available in the DSA, and the size of the largest piece of contiguous free storage.

If you want to examine the contents of a storage page, place the cursor on the page (a character position) you want to select and press Enter. The contents of the page will then be shown in the CICS Memory panel in hexadecimal and EBCDIC translation. See “CICS Memory” on page 207 for information on this panel.
**Storage Details panel**

The Storage Details panel displays when you select the Details pushbutton on Storage Allocation by Components. The following figures show the panel for CICS Version 3 and CICS Version 4.

**FIGURE 229. Storage Details Panel (CICS Version 3)**
This panel displays details of storage allocation and usage within a DSA. For CICS Version 3, the displayed information includes the start and end address of the DSA, and the address of the Page Allocation Map (PAM) control block that controls the DSA. For CICS Versions 3 and 4, the panel shows statistics on storage usage within the DSA.

If CICS is SOS, select the Current Tasks Suspended field to display tasks that are suspended due to lack of storage.

If you are using CICS Version 3, select one of the addresses shown on this panel to browse DSA storage or the PAM control block. The CICS Memory panel displays. See “CICS Memory” on page 207 for information on this panel.

If the statistics shown indicate a problem with storage usage in this DSA, you can navigate to other storage displays by selecting the Components or PAM pushbuttons to determine how DSA storage has been allocated.
**Allocations panel**

The Allocations panel displays when you select the Allocations pushbutton on Storage. Allocations by Components for CICS Version 4. The following figure shows the panel.

**FIGURE 231. Allocations Panel (CICS Version 4)**

This panel shows information on each extent in the selected DSA.
Select Tapes from the Region Status panel to display the Tape Drives panel, which displays all online tape devices, whether they are allocated to CICS or not. The following figure shows the panel.

**FIGURE 232. Tape Drives Panel**

This panel displays information about every online device in the tape configuration.

The top box in this panel displays information on CICS devices only; the bottom box displays information on all tape devices.

Use this panel to analyze which drives are causing delays in CICS due to device errors or the need for operator intervention.

If the number of errors on a device is high, the device probably should be cleaned or adjusted.
Tape Drive Details panel

The Tape Drives Details panel displays when you select a device in the Device column of the Tape Drives panel. The following figure shows the panel.

FIGURE 233. Tape Drive Details Panel

This panel displays information about a specific device in the tape configuration. Operators and system programmers can use this panel to determine why a specific tape drive may be causing delays in the CICS address space.
TempStor (Temporary Storage)

Select TempStor from the Region Status panel to display the Temporary Storage panel, which presents status information about the current use of CICS temporary storage. CICS uses temporary storage for basic mapping support (BMS), diagnostic information review, dynamic log spill message switching, and MRO/ISC local queuing. Applications use temporary storage for scratchpad, data transfer, and queuing.

Moreover, the Temporary Storage panel provides enough information to time dataset allocation, monitor the behavior of applications, and determine whether a resource shortage is causing a bottleneck for tasks attempting to use temporary storage. Figure 234 on page 374 shows the panel.

**FIGURE 234. Temporary Storage Panel**

This panel displays status information about the current use of CICS temporary storage.

The bottom portion of this panel shows the current use of VSAM resources by temporary storage queues.

Use this panel to determine if any of your tasks are waiting due to contention for temporary storage resources. The Tasks Suspended Now field shows whether tasks are currently suspended due to a wait for temporary storage. Enter S next to this field to see tasks that are waiting for temporary storage resources. The Tasks panel displays. See “Tasks” on page 257 for information on this panel.

Tasks requesting temporary storage may be waiting for VSAM strings, VSAM buffers, for physical I/O to the VSAM dataset, or for access to a queue that is in use by another task.
Temporary Storage Pushbuttons

The Temporary Storage panel contains pushbuttons that allow you to navigate to the following panels:

- Temporary Storage Queues
- Auxiliary Temporary Storage
- Temporary Storage Statistics

All the pushbuttons that appear on Temporary Storage also appear on all the panels to which you navigate using the pushbuttons.

The following sections describe each panel.

Temporary Storage Queues panel

The Temporary Storage Queues panel displays when you select the Queues pushbutton on the Temporary Storage panel. The following figure shows the panel.

FIGURE 235. Temporary Storage Queues Panel

This panel lists all the temporary storage queues that exist in this CICS system. For each queue, information such as the name of the queue, its type (that is, its location), and the number of items in the queue is shown.

Use this panel to see the queues that are in use and the size of each queue. If you choose the hexadecimal queue ID display for the panel, CICS services may be used to handle queue problems or access queue information. You can also use this panel to delete queues if you are authorized. Enter D next to the queue you want to delete. A confirmation pop-up will display to confirm the deletion.
Auxiliary Temporary Storage panel

The Auxiliary Temporary Storage panel displays when you select the Auxiliary pushbutton on the Temporary Storage Panel. The following figure shows the panel.

FIGURE 236. Auxiliary Temporary Storage Panel

This panel displays information about the use of auxiliary (VSAM dataset) temporary storage. Auxiliary temporary storage is kept in the DFHTEMP VSAM dataset rather than in main storage.

Usage data is shown for control intervals (CIs), VSAM strings, and VSAM buffers.

Use this panel to guide the tuning of your DFHTEMP VSAM dataset and its associated strings and buffers.

Analysis of the usage of strings and buffers, especially the number of waits tasks experienced to access the queues, might point out the need for changes in the way DFHTEMP is defined or in the number of buffers and strings that are specified on the TS keyword in the SIT.

Look at the % of CIs in Use field to see how close your VSAM dataset is to being full. Consider increasing the size of the DFHTEMP dataset if tasks become suspended due to a lack of auxiliary temporary storage.

Look at the % of Strings in Use field to see how close you are to having applications experience contention due to VSAM string waits.

Look at the % of Buffers in Use field to see how close you are to having applications experience contention due to VSAM buffer waits.
Temporary Storage Statistics panel

The Temporary Storage Statistics panel displays when you select the Statistics pushbutton on the Temporary Storage panel. The following figure shows the panel.

**FIGURE 237. Temporary Storage Statistics Panel**

This panel displays the addresses of the major temporary storage control areas and shows statistics indicating the use of internal temporary storage control structures.

Use this panel to see the usage of the internal control areas used by CICS to manage temporary storage.

**Shared temporary storage statistics (CICS/ESA Version 5.1.0)**

CICS/ESA Version 5.1.0 supports shared temporary storage that allows non-recoverable temporary storage queue data to be kept in a Coupling Facility Resource Manager (CFRM) pool area. You can define more than one pool; each pool is managed by its own server, which runs in its own, non-CICS address space.

You can use the shared temporary storage facility in addition to the existing main and auxiliary CICS storage facilities.

The shared temporary storage facility in OMEGAMON II for CICS includes the following:

- An area on the Temporary Storage Statistics panel displays shared temporary storage statistics.
- The Temporary Storage Table (TST) panel displays the contents of the current TST.
The Shared Temporary Storage Statistics area is displayed on the Temporary Storage Statistics panel when there are shared statistics available. In the example below, one shared temporary storage pool has been defined.

**FIGURE 238. Temporary Storage Statistics Panel (CICS/ESA Version 5.1.0)**

Temporary Storage Table (TST) panel (CICS/ESA Version 5.1.0)

The Temporary Storage Table (TST) panel displays the contents of the current temporary storage table. Use the following procedure to navigate to the Temporary Storage Table (TST) panel from the Region Status panel:

1. From the Region Status panel, pull down the GoTo menu on the action bar and select the CICS Tables option.

2. From the CICS Tables panel, select the TST (Temporary storage table) option.

As an alternative, you can enter fastpath =CO on the action bar of any CUA panel in OMEGAMON II for CICS to display the Temporary Storage Table (TST) panel.

The Temporary Storage Table (TST) panel follows.
FIGURE 239. Temporary Storage Table (TST) Panel (CICS/ESA Version 5.1.0)

<table>
<thead>
<tr>
<th>Entry</th>
<th>Generic</th>
<th>System</th>
<th>Remote</th>
<th>Shared</th>
<th>Shared Pool</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recovery</td>
<td>DF</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Recovery</td>
<td>REC</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote</td>
<td>REM</td>
<td>CS41</td>
<td>REM</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shared</td>
<td>CS41</td>
<td></td>
<td>POOL1</td>
<td>Not Connected</td>
<td></td>
</tr>
<tr>
<td>Shared</td>
<td>CS51</td>
<td></td>
<td>POOL1</td>
<td>Not Connected</td>
<td></td>
</tr>
</tbody>
</table>

Fastpath: =CO
Auto(Off)

F1=Help  F2=Keys  F3=Exit  F5=Refresh  F6=Console  F10=Action Bar  F11=Print
F15=Region Status  PA1=Switch

KC2005D                      Temporary Storage Table (TST)         Region: CICSPROD
Fastpath: =CO
Auto(Off)
TranData (Transient Data)

Select TranData from the Region Status panel to display the Transient Data panel. This panel displays statistics about the capacity and current use of the CICS Transient Data VSAM dataset, including buffer and string information and the percentage of CIs in use. The following figure shows the panel.

FIGURE 240. Transient Data Panel

This panel displays the total number of intrapartition and extrapartition queues defined in this region and some statistics on the current use of intrapartition resources.

If the number of “Queues over trigger level” is exceeding threshold values, this indicates that records are not being removed from queues at a fast enough rate. If this number is low compared with the total number of intrapartition queues, the problem is probably isolated to specific queues. However, a large percentage of queues exceeding their trigger level, in a system which is otherwise unstressed, may indicate problems with transient data resources as whole.

The length of an individual queue may exceed its trigger level for the following reasons:

- The task that reads the queue may be abending. Select Dumps from the Region Status panel to investigate this.
- The task that reads the queue may be assigned an inappropriate priority so that it is not dispatched frequently enough.
- The task that reads the queue may be assigned to a class that limits the number that may be dispatched concurrently, relative to the number of tasks that write to the queue. Consider limiting the number of concurrent tasks that write records, or move the queue reader task to a less restrictive class.
If there is a terminal facility associated with this ATI transaction, it may be out of service and/or released. If so, an AID will be created instead, pending availability of the terminal.

A large percentage of queues exceeding their trigger level, and/or high current usage of buffers, CIs, and strings may indicate that transient data resources require tuning.

This may involve:
- redefining the VSAM ESDS over multiple volumes with or without secondary extents
- increasing the number of strings and/or buffers
- modifying the CI size of the VSAM ESDS

If "CIs % in Use" is high, consider specifying REUSE in the DCT entry for each intrapartition queue.

**Benefit of REUSE**

Unlike temporary storage, each CI of the intrapartition VSAM ESDS may only contain records belonging to the same queue. Specifying REUSE for a destination allows the CI to be used by a different queue when all records in the CI have been read. This can significantly improve performance in a system where a large number of queues have been defined, since tasks will less often have to incur the overhead of handling NOSPACE conditions.

**Effects of recovery**

Intrapartition queues may be defined as recoverable. Physical recovery restores queues in the event of a system failure. Logical recovery, in addition, restores queues in the case of a task failure.

Both forms of recovery may negatively impact performance by forcing additional VSAM I/O. Logical recovery also ties up transient data records for the life of the LUW that enqueues on them.

**Tuning intrapartition transient data**

The CI size of the VSAM ESDS should only be large enough to hold the longest record plus that space which CICS uses. This is especially important when many queues have been defined because each CI can be use by only one queue at a time.

A dataset defined on a single volume with a single extent must be allocated enough space to hold all possible records. To make better use of DASD space, define the dataset with a primary extent large enough to meet average demand and secondary extents for overflow.

I/O response time constitutes one of the major bottlenecks in any CICS system. Performance may be degraded in situations where the VSAM ESDS is defined on a volume containing many other open datasets. A large number of queues with high I/O requirements will also cause a bottleneck when the intrapartition dataset is defined on a single volume.

Select DASD on the Region Status panel to determine if contention is a problem, as indicated by "% busy". This factor will increase task lifetimes and, as a result, the number of buffers, strings, and CIs in use. In this situation, redefine the dataset to use single extents on multiple volumes.
Transient data requests are queued serially. A buffer must be allocated to service each request. Multiple buffers, therefore, allow several requests to different queues to be serviced concurrently.

Also, the use of multiple buffers increases the likelihood that the control interval required by a request is already available in a buffer. This can significantly reduce the number of real VSAM I/O requests that have to be performed.

The number of buffers should be increased to minimize the time a task must wait for one to become available while at the same time making efficient use of storage.

A string is required whenever real I/O is required between a buffer and the VSAM ESDS. Multiple strings allow multiple VSAM requests to occur concurrently, leading to faster servicing of the buffers.

The number of strings can be increased up to the number of buffers defined.

Intrapartition Transient Data Statistics panel

The Statistics pushbutton on the Transient Data panel navigates to the Intrapartition Transient Data Statistics panel. The following figure shows the panel.

FIGURE 241. Intrapartition Transient Data Statistics Panel

This panel displays information reflecting the current state of intrapartition transient data. The addresses of the control blocks from where this information is retrieved are displayed, and may be selected to obtain an unformatted dump of storage at these locations.
The statistics presented fall into three categories:

- current utilization of the VSAM ESDS
- buffer usage representing requests for transient data services
- string usage representing requests for physical I/O to VSAM

If "% of CIs in use" is approaching 100% and the number of "Times NOSPACE returned" is increasing, tasks will either be terminated abnormally or will be suspended when attempting to write to an intrapartition queue, pending the deletion of queues or freeing of CIs. Suspending tasks increases task lifetimes and resource contention and degrades performance. Consider taking the following measures:

- Determine if the task responsible for reading the queue is abending or is suspended due to the unavailability of other resources; for example, enqueues.
- If queues are associated with ATI requiring a terminal, ensure that the terminal is in service, acquired and available.
- Increase the priority of the tasks reading the queues above that of the tasks writing the queues.
- As a last resort, consider deleting certain queues using the CECI DELETEQ TD command.

Before cold starting transient data next, specify REUSE in the DCT definition for eligible queues.

If the current allocation is insufficient, consider redefining the VSAM dataset with a primary allocation on multiple volumes.

A buffer is required to satisfy each request to an intrapartition queue. If many tasks are suspended because a buffer is not available, performance may be improved by increasing the number of strings that service the buffers. The number of strings may be increased to a maximum equal to the number of buffers. However, increasing the number of strings will be of benefit only if the volume on which the VSAM file is defined can handle additional concurrent requests. Display the DASD Details panel for the volume and observe the % Busy and I/O Queue fields.

Increasing the number of buffers may reduce the number of physical I/O requests performed, because the record required may already be present in the buffer. To see the effect of increasing the number of buffers on reducing I/O, compare the "Total buffers used" count with that of the "Total strings used" before and after increasing the number of buffers. The latter equals the sum of the Total Records GET and Total Records PUT fields and will get proportionally smaller as the number of buffers increases.
Destination Queues Over Limits panel

The Destination Queues Over Limits panel displays when you select either the Queues over Trigger Level or Queues over Length Limit fields on the Transient Data panel. The following figure shows the panel.

FIGURE 242. Destination Queues Over Limits Panel

This panel displays summary information and statistics for those intrapartition destinations that have exceeded either or both of the transient data resource thresholds, TD records over trigger and TD queue length.

The length of any intrapartition queue is decremented when a record is read. Therefore, make sure that the transactions that read the queues are enabled and are not abending.

If there is no ATI Tran ID associated with a queue, make sure that the mechanism for initiating the task that reads the queue is operational. For example, a program invoked via the PLTPI may issue an interval control request to start the queue reader task at regular intervals. Make sure that an ICE (interval control element) exists for the task, and consider reducing the time interval between invocations.

If many queues use the same ATI Facility ID (for example, a printer), make sure it is acquired and in service. Consider sharing the workload over additional devices.

To obtain detailed information on a specific entry, select a queue ID and press Enter. The DCT Intrapartition Information panel displays. See “DCT Intrapartition Information panel” on page 122 for information on this panel.
TCP/IP Socket Activity

Select TCP/IP from the Region Status panel to see the status of the TCP/IP socket interface.

The new status light is based on the following thresholds:

FIGURE 243. TCP/IP Thresholds

+---------------------------------------------------------------------+
|   KC2TCPT          TCP/IP Thresholds                                 |
|                                                                     |
|   Type any changes, then press Enter.                                |
|                                                                     |
|   Performance Measure                 Warning  Critical  Monitor +   |
|   ----------------------------        -------  --------  ---------     |
|   TCP/IP user exit not enabled . . .  On +     Off +     No        |
|   TCP/IP listener failed . . . . . .  On +     Off +     No        |
|   TCP/IP application waitig . . . . .  On +     Off +     No        |
|                                                                     |
|   Frequency of data collection . . .  5        (1-99)              |
|                                                                     |
|   F1=Help  F4=Prompt  F5=Refresh  F12=Cancel  F18=Default          |
| +---------------------------------------------------------------------|

The TCP/IP Socket Activity panel displays the details of the TCP/IP connection and the tasks using the TCP/IP sockets user exit.

Following is a sample TCP/IP Socket Activity panel:

FIGURE 244. TCP/IP Socket Activity

<table>
<thead>
<tr>
<th>Task</th>
<th>Tran</th>
<th>Socket</th>
<th>Current</th>
<th>Request</th>
<th>Return</th>
<th>Appl</th>
<th>Listener</th>
</tr>
</thead>
<tbody>
<tr>
<td>_ 80</td>
<td>CSKL</td>
<td>0</td>
<td>READ</td>
<td></td>
<td>Active</td>
<td></td>
<td></td>
</tr>
<tr>
<td>_ 81</td>
<td>LST2</td>
<td>0</td>
<td>GIVESOCKET</td>
<td>37</td>
<td>Active</td>
<td></td>
<td>Process</td>
</tr>
<tr>
<td>_ 82</td>
<td>LST3</td>
<td>1</td>
<td>SELECTX</td>
<td></td>
<td>Waiting</td>
<td></td>
<td>Select</td>
</tr>
<tr>
<td>_ 83</td>
<td>LST4</td>
<td>2</td>
<td>CONNECT</td>
<td>61</td>
<td>Waiting</td>
<td></td>
<td>Error</td>
</tr>
<tr>
<td>_ 106</td>
<td>TCPT</td>
<td>1</td>
<td>GETHOSTBYNAME</td>
<td></td>
<td>Active</td>
<td></td>
<td></td>
</tr>
<tr>
<td>_ 107</td>
<td>AAAB</td>
<td>3</td>
<td>TAKESOCKET</td>
<td></td>
<td>Active</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

F1=Help  F2=Keys  F3=Exit  F5=Refresh  F6=Console  F10=Action Bar  F11=Print  F15=Region Status  PA1=Switch
Web Interface

A Web-status light has been added to the Region Status panel, allowing you to navigate to the Web Interface panel. Details about Web access are displayed. The new panel and commands let you know if Web access is enabled or disabled. If the interface is disabled, the system tells you why.

The new status light is available on OMEGAMON II version 5.2 and above.

The following figure shows the panel.

**FIGURE 245. Web Interface panel**
Chapter Overview

Alerts indicate the status of exceptional conditions that can degrade response time and that may require immediate action. This chapter describes the components in the Alerts section of the Region Status panel of OMEGAMON II.

Chapter Contents

- Bottlenecks
  - Internal Bottlenecks pushbuttons
  - Internal Bottleneck Details panel
- CICS Loop (CICS Time-of-Day Clock)
  - Transaction Statistics panel
- Dumps
- Enqueues
  - Enqueues Conflicts panel
  - Two types of enqueue problems
  - Techniques for avoiding enqueue problems
  - Enqueue Details panel
- I/O Rate
  - Pushbuttons on DASD I/O Rate panel
  - DASD Details for a Device panel
- VTAM ACB
- XRF (Extended Recovery Facility)
  - Pushbuttons on XRF Information panel
**Bottlenecks**

Internal bottleneck analysis is a realtime facility that looks over a short-term time interval and identifies the various reasons why CICS tasks in your CICS region are waiting.

Select Bottlenecks from the Region Status panel to display a summary of all the detected bottlenecks in the CICS region in order by the occurrence of resource type. The Internal Bottlenecks panel displays. The following figure shows the panel.

**FIGURE 246. Internal Bottlenecks Panel**

This panel shows all the detected bottlenecks in your CICS region. You can limit the display to show only those bottlenecks that exceed a specified minimum amount of contention.

For some resource types the panel lists both a total contention value and a breakdown of each specific resource causing contention. For example, a File Control wait is broken down as both a total value for all files and as individual values for each file causing contention.

If insufficient variable buckets have been defined, the contention cannot be broken down by resource. Instead, overflow buckets are used, which display as *OVRFLW*. Consider increasing the variable bucket limit using the BOTTLENECK_OPTIONS parameter in the global data area.

You can use this panel when you have transactions that are not meeting your response time objectives by seeing which CICS resources are causing your transactions to wait (causing higher transaction response times).

You first select which group of transactions to examine; pressing F4 in the Group Name field will supply you with the list of available choices.
You next examine the list of resources to determine which resources in your CICS region are having the most impact on your group of transactions. This list of resource bottlenecks shows each resource that is taking productive time away from your group of transactions (the list also shows the percentage of productive time for your transactions, with a resource name of RUNNING).

From this bottlenecks panel, you can go to a response time analysis panel (Response Time Details) to see the recent response times for your group of transactions.

You can also go to an external contention panel to see the workloads outside of your CICS region (jobs, TSO users, and so forth) that are contending with your region for MVS resources.

**Internal Bottlenecks pushbuttons**

The Internal Bottlenecks panel contains pushbuttons that allow you to navigate to the following panels:

- External Contention
- Response Time Details

All the pushbuttons that appear on Internal Bottlenecks also appear on all the panels to which you navigate using the pushbuttons.

The following sections describe each panel.

**External Contention panel**

The External Contention panel displays when you select the External Contention pushbutton on Internal Bottlenecks. External contention analysis extends the diagnostic capabilities of bottleneck analysis. It identifies workloads that run on MVS and compete with CICS for MVS resources.

These workloads can be batch jobs, started tasks, TSO users, other CICS regions, or the CICS region itself. Bottleneck analysis locates the sources of performance degradation within a CICS region; external contention analysis assesses the effect of MVS or other address spaces on a CICS region.

OMEGAMON II’s external contention analysis identifies the main sources of impact and describes their effects on CICS. This allows you to take prompt action to reduce competing workloads and improve CICS performance. Figure 247 on page 390 shows the panel.
This panel shows how your CICS region is being impacted by other address spaces in the MVS system.

The percentage of time the CICS region was ready and executing is shown in the CICS Productive Time field. The percentage of time the CICS region was ready but was forced to wait for resources in use by other address spaces is shown in the Total Contention Time field.

The address spaces that are using the resources needed by the CICS region are shown in the body of panel.

You can use this panel when you have transactions that are not meeting your response time objectives.

You can see on this panel the address spaces that are using the resources needed by your CICS region, causing your CICS region to wait and lengthening your transaction response times.

If you want to see the particular resources in use by a contending address space, enter S next to it and press Enter.
The External Contention Details panel displays when you select an item in the Address Space column of the External Contention panel. The following figure shows the panel.

**FIGURE 248. External Contention Details Panel**

This panel shows how another CICS region or an external address space is contending with your CICS region for resources.

If the contending region is a CICS region, the performance group number is shown along with its start date, start time, CICS version number, and CICS applid. In the case of a non-CICS contending address space, its performance group number and the indicator that a non-CICS address space is involved are shown.

If the resource in contention is DASD, the volume serial number and channel unit address of the device are displayed.

This detailed panel is useful once you have determined that your CICS region is being impacted by an address space and you want to isolate the resources used by that address space.

If the resource in contention is CPU, judge the relative importance of your CICS region when compared with the contending address space. If the resource in contention is DASD, consider moving datasets from one device to another to reduce contention.


Bottlenecks

Response Time Details panel
The Response Time Details panel displays when you select the Response Time Details pushbutton on the Internal Bottlenecks panel. This panel displays response time details for all elements within a group.

The panel is sorted in descending order based on the values in the Current Minute column. The worst response time appears at the top of the display followed by the remaining groups, up to a maximum of 30.

Poor response time may be caused by a lack of resources. By identifying the resources in short supply, you can resolve the problem and restore acceptable response times.

If you are displaying the details of transaction or terminal groups you can select individual elements for further detail display. Programs and logical units may not be selected.

See “Response Time Details panel” on page 255 for more information on this panel.
### Internal Bottleneck Details panel

The Internal Bottleneck Details panel displays when you select an item in the Resource Type field on the Internal Bottlenecks panel. The following figure shows the panel.

**FIGURE 249. Internal Bottleneck Details Panel**

<table>
<thead>
<tr>
<th>Group Name</th>
<th>Group Type</th>
<th>Bottleneck Ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>ATMSTRANSGRP</em></td>
<td>Tran</td>
<td>20%</td>
</tr>
<tr>
<td>_VTAM0401</td>
<td>LU</td>
<td>15%</td>
</tr>
<tr>
<td>_PRODTRAN</td>
<td>Tran</td>
<td>10%</td>
</tr>
<tr>
<td>_ACCOUNTS</td>
<td>Tran</td>
<td>5%</td>
</tr>
<tr>
<td>_RECEIVE</td>
<td>Tran</td>
<td>0%</td>
</tr>
<tr>
<td>_PURCHASE</td>
<td>Tran</td>
<td>0%</td>
</tr>
<tr>
<td>_MGMTLVL1</td>
<td>Term</td>
<td>0%</td>
</tr>
<tr>
<td>_DEVALVL1</td>
<td>Term</td>
<td>0%</td>
</tr>
</tbody>
</table>

This panel shows the impact that one resource bottleneck is having on one or more groups. It provides details about a single resource type, describes the resource type, and then lists the percent of wait time that can be attributed to this resource type for each group.

You can display this panel directly after you view the Internal Bottleneck summary panel, so the group(s) shown here will match the group(s) displayed on that previous panel.

This panel is useful when you have a response time problem and you have identified the resource that is causing the major bottleneck (from the Internal Bottleneck summary panel). You can then use this panel to see the bottleneck’s impact on all of your transaction groups.

You can filter this panel by group name, group type or bottleneck ratio.

In addition, you can select any of the listed groups to display the response time details for the group. Viewing the response time details enables you to identify how long a specific bottleneck has impacted a particular group.
CICS Loop (CICS Time-of-Day Clock)

Select CICSloop from the Region Status panel to display the Common System Area (CSA) panel. Use the CICS time-of-day field on this panel to check the status of the CICS time-of-day clock. When this clock is not being updated, the CICS dispatcher is not getting control. This condition may be caused by a looping task.

This panel also presents some general highlights of the CSA control block, and is a gateway for further information through its selectable fields. The following figure shows the panel.

FIGURE 250. Common System Area (CSA)

This panel displays a brief overview of current CICS system indicators and shows the addresses of major CICS control blocks.

View this panel to get an overview of the state of the CICS region. This panel provides a starting point for listing the memory contents of the major CICS control blocks, such as the CSA, CWA, and DCT.

Enter S next to a control block of interest to see the memory contents of that control block.
Transaction Statistics panel

The Transaction Statistics panel displays when you select the System at MXT Limit or System at CMXT Limit fields on the CSA panel. The following figure shows the panel.

FIGURE 251. Transaction Statistics Panel (CICS Version 4)

This panel displays the number of tasks in each of the transaction classes in CICS. Values are shown for the current number of tasks, peak number of tasks, and limit number of tasks.

View this panel to see how close your system is to the limits set for the number of tasks. If tasks are not flowing through your system, this panel will indicate whether the lack of flow is due to too many tasks running.

If your CICS system is underutilizing your processor resources, you may consider increasing the limit values for tasks in the SIT (system initialization table). In CICS Version 4, transaction class limits are changed through RDO.
Dumps

Select Dumps from the Region Status panel to display the panel for the Dump summary, which shows the current state of the Dump datasets and the Dump history by dump code. The following figure shows the panel (this example is for CICS/ESA only).

FIGURE 252. Dumps Panel

This panel displays an overview of the current and past dump activity for the CICS region. Items covered include the number of dumps taken, the status of dump suppression, and the name of the current dump dataset.

View this panel to see how much dump activity has occurred on your system.
Enqueues

Select Enqueues on the Region Status panel to display the Enqueues panel, which shows problems in the event of conflicts.

A CICS enqueue represents a request by a task for exclusive control of resource. Only one task may hold an enqueue. All others either wait until the enqueue is released by the owning task or are notified of an enqueue busy condition, depending on parameters used when requesting the enqueue. Waiting tasks are granted control of the resource based on order of request.

The resource specified when an enqueue is requested takes the form of either a 4-byte address (representing a location in storage) or a variable-length hexadecimal string of 1 to 255 bytes.

The following figure shows the Enqueues panel.

**FIGURE 253. Enqueues Panel**

This panel displays all CICS enqueues. It shows the total number of tasks in the system that are waiting on enqueues and each enqueue resource name or address. For each resource, the number of tasks waiting for the enqueue (if any) is shown. For named enqueues, the length of the resource name is shown (the length field is left blank for enqueues on an address). Information about the task that owns each enqueued resource is also displayed.

Select an Enqueue Resource field to see additional details about a specific enqueue.

Select an Owning Task No. field to see additional details of a CICS task that owns a resource.

If the panel shows that a number of tasks in the system are waiting for enqueues, you may want to use the Conflicts pushbutton to navigate to the Enqueue Conflicts panel. That panel
only shows enqueues that are in contention and allows for easier recognition of deadlock conditions.

**Enqueues Conflicts panel**

The Conflicts pushbutton on the Enqueues panel allows you to navigate to the Enqueue Conflicts panel.

The following figure shows the panel.

**FIGURE 254. Enqueue Conflicts Panel**

This panel displays information on current enqueue conflicts. That is, it displays information about tasks and resources for any enqueue in the system that has been requested by two or more tasks.

This panel may be used to diagnose system problems caused by tasks not releasing exclusive control of resources.

**Two types of enqueue problems**

Two types of enqueue problems may be encountered. The first, and usually more serious, type of problem is when a task is holding a resource required by other tasks and it will not release it in any reasonable time. This may be because the task that owns the enqueue is looping or in a long wait, or because it is in a deadlock with another task. In this case, the most useful short-term remedy is to terminate the task that owns the resource causing the conflict. Show details about the owning task by typing S in the input field next to the owning task number. The Task Details panel will display, showing details about the state of the owning task. You can then issue the Kill or Force actions. For procedure on killing or force killing tasks, see the *OMEGAMON II for CICS User’s Guide*.

The second type of problem which might be encountered is a performance bottleneck that forms when exclusive control of a resource is held for longer than is desirable, thus impacting
the performance of other tasks that require that resource. Such enqueue waits are often a symptom of response time problem unrelated to the enqueues themselves. For example, this could be caused by poor response time from the resource represented by the enqueue, for instance a CICS dataset.

Techniques for avoiding enqueue problems

There are a number of techniques that can be used to avoid enqueue problems. Most are application design techniques, but there are also system parameters and tuning actions you can use to reduce the likelihood of enqueue problems.

Deadlocks between CICS tasks can be prevented by careful application design. This is done by making sure that all tasks obtain and release enqueued resources in the same order. For example, consider the following:

An application requires that some tasks must gain exclusive control of resources represented by enqueues “AAA” and “BBB”. If all tasks first enqueue on resource “AAA” and then on “BBB”, no deadlock condition can arise. If however, some (but not all) tasks enqueue first on “BBB” then “AAA”, deadlocks can occur.

Because updating CICS datasets causes implicit enqueues to be issued by CICS, datasets must also be updated in the same order by each task in the application.

If this technique cannot be used to prevent deadlocks, you should consider using the deadlock time out feature of CICS. This feature causes a task to abend after waiting on a resource for a user-specified period. If the task was part of a deadlock, its termination will release its enqueues and allow the task(s) it was deadlocked with to run to completion.

You can reduce bottlenecks caused by enqueues by minimizing the duration that any one task holds an enqueue. Some techniques include the following:

- Releasing the enqueue as soon as exclusive control is no longer required. This can be by an EXEC CICS DEQ command or by an EXEC CICS SYNCHPOINT (if a recoverable resource was being altered).
- Performing general CICS tuning to improve application response time. If tasks have good response time, they hold resources, including enqueues, for a shorter period, thus reducing the probability of a conflict with other application tasks over an enqueue. The bottleneck analysis component of OMEGAMON II gives a breakdown of application response time that allows you to identify areas of system performance that may benefit from tuning.
**Enqueue Details panel**

When you select a particular enqueue in the Enqueue Resource column on the Enqueues panel or the Enqueue Conflicts panel, the Enqueue Details panel displays. The following figure shows the panel.

**FIGURE 255. Enqueue Details Panel**

This panel provides details for a specific enqueued resource. It shows details of the enqueue resource name (for resources of type “variable”) or address (for resources of type “address”). The resource name is displayed in both character and hexadecimal format. For address enqueue resources, the resource name is displayed as an address only. The resource type and length are shown, along with the Queue element area address and the number of tasks waiting for exclusive control of the resource (if any). Tasks owning or waiting for exclusive control of the resource are listed.

If the resource is the type "variable", the first 44 bytes of the resource name are shown in both character and hexadecimal form. If the full resource name is longer than 44 bytes, the "+" symbol is shown after the 44th byte. You can select the Enqueue Resource field to display the full resource name.

Select the Enqueue Resource field to display the full name of a resource of type "variable".

Select the Queue Element Address field to show a character and hexadecimal display of the Queue Element Area (QEA), which is the primary control block used by CICS to process enqueue requests.

Select a task number field to show details of a task that owns, or is waiting for, exclusive control of a resource.
Select I/O Rate from the Region Status panel to display the DASD I/O Rate panel, which shows total and CICS I/O rates either for devices allocated to the CICS region or for all DASD devices. The following figure shows the panel.

**FIGURE 256. DASD I/O Rate Panel**

This panel presents a comparison of total I/O rates with CICS I/O rates to assess whether or not external contention is a problem. The volumes that appear depend on the options selected from the View pull-down menu, and whether "CICS" or "ALL" DASD is specified on the DASD resource threshold panel. For procedure on how to specify which DASD will display, see "Display All or Allocated Devices" in the I/O Rate section of Chapter 7 in the OMEGAMON II for CICS User’s Guide.

If the total I/O rate for any given volume greatly exceeds that of CICS, select the device to obtain details such as how many CICS datasets reside on the volume.

To determine which CICS datasets are heavily used as indicated by the EXCP count, select the CICS Open DCBs field on the DASD Details for a Device panel. Consider moving very active CICS datasets to an alternate volume.
Pushbuttons on DASD I/O Rate Panel

The DASD I/O Rate panel contains pushbuttons that navigate to the following panels:

- CICS DASD Performance
- DASD Statistics

All the pushbuttons that appear on the DASD I/O Rate panel also appear on all the panel you navigate to using the pushbuttons.

The following sections describe each panel.

**CICS DASD Performance Panel**

The CICS DASD Performance panel displays when you select the Performance pushbutton on DASD I/O Rate. The table in the first section of the panel contains two fields used to indicate the number of DASD devices accessed by CICS that are either not ready or not responding.

The table in the second section displays the DASD response time and DASD percent busy for certain volumes. The volumes that appear depend on the options selected from the View pull-down menu and whether "CICS" or "ALL" DASD is specified on the DASD resource threshold panel. The range for the response time graph varies according to the threshold settings.

See “CICS DASD Performance panel” on page 301, “Three solutions to DASD problems” on page 302, and “Tuning guidelines” on page 303 for more information on this panel.

**DASD Statistics Panel**

The DASD Statistics panel displays when you select the Statistics pushbutton on DASD I/O Rate. This panel displays utilization and response time data for either all online DASD or just those devices containing datasets opened by CICS (according to the setting specified on the DASD resource threshold panel). The display may be further filtered using the View pull-down menu. The response time is broken down into its four components.

If %Busy frequently exceeds 35% and I/O requests are being delayed, as indicated by the Avg Q Length field, select the device to determine how many CICS datasets reside on the volume and how heavily they are used. Heavily used CICS datasets should be moved to a less busy volume.

See “DASD Statistics panel” on page 306 for more information on this panel.
DASD Details for a Device panel

When you select a particular device in the Device column on the DASD I/O Rate panel, the DASD Details for a Device panel displays. The following figure shows the panel.

This panel displays device details and a response time graph for a single DASD unit.

Both the Device and Volume fields allow input. Either can be changed to obtain a detail report for any given device. However, if both device and volume are entered, device will always take precedence.

If the value in the %Busy field frequently exceeds 35%, select the CICS Open DCBs field to determine the names of CICS datasets that reside on the volume and how heavily they are used. Very active CICS datasets should be moved to a less busy volume.

The action you should take for DASD devices where the total response time exceeds 40 ms depends on where most of the time is being spent. The following list describes possible actions:
**I/O Rate**

<table>
<thead>
<tr>
<th>Component</th>
<th>Action to Take</th>
</tr>
</thead>
<tbody>
<tr>
<td>IOS Queue</td>
<td>Indicates a busy device. Consider moving heavily used datasets to a different device.</td>
</tr>
<tr>
<td>Pending</td>
<td>Indicates a busy path. Consider moving volumes to balance string use.</td>
</tr>
<tr>
<td>Connect</td>
<td>Indicates excessive data transfer time. Check for poor dataset blocking and inefficient applications.</td>
</tr>
<tr>
<td>Disconnect</td>
<td>Indicates probable excessive seek time or a rotation position sensing (RPS) miss. Check concurrent use dataset conflicts, poor VTOC placement, path contention, fragmented extents, and so forth.</td>
</tr>
</tbody>
</table>

### CICS Datasets on a DASD Volume panel

The CICS Datasets on a DASD Volume panel displays when you select the CICS Open DCBs field on the DASD Details for a Device panel. The following figure shows the panel.

**FIGURE 258. CICS Datasets on a DASD Volume Panel**

This panel displays every dataset allocated by CICS on the specified device. An EXCP count, along with a graphical representation, is presented for each CICS dataset on the volume.

Initially, this panel is sorted in descending EXCP order, thus placing the most active datasets at the top of the list. If the datasets shown are on a very busy device, you should consider moving the files with high EXCP counts to a less active device. Balancing I/O loads may reduce the amount of time it takes to complete read and write operations, thereby improving CICS performance.
Select VTAM ACB from the Region Status panel to display the Terminal Control Table Prefix panel. The following figure shows the panel.

**FIGURE 259. Terminal Control Table Prefix Panel**

This panel displays the terminal control table (TCT) prefix, which contains general information about CICS terminal control and VTAM, and shows information on the VTAM attributes of CICS terminal control such as VTAM applid in use and VTAM ACB state and information on the autoinstall of terminals.

Autoinstall refers to the process, performed by CICS, of adding entries to the TCT when a VTAM terminal requests a connection with CICS.

The use of autoinstall can result in a storage savings because only terminals connected to CICS have their entries in the TCT.
Select XRF on the Region Status panel to display the XRF Information panel. XRF provides recovery of a region by having a fully defined alternate region readily available to replace the operation of the failed region.

Since you can see data that is generated by the display function of the CICS Overseer Program, you may not need to run the Overseer.

The following figure shows the panel. This panel does not apply to CICS/MVS.

This panel displays summary information on the active (primary) and alternate CICS systems. Type S next to the Control File DSN field to get more details if you suspect problems with XRF.

To see information about the XRF-related SIT (System Initialization Table) operands TAKEOVER, ADI and JESDI, type IS on the home position, then press Enter. The Search Index pop-up window displays. Next, type SIT on the Search field, then press Enter. The Search Argument pop-up displays, showing the title of the System Initialization Table panel. Press Enter. The System Initialization Table panel displays.
Pushbuttons on XRF Information panel

The XRF Information panel contains pushbuttons that navigate to the following panels:

- CPU Rates
- Working Set Size and Paging Rates
- CICS Address Space Information
- CICS Job Information
- CICS Address Space TCBs
- MVS Loaded Modules
- MVS Resources

All the pushbuttons that appear on XRF Information also appear on all the panels you navigate to using the pushbuttons.

The following sections describe each panel.

CPU Rates panel

The CPU Rates panel displays when you select the CPU pushbutton on XRF Information. This panel displays information about CICS CPU usage.

The first section of the panel presents a breakdown of the CICS CPU rate into TCB (task control block) and SRB (service request block) times for the last OMEGAMON II cycle. The second section displays a table of CPU usage by CICS tasks.

See “CPU” on page 293 for more information on this panel.

Working Set Size and Paging Rates panel

The Working Set Size and Paging Rates panel displays when you select the Paging pushbutton on XRF Information. This panel displays statistics about the private and common areas of the CICS address space.

Use this panel to see the paging rate and storage usage and to determine if the working set size or paging rate needs adjustment.

See “Paging” on page 351 for more information on this panel.

CICS Address Space Information panel

The CICS Address Space Information panel displays when you select the ASID pushbutton on XRF Information. This panel displays general information about the CICS address space.

Use this panel to see the statistics about the CICS address space.

See “CICS Address Space Information panel” on page 295 for more information on this panel.
CICS Job Information panel
The CICS Job Information panel displays when you select the Job pushbutton on XRF Information. This panel displays information about CICS as an active MVS job. It contains information relative to MVS, JES, and VTAM.

Use this panel to see statistics about the general operation of the CICS job.

See “CICS Job Information panel” on page 296 for more information on this panel.

CICS Address Space TCBs panel
The CICS Address Space TCBs panel displays when you select the TCBs pushbutton on XRF Information. This panel displays information about the TCB (task control block) structure within the CICS address space.

A task control block (TCB) is a dispatchable unit of work and is created by an MVS ATTACH macro.

Use this panel to analyze the structure of CICS TCBs and to assess how program is performing. Since many third-party products attach multiple TCBs, you can also use this panel to locate where they are attached.

See “CICS Address Space TCBs panel” on page 297 and “TCB Details panel” on page 298 for more information.

MVS Loaded Modules panel
The MVS Loaded Modules panel displays when you select the Modules pushbutton on XRF Information. This panel displays information about the modules that have been loaded by MVS into the CICS address space.

The list does not include modules from the DFHRPL concatenation which are loaded by CICS’s own loader and are placed into DSA storage.

Modules loaded after CICS initialization can cause the region to abend if there is not enough free virtual storage left. Some of these modules include monitors, security package routines, and programming language service modules.

You can inspect the modules by placing the Show Details (S) action code next to the entry address of the load module you want to examine.

See “MVS Loaded Modules panel” on page 299 for more information on this panel.

MVS Resources panel
The MVS Resources panel displays when you select the MVS Resources pushbutton on XRF Information.

This panel displays information about MVS resource consumption within the CICS address space. This information is for the last OMEGAMON II cycle.

Use this panel to see the system resources that your CICS address space used for the last OMEGAMON II cycle.

See “MVS Resources and the System Console” on page 233 for more information on this panel.
Background Facilities (ASF, TSF, XLF)

Introduction

Background facilities are for advanced users who are familiar with OMEGAMON II commands and creating screen spaces. For information on how to obtain help for commands, see “Getting Help for OMEGAMON II Commands” on page 423.

OMEGAMON II can automatically invoke displays, initiate action, and log information in response to exception conditions (that is, when an exception message is triggered), or at specific times during the day. When the sequence is finished, OMEGAMON II then resumes normal operation. All this occurs without manual intervention through three event- and time-driven features: the timed screen facility (TSF), the exception logging facility (XLF), and the automatic screen facility (ASF).

Note: These features operate only when Auto Update mode is activated. Do not use any of these background facilities if OMEGAMON II is running under an overview product (OMEGAVIEW).

Appendix Contents

Controlling Automated Features .......................................................... 410
Timed Screen Facility (TSF) ................................................................. 411
  Turning TSF on and off ................................................................. 411
  Setting parameters for TSF operation ................................................. 412
  TSF Logging ........................................................................ 413
Exception Logging Facility (XLF) ............................................................ 414
  Turning XLF on and off ................................................................. 414
Automatic Screen Facility (ASF) ........................................................... 415
  Turning ASF on and off ................................................................. 415
Setting Parameters for XLF and ASF Operation ........................................ 416
Logging Parameters for XLF, ASF, and TSF ........................................... 418
Using Screen Spaces in ASF and TSF .................................................... 419
  How ASF and TSF screen spaces execute ........................................... 419
  Using the .RTN command .............................................................. 419
  ASF Example ........................................................................ 420
Controlling Automated Features

You must be familiar with how exception analysis works and how to create screen spaces with commands in order to use these event- and time-driven features. This section explains how to access the options that control these features.

Select the Profile option (P) on the Main Menu. From there, you can choose the following:

- Several options on the Exceptions Settings path, option A on the Profile menu, to define XLF and ASF parameters for each individual exception (fastpaths PA through PA.K).
- The Background path, option E on the Profile menu, to control the operation of the three background processing features, as well as define entries for TSF.
Timed Screen Facility (TSF)

This feature automatically invokes specified screen spaces at specified times of the day or at specified intervals. Many sites use TSF to spin off copies of the screen log (REPORT) and/or exception log (XLFLOG) files to the printer. In general, you can use the TSF facility to automate many day-to-day housekeeping routines.

Turning TSF on and off

The TSF On option (B) on the Background path activates TSF (fastpath **P.E.B**), and the TSF Off option (C) on the Background path deactivates it (fastpath **P.E.C**). You can specify the screens to be invoked and at what time of day with the TSF Entries option (A) on the Background path (fastpath **P.E.**).

**Note:** TSF functions only in Auto Update mode (VTAM or dedicated). To activate Auto Update, select the Auto Update On option (F) on the Profile menu (fastpath **P.F**).

To set time screen facility entries, select the Background option (E) on the Profile Menu or enter fastpath **P.E** from any panel. The initial panel on the Background path appears as shown in Figure 261 on page 411. Follow the instructions at the top of the panel.

**FIGURE 261. TSF Entries Panel (P.E)**

<table>
<thead>
<tr>
<th>A-TSF Entries</th>
<th>B-TSF On</th>
<th>C-TSF Off</th>
</tr>
</thead>
<tbody>
<tr>
<td>D-XLF On</td>
<td>E-XLF Off</td>
<td>F-ASF On</td>
</tr>
<tr>
<td>G-ASF Off</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

<table>
<thead>
<tr>
<th>.TSFO0 +</th>
<th>TIME=0000</th>
<th>SS=<em>NONE</em></th>
<th>DAY=DAILY</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>TIME=0000</td>
<td>SS=<em>NONE</em></td>
<td>DAY=DAILY</td>
</tr>
<tr>
<td>+</td>
<td>TIME=0000</td>
<td>SS=<em>NONE</em></td>
<td>DAY=DAILY</td>
</tr>
<tr>
<td>+</td>
<td>TIME=0000</td>
<td>SS=<em>NONE</em></td>
<td>DAY=DAILY</td>
</tr>
<tr>
<td>+</td>
<td>TIME=0000</td>
<td>SS=<em>NONE</em></td>
<td>DAY=DAILY</td>
</tr>
<tr>
<td>+</td>
<td>TIME=0000</td>
<td>SS=<em>NONE</em></td>
<td>DAY=DAILY</td>
</tr>
<tr>
<td>+</td>
<td>TIME=0000</td>
<td>SS=<em>NONE</em></td>
<td>DAY=DAILY</td>
</tr>
<tr>
<td>+</td>
<td>TIME=0000</td>
<td>SS=<em>NONE</em></td>
<td>DAY=DAILY</td>
</tr>
<tr>
<td>+</td>
<td>TIME=0000</td>
<td>SS=<em>NONE</em></td>
<td>DAY=DAILY</td>
</tr>
<tr>
<td>+</td>
<td>TIME=0000</td>
<td>SS=<em>NONE</em></td>
<td>DAY=DAILY</td>
</tr>
<tr>
<td>+</td>
<td>TIME=0000</td>
<td>SS=<em>NONE</em></td>
<td>DAY=DAILY</td>
</tr>
<tr>
<td>+</td>
<td>TIME=0000</td>
<td>SS=<em>NONE</em></td>
<td>DAY=DAILY</td>
</tr>
<tr>
<td>+</td>
<td>TIME=0000</td>
<td>SS=<em>NONE</em></td>
<td>DAY=DAILY</td>
</tr>
<tr>
<td>+</td>
<td>TIME=0000</td>
<td>SS=<em>NONE</em></td>
<td>DAY=DAILY</td>
</tr>
</tbody>
</table>

---

Background Facilities (ASF, TSF, XLF) 411
You must change or add one TSF entry at a time. Enter the entry number after the .TSF statement (.TSFnn) and then type over the values displayed. Then enter another entry number and type over its values. Then enter the next entry number and so on.

To add a new entry, use an unused entry which is identified by TIME=0000.

For more about TSF entries such as setting parameters or logging, see “Background Facilities (ASF, TSF, XLF)” on page 409.

### Setting parameters for TSF operation

To use TSF, follow this procedure.

1. Create any screen spaces you want TSF to invoke.
   
   You can use the .SGO or .FGO command to chain screen spaces together, and .RTN to end the cycle. Special considerations for creating screen spaces in TSF are discussed in “Using Screen Spaces in ASF and TSF” on page 419.

2. Select the TSF Entries option (A) on the Background path or enter fastpath P.E to enter the names of the screen spaces and the times or time intervals when you want them invoked. When values appear on the TSF Entries panel in lines beginning with a colon, you can change the values by typing over them.

3. Turn on TSF by selecting the TSF On option (B) on the Background path, or entering fastpath P.E.B.
   
   The TSF Entries panel uses command .TSF00 to list all TSF entries. The TSF table is shipped with 99 blank entries. For example:

   ```
   .TSF00
   1 TIME=0000 SS=*NONE* DAY=DAILY
   2 TIME=0000 SS=*NONE* DAY=DAILY
   3 TIME=0000 SS=*NONE* DAY=DAILY
   4 TIME=0000 SS=*NONE* DAY=DAILY
   
   Enter .TSFnn to display entry nn in the TSF table. To define an entry, enter .TSF followed by the number of the entry. For example, enter .TSF01 to produce:

   ```
   .TSF01 Time=0000 SS=*NONE* DAY=DAILY
   ```

   When you enter the new entry over the current entry, the value is reset.

   If you want to change an entry that does not appear on the panel, you can specify an argument to skip nn entries. Enter

   ```
   .TSF00 20
   ```

   to display entries 21 through 99 in the TSF table, skipping the first 20.
The following are the keywords and valid entries on the TSF Entries panel.

**Time**

Time of day (from 0000 to 2400) to invoke the screen space. \( \text{TIME}=+nn \) invokes the screen space every \( nn \) minutes. For example, \( \text{TIME}=1800 \) for 6 PM or \( \text{TIME}=+10 \) for every 10 minutes.

*Note: The screen space will not execute while the TIME=+nn entry remains on your current panel.*

**SL or SS**

Screen space to invoke if TSF is in effect. SS specifies the screen space to invoke, but does not turn on the log. SL automatically turns on the REPORT log when the time occurs and screen space logging starts. You must specify either SS or SL for TSF to work.

**DAY**

Day of the week or month for each timed event. The valid entries for day of week are MONDAY, TUESDAY, WEDNESDAY, THURSDAY, FRIDAY, SATURDAY, SUNDAY, WEEKDAY, WEEKEND, and DAILY. The days of the month are also valid entries (numbers 1–31). The default value is DAILY. For example, you may specify DAY=MONDAY, DAY=31, or DAY=DAILY. You may abbreviate the input as long as it is unique, and as long as the day of the week is recognized.

You may specify day combinations by enclosing the names of the days within parentheses, and by separating each day with either a comma or a blank.

This example shows five TSF entries.

<table>
<thead>
<tr>
<th>TSF01</th>
<th>1</th>
<th>TIME=1800</th>
<th>SL=WENDSHFT</th>
<th>DAY=DAILY</th>
</tr>
</thead>
<tbody>
<tr>
<td>TSF02</td>
<td>2</td>
<td>TIME=0600</td>
<td>SS=WEEKSTRT</td>
<td>DAY=MONDAY</td>
</tr>
<tr>
<td>TSF03</td>
<td>3</td>
<td>TIME=1200</td>
<td>SL=NOONTIME</td>
<td>DAY=(TH,F)</td>
</tr>
<tr>
<td>TSF04</td>
<td>4</td>
<td>TIME=0800</td>
<td>SS=MONTHEND</td>
<td>DAY=30</td>
</tr>
<tr>
<td>TSF05</td>
<td>5</td>
<td>TIME=+30</td>
<td>SL=STATUS</td>
<td>DAY=DAILY</td>
</tr>
</tbody>
</table>

**TSF01**

Executes and logs screen space WENDSHFT at 6:00 PM daily.

**TSF02**

Executes screen space WEEKSTRT at 6:00 AM every MONDAY.

**TSF03**

Executes and logs screen space NOONTIME at 12:00 PM every Thursday and Friday.

**TSF04**

Executes screen space MONTHEND on the 30th of each month at 8:00 AM.

**TSF05**

Executes and logs screen space STATUS every 30 minutes every day.

**TSF Logging**

Select the Log Out option (D) on the Logging path or enter fastpath :xph.PH.D:exph., to send REPORT log file data to the JES output queue and reset the log file to the beginning. Select the Log Options (A) on the Logging path or enter fastpath PH, to specify printer and routing options for the REPORT file and also print and reset the REPORT file.
Exception Logging Facility (XLF)

This feature automatically time-stamps and logs exception messages to the XLFLOG file for your review. It enables you to correct intermittent performance problems by documenting the frequency and severity of systemwide exceptions. To activate it, you must turn on XLF and specify each exception to be included in XLF.

Turning XLF on and off

The XLF On option (D) on the Background path activates XLF (fastpath P.E.D). The XLF Off option (E) on the Background path deactivates XLF (fastpath P.E.E). You can specify exceptions to be included by selecting the Exception option (A) on the Profile menu (fastpath P.A).

Note: XLF functions only in Auto Update mode (VTAM or dedicated). To activate XLF, select the Auto Update On option (F) on the Profile menu (fastpath P.F).
Automatic Screen Facility (ASF)

This feature automatically invokes a predefined screen space when a given exception occurs for more than a specified number of successive cycles. The predefined screen space can contain commands to turn on the log, further evaluate the exception condition, and perform other options. To activate ASF, you must:

- specify exceptions to be included
- specify which screen to invoke
- turn ASF on

You can specify exceptions to be included and the screens to invoke by selecting the Exceptions option (A) on the Profile menu (fastpath P.A).

Turning ASF on and off

The ASF On option (F) on the Background path activates ASF (fastpath P.E.F). The ASF Off option (G) on the Background path deactivates ASF (fastpath P.E.G).

**Note:** ASF functions only in Auto Update mode (VTAM or dedicated). To activate ASF, select the Auto Update On option (F) on the Profile menu (fastpath P.F).

If you do not return to the original screen after a series of ASF screen spaces, you may experience difficulties with the PF key settings, menu system, and navigation.
Setting Parameters for XLF and ASF Operation

Both XLF and ASF parameters are set with the XACB command using the XLF Parameters field. The XACB statement is included in the panels on the Exception Settings path (fastpaths PA.A through PA.K). XACB enables you to activate the XLF and ASF features for all occurrences of any given exception or only if the exception persists for a specified number of cycles. You can also set a limit on the number of times a given exception invokes the XLF or ASF feature.

The following figure shows the format of the XACB statement. The variable cccc is the exception name. To dynamically set parameters for an exception, type over the current value displayed with the XACB command. See “Exception Analysis” in volume 2 of this manual, for detailed information on customizing exceptions.

<table>
<thead>
<tr>
<th>XACB LIST=cccc</th>
</tr>
</thead>
<tbody>
<tr>
<td>:cccc</td>
</tr>
<tr>
<td>+ DISPLAY Parameters:</td>
</tr>
<tr>
<td>: State=</td>
</tr>
<tr>
<td>: Group=</td>
</tr>
<tr>
<td>: Bell=</td>
</tr>
<tr>
<td>+ BOX Parameters:</td>
</tr>
<tr>
<td>: Boxchar=</td>
</tr>
<tr>
<td>: Boxclr=</td>
</tr>
<tr>
<td>: Boxattr=</td>
</tr>
<tr>
<td>: Display=</td>
</tr>
<tr>
<td>: Attribute=</td>
</tr>
<tr>
<td>: ExNcyc=n</td>
</tr>
<tr>
<td>: Stop=n (m)</td>
</tr>
<tr>
<td>: Cumulative=n</td>
</tr>
<tr>
<td>THRESHOLD Parameters:</td>
</tr>
<tr>
<td>: Threshold=</td>
</tr>
<tr>
<td>CYCLE Parameters:</td>
</tr>
<tr>
<td>: Persist=nn</td>
</tr>
<tr>
<td>XLF Parameters:</td>
</tr>
<tr>
<td>: Auto=</td>
</tr>
<tr>
<td>: Log=</td>
</tr>
<tr>
<td>: Limit=nn</td>
</tr>
<tr>
<td>: Persist=nn</td>
</tr>
<tr>
<td>: Sc=</td>
</tr>
</tbody>
</table>

The XLF and ASF parameters are

**Auto**
Controls the status of ASF for this exception (ON/OFF).

**Log**
Controls the status of XLF for this exception (ON/OFF). It does not affect logging for ASF.

**Limit**
Limits the number of times (nn) XLF and/or ASF is invoked if the exception occurs. If you specify Limit=00, no events are logged. If you specify Limit=NONE, XLF and/or ASF are invoked each time the exception occurs. The parenthetical number to the right of this parameter indicates the remaining number of times that the exception will be logged. You can reset Limit to continue logging the exception.

**Repeat**
Used with the Persist threshold, Repeat=YES specifies that XLF logging or ASF action occurs each time the Persist threshold is reached. For example, if Persist=15, the exception condition persists for 15 cycles, and logging is in effect, then the message would be logged three times. If Repeat=NO, the message is logged only once as specified with the Persist parameter.
Persist

Logs the exception message and/or invokes the ASF screen spaces when the condition persists for \( nn \) consecutive OMEGAMON II cycles. After it has reached the threshold, the message is logged only once (or ASF is invoked only once) unless the condition stops for at least one cycle and then trips again. If you specify \textbf{Persist=00}, no events are logged. The default is 0 cycles.

Sc

Sc, where \( c \) may be either an S or L. You must specify this parameter for ASF to work.

- \textbf{SL}
  Specifies the screen space to invoke if ASF is in effect (Auto=ON), and specifies that the output of the ASF screen spaces is to be logged. REPORT file logging automatically turns on when the exception trips and screen space logging starts.

- \textbf{SS}
  Specifies the screen space to invoke if ASF is in effect. It does not turn on the log.
Exception messages that trip when XLF is in effect are routed to the XLFLOG file. Screen space output from ASF and TSF is routed to the REPORT file. The ddnames for XLFLOG and REPORT are defined in the OMEGAMON II jobstream.

To display or change the printing or routing parameters for ASF or TSF, select Log Options (A) on the Logging path or enter fastpath P, H. For XLF printer or routing parameters, select XLF Options (E) on the Logging path or enter fastpath :xph.P,H,E:exph. from any panel.

In XLF and ASF processing, only one record is written to the log while a given exception condition persists. However, new records are written to the XLFLOG or the REPORT log if any of the following situations occur:

- If an exception disappears for even one cycle, and then reappears, it is considered a new event.
- If you turn off a given exception and then turn it on again, you clear the event. If the exception condition still exists, another record goes to the XLF log. OMEGAMON II does not check for the condition unless the exception is turned on.
- If you turn off XLF or ASF and then turn it on again, you clear all events and new records go to the log.
- For a given exception, if you set the XACB REPEAT parameter to YES and specify a threshold for the PERSIST parameter, a new record is written each time the PERSIST threshold is reached.
Using Screen Spaces in ASF and TSF

The power of ASF and TSF lies in their ability to branch to, execute, and log an analysis screen space (or series of screen spaces). The screen space you define to call when ASF is activated can contain whatever information-gathering and/or action-taking commands you specify. You might include commands to turn on the log, change OMEGAMON II defaults, further analyze the exception condition, or even call other screen spaces (with .SGO or .FGO).

This section contains information on how to use and execute screen spaces, and how to use the .RTN command.

How ASF and TSF screen spaces execute

If two exceptions occur at the same time, screen spaces and logging execute for the first exception until the final screen space issues the .RTN command. If the second exception persists, the automatic mode reactivates on the next cycle.

If the EXSY command appears on any of your target screen spaces, any triggered exception messages appear as usual, but ASF ignores these new exceptions until the sequence is ended with the .RTN command. If the exception condition still exists, ASF proceeds to the next exception in sequence.

If you want to cancel an ASF or TSF screen space sequence while it is displaying, press any key other than a cursor key. If, for example, you press Enter, the sequence immediately terminates. However, when it terminates without a .RTN command, OMEGAMON II does not return to the original calling panel, or to another screen space defined with .RTN.

Note that TSF sequences always function at their scheduled times, except when an ASF sequence is also tripped. ASF sequences take precedence over TSF. That means that if an ASF sequence trips while a TSF sequence is in progress, the ASF sequence cancels the TSF sequence. When the ASF sequence is complete, OMEGAMON II returns to the panel displayed at the time that ASF tripped, but the TSF sequence does not continue. Similarly, if a TSF sequence is scheduled while an ASF sequence is already in progress, the TSF sequence is ignored.

Using the .RTN command

You can branch to as many screen spaces as you want in ASF and TSF by using the .FGO or .SGO command to chain screen spaces together. The .RTN immediate command is required at the bottom of the last screen space in an ASF or TSF sequence in order to terminate the sequence, return to the original calling panel or branch to the next, and re-enable exception analysis for further automatic calls. You can use OMEGAMON II definition mode (the /DEF ON command) when creating screen spaces that contain the .RTN command.

Normally, you use the .RTN command without a screen space name to return to the calling panel. The .RTN command also accepts an argument which forces the return to a screen space that is not the calling panel. For example, to return to a panel called SCREEN2, enter the .RTN command followed by SCREEN2.
You can delay the return for up to 35 cycles by placing the number of cycles to be delayed in the label field of .RTN (1 to 9 for numbers 1–9 and A–Z for numbers 10–35). The following command causes a return to SCREEN2 after 6 cycles.

6.RTN SCREEN2

On each cycle, OMEGAMON II replaces the number in the label field with the next lower number. When the count reaches zero, OMEGAMON II fetches SCREEN2.

ASF Example

ASF functions only in dedicated mode or VTAM mode with automatic updating in effect. Select the ASF On option (F) on the Background path to activate ASF or enter fastpath P.E.F from any panel.

Here are some parameters set with the XACB command for the DRDY exception.

```
XLF Parameters:
  Auto=ON
  Log=OFF
  Limit=3
  Repeat=NO
  Persist=5
  SL=DEX01
```

In this example, when the exception condition exists for 5 cycles in a row, ASF invokes screen space DEX01. From this point on, an A appears in the far right portion of the INFO-line, which indicates that the current panel is part of an ASF sequence.

DEX01 might consist of the following sequence of commands:

```
> After 8 cycles, branch to screen space DEX02
8.SGO DEX02
=======
> Reset the OMEGAMON II cycle time to 15 seconds
.SET INTERVAL=15
=======
> Start degradation analysis
PDEX START
=======
> Display degradation analysis for performance group 2
PDEX02
```
In this example, the OMEGAMON II cycle time is set to 15 seconds. Since the 8.SGO entry waits 8 cycles before it jumps to DEX02, bottleneck analysis runs on this screen for 2 minutes and logs the results. At this point, screen space DEX02 is invoked as shown below.

<table>
<thead>
<tr>
<th>_______________</th>
<th>DEX02</th>
<th>DED</th>
<th>LOG</th>
<th>PROD01</th>
<th>V&amp;OLD../C &amp;SYSID. &amp;DATE. 17:03:37</th>
</tr>
</thead>
<tbody>
<tr>
<td>&gt; Suspend degradation analysis</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PDEX STOP</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>==</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>&gt; Return to the calling screen</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>.RTN</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Upon return, the ASF sequence terminates (the A disappears from the INFO-line), thus re-enabling EXSY for further automatic calls. The .RTN command also automatically resets the interval to the one in effect when the ASF sequence started. (You can, however, add an NR argument to .RTN (.RTNNR) to keep the new interval in effect."

Note that because the SL= parameter was used, ASF automatically turned on the REPORT log when the exception occurred (if it was not already on). When you leave automatic mode, ASF also turns off the log (if it was in the off state before the exception tripped).

When you use ASF to turn on the log automatically with SL=, OMEGAMON II first logs the panel in use and then branches to the scheduled screen space. This is done so that any exceptions are logged before the ASF sequence begins.
Introduction

Most users do not need to use OMEGAMON II commands. However, advanced users or those wishing to create screen spaces for the XLF, ASF, or TSF features need to know how to enter and get help for commands.

The following section describes how to obtain help for OMEGAMON II commands. It assumes previous experience using OMEGAMON II commands.

Note: If you plan on using only the menu system, you can bypass this appendix.

You may enter immediate, major, or minor commands on any blank line of any screen.

Appendix Contents

Help for Commands .......................................................... 424
Command Reference .......................................................... 426
Command usage .............................................................. 426
OMEGAMON II for CICS commands .................................... 426
Help for Commands

For help with commands, enter a character in column 1 preceding the command:

? Displays a one-line help that stays on the screen until you clear it.
/ Displays an extended help that stays on the screen until you clear it.
; Displays an extended help that disappears on the next cycle.

An example of the one-line help for the FILE command is shown in this figure.

FIGURE 262. One-line Command Help

```
/FILE
> Search for and display datasets allocated to the CICS region.
```

A continuation character (+) at the right of a one-line help indicates that extended help is available.

An example of the extended help for the FILE command is shown in Figure 263 on page 425.
Some commands provide help about categories of commands:

**EXM** Lists and executes all minors for the preceding major command.

**.ILC** Displays help for the specified INFO-line command.

**.MIN** Lists all minors for the preceding major command.

**H.MIN** Lists all minors and their one-line helps for the preceding major.

**.MJ** Lists all major and immediate commands.

**H.MJ** Lists all major and immediate commands and their one-line helps.
OMEGAMON II for CICS commands

.. Deletes rest of screen.
   Command Format: ..

==== Repeats specified characters in a line across the screen.
   Command Format: c====aa
   Examples:
   R====++ Creates a line of red plus signs across the screen, preceded by
             four equal signs.
   T====== Creates a line of turquoise equal signs across the screen.

ACTN Displays any lines requiring operator action.
   Minor of CONS and CONU.
   Command Format: ACTN
AIDK

Terminates CICS Automatic Initiate Descriptor(s).

Command Format: \texttt{AIDK <keyword=cccc KILL>}

Use an asterisk (*) to specify a generic transaction or terminal ID.

Example:

\texttt{AIDK TRAN=AB* KILL} \quad \text{Kills AIDs for transaction IDs beginning with AB.}

AIDS

Displays CICS Automatic Initiate Descriptor (AID) information.

Command Format: \texttt{AIDS <keyword=cccc>}

AMAP

Displays the private area virtual storage utilization.

Minor of PEEK.

Command Format: \texttt{AMAP\langle a\rangle}

Example:

\texttt{AMAPA} \quad \text{Displays virtual storage utilization above the 16M line.}

\texttt{AMAPB} \quad \text{Displays virtual storage utilization below the 16M line.}

/ASF

Controls Automatic Screen Facility.

Enter on INFO-line.

Command Format: \texttt{/ASF ccc}

The Automatic Screen Facility (ASF) lets you define a screen space or series of screen spaces to invoke when a specified exception threshold is exceeded.

/ATTN

Emulates the program attention (PA1) key.

Enter on INFO-line.

Command Format: \texttt{/ATTN}

In OMEGAMON, the PA1 key resets color and clears screen.
/AUP Controls automatic update mode.
Enter on INFO-line.

Command Format: /AUP ccc

With automatic update mode on, the screen updates at regular intervals without your pressing ENTER.
Some network programs do not support automatic updating.
Applies to: VTAM mode only.

.AUP Displays/resets the status of automatic update in VTAM mode.

Command Format: .AUP<aaa> ON|OFF

With automatic update mode on, the screen updates at regular intervals without your pressing ENTER.
Some network programs do not support automatic updating.
Applies to: VTAM mode only.

AVQ Sets average IOS queue depth threshold for XDSK command.
Minor of CDEV.

Command Format: AVQnnn

Example:

AVQ105 Sets queue depth threshold to 10.5.

BLST Displays and controls wait reason data collection bucket sets.

Command Format: BLST <cccc <aaa>>

When you display all wait reason bucket sets, each line starts with a colon (:) allowing you to type over the characters in the ON/OFF column with ON or OFF. Entering ON activates the appearance of this wait reason on bottleneck analysis displays. Entering OFF suppresses the wait reason display. Neither ON nor OFF affect wait reason data collection.

If you zoom (PF11) on a specific wait reason, bucket set detail displays. Detail data contains additional CICS system data related to the wait reason along with a breakdown of the data collected for each of the 30 groups.

/BOTTOM Scrolls to the bottom of the logical screen.
Enter on INFO-line.

Command Format: /BOTTOM
CDEV Displays long-term device utilization.

Command Format: 

CDEV

CICM Executes commands to the common interface (CI).

Command Format: 

CICM ccccc

Example: 

CICM STOP OBVTAM

Stops the OBVTAM subtask of the common interface (CI).

If you need to enter a CI command longer than 73 characters, enter the command in a member of the CI control file. Then, enter an EXEC command to the CI to process the member.

CICS Displays active CICS regions and switches monitoring to another region.

Command Format: 

CICS <ccccccccc>

CICS ignores swapped-out regions, those in transition, and the current target region.

When another valid region is selected, CICS terminates the current session and initiates the new session automatically.

CINT Displays/sets response time data collector time intervals.

Command Format: 

CINT? or CINT n1,n2,n3

The default intervals are taken from the GLOBAL_OPTIONS module. You can change the time interval values only when the response time data collector is inactive. To collect response time data, you must define transaction, program, terminal or LU groups. Use the GRPS command to define or change groups.

CMT Displays/sets the master terminal function values.

Command Format: 

-CMT cccc <,n>

Example: 

-CMT AMX,3 Specifies 3 as the maximum number of active tasks.
**.CN**
Opens, closes, swaps, or sets address of the secondary console.

Command Format: `.CNxxx` or `.CN cc`

Example:
- `.CN649` Sets the address to 649.
- `.CN OP` Opens the secondary console. Note that you must precede .CN cc with a .CNxxx entry.

This command works in dedicated mode only.

**CNT**
Displays counts of response times recorded for ID groups.

Minor of CSLT and CRSP.

Command Format: `nCNT<cc>`

**COLL**
Displays/changes the status of the file and database collectors.

Command Format: `COLL`

**CON**
Sets average device connect time threshold for XDSK command.

Minor of CDEV.

Command Format: `CONnnn`

**CONS**
Displays the console image for the specified console.

Command Format: `CONSnn`<br>`<CONSNnn`<br>`<CONS=<conid|conname>>`

CONS nn displays three types of information on the command line: the type of console (CONSOLE or MASTER CONSOLE), the console’s device number, and the console’s ID number (as in ID=3).

**CONU**
Displays the console image for the console at device address nnn.

Command Format: `CONU<nnn>`

CONU nnn displays two types of information on the command line: the type of console (CONSOLE or MASTER CONSOLE) and the console’s number (as in ID=3).

**COPY**
Specifies the number of copies to print.

Minor of OUTP.

Command Format: `COPY<nn>`

COPY is active under SYSOUT control. If you set the HOLD minor command to YES, JES ignores this command.
CORE Displays a menu of CICS control blocks and their respective commands.
Command Format: CORE

CRSP Selects time interval response time monitoring.
Command Format: CRSP
Time interval monitoring uses a combination of major and minor commands. CRSP selects time interval monitoring, and the TIME minor command displays response time data for transaction, program, terminal and LU groups. The CNT minor displays counts for these groups.
To collect response time data, you must define transaction, program, terminal or LU groups. You can use the GRPS command to define or change ID groups.

CSA Displays the CICS Common System Area (CSA).
Command Format: CSA <aaaa>
CSA displays information about the CICS Common System Area.

CSAR Displays CSA and ECSA real memory allocated by key.
Command Format: CSAR
CSAR lists each key, the standard key user, the CSA and ECSA real memory allocated to the key, and the total memory allocated.

CSLT Selects response time monitoring by time slots.
Command Format: nCSLT
Time slot monitoring uses a combination of major and minor commands. CSLT selects time slot monitoring, and the TIME minor command displays response time data for transaction, program, terminal, and LU groups. The CNT minor displays counts for these groups.
To collect response time data, you must define transaction, program, terminal, or LU groups. You can use the GRPS command to define or change ID groups.

CSWP Displays/sets the swap status/DONTSWAP count of CICS.
Command Format: -CSWP <ccccccc>
The current DONTSWAP count reflects the number of OKSWAP SYSEVENTS that must be issued before the address space is again considered for swapping by the system resources manager (SRM).

CSYS Displays general information about the CICS address space.
Command Format: CSYS <GRAPH>
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CVSW</td>
<td>Displays files experiencing string waits and LSR buffer waits.</td>
</tr>
<tr>
<td>.D</td>
<td>Deletes n lines.</td>
</tr>
<tr>
<td>DADR</td>
<td>Displays the address of the device.</td>
</tr>
<tr>
<td>DALC</td>
<td>Displays number of current allocations to the devices.</td>
</tr>
<tr>
<td>DATA</td>
<td>Displays data space and hyperspace activity for an address space.</td>
</tr>
<tr>
<td>DB2</td>
<td>Displays information about the CICS/DB2 interface.</td>
</tr>
<tr>
<td>DCAT</td>
<td>Displays whether a device is static, installation-static, or dynamic.</td>
</tr>
<tr>
<td>/DCL</td>
<td>Deletes all comment lines (&gt; in column 1) on the screen.</td>
</tr>
<tr>
<td>.DCL</td>
<td>Deletes its own line and all comment lines below it.</td>
</tr>
</tbody>
</table>
**.DD** Deletes a block of data from the screen.

Command Format: **.DD**

To delete a block of lines from the physical screen, enter .DD on the first line of the block and .DD on the last line.

**DDN** Displays information about all allocated ddnames and datasets.

Minor of PEEK.

Command Format: **DDN<nnn>**

If a ddname is associated with a multi-volume dataset, only the first allocated volume is displayed.

**DDNM** Displays or overrides standard OMEGAMON II ddname.

Minor of OUTP.

Command Format: **DDNM<cccccccc>**

Your environment determines allowable ddnames. If the value you enter is not allowed, OMEGAMON II redisplays it where you entered it and does not transfer it to the pending column.

**/DEF** Sets definition mode.

Enter on INFO-line.

Command Format: **/DEF cccc**

**.DEF** Displays/resets the status of definition mode.

Command Format: **.DEF<aaa>**

Definition mode inhibits automatic updating of a dedicated or VTAM mode session so you can define a screen space that includes commands that comment themselves out or otherwise change form after execution.

**DELT** Deletes the specified screen space.

Command Format: **DELT<a>cccccccc**

Example:

**DELT SAMPLE** Deletes the screen named SAMPLE.
**DEST**

Specifies destination ccccccccc to receive report or XLFLOG.

Minor of OUTP.

Command Format: **DEST<cccccccc>**

The DEST minor is under SYSOUT control. The default is *NONE*, which sends the output to the local printer.

If the destination is a user ID and there is more than one device destination, use the DSTU minor command.

**DEV**

Selects a disk with a specified volser number or unit address.

Command Format: **DEV ccccccc|xxxx**

Example:

**DEV 5200**

Selects the disk at address 5200.

For an online device, DEV returns a message in this format:

**DEV xxx Volser=cccccc Online Alloc**

For an offline device, DEV returns a message in this format:

**DEV xxx Offline**

**DEVL**

Selects listed devices by unit address or volser number.

Command Format: **DEVL ccccccccc xxxx**

You can mix addresses and volsers on one line.

If you list an invalid address or volser, or if you specify the same disk twice, OMEGAMON II eliminates the invalid or duplicate value from the list.

**DEVP**

Selects devices by a pattern that has been set with .SPT.

Command Format: **DEVP/n**

**DEX**

Controls the bottleneck analysis data collector.

Command Format: **DEX <aaaaa <keyword=nn> >**

The data collector must be turned on in order to use bottleneck analysis.

The threshold specifies the percentage of wait reason occurrences over which bottleneck analysis displays wait reasons.

When the long-term interval elapses, the long-term buckets are set to the current value of the short-term buckets and the short-term buckets are set to zero.
DING
Forces the terminal bell to ring.
Command Format: DING
The bell must be activated with the BELL=ON option of the OPTN command.

DIO
Displays start I/Os on drive (RMF required).
Minor of device majors.
Command Format: DIO <.a>
You may use DIO to display I/O rates or increments by adding modifiers in columns 6-7 (note the blank in column 5):

- DIO .R Displays I/O rate per second
- DIO .S Displays I/O rate per second
- DIO .M Displays I/O rate per minute
- DIO .H Displays I/O rate per hour
- DIO .D Displays I/O count increase in the current cycle

Applies to: RMF only.

DIOQ
Displays the depth of I/O queue for the device(s).
Minor of device majors.
Command Format: DIOQ
Use a device major to select the device(s) for DIOQ.

DISK
Selects disk drives (DASDs).
Command Format: DISK<AL>

DLI
Displays CICS/DLI interface information
Command Format: DLI <aaaaaaa>
DLI displays information about the local CICS/DLI interface component.

DLST
Displays all DASD devices (online or offline).
Command Format: DLST

.DM
Dumps 4 hex bytes at offset xxx from Unit Control Block (UCB).
Minor of device majors.
Command Format: C.DMxxx
.DM is considered a generalized minor command because it may be used with several major commands.
DOPN  Displays the number of open DCBs on the device(s).
Minor of device majors.
Command Format: DOPN

/DOWN  Scrolls down the screen a specified number of lines.
Enter on INFO-line.
Command Format: /DOWN <cccc> or /D <cccc>
/D is the alias for /DOWN.

DPIN  Displays whether a device is pinned.
Minor of device majors, for example, DISK.
Command Format: DPIN
Applies to MVS/SP 4.2 and above.

DPLT  Displays device activity every nn milliseconds for 50 samples.
Minor of device majors.
Command Format: DPLTnn
The display includes:

- **DBsy**  
  D = Device busy, 
  S = Suspended channel program

- **CBsy**  
  C = Control unit busy

- **Chan**  
  H = Channel busy

- **IOQ**  
  Depth of I/O queue

- **I/O#**  
  Wraparound I/O number, 00 to 99 (> indicates start of I/O)

- **CPU**  
  | = Dispatchable, 
  . = Wait

- **User**  
  User of device

- **Cyl**  
  Cylinder being accessed. Displays Rls in this field when standalone release is in progress (a cylinder is not involved).

- **Nrty**  
  N = Device not ready

- **Resv**  
  R = Device reserved

DPLT requires RMF.

DRES  Displays reserve count from this CPU.
Minor of disk majors.
Command Format: DRES
.DSA  Sets authorization to list and/or zap non-sharable data spaces.
Command Format: .DSA<aa>

DSC  Sets average device disconnect time threshold for XDSK command.
Minor of CDEV.
Command Format: DSCnnn

.DSE  Displays the status of the stack.
Command Format: .DSE
.DSE displays:
- Status of the screen stacking facility
- GETMAINed size of each screen
- Time stamp indicating when the screen was stacked
- Total amount of storage allocated for all stacked screens
- Relative position of the current stack entry pointer

.DSKa  Displays selected DASD devices.
Command Format: DSKa <cc>

DSTA  Displays the device mount status.
Minor of disk majors.
Command Format: DSTA
The status can be PRIVATE, PUBLIC, or STORAGE.

.DSTU  Displays/sets destination user ID for log output.
Minor of OUTP.
Command Format: DSTU<cccccccc>
DSTU is active under SYSOUT control.

.DTYP  Displays the device type.
Minor of device majors.
Command Format: DTYP

DUMP  Displays the status of the CICS dump component.
Command Format: nDUMP <DUMP>
DUSR  Displays current user of device.
Minor of device majors.
Command Format:          DUSR

DUT   Sets average device utilization threshold for XDSK command.
Minor of CDEV.
Command Format:          DUTnnn
Example:
                      DUT60     Sets device utilization threshold to 60%.

DVMP  Displays the unit control block (UCB) for the device in hex format.
Minor of device majors.
Command Format:          DVMP
DVMP dumps the UCB, the UCB prefix and all appropriate extensions for
the device. It also shows the device status.

DVOL  Displays volser of selected disk or tape device.
Minor of device majors.
Command Format:          DVOL

ENQ   Displays tasks waiting on enqueues and the owners of these resources.
Command Format:          nENQ <QEA=xxxxxxxx> | <RESOURCE=cccccccc>
                      <DUMP>
Displays CICS enqueue resources and related owning and waiting tasks.

ETE   Displays end-to-end response times for logical units.
Command Format:          ETE <cccccccc> | <keyword=nn>
Applies to: VTAM 3.1.1 and later releases.

EXIT  EXIT displays information about CICS Exit Program Blocks.
Command Format:          EXIT <EPBS>
.EXM
Lists and executes all minor commands for the preceding major command.
Command Format: .EXM <n> or .EXM <c1 c2>
Example:
.EXM A F  Executes minors for the preceding major that have
names starting with A through F.

.EXP
Displays the Candle product’s expiration date.
Command Format: .EXP
Product updates contain new features, support for new IBM releases,
enhanced operations, and maintenance. You should reinstall the product
on a regular basis to keep up with enhancements and updates.

.EXSY
Invokes exception analysis.
Command Format: EXSY<nn>

.FGO
Moves to the specified screen space with no display.
Command Format: .FGO cccccccc
FGO cccccccc &bbbbbbbb aa value
FGO ddddd=YES
This command is also useful for the Automatic Screen Facility (ASF) and the Timed
Screen Facility (TSF). If logging is in effect, the screens are logged.
.FGO is turned off after 64 cycles (screen spaces) to protect against a looping
condition.
Examples:
.FGO SAMPLE  Goes to screen space named SAMPLE.
.FGO SAMPLE OPSYS EQ ESA  Goes to screen space SAMPLE only if
the value of OPSYS is ESA.

.FILE
Search for and display datasets allocated to the CICS region.
Command Format: FILE<keyword=cccc,keyword=cccc...>

.FOLD
Prints lowercase alphabetic characters in uppercase.
Minor of OUTP.
Command Format: FOLD<ccc>
FOLD is active under ddname or SYSOUT control.
FORM Displays/sets the name of the form on which to print log output.
Minor of OUTP.
Command Format: \texttt{FORM<ccc>}
Your installation determines values for FORM.

GDEV Lists online DASD and tape devices with the generic name cccccc.
Command Format: \texttt{nGDEVcccccc}
Use GLST to list the generic names in the system.

GDFN Displays/sets an exception group for exception analysis.
Command Format: \texttt{GDFN<keyword=value keyword=value ...>}
Example:
\begin{verbatim}
GDFN GROUP=SP POSITION=1 NAME='SYSTEMS PROGRAMMER'
GDFN GROUP=SP LIST=ABND ELAP MAXU PSCU SLOG TSOR WAIT XCON
\end{verbatim}
Defines the SP exception group.
Enter GDFN on each new line if the keywords and values that you specify cannot fit on only one line.

GLST Lists esoteric and generic device names.
Command Format: \texttt{GLST <cccc>}
Example:
\begin{verbatim}
GLST CTC DASD
\end{verbatim}
Displays direct access and channel to channel device esoteric and generic names.

GLOB Displays global data area settings. (Candle Customer Support uses this command for problem diagnosis.)
Command Format: \texttt{GLOB}
\texttt{or}
\texttt{GLOB <cccc>}
Examples:
\begin{verbatim}
GLOB
\end{verbatim}
The sub options display.
\begin{verbatim}
GLOB GLOB
\end{verbatim}
Displays global data area contents (including the PTF level).
GRPS  Add, update, delete, and display Groups and their element(s).
Command Format:    GRPS <operand
                     <keyword=arg,keyword=arg,...>>

/HELP  Invokes the HELP screen space.
Enter on INFO-line.
Command Format:   /HELP or /H
/H is the alias for /HELP.
Use /HELP or /H to call up the HELP screen space, which tells you more about the
functions, features, and operation of OMEGAMON II.
To get help for an individual command, enter a question mark (?) in column 1 preceding
the command. If there is extended help for the command, a plus sign (+) appears to the
right of the command. To see the extended help, enter a slash (/) or semicolon (;) in
column 1 preceding the command.

/HOLD  Controls screen space updating.
Enter on INFO-line.
Command Format:    /HOLD aaa
The /HOLD command is designed for users of VM/PASSTHRU. If you are not a user of
VM/PASSTHRU, /HOLD functions the same as placing the cursor in column 1, row 1.

HOLD  Displays/sets that output be placed in the hold queue.
Minor of OUTP.
Command Format:    HOLD<ccc>
HOLD is active under SYSOUT control. If you set HOLD to YES, JES ignores the
setting for COPY command.

.I  Inserts a blank line or lines.
Command Format:    .I <nn>
.I does not interrupt command output. If you invoke .I between a command and the end
of its output, OMEGAMON II inserts the blank lines immediately following the output.
**IACL**
Sets the long-term clearing interval for the impact analysis display.

Command Format: \textit{IACL}<n>

Examples:
- IACL: Clears long-term intervals and gives current value.

**IACS**
Sets the length of the short-term clearing interval.

Command Format: \textit{IACS}<nn>

Examples:
- IACS: Clears short-term interval and gives current value.

**IANC**
Sets the maximum number of CICS regions or region groups to monitor.

Command Format: \textit{IANC}<n>

You must set the maximum before initiating the impact analysis session. Otherwise, you must stop the collector with the IANL END command first.

**IANL**
Shows the MVS workload impact on your CICS workload.

Command Format: \texttt{aIANL}

or

\texttt{aIANL <jobname|GROUP=a|LIST|LIST=ALL|DELETE|END>}

or

\texttt{aIANL <jobname<,LIST|DELETE>>}

or

\texttt{aIANL <GROUP=a,LIST>}

**IANQ**
Sets the enqueue sampling interval for impact analysis.

Command Format: \textit{IANQ}<ON|OFF|nn>

The default is OFF. If ON is specified, the default enqueue sampling interval is 10.

Example: \texttt{IANQ5}

Sets the enqueue sampling interval to 5 cycles.

You cannot adjust enqueue collection while the collector is running. You must do so before you start the collector. Or, you must stop the collector (use IANL END command), adjust enqueue collection, and then restart the collector (use IANL command). You can display the current enqueue sampling interval during active collection.
IAST     Sets the impact analysis sampling interval.
Command Format:   IAST<nn>
Since impact analysis is based on a statistical sampling technique, smaller sampling
intervals provide more accurate data, but do so at the expense of CPU time. Larger
intervals reduce the accuracy of the data. Candle suggests that you use the default, .9
seconds, before adjusting the sampling interval for your system.

IATH     Sets the impact analysis severity threshold by percentage.
Command Format:   IATH<nn|0>
By default, only those impact sources that account for 5% or more of the total non-idle
time of the CICS region or group are shown on the display.
IATH does not comment itself out after execution.

IATO     Displays/sets the impact analysis timeout interval.
Command Format:   IATO<nn>
IATO may be issued whether or not the impact analysis collector is active.

ICEK     Terminates CICS Interval Control Element(s) (ICEs).
Command Format:   ICEK<keyword=cccc KILL>
Use * to specify a generic transaction or terminal ID.
Example:   ICEK TRAN=AB* KILL
Kills ICEs for transaction IDs beginning with AB.

ICES     Displays CICS interval control element (ICE) information.
Command Format:   ICES <keyword=cccc>

ICHP     Displays installed channel path n for a device.
Minor of device majors.
Command Format:   ICHPn

ID1      Requests separator pages and headers to identify OMEGAMON II sessions.
Minor of OUTP.
Command Format:   ID1<cccccccc>
ID1 is active under ddname or SYSOUT control.
ID2  Defines up to 16 characters on the left of separator page.
Minor of OUTP.
Command Format: ID2<ccc...ccc>
ID2 is active under SYSOUT or ddname control.

ID3  Defines up to 16 characters in the center of separator page.
Minor of OUTP.
Command Format: ID3<ccc...ccc>
ID3 is active under ddname or SYSOUT control.

ID4  Defines up to 16 characters on the right of separator page.
Minor of OUTP.
Command Format: ID4<ccc...ccc>
ID4 is active under ddname or SYSOUT control.

.ILC  Displays all INFO-line commands or one command’s help text.
Command Format: ILC </cccccccc>

/INT Sets the interval for Automatic Updating (AUP).
Enter on INFO-line.
Command Format: /INT nnn
If you specify 0 as an interval, Automatic Update mode turns off and OMEGAMON II reverts to interactive update.
Dedicated mode always uses Automatic Updating. In VTAM mode, use the /AUP command to turn Automatic Updating on and off.

INTR Displays and controls the status of interval recording.
Command Format: INTR <aaaaa <keyword=nn> >

IOPT Sets global OMEGAMON II installation options.
Command Format: IOPT<keyword=value keyword=value ...>
IOPT settings do not take effect until your next session.

IOS  Sets IOS queue time threshold for XDSK command.
Minor of CDEV.
Command Format: IOSnnn
IPRF Saves/deletes the installation default profile.
Command Format: `IPRF SAVE|DELETE`

The installation profile identification is internally generated. The 2-character product code followed by the constant, INSTAL, identifies the installation profile. For example, OCINSTAL serves as the installation profile identifier for the OMEGAMON II for CICS product.

IPRO Displays the resource impact or workload impact profile.
Command Format: `IPRO <PDEXnn|IANL cccccccc|GROUP=aaaaaaaaaaaaa>

If you do not specify a jobname or groupname, IPRO defaults to the last job or group specified with IANL.

Examples:
- `IPRO PDEX10` Resource impact profile for transaction group 10.
- `IPRO IANL GROUP=CICSGROUP1` Workload impact profile for the CICSGROUP1 region group.

JOBS Displays job information.
Minor of PEEK.
Command Format: `JOBS` Displays:
- Start time and date
- Jobclass
- Msgclass
- Programmer name

KILL Displays CICS task(s) and terminates a task after user confirmation.
Command Format: `nKILL <keyword=cccc…>`

LEXC Displays/sets order of exceptions for exception analysis sampling.
Command Format: `LEXC<cccc=n>`
Example:
- `LEXC AMXP=1 CMXP=2`

When you enter 1 or more operands, LEXC does not display exception settings. Any sequence of exceptions defined by LEXC can be saved in a user profile.

LINE Displays nn lines of the console.
Minor of CONS.
Command Format: `LINE nn`
**LNCT** Sets the number of lines per page for REPORT file and XLFLOG output. Minor of OUTP.

Command Format: `LNCT<nn>`

The LNCT command takes effect immediately. Therefore, the pending and current line number settings are always equal.

**/LOG** Controls the OMEGAMON II REPORT log. Enter on INFO-line.

Command Format: `/LOGccc`

OMEGAMON II lets you print a copy of screen images via the REPORT log facility.

**.LOG** Turns on/off the OMEGAMON II REPORT log.

Command Format: `LOG<aaaa>`

.LOG is especially useful in ASF or TSF screens.

**LSCR** Loads screen spaces from RKOCPCSV to the in-storage screen facility.

Command Format: `LSCR ccc ccc...`

LSCR loads screen spaces from the RKOCPCSV dataset to the in-storage screen facility. You may specify as many screen names as will fit on the input line. Screens loaded at OMEGAMON initiation remain in memory throughout the OMEGAMON session. Repeat lines as necessary for more screens.

**LSR** Displays the Local Shared Resource (LSR) pools’ statistics.

Command Format: `LSR <cccc | POOL=n<,ddddd>>`

**MAXR** Displays/sets the value of the global CPU time monitoring limit.

Command Format: `MAXR <CPU=n>`

If n > 0, transactions (except those whose programs start with DFH) with CPU time greater than n, trip the MAXR exception.

**MCHN** Scans common area control block chains.

Command Format: `MCHNc addr,string,olen,chain,dlen`

MCHN displays the control block chain that contains the string if the scan is successful.

**MDEF** Displays/sets names for addresses.

Command Format: `MDEFcc addr,name`
.MIN  Lists all minor commands for the preceding major command.
Command Format:  a.MIN<n>  or  a.MIN<c1 c2>
Example:  H.MIN B D
Displays help for the minors of the preceding major that begin with the letters B through D.

.MJ  Lists all major and immediate OMEGAMON II commands.
Command Format:  a.MJ<cc>

.MJC  Lists all major commands.
Command Format:  .MJC<cc>

.MJI  Lists all OMEGAMON II immediate commands.
Command Format:  a.MJI<cc>

MLST  Displays bytes of memory from commonly-addressable storage.
Command Format:  -MLSTc addr,dlen
To display fetch-protected areas, you must supply the action character in the label field.

.MMA  Lists all major commands for a minor command.
Command Format:  .MMA cccc

MSCN  Displays the location in storage of a specific string.
Command Format:  MSCNc addr,string,slen,dlen

MZAP  Sets the contents of commonly addressable storage.
Command Format:  -MZAP addr+offset,xxxxxxxx,yyyyyyyy

.NXE  Controls message display for exceptions not currently being tested.
Command Format:  .NXE<aaa>
.NXE controls whether OMEGAMON II displays exception messages for exceptions that have occurred during a previous cycle, but that are not currently being tested.
To set the frequency for testing an exception, use the ExNcyc keyword of the XACB command.
**OCHP** Displays online channel path n for the device.
Minor of device majors.
Command Format:  

```
OCHPn
```

Use .MMA OCHP to see the major commands for OCHP.
An asterisk (*) displays next to the channel number when the device is installed but not online.

**OCMD** Issues MVS and JES commands.
Command Format:  

```
-OCMDnn <CONS=<conid|conname>> ccccc
```

**OMEG REMOVE**
Causes C2 to shut down and remove all traces except for one maintenance-free load module. A subsequent OMEG INIT command causes all load modules to be refreshed.

**ONDV** Displays historical task related data.
Command Format:  

```
ONDV <cccccc>
```

**OPT** Displays/sets CICS shutdown option.
Command Format:  

```
OPT <PURGE|NOPURGE|OPER>
```

**OPTN** Sets the global OMEGAMON II options.
Command Format:  

```
OPTN<keyword=value keyword=value ...>
```

Example:  

```
OPTN ASF=ON LOG=ON SCREENCASE=UPPER
```

Turns the ASF and log function features on, and sets screen output to uppercase.

**OSPC** Lists attributes of the owner of a data space.
Command Format:  

```
OSPC cccccccc
```

**OUTP** Displays specified heading for minor commands for XLFLOG or REPORT.
Command Format:  

```
OUTP XLFLOG|REPORT
```

**PARM** Displays current job step EXEC parameter information.
Minor of PEEK.
Command Format:  

```
PARM
```

Displays the parameter information provided on the EXEC statement for the current job step.
**PDEX**
Displays bottleneck analysis wait reasons by percentage.
Command Format: `PDEX<nn> <id> <mm>`
PDEX provides bottleneck analysis information by displaying CICS task wait reasons by percentage of total system activity.

**PDSK**
Displays CICS DASD devices whose volser matches the supplied pattern.
Minor of CDEV.
Command Format: `PDSK nnnnnn`
You can use an asterisk (*) as a wildcard to match any character. An asterisk at the end of a string causes any following characters to match.
Examples:
- **PDSK** `VS*` Selects any devices starting with VS, such as VSRESA, VSAM1, VS, and so forth
- **PDSK** `*VOL01` Selects devices like AVOL01, BVOL01, and so forth
- **PDSK** `*` Selects all DASD devices

**PEEK**
Collects data on address space `cccccccc`.
Command Format: `-PEEK cccccccc`

**.PFK**
Displays/sets PF key definitions for this OMEGAMON II session.
Command Format: `a.PFK <nn=cccc</*comment>>`
Examples:
- `.PFK15=STOP` Assigns the STOP command to PF15.
- `.PFK18=_` Deletes the definition for PF18.

**PND**
Sets device pending time threshold for XDSK command.
Minor of CDEV.
Command Format: `PNDnnn`

**PPRF**
Saves/deletes/comments/lists the user’s session profile.
Command Format: `PPRF aaaaaaaa <cc>`
When you do not supply a user profile identifier, PPRF applies to the current profile, using the value of the USER= start parameter.
/PRINT  Prints the current logical screen.
Enter on INFO-line.
Command Format:  /PRINT or /P
/P is the alias for /PRINT.
When this command executes, a >LOGGED< message appears on the INFO-line to confirm that printing has occurred.
The .PLM limit does not affect this command.

.PRIM  Displays current values of the OMEGAMON II start-up command parameters.
Command Format:  .PRM
Displays these start-up parameters:
  IOMODE=cc  Current OMEGAMON II I/O mode. This is not the mode that appears on the INFO-line; it is the 2-character code entered as the mode in the start-up parameters. In VTAM mode, OMEGAMON II displays IOMODE=IC.
  USER=cc  OCUSERcc module suffix (same as on the INFO-line).
  ROWS=nn  Number of rows on the physical terminal.
  LROWS=nnn Number of rows per screen that are available for scrolling or printing.
  COLS=nnn Number of columns on the physical terminal.
  UNIT=ccc Terminal address of a dedicated OMEGAMON II session. Does not appear when OMEGAMON II is in TSO mode.

.PRT  Prints the specified portion of the screen to the report file.
Command Format:  .PRT<H>

PSW  Displays CICS PSW and CICS’ TCB general purpose registers.
Command Format:  PSW
PSW displays the PSW and general purpose registers for CICS’ major TCBs (quasi-entrant, resource-owning, and concurrent).
/PWD

Specifies an OMEGAMON II password.
Enter on INFO-line.

Command Format: /PWD cccccccc

Some commands may require that you enter a password before you attempt to execute
them. Use the /PWD command to enter your password.

OMEGAMON II prompts you for a password after you enter the /PWD command. For
security reasons, the password does not appear on the screen. The password remains in
effect until you reset it by pressing the PA1 key or entering the /ATTN or /PWD
command.

.R

Repeats the preceding major/minor command sequence n times.

Command Format: .R<nnn>

This command is helpful for use with major commands that select more items than can
fit on one line.

RATE

Transaction rates for transactions exceeding thresholds.

Command Format: RATE <RESET> | <keyword=cccc...>

The operands can be entered with the rate command or their values modified by
overtyping the command line output.

.RC

Repeats preceding major/minor command sequence to display all items.

Command Format: .RC

.RC repeats the preceding sequence of major and minor commands from a major
command that selects multiple items up to .RC. It repeats the sequence until all items
selected by the major are displayed.

Example: 3380 DADR DSTA .RC

Repeats 3380, DADR, and DSTA until all volumes are listed.

RCMD

Routes MVS and JES2 commands to a desired system in a sysplex.

Command Format: -RCMDnn sysname <CONS=<conid|conname>> ccccc
**Command Reference**

**RENM**  Renames a screen space.
Command Format:  \texttt{RENM \textit{a bbbbbbbb cccccccc}}

.REC repeats the preceding sequence of major and minor commands from a major command that selects multiple items up to .REC. It repeats the sequence until all items selected by the major are displayed.

Example:

\textbf{RENM SAMPLE SAMPLE2}  Renames screen space \texttt{SAMPLE} to \texttt{SAMPLE2} in the in-storage screen facility.

The rename request is ignored if the RKOCPCSV DD statement consists of concatenated datasets.

**/REP**  Replaces the existing screen space or PFK definition.
Enter on INFO-line.
Command Format:  \texttt{/REP \textit{ccccccc} \textit{a}}

/REP only replaces existing named screen spaces.

**/RESHOW**  Displays a new copy of the current screen space.
Enter on INFO-line.
Command Format:  \texttt{/RESHOW}

After you have altered the screen by deleting or adding commands, you may want to obtain a new copy of the screen. If you assign a function key to the /RESHOW command, you do not need to retype the current screen space name to refresh the screen.

**RESP**  Displays response times over the last ten minutes for monitored IDs.
Command Format:  \texttt{nRESP \textit{ID=cccccccc} | G|TR|TE|P|LU | \textit{N=nn}}

**RLIM**  Displays the status of resource limiting.
Command Format:  \texttt{RLIM \textit{ON}|OFF}}

You must first define thresholds for CICS resources and transactions.

If resource limiting is active, OMEGAMON II purges any CICS transaction reaching its resource limit. If the status is not active, OMEGAMON II does not purge CICS transactions.

Note:

\textbf{GLOB RLIM}  Displays the type of resource limiting set up.
.RMF Displays RMF information.
Command Format: .RMF
This command displays whether or not RMF is active. When OMEGAMON II is authorized, it also displays the RMF version code and version number, the current interval length, and the cycle time.

RMFS Sets the RMF level when OMEGAMON II has selected the default.
Command Format: RMFS nnn
For example, RMFS 351 monitors a system that is running RMF level 3.5.1.
RMFS cannot change the RMF level setting when OMEGAMON II has dynamically determined the correct level. Use the .RMF command to display the level of RMF that your system is running.

RSP Sets device pending time threshold for XDSK command.
Minor of CDEV.
Command Format: RSPnnn

RSP Displays moving time slot response time data.
Command Format: nRSP<TX|PG|TR|LU>

RTA Controls the response time collector status and RSP display scale/window.
Command Format: RTA <cccc> | <keyword=n>

.RTN Returns to calling screen space during ASF or TSF processing.
Command Format: n.RTN<NR><ccccccc>
Required at the bottom of the last screen in an ASF or TSF sequence. It returns to the calling or specified screen and re-enables exception analysis for further automatic calls.

/SAVE Saves the specified new screen space.
Enter on INFO-line.
Command Format: /SAVE cccccccc <a> or /S cccccccc <a>
/SAVE works only if you have an RKOCPCSV allocated and cccccccc does not already exist. If cccccccc already exists, use /REP.
To save the cursor in any position on the screen, move the cursor to the desired position and press enter. The cursor appears in that position whenever OMEGAMON II invokes the screen. The default cursor position is on the INFO-line.
.SCC Displays/sets options for screen color and/or highlighting.

Command Format: .SCC

.SCC sets screen intensity/color options for either the current session or for a user profile. .SCC accepts keyword input on the command line and displays a message after the command is executed. For example:

.SCC Display=COLOR     >>Done<<

To define a set of options for a user profile, set the ProfileDefinitionMode keyword to ON. Changes made in this mode do not affect your current session unless you change the setting for the DISPLAY keyword from Basic, High, or Low to Color, or from Color to Basic; then the related keyword settings are automatically converted to those specified in your user profile.

SCHN Scans data space control block.

Command Format: -SCHNc

jobname,spacename,addr,string,off1,off2,plen

SSCN scans data space storage until it finds a match to the string, the chain loops, or until the address of the next control block is zero. When necessary, an SRB is scheduled into the address space of the TCB owning the data space to be scanned.

SCRN Lists screen member names.

Command Format: SCRN<a><c1 c2>

Example:

SCRN C D  Lists all screens stored in both disk datasets and main storage that have names starting with C or D.

SDSK Selects device by string address.

Minor of CDEV.

Command Format: aSDSK xx

Example:

FSDSK12  Selects all CICS DASD devices on the 12x string.

.SET Displays or sets OMEGAMON II global values and switches.

Command Format: .SET keyword=value keyword=value ...

Example:

.SET PEEKSIZE=4096 DGENLIMIT=200

The command shown above sets the PEEK buffer size to 4096 bytes and the DGENLIMIT to 200.
.SGO Fetches the specified screen space on the next update.
Command Format: \textit{nSGO cccccccc <bbbbbbbb aa value>}
Examples:
\textit{.SGO SAMPLE} Fetches screen SAMPLE.
\textit{.SGO SAMPLE OPSYS=ESA} Fetches screen SAMPLE only if OPSYS=ESA.

SIT Displays system initialization table (SIT) information.
Command Format: \textit{SIT<ccccccc>}
SIT displays information from the CICS System Initialization Table. The values displayed reflect any SIT overrides entered during initialization.

SLST Lists data space storage.
Command Format: \textit{-SLSTa jobname,spacename,addr,plen}
SLST lists memory from data spaces. When necessary, an SRB is scheduled into the address space of the TCB owning the data space to be listed.

SOUT Displays/sets the SYSOUT class.
Minor of OUTP.
Command Format: \textit{SOUT<c>}
SOUT removes control from ddname.

.SPT Sets pattern number n to the value ccccccc for generic selection.
Command Format: \textit{.SPT</n cccccccc>}
You can use .SPT to a set up to 10 patterns for use with the DEVP command and the address space major commands. To invoke a pattern, follow DEVP (or any address space major) with a slash (/) and the pattern number. To invoke the default pattern, follow DEVP or the address space major with a /.

SSCN Scans data space storage for a specified string of data.
Command Format: \textit{-SSCNa jobname,spacename,addr,string,len1,len2}
SSCN scans data space storage until it finds a match to the string or the length of storage specified is exhausted. When necessary, an SRB is scheduled into the address space of the TCB owning the data space to be scanned.

STAT Used by the OMEGAMON II CUA interface for internal use.
Command Format: \textit{STAT}
**STEP**
Displays information about the region and program for this step.
Minor of PEEK.

Command Format: `STEP`
For each region, STEP displays the region’s size, storage in use, limit, current program, and so forth.

**/STK**
Performs screen stacking functions.
Enter on INFO-line.

Command Format: `/STK <cccc>`
Recalled stacked entries remain on the stack until explicitly deleted or cleared.

**/STOP**
Stops current OMEGAMON II session.
Enter on INFO-line.

Command Format: `/STOP`

**STOP**
Stops current OMEGAMON II session.

Command Format: `STOP`

**STOR**
CICS storage data and storage usage by tasks and CICS subpools.

Command Format: `STOR <cccc...>`

**STST**
Used by the OMEGAMON II CUA interface for internal use.

Command Format: `STST`

**SUBP**
Displays information about storage allocated in subpools.
Minor of PEEK.

Command Format: `aSUBP<nn>`

**SZAP**
Zaps data space storage.

Command Format: `-SZAP jobname,spacename,addr,vercode,repcode`
SZAP zaps memory in data spaces. When necessary, an SRB is scheduled into the address space of the TCB owning the data space to be zapped.

**Important:** Data may be lost when using SZAP on hyperspaces. If OMEGAMON II is writing pages back to the hyperspace while another user is writing to the same page of the hyperspace, the newly entered data may be lost.
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
<th>Command Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>TABL</td>
<td>Search and display CICS Tables and their entries.</td>
<td>TABL &lt;tablename&gt; &lt;keyword=cccc,keyword=cccc...&gt;</td>
</tr>
<tr>
<td>TAPE</td>
<td>Selects all online tape drives.</td>
<td>TAPE</td>
</tr>
<tr>
<td>TASK</td>
<td>Displays formatted information about a selected task or tasks.</td>
<td>nTASK &lt;operand</td>
</tr>
<tr>
<td>TCBS</td>
<td>Displays the task control block (TCB) structure.</td>
<td>aTCBS</td>
</tr>
<tr>
<td>TCTV</td>
<td>Displays Terminal Control Table prefix information.</td>
<td>TCTV &lt;DUMP&gt;</td>
</tr>
<tr>
<td>TDDL</td>
<td>Displays summary information and statistics on all transient data destinations defined in your system.</td>
<td>TDDL</td>
</tr>
<tr>
<td>TERP</td>
<td>Displays permanent read/write errors accumulated for a tape drive.</td>
<td>TERP</td>
</tr>
<tr>
<td>TERT</td>
<td>Displays temporary read/write errors accumulated for a tape drive.</td>
<td>TERT</td>
</tr>
<tr>
<td>TIME</td>
<td>Displays response time data for ID groups.</td>
<td>nTIME&lt;cc&gt;</td>
</tr>
</tbody>
</table>
TLBL Displays the tape label type.
Minor of tape majors.
Command Format: TLBL
The tape label types are SL, NL, or NON-STD. BLP tapes appear as NL.

TLST Selects all tape drives (online and offline).
Command Format: TLST
Displays unit addresses of selected drives. Offline drives are preceded by a hyphen (-).

TMPS Displays Temporary Storage information.
Command Format: TMPS <DUMP>
TMPS displays details about the temporary storage component of CICS, including information about both auxiliary and main temporary storage.

/TOP Scrolls to top of the logical screen.
Enter on INFO-line.
Command Format: /TOP
This is the same as /UP MAX or /UP TOP.

TPaa Displays selected tape drives.
Command Format: TPaa <cc>
Displays unit addresses of selected drives.

TRAC Display CSA trace and monitoring controls or trace tables.
Command Format: TRAC <TRTAB> | <PCATT <DUMP>>

TRND Displays Transient Data information.
Command Format: TRND <DUMP>

TSEQ Displays open file sequence number on a tape drive.
Minor of tape majors.
Command Format: TSEQ
Displays unit addresses of selected drives.
.TSF Displays/sets the Timed Screen Facility (TSF).
Command Format:   .TSF<ccc>
Example:   
           .TSFOFF   Turns TSF off.

/TSF Turns on/off the Timed Screen Facility (TSF).
Enter on INFO-line.
Command Format:   /TSFccc
TSF lets you define a screen space or series of screen spaces to be invoked at
certain times of the day or at specified intervals. The definitions are set with .TSF.
The screens can be named screen spaces or PF key screens kept in memory. You
must save your user profile to make these changes permanent.
A screen space can contain commands to turn on different analyses, as well as the
log. You can use TSF to automate many of your daily tasks.

TSQ Displays temporary storage queues.
Command Format:   nTSQ  <ID=cccccccc>  <SEL=aaaa>

TSQD Performs temporary storage queue deletions.
Command Format:   nTSQD  <ID=cccccccc>  <SEL=aaaa>

/UP Scrolls up cccc lines.
Enter on INFO-line.
Command Format:   /UP <cccc>:exph. or :xph./U <cccc>
/U is the alias for /UP. The initial PF setting for the /U command is PF19. If you enter
any of the optional arguments on the INFO-line before you press the PF key,
OMEGAMON II interprets the entry as if you had entered the command plus the
arguments.

VANL Used by the OMEGAMON II CUA interface for internal use.
Command Format:   VANL
**.VAR**
Displays/sets variable symbols.

Command Format:
```
 VAR
```
or
```
 VAR aaa &bbbbbbbbb
```
or
```
 VAR SET &bbbbbbbbb 'ccc...ccc' <comment>
```
or
```
 C.VAR SET &bbbbbbbbb 'ccc...ccc' &ddddddd rel 'eee...eee'
```

Examples:
```
 VAR
List all defined variables.

 VAR DEL &ZSVAR
Delete variable named ZSVAR.

 VAR SET &ZSVAR CICS
Set value of ZSVAR to CICS.

 C.VAR SET &ZSVAR CICS &ZSOPS=ESA
Set value of ZSVAR to CICS only if value of ZSOPS is ESA.
```

**VSAM**
Provides summary and detail display of open VSAM files.

Command Format:
```
 nVSAM <cccccccc>
```

**.VTM**
Displays multi-session status information.

Command Format:
```
 .VTM
```

**.WAT**
Specifies a delay before executing the commands that follow.

Command Format:
```
 .WATnn
```

Example:
```
 .WAT02 .FGO MYSCREEN
Causes OMEGAMON II to wait 2 seconds before fetching screen space MYSCREEN.
```

**WSIZ**
Displays/resets the data collection work area’s size (shown in K).

Minor of PEEK.

Command Format:
```
 WSIZ<nnn>
```

When the work area size is changed, the work area is released, disabling all subsequent minor commands on the screen for that interval. On the subsequent interval, a new work area is obtained at the specified size.
XACB Displays/sets exception thresholds and attributes dynamically.
Command Format:

\[
\text{XACB } \langle \text{GROUP=cc} | \text{LIST=aaaa} \rangle <\text{VERBOSE|TERSE}> <\text{FORCE}> \]

Example:

\[
\text{XACB LIST=TPDR TNRS VERBOSE FORCE}
\]
Executes and displays the TPDR and TNRS exceptions in multiline format.

XDSK Selects device by exception.
Minor of CDEV.
Command Format: \(\text{aXDSK}\)
Exception thresholds are set with other minor commands of CDEV. (Do a .MIN command to list them.) For example, if the total device response time threshold has been set to 100 milliseconds with the RSP:hp1.nnn:ehp1. minor command, then XDSK selects any DASD device whose total response time is greater than 100 ms.

XGRP Invokes exception analysis for exception group cc.
Command Format: \(\text{XGRPcc}\)

XGSW Displays/sets exception group switches.
Command Format:

\[
\text{XGSW } \langle \text{GROUP=cc} | \text{STATE=ON|OFF|TEST|NDSP|NULL}> >
\]
ON, OFF, NDSP, and TEST override the individual exception settings for group switches.

/XLF Turns on/off the Exception Logging Facility (XLF).
Enter on INFO-line.
Command Format: \(\text{/XLF<ON|OFF|OUT}>\)
Example:

\[
\text{/XLF OFF}
\]
Turns off XLF.
Use .XLF to log exception messages automatically. This command functions only in dedicated mode or in VTAM mode with Automatic Updating in effect.
.XLF writes exceptions to the XLFLOG. To view or change the defaults for this file, use the OUTP major command.
.XLF  Turns on/off the Exception Logging Facility (XLF).
Command Format:  .XLF<ON|OFF|OUT>
Example:
   .XLFOFF  Turns off XLF
Use .XLF to log exception messages automatically. This command functions only in
dedicated mode or in VTAM mode with Automatic Updating in effect.
.XLF writes exceptions to the XLFLOG. To view or change the defaults for this file,
use the OUTP major command.

XMCH  Scans control block chains for a string of hex values or characters in a CICS address
space.
Command Format:  -XMChc targ,addr,string,olen,chain,dlen
XMCH displays the control block chain that contains the string if the scan is
successful.

XMLS  Displays storage of specified CICS address space.
Command Format:  -XMLSc targ,addr,dlen

XMSC  Scans a CICS address space for a string of hex values or characters.
Command Format:  -XMSCa targ,addr,string,slen,dlen
Displays the string if scan is successful.

XMZP  Modifies a CICS address space’s private storage area.
Command Format:  -XMZP targ,addr,xxxxxxxx,yyyyyyyy
XMZP schedules an SRB into the target address and modifies the contents of the
indicated storage, so XMZP must be used with caution.

XRF  Displays the status of the CICS Extended Recovery Facility (XRF).
Command Format:  XRF

XSUM  Displays a summary of the exceptions and their current states.
Command Format:  XSUM <GROUP=cc> <LIST=I> <RESET>
XSUM displays exceptions in the specified order. Each exception is followed by its
current state, threshold value (if any), and group ID.
Example:
   XSUM GROUP=OS LIST=I  Displays the exceptions in the OS exception
group in invocation order. Each exception
is followed by its current state, threshold
value (if any), and group ID.
XTRP Displays a summary of the tripped exceptions.
Command Format:  **XTRP** <GROUP=cc> <LIST=I> <RESET>

XTRP displays each tripped exception followed by its current state, threshold values, and group ID.

Example:

**XTRP GROUP=OS LIST=I**  Displays exceptions that have tripped in the OS exception group in invocation order. Each exception is followed by its current state, threshold value, and group ID.

XTXT Specifies the message to display when no exceptions have tripped.
Command Format:  **XTXT<ccc...>**

Example:

**XTXT 'no problems'**  Displays the message, no problems, when no exceptions have tripped.

XVSC Sets VSAM split and extent exception analysis cycle.
Command Format:  **XVSC<nn>**

The setting of XVSC affects the frequency in which messages are displayed for VCAS, VCIS and VMEX.

.ZAP Displays maintenance applied.
Command Format:  **.ZAP**

The .ZAP command displays maintenance information as well as product and environment data. This output is used primarily in consultation with Candle support personnel.

/ZERO Displays/sets the way zeros display.
Enter on INFO-line.
Command Format:  **/ZERO ccc**

You may find that the screen is easier to read when zeros are displayed as blanks (as with /ZERO OFF).

/ZOOM Zooms to the screen determined by the command at the cursor location.
Enter on INFO-line.
Command Format:  **/ZOOM<cccc>**

The cursor must not be in either row 0 or the first or last position of a row.
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
<th>Command Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>2305</td>
<td>Displays all 2305 disks.</td>
<td>2305</td>
</tr>
<tr>
<td></td>
<td>For non-base exposures, the unit address and exposure number appear instead of the volser.</td>
<td></td>
</tr>
<tr>
<td>3330</td>
<td>Displays all 3330 disks.</td>
<td>3330nn</td>
</tr>
<tr>
<td>3340</td>
<td>Displays all 3340 disks.</td>
<td>3340</td>
</tr>
<tr>
<td>3350</td>
<td>Displays all 3350 disks.</td>
<td>3350c</td>
</tr>
<tr>
<td>3375</td>
<td>Displays all 3375 disks.</td>
<td>3375</td>
</tr>
<tr>
<td>3380</td>
<td>Displays all 3380 disks.</td>
<td>3380</td>
</tr>
<tr>
<td>3390</td>
<td>Displays all 3390 disks.</td>
<td>3390</td>
</tr>
</tbody>
</table>
Introduction

This appendix describes the Simplified Signon feature. With this feature enabled, you will see the CICS Regions panel when you sign onto OMEGAMON II for CICS. From this panel, you can select a region to monitor.

Appendix Contents

Using Simplified Signon ................................................................. 466
  Introduction ......................................................................... 466
  Requirements ...................................................................... 466
Implementing Simplified Signon for an Existing User  ................................................................. 467
  Introduction ......................................................................... 467
  Procedure ........................................................................... 467
  Security for an existing user ................................................. 467
Using Simplified Signon ................................................................. 468
  Introduction ......................................................................... 468
  Regions listed ...................................................................... 468
  Selecting a region ................................................................ 468
  Switching regions ................................................................ 469
  Sorting Regions .................................................................. 469
  Filtering regions .................................................................. 470
Using Simplified Signon

Introduction

Using Simplified Signon, you provide only your user ID and password when you sign onto OMEGAMON II for CICS. You no longer need to specify the OMEGAMON collector VTAM applid or the CICS jobname in the logon options.

Whenever you are using the CUA interface to monitor a CICS region, you can easily select another CICS region to monitor by using the region switch key (default PA1) to display the CICS Regions panel.

If the region you are monitoring terminates, the CICS Regions panel redispalyes. You can then select another region to monitor or you can sign off.

Requirements

To use simplified signon, the following is required:

- MVS/ESA
- OMEGAMON II for CICS CUA interface
Implementing Simplified Signon for an Existing User

Introduction

If OMEGAMON II for CICS is already installed at your site, use the following procedure to implement Simplified Signon:

Procedure

1. Update the KC2IPAnn member of rhilev.RKANPAR as follows:
   - OCII_COMMMON_INTERFACE_APPLID=*  
   - CICS_JOB_NAME=*  

2. If you want to restrict users from monitoring certain CICS regions, implement CUA Function Level Security and authorize users to monitor CICS regions, as required for your site. See “Security for an existing user”.

3. Recycle the CUA interface address space (KC2PROC).

Security for an existing user

If you want to restrict CICS region access, you must:

1. Implement CUA Function Level Security as described in OMEGAMON II for CICS Configuration and Customization Guide.

2. In your external security manager (such as RACF, CA-ACF2, or CA-TOP SECRET), specify that your users can access CUA resource name
   - cicsname.KC2.REG.SWITCH

where cicsname is the applid of the CICS region the users can monitor.
Using Simplified Signon

Introduction

The following sections describe how to use the Simplified Signon feature.

Regions listed

For a region to be included on the CICS Regions panel:

- OMEGAMON II for CICS must be initialized in the CICS region by executing program KOCOME00 in the PLTPI or by executing transaction OMEG INIT.
- The CICS region must reside in the same MVS image as the KC2PROC address space.
- When the CUA function level security is enabled, the current user must be authorized to monitor that region.

Selecting a region

After you sign on, the CICS Regions panel displays the CICS regions that you can monitor. Select the region you wish to monitor and press Enter.

FIGURE 264. CICS Regions Panel

If the region you want to monitor:

- is swapped out, **Swapped** is displayed in the CICS Applid field. Swapped out regions cannot be monitored.
- does not appear on the CICS Regions panel, press F11 (Logon Options) and then specify a common interface applid and a CICS jobname.
Switching regions

If you are already monitoring a region, use the following procedure to switch regions.

1. From any OMEGAMON II for CICS CUA interface panel, press the Region Switch Key; the default is PA1.

   The CICS Regions panel is displayed as shown in “Selecting a region” on page 468. In this case, the current region is displayed in the top right hand corner of the panel.

   Note: You can modify the Region Switch Key on the Session Defaults pop-up under the Controls selection of the Options pulldown (fastpath OCS).

2. Select a region to monitor or return to the original region by pressing F12.

Sorting Regions

When you are on the CICS Regions panel (see “Selecting a region” on page 468), you can use the View pulldown to select which regions to display and in what order.

FIGURE 265. View Pulldown Menu

```
1 1. All
   2. Some...

1 1. Sort by CICS jobname
   2. Sort by CICS applid
   3. Sort by CICS release
   4. Sort by start date/time
   5. Sort by OMEGAMON applid
   6. Sort by region profile

Sort order
1 1. Ascending
   2. Descending

F1=Help  F12=Cancel
```

Use this View pulldown to select all regions or only those regions matching your specified criteria, and to sort by any display column in ascending or descending order.
Filtering regions

When you select View Some from the View pulldown, you can use the View Some pop-up to filter the CICS Regions display by CICS jobname, CICS applid, OMEGAMON applid, or region profile.

FIGURE 266. View Some Panel

You can specify selection criteria for any of these fields.
Introduction

This appendix describes how you can modify attributes for some CICS resources directly on OMEGAMON II for CICS panels.

Appendix Contents

Using CUA Actions ................................................................. 472
Purpose .................................................................................. 472
Description ............................................................................. 472
Requirements .......................................................................... 472
Procedures for Modifying Resource Attributes .......................... 473
Performing actions from a summary panel ................................. 473
Performing actions from a detail panel ..................................... 473
Typing attribute values in entry fields ....................................... 475
Summary of Panel Changes ....................................................... 476
Introduction ............................................................................ 476
CICS release 2.1.2 ................................................................... 476
CICS release 3.1.1 or 3.2.1 ........................................................ 478
CICS release 3.3.0 ................................................................ 481
CICS release 4.1.0 .................................................................. 483
CICS release 5.1.0 .................................................................. 485
Using CUA Actions

Purpose
You can manage CICS resources more easily by modifying resource attributes directly on the Common User Access (CUA) summary and detail panels in OMEGAMON II for CICS.

Description
The following changes have been made to the CUA panels in OMEGAMON II for CICS:

- New actions codes have been added to specific CUA panels.
- To aid memorization, new action codes are displayed on summary panels.
- Some previously display-only fields are now entry fields, and new entry fields have been added to some panels. With these changes, you can modify a resource attribute (for example, the Maximum Tasks Limit) displayed in a field.

Requirements
You must be authorized in OMEGAMON II for CICS to perform the specified actions. There are two kinds of security:

- If you are using function-level security, user authorization is controlled by the CUA function level security resource `cicsname.KC2.MEM.CEMT`
- If you are using menu system security, you can control user authorization for the actions by restricting access to the CMT command
Procedures for Modifying Resource Attributes

Performing actions from a summary panel

Action codes are usually displayed directly on a summary panel to indicate the actions you can perform on a resource. For example, the following Programs panel shows the action codes (E, I, N, and P) you can specify for programs. Action codes differ depending on the panel that is displayed.

On the Programs panel, for example, you type the appropriate code in the action entry field preceding the Program ID to change the attribute for that program. In the following example, the NewCopy(N) action is selected for the CMRTRNJ0 program.

FIGURE 267. Action Codes on the Programs Panel

Performing actions from a detail panel

From a detail panel, you can select the action you want to perform on the resource from the Actions pull-down menu. The choices on the Actions menu differ depending on the panel that is displayed. For example, the following Actions pull-down menu for the Programs Entry detail panel lists the actions (Enable, Disable, Hencoop, and Phasing) you can perform on the CMRTRNJ0 program.

In this example, the Kneecapping) action is selected for the CMRTRNJ0 program.

Note: You can also type the mnemonic AN on the action bar to perform this action.
FIGURE 268. Actions Pull-down Menu for the Program Entry Panel

______ Actions  GoTo  Index  Options  Help
+-----------------------------------------------+-------------------------------+
| N 1. Show details                        ntry                                  |
| +---| 2. Enable program Entry address . . . : 08C7C5E8 |
|    | 3. Disable program Definition type . . : Catalog |
|    | 4. Newcopy Program attribute . . : Reusable   |
|    | 5. Phasein Current use count . . : 0          |
|    | 6. Exit Total use count . . : 0               |
|    | F1=Help Current copies . . . : 0              |
|    | F12=Cancel Load status . . . : Located        |
|    | Load point . . . . . : n/a                    |
|    | Loaded from . . . . . : n/a                   |
|    | Data location . . . . : Below                 |
|    | Use count . . . . . : 0                       |
|    | Fetch count . . . . . : 0                     |
|    | Statistics last reset : 6:13:17               |
| +-----------------------------------------------+-------------------------------+
| RPL dataset . . . . : CICS.PROD.LOAD             |

F1=Help  F2=Keys  F3=Exit  F4=Prompt  F5=Refresh  F6=Console  F10=Action Bar
F11=Print  F15=Region Status  PA1=Switch
Typing attribute values in entry fields

Another method you can use to modify selected resource attributes is to type a value into an entry field on the panel. In this example (for a system monitoring CICS Release 4.1.0), you can type a value into a field in the :ehp2. Active Limit:ehp2. column to change the maximum tasks limit (MXT) or the maximum number of tasks for the defined transaction classes.

FIGURE 269. Entry Fields on the Transaction Statistics Panel
Summary of Panel Changes

Introduction
The resource attributes you can modify differ depending on the release of CICS you are monitoring as shown in the following tables.

Each table provides the following information:
- CICS resource.
- Resource attribute.
- CUA panel name on which you can specify the resource attribute.
- Fast path code for accessing the panel.

CICS release 2.1.2
The following table describes the OMEGAMON II for CICS panel changes you will see when you are monitoring CICS Release 2.1.2.

<table>
<thead>
<tr>
<th>CICS Resource</th>
<th>Resource Attributes</th>
<th>CUA Panel Name</th>
<th>Fast Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auxiliary Trace</td>
<td>New actions:</td>
<td></td>
<td>=CR</td>
</tr>
<tr>
<td></td>
<td>Start auxiliary trace</td>
<td>Trace</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Stop auxiliary trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Destinations</td>
<td>New actions:</td>
<td>Destination Control Table (DCT)</td>
<td>=CD</td>
</tr>
<tr>
<td></td>
<td>Open queue</td>
<td>DCT Extrapartition Information</td>
<td>=CDE</td>
</tr>
<tr>
<td></td>
<td>Close queue</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Enable queue</td>
<td>Destination Queues Over Limits</td>
<td>=RNL</td>
</tr>
<tr>
<td></td>
<td>Disable queue</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>New actions:</td>
<td>DCT Intrapartition Information</td>
<td>=CDP</td>
</tr>
<tr>
<td></td>
<td>Enable queue</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Disable queue</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DSA cushion size</td>
<td>New entry field:</td>
<td>CICS Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td></td>
<td>Cushion size</td>
<td>Storage Details</td>
<td>=RSD</td>
</tr>
<tr>
<td>Files</td>
<td>New actions:</td>
<td>File Control Table (FCT)</td>
<td>=CF</td>
</tr>
<tr>
<td></td>
<td>Open file</td>
<td>File Control Table Entry</td>
<td>=CFE</td>
</tr>
<tr>
<td></td>
<td>Close file</td>
<td>File Control Table Entry - Statistics</td>
<td>=CFS</td>
</tr>
<tr>
<td></td>
<td>Enable file</td>
<td>File Control Table - Data Table</td>
<td>=CFL</td>
</tr>
<tr>
<td></td>
<td>Disable file</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Table 5. CUA Panel Enhancements (CICS Release 2.1.2)

<table>
<thead>
<tr>
<th>CICS Resource</th>
<th>Resource Attributes</th>
<th>CUA Panel Name</th>
<th>Fast Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal trace</td>
<td>New actions:</td>
<td>Trace</td>
<td>=CR</td>
</tr>
<tr>
<td></td>
<td>▪ Start internal trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>▪ Stop internal trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Maximum active tasks limit</td>
<td>New entry field:</td>
<td>CICS Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td></td>
<td>▪ Maximum active tasks</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>New entry field:</td>
<td>Transaction Statistics</td>
<td>=WTN</td>
</tr>
<tr>
<td></td>
<td>▪ AMXT Active Limit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Maximum tasks limit</td>
<td>New entry field:</td>
<td>CICS Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td></td>
<td>▪ Maximum tasks</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>New entry field:</td>
<td>Transaction Statistics</td>
<td>=WTN</td>
</tr>
<tr>
<td></td>
<td>▪ MXT Active Limit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Programs</td>
<td>New actions:</td>
<td>Programs</td>
<td>=CP</td>
</tr>
<tr>
<td></td>
<td>▪ Enable program</td>
<td>Program Entry</td>
<td>=CPE</td>
</tr>
<tr>
<td></td>
<td>▪ Disable program</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>▪ Newcopy</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Region exit interval</td>
<td>New entry field:</td>
<td>CICS Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td></td>
<td>▪ Region exit interval</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Runaway task interval</td>
<td>New entry field:</td>
<td>CICS Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td></td>
<td>▪ Runaway task interval</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Stall time interval</td>
<td>New entry field:</td>
<td>CICS Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td></td>
<td>▪ Stall time interval</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Systems</td>
<td>New actions:</td>
<td>Terminal Control Table System Entries</td>
<td>=RM</td>
</tr>
<tr>
<td></td>
<td>▪ Set terminal inservice</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>▪ Set terminal outservice</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>▪ Acquire session</td>
<td>TCT System Entry</td>
<td>=RME</td>
</tr>
<tr>
<td></td>
<td>▪ Release session</td>
<td>TCT System Entry Statistics</td>
<td>=RMS</td>
</tr>
<tr>
<td>Terminals</td>
<td>New actions:</td>
<td>Terminal Control Table (TCT)</td>
<td>=CT</td>
</tr>
<tr>
<td></td>
<td>▪ Set terminal inservice</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>▪ Set terminal outservice</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>▪ Acquire session</td>
<td>TCTTE</td>
<td>=CTE</td>
</tr>
<tr>
<td></td>
<td>▪ Release session</td>
<td>Sequential TCTTE</td>
<td>=CTQ</td>
</tr>
<tr>
<td></td>
<td></td>
<td>TCTTE Statistics</td>
<td>=CTS</td>
</tr>
</tbody>
</table>
### Table 5. CUA Panel Enhancements (CICS Release 2.1.2)

<table>
<thead>
<tr>
<th>CICS Resource</th>
<th>Resource Attributes</th>
<th>CUA Panel Name</th>
<th>Fast Path</th>
</tr>
</thead>
</table>
| Transaction class limits | New entry fields:  
|                     | - Class 1 - Class 10 maximum tasks          | CICS Master Terminal                | =ME       |
|                     | New entry fields:  
|                     | - Class01 - Class10 Active Limit            | Transaction Statistics              | =WTN      |
| Transactions        | New actions:  
|                     | - Enable transaction                        | Transactions                        | =CN       |
|                     | - Disable transaction                        | Transaction Entry                    | =CNE      |
| VTAM ACB            | New actions:  
|                     | - Open VTAM ACB                             | Terminal Control Table              | =AV       |
|                     | - Close VTAM ACB                            | Prefix (TCTFX)                       |           |

### CICS release 3.1.1 or 3.2.1

The following table describes the OMEGAMON II for CICS panel changes you will see when you are monitoring CICS Release 3.1.1 or 3.2.1.

### Table 6. CUA Panel Enhancements (CICS Release 3.1.1 or 3.2.1)

<table>
<thead>
<tr>
<th>CICS Resource</th>
<th>Resource Attributes</th>
<th>CUA Panel Name</th>
<th>Fast Path</th>
</tr>
</thead>
</table>
| Auxiliary Trace     | New actions:  
|                     | - Start auxiliary trace                      | Trace                                | =CR       |
|                     | - Pause auxiliary trace                      |                                      |           |
|                     | - Stop auxiliary trace                       |                                      |           |
|                     | - Switch dataset                            |                                      |           |
| Destinations        | New actions:  
|                     | - Open queue                                | Destination Control Table            | =CD       |
|                     | - Close queue                               | (DCT)                                |           |
|                     | - Enable queue                              | DCT Extrapartition Information       | =CDE      |
|                     | - Disable queue                             |                                      |           |
|                     | New actions:  
|                     | - Enable queue                              | DCT Intrapartition Information       | =CDP      |
|                     | - Disable queue                             | Destination Queues Over Limits       | =RNL      |
### Table 6. CUA Panel Enhancements (CICS Release 3.1.1 or 3.2.1)

<table>
<thead>
<tr>
<th>CICS Resource</th>
<th>Resource Attributes</th>
<th>CUA Panel Name</th>
<th>Fast Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>DSA cushion size</td>
<td>New entry fields:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- DSA storage cushion</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- EDSA storage cushion</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>The cushion size for the selected area is given in the new <strong>Cushion size</strong> entry field.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Files</td>
<td>New actions:</td>
<td>File Control Table (FCT)</td>
<td>=CF</td>
</tr>
<tr>
<td></td>
<td>- Open file</td>
<td>File Control Table Entry</td>
<td>=CFE</td>
</tr>
<tr>
<td></td>
<td>- Close file</td>
<td>File Control Table Entry - Statistics</td>
<td>=CFS</td>
</tr>
<tr>
<td></td>
<td>- Enable file</td>
<td>File Control Table - Logging</td>
<td>=CFL</td>
</tr>
<tr>
<td></td>
<td>- Disable file</td>
<td>File Control Table - Data Table</td>
<td>=CFT</td>
</tr>
<tr>
<td>GTF trace</td>
<td>New actions:</td>
<td>Trace</td>
<td>=CR</td>
</tr>
<tr>
<td></td>
<td>- Start GTF trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Stop GTF trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Internal trace</td>
<td>New actions:</td>
<td>Trace</td>
<td>=CR</td>
</tr>
<tr>
<td></td>
<td>- Start internal trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Stop internal trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Maximum active tasks limit</td>
<td>New entry field:</td>
<td>CICS Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td></td>
<td>- Maximum active tasks</td>
<td>Transaction Statistics</td>
<td>=WTN</td>
</tr>
<tr>
<td>Maximum tasks limit</td>
<td>New entry field:</td>
<td>CICS Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td></td>
<td>- Maximum tasks</td>
<td>Transaction Statistics</td>
<td>=WTN</td>
</tr>
<tr>
<td>Programs</td>
<td>New actions:</td>
<td>Programs</td>
<td>=CP</td>
</tr>
<tr>
<td></td>
<td>- Enable program</td>
<td>Program Entry</td>
<td>=CPE</td>
</tr>
<tr>
<td></td>
<td>- Disable program</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Newcopy</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Phasein</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Region exit interval</td>
<td>New entry field:</td>
<td>CICS Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td></td>
<td>- Region exit interval</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Summary of Panel Changes

#### Table 6. CUA Panel Enhancements (CICS Release 3.1.1 or 3.2.1)

<table>
<thead>
<tr>
<th>CICS Resource</th>
<th>Resource Attributes</th>
<th>CUA Panel Name</th>
<th>Fast Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Runaway task interval</td>
<td>New entry field:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Runaway task interval</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scan delay interval</td>
<td>New entry field:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Scan delay interval</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Systems</td>
<td>New actions:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1. Set terminal inservice</td>
<td></td>
<td>=RM</td>
</tr>
<tr>
<td></td>
<td>2. Set terminal outservice</td>
<td></td>
<td>=RME</td>
</tr>
<tr>
<td></td>
<td>3. Acquire session</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>4. Release session</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Terminals</td>
<td>New actions:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1. Set terminal inservice</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>2. Set terminal outservice</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>3. Acquire session</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>4. Release session</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Transaction class limits</td>
<td>New entry fields:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1. Class 1 - Class 10 maximum tasks</td>
<td></td>
<td>=ME</td>
</tr>
<tr>
<td></td>
<td>2. Class01 - Class10 Active Limit</td>
<td></td>
<td>=WTN</td>
</tr>
<tr>
<td>Transactions</td>
<td>New actions:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1. Enable transaction</td>
<td></td>
<td>=CN</td>
</tr>
<tr>
<td></td>
<td>2. Disable transaction</td>
<td></td>
<td>=CNE</td>
</tr>
<tr>
<td>VTAM ACB</td>
<td>New actions:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1. Open VTAM ACB</td>
<td></td>
<td>=AV</td>
</tr>
<tr>
<td></td>
<td>2. Close VTAM ACB</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**CICS release 3.3.0**

The following table describes the OMEGAMON II for CICS panel changes you will see when you are monitoring CICS Release 3.3.0.

**Table 7. CUA Panel Enhancements (CICS Release 3.3.0)**

<table>
<thead>
<tr>
<th>CICS Resource</th>
<th>Resource Attributes</th>
<th>CUA Panel Name</th>
<th>Fast Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auxiliary Trace</td>
<td>New actions:</td>
<td>Trace</td>
<td>=CR</td>
</tr>
<tr>
<td></td>
<td>- Start auxiliary trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Pause auxiliary trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Stop auxiliary trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Switch dataset</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Destinations</td>
<td>New actions:</td>
<td>Destination Control Table (DCT)</td>
<td>=CD</td>
</tr>
<tr>
<td></td>
<td>- Open queue</td>
<td>DCT Extrapartition Information</td>
<td>=CDE</td>
</tr>
<tr>
<td></td>
<td>- Close queue</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Enable queue</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Disable queue</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>New actions:</td>
<td>Destination Control Table Information</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Enable queue</td>
<td></td>
<td>=CDP</td>
</tr>
<tr>
<td></td>
<td>- Disable queue</td>
<td>Destination Queues Over Limits</td>
<td>=RNL</td>
</tr>
<tr>
<td>DSA cushion size</td>
<td>New entry fields:</td>
<td>CICS Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td></td>
<td>- CDSA storage cushion</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- UDSA storage cushion</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- ERDSA storage cushion</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- ECDSA storage cushion</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- EUDSA storage cushion</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Cushion size for the</td>
<td>Storage Details</td>
<td>=RSD</td>
</tr>
<tr>
<td></td>
<td>selected area is given in</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>the new <strong>Cushion size</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>entry field.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Files</td>
<td>New actions:</td>
<td>File Control Table (FCT)</td>
<td>=CF</td>
</tr>
<tr>
<td></td>
<td>- Open file</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Close file</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Enable file</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Disable file</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>File Control Table Entry</td>
<td></td>
<td>=CFE</td>
</tr>
<tr>
<td></td>
<td>- Statistics</td>
<td></td>
<td>=CFS</td>
</tr>
<tr>
<td></td>
<td>File Control Table - Data</td>
<td></td>
<td>=CFT</td>
</tr>
<tr>
<td></td>
<td>Table</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>File Control Table - Logging</td>
<td></td>
<td>=CFL</td>
</tr>
</tbody>
</table>
## Summary of Panel Changes

### Table 7. CUA Panel Enhancements (CICS Release 3.3.0)

<table>
<thead>
<tr>
<th>CICS Resource</th>
<th>Resource Attributes</th>
<th>CUA Panel Name</th>
<th>Fast Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>GTF trace</td>
<td>New actions:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Start GTF trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Stop GTF trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Internal trace</td>
<td>New actions:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Start internal trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Stop internal trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Maximum active tasks limit</td>
<td>New entry field: Maximum active tasks</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>AMXT Active Limit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Maximum tasks limit</td>
<td>New entry field: Maximum tasks</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>MXT Active Limit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Programs</td>
<td>New actions:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Enable program</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Disable program</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Newcopy</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Phasein</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Region exit interval</td>
<td>New entry field: Region exit interval</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Runaway task interval</td>
<td>New entry field: Runaway task interval</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scan delay interval</td>
<td>New entry field: Scan delay interval</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Systems</td>
<td>New actions:</td>
<td>Terminal Control Table</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Set terminal inservice</td>
<td>System Entries</td>
<td>=RM</td>
</tr>
<tr>
<td></td>
<td>Set terminal outservice</td>
<td></td>
<td>=RME</td>
</tr>
<tr>
<td></td>
<td>Acquire session</td>
<td>TCT System Entry</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Release session</td>
<td>TCT System Entry Statistics</td>
<td>=RMS</td>
</tr>
<tr>
<td>Terminals</td>
<td>New actions:</td>
<td>Terminal Control Table (TCT)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Set terminal inservice</td>
<td></td>
<td>=CT</td>
</tr>
<tr>
<td></td>
<td>Set terminal outservice</td>
<td></td>
<td>=CTE</td>
</tr>
<tr>
<td></td>
<td>Acquire session</td>
<td></td>
<td>=CTQ</td>
</tr>
<tr>
<td></td>
<td>Release session</td>
<td></td>
<td>=CTS</td>
</tr>
</tbody>
</table>

---

Table 7. CUA Panel Enhancements (CICS Release 3.3.0)
## CICS release 4.1.0

The following table describes the OMEGAMON II for CICS panel changes you will see when you are monitoring CICS Release 4.1.0.

<table>
<thead>
<tr>
<th>CICS Resource</th>
<th>Resource Attributes</th>
<th>CUA Panel Name</th>
<th>Fast Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transaction class limits</td>
<td>New entry fields:</td>
<td>CICS Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td></td>
<td>- Class 1 - Class 10</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- maximum tasks</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>New entry fields:</td>
<td>Transaction Statistics</td>
<td>=WTN</td>
</tr>
<tr>
<td></td>
<td>- Class01 - Class10</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Active Limit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Transactions</td>
<td>New actions:</td>
<td>Transactions</td>
<td>=CN</td>
</tr>
<tr>
<td></td>
<td>- Enable transaction</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Disable transaction</td>
<td>Transaction Entry</td>
<td>=CNE</td>
</tr>
<tr>
<td>VTAM ACB</td>
<td>New actions:</td>
<td>Terminal Control Table</td>
<td>=AV</td>
</tr>
<tr>
<td></td>
<td>- Open VTAM ACB</td>
<td>Prefix (TCTFX)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Close VTAM ACB</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CICS Resource</th>
<th>Resource Attributes</th>
<th>CUA Panel Name</th>
<th>Fast Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auxiliary Trace</td>
<td>New actions:</td>
<td>Trace</td>
<td>=CR</td>
</tr>
<tr>
<td></td>
<td>- Start auxiliary trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Pause auxiliary trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Stop auxiliary trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Switch dataset</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Destinations</td>
<td>New actions:</td>
<td>Destination Control Table (DCT)</td>
<td>=CD</td>
</tr>
<tr>
<td></td>
<td>- Open queue</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Close queue</td>
<td>DCT Extrapartition Information</td>
<td>=CDE</td>
</tr>
<tr>
<td></td>
<td>- Enable queue</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Disable queue</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>New actions:</td>
<td>Destination Control Table Information</td>
<td>=CDP</td>
</tr>
<tr>
<td></td>
<td>- Enable queue</td>
<td>DCT Intrapartition Information</td>
<td>=RNL</td>
</tr>
<tr>
<td></td>
<td>- Disable queue</td>
<td>Destination Queues Over Limits</td>
<td></td>
</tr>
<tr>
<td>DSA limits</td>
<td>New entry fields:</td>
<td>CICS Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td></td>
<td>- DSA limit</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- EDSA limit</td>
<td>CICS Storage</td>
<td>=RS</td>
</tr>
</tbody>
</table>

---

Table 8. CUA Panel Enhancements (CICS Release 4.1.0)
### Table 8. CUA Panel Enhancements (CICS Release 4.1.0)

<table>
<thead>
<tr>
<th>CICS Resource</th>
<th>Resource Attributes</th>
<th>CUA Panel Name</th>
<th>Fast Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Files</td>
<td>New actions:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Open file</td>
<td>File Control Table (FCT)</td>
<td>=CF</td>
</tr>
<tr>
<td></td>
<td>- Close file</td>
<td>File Control Table Entry</td>
<td>=CFE</td>
</tr>
<tr>
<td></td>
<td>- Enable file</td>
<td>File Control Table Entry - Stats</td>
<td>=CFS</td>
</tr>
<tr>
<td></td>
<td>- Disable file</td>
<td>File Control Table - Logging</td>
<td>=CFL</td>
</tr>
<tr>
<td></td>
<td></td>
<td>File Control Table - Data Table</td>
<td>=CFT</td>
</tr>
<tr>
<td>GTF trace</td>
<td>New actions:</td>
<td>Trace</td>
<td>=CR</td>
</tr>
<tr>
<td></td>
<td>- Start GTF trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Stop GTF trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Internal trace</td>
<td>New actions:</td>
<td>Trace</td>
<td>=CR</td>
</tr>
<tr>
<td></td>
<td>- Start internal trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Stop internal trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Maximum tasks limit</td>
<td>New entry field:</td>
<td>CICS Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td></td>
<td>- Maximum tasks</td>
<td>Transaction Statistics</td>
<td>=WTN</td>
</tr>
<tr>
<td>Programs</td>
<td>New actions:</td>
<td>Programs</td>
<td>=CP</td>
</tr>
<tr>
<td></td>
<td>- Enable program</td>
<td>Program Entry</td>
<td>=CPE</td>
</tr>
<tr>
<td></td>
<td>- Disable program</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Newcopy</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Phasein</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Region exit interval</td>
<td>New entry field:</td>
<td>CICS Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td></td>
<td>- Region exit interval</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Runaway task interval</td>
<td>New entry field:</td>
<td>CICS Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td></td>
<td>- Runaway task interval</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scan delay interval</td>
<td>New entry field:</td>
<td>CICS Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td></td>
<td>- Scan delay interval</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Systems</td>
<td>New actions:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Set terminal inservice</td>
<td>Terminal Control Table</td>
<td>=RM</td>
</tr>
<tr>
<td></td>
<td>- Set terminal outservice</td>
<td>System Entries</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Acquire session</td>
<td>TCT System Entry</td>
<td>=RME</td>
</tr>
<tr>
<td></td>
<td>- Release session</td>
<td>TCT System Entry Statistics</td>
<td>=RMS</td>
</tr>
</tbody>
</table>
The following table describes the OMEGAMON II for CICS panel changes you will see when you are monitoring CICS Release 5.1.0.

**Table 8. CUA Panel Enhancements (CICS Release 4.1.0)**

<table>
<thead>
<tr>
<th>CICS Resource</th>
<th>Resource Attributes</th>
<th>CUA Panel Name</th>
<th>Fast Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Terminals</td>
<td>New actions:</td>
<td>Terminal Control Table (TCT)</td>
<td>=CT</td>
</tr>
<tr>
<td></td>
<td>Set terminal inservice</td>
<td>TCTTE</td>
<td>=CTE</td>
</tr>
<tr>
<td></td>
<td>Set terminal outservice</td>
<td>Sequential TCTTE</td>
<td>=CTQ</td>
</tr>
<tr>
<td></td>
<td>Acquire session</td>
<td>TCTTE Statistics</td>
<td>=CTS</td>
</tr>
<tr>
<td>Transaction class limits</td>
<td>New entry fields: An Active Limit field for each defined transaction class</td>
<td>Transaction Statistics</td>
<td>=WTN</td>
</tr>
<tr>
<td>Transactions</td>
<td>New actions:</td>
<td>Transactions</td>
<td>=CN</td>
</tr>
<tr>
<td></td>
<td>Enable transaction</td>
<td>Transaction Entry</td>
<td>=CNE</td>
</tr>
<tr>
<td>VTAM ACB</td>
<td>New actions:</td>
<td>Terminal Control Table Prefix (TCTFX)</td>
<td>=AV</td>
</tr>
<tr>
<td></td>
<td>Open VTAM ACB</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Close VTAM ACB</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**CICS release 5.1.0**

The following table describes the OMEGAMON II for CICS panel changes you will see when you are monitoring CICS Release 5.1.0.

**Table 9. CUA Panel Enhancements (CICS Release 5.1.0)**

<table>
<thead>
<tr>
<th>CICS Resource</th>
<th>Resource Attributes</th>
<th>CUA Panel Name</th>
<th>Fast Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auxiliary Trace</td>
<td>New actions:</td>
<td>Trace</td>
<td>=CR</td>
</tr>
<tr>
<td></td>
<td>Start auxiliary trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Pause auxiliary trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Stop auxiliary trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Switch dataset</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Destinations</td>
<td>New actions:</td>
<td>Destination Control Table (DCT)</td>
<td>=CD</td>
</tr>
<tr>
<td></td>
<td>Open queue</td>
<td>DCT Extrapartition Information</td>
<td>=CDE</td>
</tr>
<tr>
<td></td>
<td>Close queue</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Enable queue</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Disable queue</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>New actions:</td>
<td>DCT Intrapartition Information</td>
<td>=CDP</td>
</tr>
<tr>
<td></td>
<td>Enable queue</td>
<td>Destination Queues Over Limits</td>
<td>=RNL</td>
</tr>
<tr>
<td></td>
<td>Disable queue</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Summary of Panel Changes

### Table 9. CUA Panel Enhancements (CICS Release 5.1.0)

<table>
<thead>
<tr>
<th>CICS Resource</th>
<th>Resource Attributes</th>
<th>CUA Panel Name</th>
<th>Fast Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>DSA limits</td>
<td>New entry fields:</td>
<td>CICS Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td></td>
<td>- DSA limit</td>
<td>CICS Storage</td>
<td>=RS</td>
</tr>
<tr>
<td></td>
<td>- EDSA limit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Files</td>
<td>New actions:</td>
<td>File Control Table (FCT)</td>
<td>=CF</td>
</tr>
<tr>
<td></td>
<td>- Open file</td>
<td>File Control Table Entry=CFE</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Close file</td>
<td>File Control Table Entry - Statistics</td>
<td>=CFS</td>
</tr>
<tr>
<td></td>
<td>- Enable file</td>
<td>File Control Table - Logging</td>
<td>=CFL</td>
</tr>
<tr>
<td></td>
<td>- Disable file</td>
<td>File Control Table - Data Table</td>
<td>=CFT</td>
</tr>
<tr>
<td>GTF trace</td>
<td>New actions:</td>
<td>Trace</td>
<td>=CR</td>
</tr>
<tr>
<td></td>
<td>- Start GTF trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Stop GTF trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Internal trace</td>
<td>New actions:</td>
<td>Trace</td>
<td>=CR</td>
</tr>
<tr>
<td></td>
<td>- Start internal trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Stop internal trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Journals</td>
<td>New actions:</td>
<td>Journals</td>
<td>=RJ</td>
</tr>
<tr>
<td></td>
<td>- Enable journal</td>
<td>Journal Details</td>
<td>=RJD</td>
</tr>
<tr>
<td></td>
<td>- Disable journal</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Flush journal</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Reset journal</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Maximum tasks limit</td>
<td>New entry field:</td>
<td>CICS Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td></td>
<td>- Maximum tasks</td>
<td>Transaction Statistics</td>
<td>=WTN</td>
</tr>
<tr>
<td></td>
<td>New entry field:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- MXT Active Limit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Programs</td>
<td>New actions:</td>
<td>Programs</td>
<td>=CP</td>
</tr>
<tr>
<td></td>
<td>- Enable program</td>
<td>Program Entry</td>
<td>=CPE</td>
</tr>
<tr>
<td></td>
<td>- Disable program</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Newcopy</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Phasein</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Region exit interval</td>
<td>New entry field:</td>
<td>CICS Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td></td>
<td>- Region exit interval</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Runaway task interval</td>
<td>New entry field:</td>
<td>CICS Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td></td>
<td>- Runaway task interval</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scan delay interval</td>
<td>New entry field:</td>
<td>CICS Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td></td>
<td>- Scan delay interval</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Summary of Panel Changes

#### Systems
- New actions:
  - Set terminal inservice
  - Set terminal outservice
  - Acquire session
  - Release session

#### Terminals
- New actions:
  - Set terminal inservice
  - Set terminal outservice
  - Acquire session
  - Release session

#### Transaction class limits
- New entry fields:
  - Active Limit

#### Transactions
- New actions:
  - Enable transaction
  - Disable transaction

#### UOW
- New actions:
  - Force commit
  - Force backout
  - Force defined action

#### UOW links
- New action:
  - Delete UOW link

#### VTAM ACB
- New actions:
  - Open VTAM ACB
  - Close VTAM ACB

---

### Table 9. CUA Panel Enhancements (CICS Release 5.1.0)

<table>
<thead>
<tr>
<th>CICS Resource</th>
<th>Resource Attributes</th>
<th>CUA Panel Name</th>
<th>Fast Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Systems</td>
<td>New actions:</td>
<td>Terminal Control Table System Entries</td>
<td>=RM</td>
</tr>
<tr>
<td></td>
<td></td>
<td>TCT System Entry</td>
<td>=RME</td>
</tr>
<tr>
<td></td>
<td></td>
<td>TCT System Entry Statistics</td>
<td>=RMS</td>
</tr>
<tr>
<td>Terminals</td>
<td>New actions:</td>
<td>Terminal Control Table (TCT)</td>
<td>=CT</td>
</tr>
<tr>
<td></td>
<td></td>
<td>TCTTE</td>
<td>=CTE</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Sequential TCTTE</td>
<td>=CTQ</td>
</tr>
<tr>
<td></td>
<td></td>
<td>TCTTE Statistics</td>
<td>=CTS</td>
</tr>
<tr>
<td>Transaction class limits</td>
<td>New entry fields:</td>
<td>Transaction Statistics</td>
<td>=WTN</td>
</tr>
<tr>
<td>Transactions</td>
<td>New actions:</td>
<td>Transactions</td>
<td>=CN</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Transaction Entry</td>
<td>=CNE</td>
</tr>
<tr>
<td>UOW</td>
<td>New actions:</td>
<td>UOWs</td>
<td>=WU</td>
</tr>
<tr>
<td></td>
<td></td>
<td>UOW Details</td>
<td>=WUD</td>
</tr>
<tr>
<td></td>
<td></td>
<td>UOW Enqueues</td>
<td>=WUQ</td>
</tr>
<tr>
<td></td>
<td></td>
<td>UOW Links</td>
<td>=WUL</td>
</tr>
<tr>
<td>UOW links</td>
<td>New action:</td>
<td>UOW Links</td>
<td>=WUL</td>
</tr>
<tr>
<td>VTAM ACB</td>
<td>New actions:</td>
<td>Terminal Control Table Prefix (TCTFX)</td>
<td>=AV</td>
</tr>
</tbody>
</table>
Summary of Panel Changes
Introduction

Candle Corporation is committed to producing top-quality software products and services. To assist you with making effective use of our products in your business environment, Candle is also committed to providing easy-to-use, responsive customer support.

Precision, speed, availability, predictability—these terms describe our products and Customer Support services.

Included in this Guide to Candle Customer Support is information about the following:

Base Maintenance Plan .................................................. 490
  – Telephone Support
  – eSupport
  – Description of Severity Levels
  – Service-level objectives
  – Recording and monitoring calls for quality purposes
  – Customer Support Escalations
  – Above and Beyond

Enhanced Support Services ........................................... 494
  – Assigned Support Center Representative (ASCR)
  – Maintenance Assessment Services (MAS)
  – Multi-Services Manager (MSM)

Customer Support Contact Information ............................. 495
  – Link to Worldwide Support Telephone and E-mail information
Base Maintenance Plan

Overview
Candle offers a comprehensive Base Maintenance Plan to ensure that you realize the greatest value possible from your Candle software investments. We have more than 200 technicians providing support worldwide, committed to being responsive and to providing expedient resolutions to support requests. Technicians are available worldwide at all times during the local business day. In the event of an after-hours or weekend emergency, our computerized call management and forwarding system will ensure that a technician responds to Severity One situations within one hour. For customers outside of North America, after-hours and weekend support is provided in English language only by Candle Customer Support technicians located in the United States.

Telephone support
Candle provides consistently reliable levels of service—thanks to our worldwide support network of dedicated experts trained for specific products and operating systems. You will always work with a professional who truly understands your problem.

We use an online interactive problem management system to log and track all customer-reported support requests. We give your support request immediate attention by routing the issue to the appropriate technical resource, regardless of geographic location.

- **Level 0 Support** is where your call to Candle Customer Support is first handled. Your support request is recorded in our problem management system, then transferred to the appropriate Level 1 support team. We provide Level 0 manual interaction with our customers because we support more than 170 products. We feel our customers would prefer personal interaction to a complex VRU or IVR selection menu.

- **Level 1 Support** is the service provided for initial support requests. Our Level 1 team offers problem determination assistance, problem analysis, problem resolutions, installation assistance, and preventative and corrective service information. They also provide product usage assistance.

- **Level 2 Support** is engaged if Level 1 cannot provide a resolution to your problem. Our Level 2 technicians are equipped to analyze and reproduce errors or to determine that an error is not reproducible. Problems that cannot be resolved by Level 2 are escalated to Candle’s Level 3 R&D support team.

- **Level 3 Support** is engaged if a problem is identified in Candle product code. At Level 3, efforts are made to provide error correction, circumvention or notification that a correction or circumvention is not available. Level 3 support provides available maintenance modifications and maintenance delivery to correct appropriate documentation or product code errors.

**eSupport**
In order to facilitate the support process, Candle also provides **eSupport**, an electronic full-service information and customer support facility, via the World Wide Web at [www.candle.com/support/](http://www.candle.com/support/). **eSupport** allows you to open a new service request and update
existing service requests, as well as update information in your customer profile. New and updated service requests are queued to a support technician for immediate action. And we can respond to your request electronically or by telephone—it is your choice.

**eSupport** also contains a continually expanding knowledge base that customers can tap into at any time for self-service access to product and maintenance information.

The Candle Web Site and **eSupport** can be accessed 24 hours a day, 7 days a week by using your authorized Candle user ID and password.

**Description of Candle severity levels**

Responses to customer-reported product issues and usage questions are prioritized within Candle according to Severity Code assignment. Customers set their own Severity Levels when contacting a support center. This ensures that we respond according to your individual business requirements.

<table>
<thead>
<tr>
<th>Severity 1</th>
<th>Crisis</th>
</tr>
</thead>
<tbody>
<tr>
<td>A crisis affects your ability to conduct business, and no procedural workaround exists. The system or application may be down.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Severity 2</th>
<th>High</th>
</tr>
</thead>
<tbody>
<tr>
<td>A high-impact problem indicates significant business effect to you. The program is usable but severely limited.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Severity 3</th>
<th>Moderate</th>
</tr>
</thead>
<tbody>
<tr>
<td>A moderate-impact problem involves partial, non-critical functionality loss or a reasonable workaround to the problem. A “fix” may be provided in a future release.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Severity 4</th>
<th>Low</th>
</tr>
</thead>
<tbody>
<tr>
<td>A low-impact problem is a “how-to” or an advisory question.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Severity 5</th>
<th>Enhancement Request</th>
</tr>
</thead>
<tbody>
<tr>
<td>This is a request for software or documentation enhancement. Our business units review all requests for possible incorporation into a future release of the product.</td>
<td></td>
</tr>
</tbody>
</table>

**Candle has established the following service-level objectives:**

<table>
<thead>
<tr>
<th>Call Status</th>
<th>Severity 1 Goal</th>
<th>Severity 2 Goal</th>
<th>Severity 3 Goal</th>
<th>Severity 4 Goal</th>
<th>Severity 5 Goal</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Call Time to Answer</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Level 1 Response (Normal Business Hours)</td>
<td>90% within one minute</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Level 2 Response (Normal Business Hours)</td>
<td>90% within 5 minutes</td>
<td>90% within one hour</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Warm Transfer</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The above information is for guideline purposes only. Candle does not guarantee or warrant the above service levels. This information is valid as of October 1999 and is subject to change without prior notice.
## Base Maintenance Plan

<table>
<thead>
<tr>
<th>Call Status</th>
<th>Severity 1 Goal</th>
<th>Severity 2 Goal</th>
<th>Severity 3 Goal</th>
<th>Severity 4 Goal</th>
<th>Severity 5 Goal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scheduled follow-up (status update)</td>
<td>Hourly or as agreed</td>
<td>Daily or as agreed</td>
<td>Weekly or as agreed</td>
<td>Notification is made when an enhancement is incorporated into a generally available product.</td>
<td></td>
</tr>
</tbody>
</table>

Notification is made when a fix is incorporated into a generally available product.

The above information is for guideline purposes only. Candle does not guarantee or warrant the above service levels. This information is valid as of October 1999 and is subject to change without prior notice.
Recording and Monitoring Calls for Quality Purposes

Candle is committed to customer satisfaction. To ensure that our customers receive high levels of service, quality and professionalism, we’ll monitor and possibly record incoming and outgoing Customer Support calls. The information gleaned from these calls will help us serve you better. If you prefer that your telephone call with Candle Customer Support in North America not be monitored or recorded, please advise the representative when you call us at (800) 328-1811 or (310) 535-3636.

Customer Support Escalations

Candle Customer Support is committed to achieving high satisfaction ratings from our customers. However, we realize that you may occasionally have support issues that need to be escalated to Candle management. In those instances, we offer the following simple escalation procedure:

If you experience dissatisfaction with Candle Customer Support at any time, please escalate your concern by calling the Candle support location closest to you. Ask to speak to a Customer Support manager. During standard business hours, a Customer Support manager will be available to talk with you or will return your call. If you elect to hold for a manager, you will be connected with someone as soon as possible. If you wish a return call, please tell the Candle representative coordinating your call when you will be available. After contacting you, the Customer Support manager will develop an action plan to resolve your issue. All escalations or complaints received about support issues are logged and tracked to ensure responsiveness and closure.

Above and Beyond

What differentiates Candle’s support services from our competitors? We go the extra mile by offering the following as part of our Base Maintenance Plan:

- Unlimited multi-language defect, installation and operations support
- eSupport using the World Wide Web
- Regularly scheduled product updates and maintenance provided at no additional charge
- Over 200 specialized technicians providing expert support for your Candle products
Enhanced Support Services

Overview

Our Base Maintenance Plan provides a high level of software support in a packaged offering. However, in addition to this plan, we have additional fee-based support services to meet unique customer needs.

The following are some examples of our added-value support services:

- **Assigned Support Center Representative Services (ASCR)**
  - An assigned focal point for managing support escalation needs
  - Proactive notification of available software fixes
  - Proactive notification of product version updates
  - Weekly conference calls with your ASCR to review active problem records
  - Monthly performance reviews of Candle Customer Support service levels
  - Optional on-site visits (extra charges may apply)

- **Maintenance Assessment Service (MAS)**
  - On-site assessment services
  - Advice about product maintenance and implementation
  - Training your staff to develop efficient and focused procedures to reduce overall cost of ownership of your Candle software products
  - Analysis of your Candle product environment: versions, updates, code correction history, incident history and product configurations
  - Reviews to ensure that purchased Candle products and solutions are used effectively

- **Multi-Services Manager (MSM)**
  Multi-Services Manager provides highly valued services to customers requiring on-site full time expertise to complement their technical resources.
  - Dedicated on-site Candle resource (6 months or one year) at your site to help ensure maximum use and effectiveness of your Candle products
  - Liaison for all Candle product support activities, coordination and assistance with implementation of all product updates and maintenance releases
  - Works with your staff to understand business needs and systems requirements
  - Possesses technical and systems management skills to enhance your staff’s knowledge and expertise
  - Other projects as defined in Statement of Work for MSM services
Customer Support Contact Information

Link to Worldwide Support Telephone and E-mail information

To contact Customer Support, the current list of telephone numbers and e-mail addresses can be found on the Candle Web site, www.candle.com/support/.

Select Support Contacts from the list on the left of the page.
Customer Support Contact Information
### Symbols
- .FGO command 412, 419
- .RTN command 419
- .RTN immediate 421
- .SGO command 412, 419
- .TSF command 412

### Numerics
- 3270 terminal emulator 38

### A
- accessing OMEGAMON II 36
- account level security 50
- account number 50
- action bar
  - Actions 39
  - definition 37
  - GoTo 39
  - Help 39, 44
  - home position on 39
  - Index 39
  - options 39
  - using 39
  - View 39
- action code 42
  - explicit 81
  - implicit 81
- address space
  - CT/Engine 50
  - initialization 50
  - storage 360
- address symbol 210
- Adobe portable document format 21
- advanced features 409
- AIDs 116
- alerts (CUA)
  - bottlenecks 388
  - CICS loop (time-of-day) 394
  - dumps 396
  - enqueues 397
  - extended recovery facility (XRF) 406
  - I/O rate 401
  - VTAM ACB 405
- allocating
  - storage by components 364
  - storage by tasks 366
- Allocations panel (CUA) 371
- alternative logon method 55
- AMXT
  - % of 257
- analyzing problems 62
- anchor 208
  - address 212
- application
  - file control table element (AFCTE) 129
  - owning region (AOR) 247
- Application Trace 192
- application trace, activating
  - activating collection 105
- ASCR
  - assigned support center representative 494
- ASF 415
- assigned support center representative
  - ASCR 494
- asterisk 38
- Authorized Command Facility password 83
- authorized commands
  - disable 87
  - enable 87
- Auto keyword 416
- auto refresh interval 66, 84
- autoinstall 405
- automated features 410
- automatic initiate descriptors (CUA) 116
  - definition 244
  - Details panel 245
  - summary panel 244
  - terminating 244
- automatic screen facility (ASF) 415
  - cancel 419
  - example 420
  - logging parameters 418
  - parameters 416
  - using screen spaces 419
- automating and logging features 410–421

### B
- background facilities 409
- background option 410
- basic mapping support
  - Details panel 246
- batch reports (CUA) 35, 93
bottleneck analysis (CUA) 388
   internal bottlenecks 256
   internal/external contention 389
branch
   after compare 223
   after test under mask 225

C

CAVM 406
CEDA transaction 267
CEMT 227
chaining screens 419
character conversion 220
choice 37
CICS Address Space Information panel 235, 295, 407
CICS Address Space TCBs panel 236, 297, 408
CICS Dataspaces panel 229
CICS File/Database
   activating collection 95
CICS Job Information panel 408
CICS Master Terminal panel 227
CICS Memory (CUA)
   action codes 211
   address symbol 210, 217
   anchor 208
   arrangement of virtual storage 208
   chase chain 214
   CICS address space 207
   displacement 208
   indirect addressing 211
   offset value 210
   Panel 208
   panel 72
   pointers 210
   pushbuttons 226
   scan memory 213
   unformatted virtual storage content 207
   zap memory 216
CICS monitoring facility (CMF) 165, 258
CICS region 64
CICS system analysis 33
CICS Tables (CUA) 113–163
   automatic initiate descriptors (AIDs) 116, 244
   CICS common system area (CSA) 117
   DCT Extrapartition 120
   DDIR (DL/I Database Directory) 123
   Destinations (DCT) 118
   DL/I
      Control Blocks 124
      PSB Directory Entry (PDIR Entry) 139
   Dumps 125
   Enqueues 126
   EXITS
      exit program blocks (EPBs) 127
      global user exits (GLUEs) 127
      extended recovery facility (XRF) 163
   FCT 129
   ICE (Interval Control Elements) 133
   JOUR (Journals) 134
   journal model resource definitions 134
   LSR (local shared resources) 137
   panel 70
   PDIR (DL/I PSB directory) 138
   PROG (Programs) 140
   Sequential TCTTE 149
   SIT (System Initialization Table) 143
   TCB (CICS TCBs) 144
   TCT System Entry 147, 348
   TCTFX (Terminal Control Table Prefix) 151
   TCTSE (TCT System Entries) 152
   Terminal Control Table Terminal Entry
      (TCTTE) 146
   TRACE
      for CICS/ESA 155
      for CICS/MVS 156
   TRAN (Transactions) 158
   Transaction Entry 159
   TS (Temporary Storage) 161
   TSQ (Temporary Storage Queues) 162
close print log 109
CMF 165
CMXT exception 257
color
   highlighting 38
   status bar 37
   terminal 61
commands
   reference 426
   usage 426
commands (CUA)
   authority 238, 239
   authorized 54
   protected 54
commands (Menu) 423–464
   EXEC level 96
   common interface (CI)
      password (CUA) 53
   common system area (CSA) 117, 394
   compressions, program 359
   console ID 238, 239
   continuation character
      extended help indicator 424
   control
      area split 321
Index 499

interval split 321
pull-down 83
custom data collection 63
CPU (CUA) 293
pushbuttons 294
rates 235
service request block (SRB) 293
task control block (TCB) 293
CPU Rates panel 407
CT/Engine address space 50
CUA interface 31
accessing through direct logon 31, 36
accessing through OMEGAVIEW 31, 36
customizing options for the panel contents 36
session 79, 106
using 31, 36
current time 82
customer service
telephone support 490
customer support
base maintenance plan 490
contact information 495
enhanced support services 494
eSupport 490
severity levels 491
customization defaults, verifying 56

D

DASD (CUA) 301
CICS datasets on a volume 307
details for a device 307
solutions to problems 302
tuning guidelines 303
data
display area 37
data collection 88
for interval recording (CUA) 93
frequency of 63
dataspace
CUA panel 229
Dataspace Memory panel 230
date and time stamp
on Region Status panel 65
DAY keyword 413
DB2 (CUA) 308
Transaction Details 309
DBCTL (CUA) 310
DDIR
DL/I Database Directory 123
deadlocks 399
default options 79
settings
changing response time 251
intervals 251
thresholds 251
userid profile 108
view 84
Destinations (DCT)
Extrapartition Information panel 120
Indirect Information panel 119
Intrapartition Information panel 122
intrapartition transient data queues, deleting 119
Remote Information panel
remote transient data queues, deleting 121
direct logon 50
disable authorized commands 87
dispatcher task area (DTA) 261
displacement 208
DL/I (CUA) 312
configuration 314
control blocks 124
ISAM/OSAM Buffers 315
PSB Directory Entry (PDIR Entry) panel 139
DRDY exception 420
DSA Storage panel 358
dump (CUA)
CICS activity 125
field 396

e

ellipsis 38
emulator
3270 terminal 38
dead-end response time (CUA) 251, 255
enqueue (CUA) 126, 397
techniques for avoiding problems 399
two types of problems 398
Enter key 45
eSupport
customer support 490
exception analysis 410
logging facility (XLF) 414
logging parameters 416
option 410
exception logging facility 414
excessive CPU usage 293
EXEC level command 96
exit
code 127
from OMEGAMON II 46
point 127
status 127
Exit Program Blocks (EPBs)
panel 127
EXSY 419
extended recovery facility (XRF) 163
    information panel 406
external contention 256
external contention analysis 33
External Contention Details panel 391
External Contention panel 389
Extrapartition Information panel, DCT 120

F
fast path character 42
fast pathing (CUA) 43, 74
features, monitoring 33
FEPI 180
field-level help 45
fields, selectable 37
file
    field 320
    open VSAM 320
File Control Table Entry (FCTE) 129
    Data Table panel 132
    Logging panel 131
    panel 129
    pushbuttons 130
    Statistics panel 130
filtering criteria 76
frequency of data collection 63, 106
front end programming interface (FEPI) 180
function keys 46
function keys (CUA) 37
    on the Region Status panel 67, 81

G
global
data area 96
glossary
    help for 45
GoTo pull-down menu 69
group
    level security 50
    logical unit (LU) 251
group types
    logical unit (LU) 107
    program 107
    terminal 107
    transaction 107

H
hardcopy log 237
hardware error 301
heartbeat interval 406
help
    from a panel 45
    from an input field 45
    from the action bar 44
glossary 45
    online 44
    pull-down menu 44, 111
search help glossary 44
search help index 44
    system (CUA interface) 111
hexadecimal calculation 221
highlighting
    color 38
    fields 38
    types of text 38
    underscore 38
hiperspace 229, 230
historical facility 31
Historical Reporter 35
home position 39

I
I/O
    rate 401
ICEs 249
ICP:PUT Data Details 246
    implicit action/selection 42, 81
    index
        pull-down menu, fast path codes 74
        index of panels 74
    indirect
        addressing 211
Indirect Information panel, DCT 119
internal bottleneck
    activating collection 89
    analysis 388
    display controls
        activating 91
    internal bottleneck analysis 89
    internal bottleneck collection 33
    Internal Bottleneck Details panel 393
    Internal Bottlenecks panel 388
    intersystem communication 347
    interval control element (CUA) 249
    CICS Tables 133
        details panel 250
        summary panel 249
        terminating 249
    interval recording (CUA)
        activating collection 93
    intrapartition
        Information Panel 122
        intrapartition transient data queues, deleting 119,
<table>
<thead>
<tr>
<th>Page Numbers</th>
<th>Index Terms</th>
</tr>
</thead>
<tbody>
<tr>
<td>121, 122</td>
<td>ISAM/OSAM Buffers 315</td>
</tr>
<tr>
<td>J</td>
<td>journal (CUA) 330</td>
</tr>
<tr>
<td></td>
<td>JCT entry 135</td>
</tr>
<tr>
<td></td>
<td>journal control table (CUA) 134</td>
</tr>
<tr>
<td></td>
<td>Journal Details panel 333</td>
</tr>
<tr>
<td></td>
<td>Journal Models panel 134, 332</td>
</tr>
<tr>
<td></td>
<td>Journals panel 330</td>
</tr>
<tr>
<td>K</td>
<td>key sequenced datasets (KSDS) 324</td>
</tr>
<tr>
<td></td>
<td>kill</td>
</tr>
<tr>
<td></td>
<td>AID 244</td>
</tr>
<tr>
<td></td>
<td>ICE 249</td>
</tr>
<tr>
<td></td>
<td>task 258, 259, 293</td>
</tr>
<tr>
<td></td>
<td>KOCDCBCOL macro 182</td>
</tr>
<tr>
<td>L</td>
<td>Limit field 416</td>
</tr>
<tr>
<td></td>
<td>Local Shared Resources (CUA) 137</td>
</tr>
<tr>
<td></td>
<td>buffer counts 341</td>
</tr>
<tr>
<td></td>
<td>buffer pool details 340</td>
</tr>
<tr>
<td></td>
<td>pools 339</td>
</tr>
<tr>
<td></td>
<td>Local shared resources (CUA) 338</td>
</tr>
<tr>
<td></td>
<td>Log field 416</td>
</tr>
<tr>
<td></td>
<td>log manager domain 330</td>
</tr>
<tr>
<td></td>
<td>log stream 134, 330</td>
</tr>
<tr>
<td></td>
<td>log stream failure 331</td>
</tr>
<tr>
<td></td>
<td>Log Streams panel 332</td>
</tr>
<tr>
<td></td>
<td>logical rows parameter 54</td>
</tr>
<tr>
<td></td>
<td>logical tuning approach 32</td>
</tr>
<tr>
<td></td>
<td>logon</td>
</tr>
<tr>
<td></td>
<td>account level security 50</td>
</tr>
<tr>
<td></td>
<td>choices 49</td>
</tr>
<tr>
<td></td>
<td>group level security 50</td>
</tr>
<tr>
<td></td>
<td>options 52</td>
</tr>
<tr>
<td></td>
<td>to OMEGAMON II</td>
</tr>
<tr>
<td></td>
<td>direct 50</td>
</tr>
<tr>
<td></td>
<td>through OMEGAVIEW 55</td>
</tr>
<tr>
<td></td>
<td>looping task 259</td>
</tr>
<tr>
<td></td>
<td>LROWS 54</td>
</tr>
<tr>
<td></td>
<td>LSR 137</td>
</tr>
<tr>
<td></td>
<td>LU6.2 Details pop-up 247</td>
</tr>
<tr>
<td>M</td>
<td>machine instructions 222</td>
</tr>
<tr>
<td></td>
<td>maintenance assessment service</td>
</tr>
<tr>
<td></td>
<td>MAS 494</td>
</tr>
<tr>
<td></td>
<td>MAS</td>
</tr>
<tr>
<td></td>
<td>maintenance assessment service 494</td>
</tr>
<tr>
<td></td>
<td>Master Terminal panel 227</td>
</tr>
<tr>
<td></td>
<td>measuring performance 32</td>
</tr>
<tr>
<td></td>
<td>migrate profile 53</td>
</tr>
<tr>
<td></td>
<td>minus sign (-) 38</td>
</tr>
<tr>
<td></td>
<td>mnemonics 42</td>
</tr>
<tr>
<td></td>
<td>monitoring</td>
</tr>
<tr>
<td></td>
<td>controls, setting 106</td>
</tr>
<tr>
<td></td>
<td>OMEGAMON II features 33</td>
</tr>
<tr>
<td></td>
<td>performance 32</td>
</tr>
<tr>
<td></td>
<td>monitoring control, activating</td>
</tr>
<tr>
<td></td>
<td>activating collection 99</td>
</tr>
<tr>
<td></td>
<td>monochrome terminal 37, 38, 61</td>
</tr>
<tr>
<td></td>
<td>selecting items on 42</td>
</tr>
<tr>
<td></td>
<td>unavailable items on 38</td>
</tr>
<tr>
<td></td>
<td>more information, displaying 38</td>
</tr>
<tr>
<td></td>
<td>MRO/ISC (CUA) 267, 347</td>
</tr>
<tr>
<td></td>
<td>MSM</td>
</tr>
<tr>
<td></td>
<td>multi-services manager 494</td>
</tr>
<tr>
<td></td>
<td>multi-services manager</td>
</tr>
<tr>
<td></td>
<td>MSM 494</td>
</tr>
<tr>
<td></td>
<td>MVS</td>
</tr>
<tr>
<td></td>
<td>loaded modules 236</td>
</tr>
<tr>
<td></td>
<td>MVS Loaded Modules panel 299, 408</td>
</tr>
<tr>
<td></td>
<td>MVS resources</td>
</tr>
<tr>
<td></td>
<td>CICS</td>
</tr>
<tr>
<td></td>
<td>Address Space Information 235</td>
</tr>
<tr>
<td></td>
<td>Address Space TCBs 236</td>
</tr>
<tr>
<td></td>
<td>Job Information 236</td>
</tr>
<tr>
<td></td>
<td>CPU Rates 235</td>
</tr>
<tr>
<td></td>
<td>MVS Loaded Modules 236</td>
</tr>
<tr>
<td></td>
<td>pushbuttons 235</td>
</tr>
<tr>
<td></td>
<td>Working Set Size and Paging Rates 235</td>
</tr>
<tr>
<td></td>
<td>XRF Information 236</td>
</tr>
<tr>
<td></td>
<td>MVS Resources panel 408</td>
</tr>
<tr>
<td></td>
<td>MVS system logger 134, 330</td>
</tr>
<tr>
<td>N</td>
<td>national language 81</td>
</tr>
<tr>
<td></td>
<td>navigation</td>
</tr>
<tr>
<td></td>
<td>fast path 43</td>
</tr>
<tr>
<td></td>
<td>point-and-shoot 42</td>
</tr>
<tr>
<td></td>
<td>pushbuttons 43</td>
</tr>
<tr>
<td></td>
<td>transplex 43</td>
</tr>
<tr>
<td></td>
<td>not responding/ready 304</td>
</tr>
<tr>
<td></td>
<td>number conversion 219</td>
</tr>
<tr>
<td>O</td>
<td>OMEGAMON 251</td>
</tr>
<tr>
<td></td>
<td>OMEGAMON II for CICS Dataspaces panel 231</td>
</tr>
<tr>
<td></td>
<td>OMEGAMON II for CICS Memory Panel 226</td>
</tr>
<tr>
<td></td>
<td>OMEGAVIEW</td>
</tr>
<tr>
<td></td>
<td>accessing CUA interface through 49</td>
</tr>
</tbody>
</table>
online help 44
CUA interface 111
operator
authority 237
console 237, 238
Options pull-down menu
CICS shutdown option 106
close print log 109
collection controls 88
controls 83
date format 81
default options 79
delete confirmation 81
exit confirmation 81
implicit action 81
managing
CICS region 109
national language 81
panel ID 80
preferences 80
region profiles 109
thresholds 106
time format 82
userid profiles 108
OPTN keyword 420
OUTP 418
overview products 409

P
Page Allocation Map panel (CUA) 367
paging (CUA) 351
panel characteristics
asterisks 38
body 37
color 38
ellipsis 38
help 45
highlighting 38
ID 80
reverse video 38
scrolling 38
scrolling using More 38
status bars 37
underlining 38
using overtypable line 38
panels
action bar 36
body 36
characteristics 36
function keys 36
pushbuttons 36
password 50

authorization 54
authorized commands 54
changing the 51
common interface 53
duration of 54
entering 51
reset authorization for 54
PDIR
(DLI PSB directory) 138
performance 37
data collection 88
identifying problems 32
measure 57
monitoring 106
setting standards 32
performance monitoring 32
Persist keyword 417
plus sign 38
plus sign (+) 38
point-and-shoot 31
pointers
list memory outside of 210
list memory using 210
poor response time 252
pop-up Window 41
power failure 301
printing problems 21
problem reporter
reports 93
profile
default 109
default user ID 108
managing user 108
menu option 410
PROG (Programs) 140
program 299
definition of 357
response time 251
status word (PSW) 157, 299
Program Check/Abend Trace Table 157
Program Compressions panel 359
programs, user written 35
PSW 157, 299
pull-down Menu 40
pushbuttons 37
fast pathing with 43

R
realtime monitor 31
recovery
effects of transient data 381
region
profile 53, 64, 79, 109, 110
switching 64
Region Status panel 57
Remote Information panel, DCT 121
Repeat keyword 416
REPORT log 418, 421
reporter 35
methods 35
resource limiting
activating collection 96
global data area module 96
KOCRLIM macro 96
setting thresholds 96
resource usage 63
resources
CPU Rates panel
excluded tasks on 293
resources (CUA)
CPU 293
DASD 301
DB2 308
DBCTL 310
DL/I 312
files 320
IMS pool types 312
journals
general logs 330
log-of-logs 331
system logs 330
local shared resources (LSR) 338
MRO/ISC 347
paging 351
storage 354
tapes 372
temporary storage 374
transient data 380
type 323
resources (Menu)
limiting 96
response time (CUA)
activating collection 92
cause of poor 252
collection 251
definition of 251
details panel 255
End-to-End feature (ETE) 251
groups 107, 251
history 253
programs 251
pushbuttons 255
summary panel 251
terminals 251
transactions 251
VTAM LU 251
response time collection (CUA) 34
Response Time Details panel 392
restoring values 78
reusing transient data 381
S
SAS 35
Sc field 417
scanning CICS memory 213
screen
print log 109
space 410
scrolling 38
search facility
for help glossary 45
for help index 45
for the Index pull-down 74
search index 74
security
programs 54
requirements 50
selectable field 37
Sequential TCTTE panel 149
service level indicator 106
session defaults 79, 83
severity levels
customer support 491
shared temporary storage 377
short-on-storage (CUA) 257, 357
show details 62
shutdown CICS 106
Sign On panel
CUA interface 50, 52
simplified signon 466
SL keyword 413, 417
software performance monitor 31
SS keyword 413, 417
starting an OMEGAMON II session 56
Statistical Analysis System (SAS) 35
status
bar, color of 62
characters 61, 85
condition following 32
default 61
words 61, 85
status bar
color of 37
Storage (CUA)
Allocations panel 371
storage (CUA) 354
address space 360

Index 503
allocation by
  components 364
tasks 366
dynamic storage area (DSA) 357
extended dynamic storage area (EDSA) 357
program compression 357, 359
short-on- 357
storage protection 357
subpools 365
transaction isolation 357
violation 357
stress 257
suspend area 261
switching
  regions 64
system
defaults, changing 79
system analysis, CICS 33
System Console panel 237
  adding a command 240
  assigning a mnemonic 240
  command groups 239
  deleting a command 242
  issuing a command 240
  modifying a command 241
  selecting commands for 239
system initialization table (CUA) field 143
System Management Facility (SMF) 35, 93
  records 93
system task control area 261
Systems Application Architecture (SAA) 31
tapes 372
  drive details 373
Task Bridge Details panel 280
task control block (CUA) 261
definition of 297
dispatcher task area (DTA) 261
for CICS 144
selectable TCBs 298
suspend area 261
transaction 261
User TCA (Task Control Area) 261
Task History (CUA) 165–188
  activating collection 94
ADABAS 185
ADABAS requests 168
CICS monitoring facility (CMF) 165
DATA COM 187
DATA COM requests 168
DB2 184
DB2 requests 168
details panel
  excluded tasks on 168
DL/I 183, 189
DL/I requests 168
EXEC FILE 182
FCT 181
FCT requests 168
front end programming interface (FEPI) 180
global data area module with 167
IDMS 186
IDMS requests
  requests 168
panel 71
searching the data store 167
Statistics 175
Storage 170
summary panel
  excluded tasks on 166
  use of 166
SUPRA 188
SUPRA requests 168
Terminal Statistics 179
TIME USED facility 167
Timings 172, 273
Timings panel
  excluded tasks on 172, 273
umbrella data 178
task-related user exits (TRUEs) 127
Tasks (CUA)
Addresses panel 260
DB2 Statistics panel 263, 265
details panel
  excluded tasks on 258
DL/I Statistics panel 264
flow 395
summary panel
  AMXT, % of 257
  CMXT, highest % of 257
  excluded tasks on 257
  MXT, % of 257
Task FEPI Statistics panel 278
Task File Statistics panel 261
Task Program Storage HWM panel 273
Task Remote Information panel 266
  transplex navigation from 267
Task Statistics panel 268
Task Storage panel 272
Task Terminal Statistics panel 279
Task Umbrella Data panel 277
terminating 258, 259
transplex navigation pushbuttons 259
index

unit-of-work ID (UOW ID) 266
VSAM File Statistics panel 262
wait reasons 258
TCB 297
TCP/IP socket activity 385
TCTFX (Terminal Control Table Prefix) 151
TCTSE (TCT System Entries) 152
TCTTE, sequential 149
TD (Transient Data) 154
telephone support
customer service 490
temporary storage (CUA) 374
shared 377
Temporary Storage Queues panel
deleting queues 375
hexadecimal queue ID display 375
temporary storage table 378
terminal (CUA)
  owning region (TOR) 247
  response time 251
terminal emulator, 3270 38
terminal, monochrome 37, 38
  selecting items on 42
  unavailable items on 38
terminating
  AIDs 244
  ICE(s) 249
  tasks 258, 259
This 415
threshold (CUA) 57, 79
  critical 106
  default response time settings 251
  value 106
  warning 106
threshold (Menu)
  CALL DL/I 96
database request 96
  DB2 96
  EXEC level file control 96
  resource limiting 96
  storage 96
  third-party database 96
time
  keyword 413
time and date display 80
timed screen facility (TSF) 411
  cancel while running 419
  logging parameters 418
  table 412
  using screen spaces 419
tip of the day 54
tips for using OMEGAMON II 45
Tools
branch
  after arithmetic 224
  after compare 223
  after test under mask 225
  machine instructions 222
  pull-down menu 218
TRACE
  for CICS/ESA 155
  for CICS/MVS 156
  for CICS/MVS Program Check/Abend Trace
Table 157
TRAN (Transactions) 158
TranData (CUA) 380
transaction (CUA)
  classes 395
  manager transaction (TXN) 261
  monitoring area (TMA) 261
  queue element (TQE) 261
  response time 251
  work area (TWA) 261
transaction (Menu)
  MACRO level 96
Transaction Entry panel 159
transaction rate (CUA) 281
Transaction Routing Details panel 247
Transaction Statistics panel 395
transient data 380
transient data (CUA)
  benefits of REUSE 381
  destination queues over limits 384
  effects of recovery 381
  intrapartition tuning 381
  transient data details panel 248
transient data queue types, deleting
  indirect 119
  intrapartition 122
  remote 121
transient data queues 119, 122
transplex navigation 43, 267
  pushbuttons 259
trigger key 73, 84
TS (Temporary Storage) 161
TSF 411–413
TSQ (Temporary Storage Queues) 162
TST 378
tuning
  CICS 32
  guidelines for DASD 303
tuning (CUA)
  intrapartition transient data 381
umbrella user data (CUA) 178, 277
unit of work (CUA)
definition 283
usage tips 45
user
    CUA interface 31
user ID 50
User TCA (Task Control Area) 261
user written programs 35
userid profile 53, 79, 108
    settings for 108
values, restoring 78
Version 520 enhancements 25
View pull-down menu 76
View Some pop-up window
    asterisks in the 77
    comparative operators 77
    filtering data through 76
    promptable fields and columns 77
    two or more search criteria in 77
violation storage 357
virtual storage
    unformatted 207
VSAM 324
    details 324
    open files 320
VTAM (CUA)
    ACB 405
    APPLID 50
    netname 266

W
wait
    reasons 91, 323
    for CICS/ESA 258
    provided by OMEGAMON II 258
    resource 91
waiting conversational tasks
    whether to purge 106
    whether to terminate 106
web interface 386
Working Set Size and Paging Rates panel 235, 294, 407

X
XACB 416, 420
XLF 414, 416
XLFLOG 418

Z
zap memory 216
zoom
    return from 84
    return to the CUA interface 73
    to OMEGAMON II menu system 73